Safety Guidelines

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring to property damage only have no safety alert symbol. The notices shown below are graded according to the degree of danger.

Danger
indicates that death or severe personal injury will result if proper precautions are not taken.

Warning
indicates that death or severe personal injury may result if proper precautions are not taken.

Caution
with a safety alert symbol indicates that minor personal injury can result if proper precautions are not taken.

Caution
without a safety alert symbol indicates that property damage can result if proper precautions are not taken.

Attention
indicates that an unintended result or situation can occur if the corresponding notice is not taken into account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning and operation of a device/system may only be performed by qualified personnel. Within the context of the safety notices in this documentation qualified persons are defined as persons who are authorized to commission, ground and label devices, systems and circuits in accordance with established safety practices and standards.

Prescribed Usage

Note the following:

Warning
This device and its components may only be used for the applications described in the catalog or the technical description, and only in connection with devices or components from other manufacturers which have been approved or recommended by Siemens. Correct, reliable operation of the product requires proper transport, storage, positioning and assembly as well as careful operation and maintenance.

Trademarks

All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Copyright Siemens AG 2005 All rights reserved

The distribution and duplication of this document or the utilization and transmission of its contents are not permitted without express written permission. Offenders will be liable for damages. All rights, including rights created by patent grant or registration of a utility model or design, are reserved

Siemens AG
Automation and Drives
Postfach 4848, 90327 Nuremberg, Germany

Siemens Aktiengesellschaft

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG 2005
Technical data subject to change.

A5E00324650-01
Preface

Purpose of the Manual

This manual provides you with a complete overview of programming with S7-SCL. It supports you during the installation and setting up of the software. It includes explanations of how to create a program, the structure of user programs, and the individual language elements.

The manual is intended for programmers writing S7-SCL programs and people involved in configuration, installation and service of programmable logic controllers. We recommend that you familiarize yourself with the example described in Chapter 2 "Designing an S7-SCL Program". This will help you to get to know S7-SCL quickly.

Required Experience

To understand the manual, you should have general experience of automation engineering.

You should also be familiar with working on computers or PC-type machines (for example programming devices with the MS Windows 2000 Professional and MS Windows XP Professional operating systems. Since S7-SCL uses the STEP 7 platform, you should also be familiar with working with the standard software described in the "Programming with STEP 7 V5.3" manual.

Scope of the Manual

The manual is valid for the S7-SCL V5.3 software package as of Service Pack1.
## Documentation Packages for S7-SCL and the STEP 7 Standard Software

The following table provides you with an overview of the STEP 7 and S7-SCL documentation:

<table>
<thead>
<tr>
<th>Manuals</th>
<th>Purpose</th>
<th>Order Number</th>
</tr>
</thead>
</table>
| Basics of SCL and reference:  
  - S7-SCL for S7-300/400, Programming Blocks | Basic and reference information explaining how to create a program, the structure of user programs and the individual language elements. | The manual cannot be ordered separately. It is available on the product CD, the manual collection and on the internet. |
| Basics of STEP 7:  
  - Getting Started and Exercises with STEP 7 V5.3  
  - Programming with STEP 7 V5.3  
  - Configuring Hardware and Connections with STEP 7 V5.3  
  - Converting from S5 to S7 | The basics for technical personnel describing how to implement control tasks with STEP 7 and S7-300/400. | 6ES7810-4CA07-8BW0 |
| STEP 7 reference:  
  - LAD/FBD/STL manuals for S7-300/400  
  - Standard and System Functions for S7-300/400 | Reference work describing the LAD, FBD and STL programming languages as well as standard and system functions as a supplement to the STEP 7 basics. | 6ES7810-4CA07-8BW1 |

<table>
<thead>
<tr>
<th>Online Help</th>
<th>Purpose</th>
<th>Order Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help on S7-SCL</td>
<td>Basics and reference for S7-SCL as online help</td>
<td>Part of the S7-SCL software package</td>
</tr>
<tr>
<td>Help on STEP 7</td>
<td>Basics on programming and configuring hardware with STEP 7 as online help</td>
<td>Part of the STEP 7 software package</td>
</tr>
</tbody>
</table>
| Reference help on STL/LAD/FBD  
Reference help on SFBs/SFCs  
Reference help on organization blocks  
Reference help on IEC functions  
Reference help on system attributes | Context-sensitive reference | Part of the STEP 7 software package |
Online Help

The online help provides you with information at the point at which you need it. You can find the information you require quickly without needing to refer to manuals. The online help includes the following topics:

- **Contents**: Gives you access to various options for displaying help information.
- **Context-Sensitive Help** (F1 key): Displays information about the selected object or currently active dialog or window.
- **Introduction**: Displays a brief overview of the use, essential characteristics, and range of functions of the application.
- **Getting Started**: This item summarizes the activities you need to perform to achieve your first success.
- **Using Help**: This item describes the options open to you for finding specific information in the help system.
- **About**: Displays information about the current version of the application.

Further Support

If you have any technical questions, please get in touch with your Siemens representative or agent responsible.

You will find your contact person at:


You will find a guide to the technical documentation offered for the individual SIMATIC Products and Systems here at:


The online catalog and order system is found under:


Training Centers

Siemens offers a number of training courses to familiarize you with the SIMATIC S7 automation system. Please contact your regional training center or our central training center in D 90327 Nuremberg, Germany for details:

Telephone: +49 (911) 895-3200.

Internet: [http://www.sitrain.com](http://www.sitrain.com)
Technical Support

You can reach the Technical Support for all A&D products

- Via the Web formula for the Support Request [http://www.siemens.com/automation/support-request](http://www.siemens.com/automation/support-request)
- Phone: + 49 180 5050 222
- Fax: + 49 180 5050 223

Additional information about our Technical Support can be found on the Internet pages [http://www.siemens.com/automation/service](http://www.siemens.com/automation/service)

Service & Support on the Internet

In addition to our documentation, we offer our Know-how online on the internet at: [http://www.siemens.com/automation/service&support](http://www.siemens.com/automation/service&support)

where you will find the following:

- The newsletter, which constantly provides you with up-to-date information on your products.
- The right documents via our Search function in Service & Support.
- A forum, where users and experts from all over the world exchange their experiences.
- Your local representative for Automation & Drives.
- Information on field service, repairs, spare parts and more under "Services".
## Contents

### 1 Product Overview
- 1.1 Area of Application of S7-SCL ................................................................. 1-1
- 1.2 How S7-SCL Functions ........................................................................... 1-2
- 1.3 Which Functions Does S7-SCL Offer? .................................................. 1-4
- 1.4 What is New in Version V5.3 SP1? ......................................................... 1-6

### 2 Installation
- 2.1 Automation License Manager ................................................................. 2-1
  - 2.1.1 User Rights Through The Automation License Manager .................. 2-1
  - 2.1.2 Installing the Automation License Manager ..................................... 2-4
  - 2.1.3 Guidelines for Handling License Keys ............................................. 2-5
- 2.2 Installation ............................................................................................... 2-6
  - 2.2.1 Installation Requirements ............................................................... 2-6
  - 2.2.2 Installation of S7-SCL ..................................................................... 2-6

### 3 Designing an S7-SCL Program
- 3.1 Welcome to "Measured Value Acquisition" - A Sample Program for First-Time Users .............................................................. 3-1
- 3.2 Task ......................................................................................................... 3-2
- 3.3 Design of a Structured S7-SCL Program ............................................... 3-4
- 3.4 Defining the Subtasks ............................................................................ 3-6
- 3.5 Defining the Interfaces Between Blocks ............................................... 3-8
- 3.6 Defining the Input/Output Interface ....................................................... 3-10
- 3.7 Defining the Order of the Blocks in the Source File ....................... 3-11
- 3.8 Defining Symbols .................................................................................. 3-12
- 3.9 Creating the SQUARE Function ........................................................ 3-13
  - 3.9.1 Statement Section of the SQUARE Function ................................. 3-13
- 3.10 Creating the EVALUATE function block .................................... 3-14
  - 3.10.1 Flow Chart for EVALUATE ......................................................... 3-14
  - 3.10.2 Declaration Section of FB EVALUATE .................................. 3-15
  - 3.10.3 Statement Section of FB EVALUATE ..................................... 3-16
- 3.11 Creating the function block ACQUIRE ............................................ 3-18
  - 3.11.1 Flow Chart for ACQUIRE .......................................................... 3-18
  - 3.11.2 Declaration Section of FB ACQUIRE .................................... 3-19
  - 3.11.3 Statement Section of FB ACQUIRE ........................................ 3-21
- 3.12 Creating the CYCLE Organization Block ....................................... 3-23
- 3.13 Test Data .............................................................................................. 3-25
4 Using S7-SCL

4.1 Starting the S7-SCL Software ............................................................... 4-1
4.2 User Interface ......................................................................................... 4-2
4.3 Customizing the User Interface ............................................................... 4-3
4.4 Creating and Handling an S7-SCL Source File ..................................... 4-4
4.4.1 Creating a New S7-SCL Source File .................................................. 4-4
4.4.2 Opening an S7-SCL Source File ......................................................... 4-5
4.4.3 Closing an S7-SCL Source File ........................................................... 4-5
4.4.4 Opening Blocks .................................................................................. 4-6
4.4.5 Specifying Object Properties ............................................................... 4-6
4.4.6 Creating SCL Source Files with a Standard Editor ......................... 4-6
4.4.7 Block Protection .................................................................................. 4-7
4.5 Guidelines for S7-SCL Source Files ...................................................... 4-7
4.5.1 General Rules for S7-SCL Source Files ............................................. 4-7
4.5.2 Order of the Blocks ............................................................................ 4-8
4.5.3 Using Symbolic Addresses ................................................................. 4-8
4.6 Editing in S7-SCL Source Files .............................................................. 4-9
4.6.1 Undoing the Last Editing Action ......................................................... 4-9
4.6.2 Redoing an Editing Action ................................................................. 4-9
4.6.3 Finding and Replacing Text Objects .................................................. 4-9
4.6.4 Selecting Text Objects ....................................................................... 4-10
4.6.5 Copying Text Objects ....................................................................... 4-10
4.6.6 Cutting Text Objects ......................................................................... 4-11
4.6.7 Deleting Text Objects ....................................................................... 4-11
4.6.8 Positioning the Cursor in a Specific Line .......................................... 4-12
4.6.9 Syntactically Correct Indenting of Lines ........................................... 4-13
4.6.10 Setting the Font Style and Color ....................................................... 4-14
4.6.11 Placing Bookmarks In The Source Text ............................................ 4-15
4.6.12 Inserting Templates ........................................................................ 4-16
4.6.12.1 Inserting Block Templates ............................................................. 4-16
4.6.12.2 Inserting Block Calls ................................................................. 4-16
4.6.12.3 Inserting Templates for Comments ............................................. 4-16
4.6.12.4 Inserting Parameter Templates ..................................................... 4-17
4.6.12.5 Inserting Control Structures ......................................................... 4-17
4.7 Compiling an S7-SCL Program ............................................................. 4-18
4.7.1 What You Should Know About Compiling ...................................... 4-18
4.7.2 Customizing the Compiler ................................................................ 4-19
4.7.3 Compiling the Program .................................................................... 4-20
4.7.4 Creating a Compilation Control File .................................................. 4-21
4.7.5 Debugging the Program After Compilation ..................................... 4-22
4.8 Saving and Printing an S7-SCL Source File ........................................ 4-23
4.8.1 Saving an S7-SCL Source File ........................................................... 4-23
4.8.2 Customizing the Page Format ............................................................ 4-23
4.8.3 Printing an S7-SCL Source File ........................................................ 4-24
4.8.4 Setting the Print Options ................................................................. 4-25
4.9 Downloading the Created Programs .................................................... 4-26
4.9.1 CPU Memory Reset ......................................................................... 4-26
4.9.2 Downloading User Programs to the CPU ......................................... 4-26
4.10 Testing the Created Programs .............................................................. 4-28
4.10.1 The S7-SCL Debugging Functions ................................................... 4-28
4.10.2 The "Monitor" Debugging Function .................................................. 4-29
4.10.3 Debugging with Breakpoints/Single Step Mode ................................ 4-30
4.10.4 Steps in Monitoring ....................................................................... 4-31
4.10.4.1 Defining a Call Environment for Blocks ................................... 4-32
## Contents

4.10.5 Steps in Testing with Breakpoints ................................................................. 4-33
4.10.5.1 Defining Breakpoints .................................................................................. 4-33
4.10.5.2 Starting the Test with Breakpoints .............................................................. 4-33
4.10.5.3 Stopping the Test with Breakpoints ............................................................ 4-34
4.10.5.4 Activating, Deactivating and Deleting Breakpoints ................................. 4-34
4.10.5.5 Defining A Call Environment for Breakpoints ........................................... 4-35
4.10.5.6 Debugging in the Single Step Mode ........................................................... 4-36
4.10.6 Using the STEP 7 Test/Debug Functions .......................................................... 4-37
4.10.6.1 Creating and Displaying Reference Data ..................................................... 4-37
4.10.6.2 Monitoring and Modifying Variables ............................................................ 4-38
4.10.6.3 Checking the Block Consistency .................................................................. 4-38
4.11 Displaying and Modifying the CPU Properties .................................................... 4-40
4.11.1 Displaying and Modifying the CPU Operating Mode ..................................... 4-40
4.11.2 Displaying and Setting the Date and Time on the CPU .................................. 4-40
4.11.3 Reading Out CPU Data ................................................................................... 4-41
4.11.4 Reading Out the Diagnostic Buffer of the CPU .............................................. 4-41
4.11.5 Displaying/Compressing the User Memory of the CPU ............................... 4-41
4.11.6 Displaying the Cycle Time of the CPU ......................................................... 4-42
4.11.7 Displaying the Time System of the CPU ....................................................... 4-42
4.11.8 Displaying the Blocks on the CPU ................................................................. 4-42
4.11.9 Displaying Information about Communication with the CPU ....................... 4-43
4.11.10 Displaying the Stacks of the CPU .................................................................. 4-43

5 S7-SCL Basic Terms .................................................................................................. 5-1
5.1 Interpreting the Syntax Diagrams ........................................................................ 5-1
5.2 Character Set ........................................................................................................ 5-4
5.3 Reserved Words ................................................................................................... 5-5
5.4 Identifiers ............................................................................................................ 5-6
5.5 Standard Identifiers ............................................................................................ 5-7
5.6 Block Identifiers .................................................................................................. 5-7
5.7 Address Identifiers .............................................................................................. 5-9
5.8 Timer Identifiers .................................................................................................. 5-10
5.9 Counter Identifiers ............................................................................................... 5-10
5.10 Numbers ........................................................................................................... 5-11
5.11 Character Strings .............................................................................................. 5-13
5.12 Symbol .............................................................................................................. 5-14
5.13 Comment Section .............................................................................................. 5-15
5.14 Line Comment ................................................................................................... 5-16
5.15 Variables ........................................................................................................... 5-17

6 S7-SCL Program Structure ......................................................................................... 6-1
6.1 Blocks in S7-SCL Source Files .......................................................................... 6-1
6.2 Order of the Blocks ............................................................................................. 6-2
6.3 General Structure of a Block .............................................................................. 6-3
6.4 Block Start and End ............................................................................................ 6-3
6.5 Attributes for Blocks .......................................................................................... 6-5
6.6 Block Comment ................................................................................................... 6-8
6.7 System Attributes for Blocks .............................................................................. 6-9
6.8 Declaration Section .............................................................................................. 6-10
6.9 System Attributes for Parameters ...................................................................... 6-11
6.10 Statement Section ................................................................................................ 6-12
6.11 Statements ......................................................................................................... 6-13
6.12 Structure of a Function Block (FB) .................................................................... 6-14
6.13 Structure of a Function (FC) ............................................................................. 6-16
6.14 Structure of an Organization Block (OB) ........................................................... 6-18
6.15 Structure of a User-Defined Data Type ............................................................ 6-19
6.16 Compiler Options in S7-SCL Source Files ....................................................... 6-21
Contents

7 Data Types
7.1 Overview of the Data Types in SCL ............................................................. 7-1
7.2 Elementary Data Types ............................................................................. 7-3
7.2.1 Bit Data Types ...................................................................................... 7-3
7.2.2 Character Types ................................................................................... 7-3
7.2.3 Numeric Data Types ............................................................................. 7-3
7.2.4 Time Types .......................................................................................... 7-4
7.3 Complex Data Types ............................................................................... 7-5
7.3.1 DATE_AND_TIME Data Type ............................................................... 7-5
7.3.2 STRING Data Type ............................................................................... 7-7
7.3.3 ARRAY Data Type ................................................................................ 7-9
7.3.4 STRUCT Data Type ............................................................................... 7-11
7.4 User-Defined Data Types (UDT) ............................................................. 7-13
7.5 Data Types for Parameters ..................................................................... 7-15
7.5.1 TIMER and COUNTER Data Types .................................................... 7-15
7.5.2 BLOCK Data Types ............................................................................. 7-16
7.5.3 POINTER Data Type ............................................................................ 7-17
7.6 ANY Data Type ....................................................................................... 7-19
7.6.1 Example of the ANY Data Type .......................................................... 7-20

8 Declaration of Local Variables and Parameters ................................. 8-1
8.1 Local Variables and Block Parameters ................................................. 8-1
8.2 General Syntax of a Variable or Parameter Declaration ..................... 8-2
8.3 Initialization ............................................................................................ 8-3
8.4 Declaring Views of Variable Ranges ..................................................... 8-5
8.5 Using Multiple Instances ..................................................................... 8-7
8.6 Instance Declaration .............................................................................. 8-8
8.7 Flags (OK Flag) ..................................................................................... 8-9
8.8 Declaration Subsections ......................................................................... 8-10
8.8.1 Overview of the Declaration Subsections ......................................... 8-10
8.8.2 Static Variables .................................................................................. 8-11
8.8.3 Temporary Variables ......................................................................... 8-12
8.8.4 Block Parameters ............................................................................... 8-13

9 Declaring Constants and Labels ............................................................. 9-1
9.1 Constants ............................................................................................... 9-1
9.1.1 Declaring Symbolic Names for Constants ......................................... 9-2
9.1.2 Data Types for Constants ................................................................ 9-3
9.1.3 Notation for Constants ...................................................................... 9-4
9.1.3.1 Bit Constants .................................................................................. 9-6
9.1.3.2 Integer Constants ......................................................................... 9-7
9.1.3.3 Real Number Constants ............................................................... 9-8
9.1.3.4 Char Constants (Single Characters) ............................................... 9-9
9.1.3.5 String Constants .......................................................................... 9-11
9.1.3.6 Date Constants ............................................................................. 9-13
9.1.3.7 Time Period Constants ............................................................... 9-13
9.1.3.8 Time-of-Day Constants ............................................................... 9-16
9.1.3.9 Date and Time Constants ............................................................ 9-17
9.2 Declaring Labels .................................................................................... 9-18
## Contents

### 10 Shared Data

10.1 Overview of Shared Data ................................................................. 10-1
10.2 Memory Areas of the CPU ............................................................... 10-2
10.2.1 Overview of the Memory Areas of the CPU ................................. 10-2
10.2.2 Absolute Access to Memory Areas of the CPU ......................... 10-3
10.2.3 Symbolic Access to Memory Areas of the CPU ......................... 10-5
10.2.4 Indexed Access to Memory Areas of the CPU ......................... 10-6
10.3 Data Blocks ................................................................................. 10-7
10.3.1 Overview of Data Blocks ........................................................... 10-7
10.3.2 Absolute Access to Data Blocks ............................................... 10-8
10.3.3 Indexed Access to Data Blocks .................................................. 10-10
10.3.4 Structured Access to Data Blocks ............................................. 10-11

### 11 Expressions, Operations and Addresses

11.1 Overview of Expressions, Operations and Addresses .................. 11-1
11.2 Operations .................................................................................. 11-2
11.3 Addresses ................................................................................... 11-3
11.4 Syntax of an Expression ............................................................... 11-5
11.5 Simple Expression ....................................................................... 11-7
11.6 Arithmetic Expressions ................................................................. 11-8
11.7 Logical Expressions ..................................................................... 11-10
11.8 Comparison Expressions ............................................................. 11-12

### 12 Statements

12.1 Value Assignments ........................................................................ 12-1
12.1.1 Value Assignments with Variables of an Elementary Data Type .. 12-2
12.1.2 Value Assignments with Variables of the Type STRUCT and UDT .. 12-3
12.1.3 Value Assignments with Variables of the Type ARRAY ......... 12-5
12.1.4 Value Assignments with Variables of the Data Type STRING ... 12-7
12.1.5 Value Assignments with Variables of the Type DATE_AND_TIME .. 12-8
12.1.6 Value Assignments with Absolute Variables for Memory Areas .. 12-9
12.1.7 Value Assignments with Shared Variables ......................... 12-10
12.2 Control Statements ...................................................................... 12-12
12.2.1 Overview of Control Statements .............................................. 12-12
12.2.2 Conditions .............................................................................. 12-13
12.2.3 IF Statements .......................................................................... 12-14
12.2.4 CASE Statement ................................................................. 12-16
12.2.5 FOR Statement ................................................................. 12-18
12.2.6 WHILE Statement ............................................................ 12-20
12.2.7 REPEAT Statement ............................................................ 12-22
12.2.8 CONTINUE Statement ......................................................... 12-23
12.2.9 EXIT Statement .................................................................. 12-24
12.2.10 GOTO Statement ............................................................... 12-25
12.2.11 RETURN Statement ........................................................... 12-25
12.3 Calling of Functions and Function Blocks .................................... 12-26
12.3.1 Call and Parameter Transfer ................................................. 12-27
12.3.2 Calling Function Blocks ......................................................... 12-28
12.3.2.1 Calling Function Blocks (FB or SFB) ................................ 12-28
12.3.2.2 Supplying FB Parameters .............................................. 12-29
12.3.2.3 Input Assignment (FB) ..................................................... 12-30
12.3.2.4 In/Out Assignment (FB) .................................................. 12-31
12.3.2.5 Reading Output Values (FB Call) .................................... 12-32
12.3.2.6 Example of a Call as a Shared Instance ......................... 12-32
12.3.2.7 Example of a Call as a Local Instance ............................ 12-33
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.3.3</td>
<td>Calling Functions</td>
</tr>
<tr>
<td>12.3.3.1</td>
<td>Calling Functions (FC)</td>
</tr>
<tr>
<td>12.3.3.2</td>
<td>Return Value (FC)</td>
</tr>
<tr>
<td>12.3.3.3</td>
<td>FC Parameters</td>
</tr>
<tr>
<td>12.3.3.4</td>
<td>Input Assignment (FC)</td>
</tr>
<tr>
<td>12.3.3.5</td>
<td>Output and In/Out Assignment (FC)</td>
</tr>
<tr>
<td>12.3.3.6</td>
<td>Example of a Function Call</td>
</tr>
<tr>
<td>12.3.4</td>
<td>Implicitly Defined Parameters</td>
</tr>
<tr>
<td>12.3.4.1</td>
<td>Input Parameter EN</td>
</tr>
<tr>
<td>12.3.4.2</td>
<td>Output Parameter ENO</td>
</tr>
</tbody>
</table>

## 13 Counters and Timers

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>13.1</td>
<td>Counters</td>
</tr>
<tr>
<td>13.1.1</td>
<td>Counter Functions</td>
</tr>
<tr>
<td>13.1.2</td>
<td>Calling Counter Functions</td>
</tr>
<tr>
<td>13.1.3</td>
<td>Supplying Parameters for Counter Functions</td>
</tr>
<tr>
<td>13.1.5</td>
<td>Count Up (S_CU)</td>
</tr>
<tr>
<td>13.1.6</td>
<td>Count Down (S_CD)</td>
</tr>
<tr>
<td>13.1.7</td>
<td>Count Up/Down (S_CUD)</td>
</tr>
<tr>
<td>13.1.8</td>
<td>Example of Counter Functions</td>
</tr>
<tr>
<td>13.2</td>
<td>Timers</td>
</tr>
<tr>
<td>13.2.1</td>
<td>Timer Functions</td>
</tr>
<tr>
<td>13.2.2</td>
<td>Calling Timer Functions</td>
</tr>
<tr>
<td>13.2.3</td>
<td>Supplying Parameters for Timer Functions</td>
</tr>
<tr>
<td>13.2.4</td>
<td>Input and Evaluation of a Time Value</td>
</tr>
<tr>
<td>13.2.5</td>
<td>Start Timer as Pulse Timer (S_PULSE)</td>
</tr>
<tr>
<td>13.2.6</td>
<td>Start Timer as Extended Pulse Timer (S_PEXT)</td>
</tr>
<tr>
<td>13.2.7</td>
<td>Start Timer as On-Delay Timer (S_ODT)</td>
</tr>
<tr>
<td>13.2.8</td>
<td>Start Timer as Retentive On-Delay Timer (S_ODTS)</td>
</tr>
<tr>
<td>13.2.9</td>
<td>Start Timer as Off-Delay Timer (S_OFFDT)</td>
</tr>
<tr>
<td>13.2.10</td>
<td>Example of Timer Functions</td>
</tr>
<tr>
<td>13.2.11</td>
<td>Selecting the Right Timer</td>
</tr>
</tbody>
</table>

## 14 Standard Functions of S7-SCL

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.1</td>
<td>Data Type Conversion Functions</td>
</tr>
<tr>
<td>14.1.1</td>
<td>Converting Data Types</td>
</tr>
<tr>
<td>14.1.2</td>
<td>Implicit Data Type Conversion</td>
</tr>
<tr>
<td>14.1.2.1</td>
<td>Conversion Functions Class A</td>
</tr>
<tr>
<td>14.1.3</td>
<td>Standard Functions for Explicit Data Type Conversion</td>
</tr>
<tr>
<td>14.1.3.1</td>
<td>Conversion Functions Class B</td>
</tr>
<tr>
<td>14.1.3.2</td>
<td>Functions for Rounding and Truncating</td>
</tr>
<tr>
<td>14.1.3.3</td>
<td>Examples of Converting with Standard Functions</td>
</tr>
<tr>
<td>14.2</td>
<td>Numeric Standard Functions</td>
</tr>
<tr>
<td>14.2.1</td>
<td>General Arithmetic Standard Functions</td>
</tr>
<tr>
<td>14.2.2</td>
<td>Logarithmic Functions</td>
</tr>
<tr>
<td>14.2.3</td>
<td>Trigonometric Functions</td>
</tr>
<tr>
<td>14.2.4</td>
<td>Examples of Numeric Standard Functions</td>
</tr>
<tr>
<td>14.3</td>
<td>Bit String Standard Functions</td>
</tr>
<tr>
<td>14.3.1</td>
<td>Examples of Bit String Standard Functions</td>
</tr>
<tr>
<td>14.4</td>
<td>Functions for Processing Strings</td>
</tr>
<tr>
<td>14.4.1</td>
<td>Functions for String Manipulation</td>
</tr>
<tr>
<td>14.4.2</td>
<td>Functions for Comparing Strings</td>
</tr>
<tr>
<td>14.4.3</td>
<td>Functions for Converting the Data Format</td>
</tr>
<tr>
<td>14.4.4</td>
<td>Example of Processing Character Strings</td>
</tr>
</tbody>
</table>
Contents

14.5 Functions for Selecting Values ................................................................. 14-24
14.5.1 Functions for Selecting Values ............................................................. 14-24
14.6 System Functions/Function Blocks and the Standard Library .................. 14-28
14.6.1 System Functions/Function Blocks and the Standard Library .............. 14-28
14.6.2 Transfer Interface to OBs ................................................................. 14-30

15 Language Description 15-1

15.1 Formal Language Description ................................................................... 15-1
15.1.1 Overview of Syntax Diagrams ............................................................... 15-1
15.1.2 Rules .................................................................................................... 15-2
15.1.3 Terms Used in the Lexical Rules ............................................................ 15-5
15.1.4 Formatting Characters, Separators and Operations ............................ 15-7
15.1.5 Keywords and Predefined Identifiers ................................................... 15-10
15.1.6 Address Identifiers and Block Keywords .............................................. 15-13
15.1.7 Overview of Non Terms ........................................................................ 15-14
15.1.8 Overview of Tokens ............................................................................ 15-15
15.1.9 Identifiers ............................................................................................. 15-15
15.1.10 Assigning Names in S7-SCL ................................................................. 15-17
15.1.11 Predefined Constants and Flags ......................................................... 15-20
15.2 Lexical Rules ......................................................................................... 15-21
15.2.1 Overview: Lexical Rules ....................................................................... 15-21
15.2.2 Identifiers ............................................................................................. 15-21
15.2.3 Constants ............................................................................................. 15-23
15.2.4 Absolute Addressing ........................................................................... 15-28
15.2.5 Comments ............................................................................................ 15-30
15.2.6 Block Attributes .................................................................................. 15-31
15.2.7 Compiler Options ................................................................................ 15-33
15.3 Syntactic Rules ...................................................................................... 15-34
15.3.1 Overview: Syntax Rules ....................................................................... 15-34
15.3.2 Structure of S7-SCL Source Files ....................................................... 15-35
15.3.3 Structure of the Declaration Sections .................................................. 15-37
15.3.4 Data Types in S7-SCL .......................................................................... 15-42
15.3.5 Statement Section ................................................................................ 15-45
15.3.6 Value Assignments ............................................................................. 15-47
15.3.7 Calling Functions and Function Blocks ................................................. 15-50
15.3.8 Control Statements ............................................................................ 15-52

16 Tips and Tricks 16-1

Glossary

Index
1 Product Overview

1.1 Area of Application of S7-SCL

S7-SCL (Structured Control Language) is a PASCAL-oriented high-level language for programming PLCs with SIMATIC S7.

PLCopen certificate

S7-SCL fulfills the textual high-level language ST (Structured Text) defined in IEC 61131-3 and was prepared for certifying for the Reusability Level.

Area of application

S7-SCL is optimized for the programming of programmable logic controllers and contains both language elements from the PASCAL programming language as well as typical PLC elements such as inputs/outputs, timers and counters.

S7-SCL is particularly suitable for the following tasks:

- Programming of complex algorithms
- Programming of mathematical functions
- Data and recipe management
- Process optimization
1.2 How S7-SCL Functions

Integration in STEP 7

S7-SCL supports the STEP 7 block concept.

You can create the following STEP 7 blocks with S7-SCL:

- OB
- FC
- FB
- DB
- UDT

In an S7 program S7-SCL blocks can also be combined with blocks from other STEP 7 programming languages. The blocks can call each other up. S7-SCL blocks can also be stored in libraries and from there used in other languages.

Because S7-SCL programs are programmed as ASCII sources, they can be imported and exported easily.

S7-SCL blocks can be recompiled into the STEP 7 programming language STL (statement list). However, note that they can no longer be edited in S7-SCL after they have been stored in STL.
Development environment

For practical use S7-SCL offers a powerful development environment which is tuned to both specific properties of S7-SCL as well as to STEP 7. The development environment consists of the following component:

- An **editor** in order to program programs consisting of functions (FC), function blocks (FB), organization blocks (OB), data blocks (DB) and user-defined data types (UDT). The programmer is supported in the process by powerful functions.
- A **batch compiler** in order to compile the edited program into MC7 machine code. The generated MC7 code can be executed on all the CPUs of the S7-300/400 programmable controller as from CPU 314.
- A **debugger** in order to search for logical program errors in an error-free compilation. Error searching is carried out in the source language.

The following figure provides an overview of the components of the development environment.
1.3 Which Functions Does S7-SCL Offer?

S7-SCL offers all the advantages of a higher-level language. In addition, S7-SCL offers features that have been designed specially to support structured programming:

**Block libraries**

Pre-defined blocks are supplied in libraries, for example:

- System functions
- IEC functions
- Conversion functions

A dialog box supports navigation in the library. When a block is selected, the parameter template of the function automatically into the processed file. You only still have to enter the desired parameters.

**Program templates**

The S7-SCL editor offers diverse templates for insertion which only still have to be filled out:

- Templates for blocks (for example function blocks, data blocks) and their calls
- Templates for block comments, block parameters and constants
- Templates for control structures (IF, CASE, FOR, WHILE, REPEAT)

**Language elements from high-level programming**

Simple, rapid program creation not prone to error through the use of powerful language constructs, for example:

- Loops
- Alternative branches (IF ... THEN ... ELSE)
- Jumps

**Program easy to understand**

The following features increase the legibility of the program:

- Full-symbolic programming
- Comments
- Elementary and self-defined data types
- Display of cross-references
- Automatic formatting of the input through indentation
- Syntax-specific coloring of the language elements
Debugger on high-level language level

The debugger allows simple program debugging on a high-level language level. It offers the following functionality:

- Continuous monitoring of the program execution
- Step-by-step monitoring by means of breakpoints that can be set individually.
- Step-in functionality (possibility of jumping into called blocks during debugging)
1.4 What is New in Version V5.3 SP1?

Language extensions
Language resources that are defined in IEC 61131-3 have been added to S7-SCL V5.3 SP1:

- Functions for processing numerical values as internal S7-SCL functions (SEL, MAX, MIN, LIMIT, MUX)
- Support of BCD representation of integers by means of conversion functions (BCD_TO_INT, INT_TO_BCD, etc.)
- Assignment operator => for output parameters of functions
- Field initialization with bracketing
- New conversion functions (BYTE_TO_INT, INT_TO_BYTE, etc.)

Compiler settings in the source
Compiler settings can be stored in S7-SCL sources or compiler control files. This means that you can store the properties of a compilation source-specifically.

Extended debugging functions
- Block inconsistencies and time stamp conflicts in S7-SCL blocks can be determined and corrected with the STEP 7 debug function "Check block consistency". This debug function is available as from STEP 7 Version 5.3 SP2.
- The "Monitor" debug function can be used more specifically by defining call environments.
- The monitoring range for the "Monitor" debug function can be limited specifically by marking a section in the source.

Color printing
S7-SCL can also be printed out in color.

Extended search function
S7-SCL now also allows searching from the cursor position upwards and searching within a selection.

Placing of bookmarks in the source text
You can now use bookmarks to navigate rapidly with a source.
Creation of S7-SCL blocks with foreign-language character set

S7-SCL sources can contain texts with foreign-language character sets. This allows you to create blocks for the world-wide market in which the important elements visible to the user are displayed in foreign-language character sets (for example symbolic blocks names, attributes and comments).

For further information about foreign-language character sets please refer to the Readme file.
2 Installation

2.1 Automation License Manager

2.1.1 User Rights Through The Automation License Manager

Automation License Manager

To use programming software, you require a product-specific license key (user rights). Starting with S7-SCL V5.3, this key is installed with the Automation License Manager.

The Automation License Manager is a software product from Siemens AG. It is used to manage the license keys (license modules) for all systems.

The Automation License Manager is located in the following places:

- On the installation device for STEP 7
- As a download from the Internet page of A&D Customer Support at Siemens AG

The Automation License Manager has its own integrated online help. To obtain help after the license manager is installed, press F1 or select the Help > Help on License Manager. This online help contains detailed information on the functionality and operation of the Automation License Manager.

Licenses

Licenses are required to use STEP 7 program packages whose legal use is protected by licenses. A license gives the user a legal right to use the product. Evidence of this right is provided by the following:

- The CoL (Certificate of License), and
- The license key

Certificate of License (CoL)

The "Certificate of License" that is included with a product is the legal evidence that a right to use this product exists. This product may only be used by the owner of the Certificate of License (CoL) or by those persons authorized to do so by the owner.
License Keys

The license key is the technical representation (an electronic "license stamp") of a license to use software.

SIEMENS AG issues a license key for all of its software that is protected by a license. When the computer has been started, such software can only be used in accordance with the applicable license and terms of use after the presence of a valid license key has been verified.

Notes

- You can use the standard software without a license key to familiarize yourself with the user interface and functions.
- However, a license is required and necessary for full, unrestricted use of the software in accordance with the license agreement.
- If you have not installed the license key, you will be prompted to do so at regular intervals.

License Keys can be stored and transferred among various types of storage devices as follows:

- On license key diskettes
- On the local hard disk
- On network hard disk

For further information on obtaining and using license keys, please refer to the online help for the Automation License Manager.
Types of Licenses

The following different types of application-oriented user licenses are available for software products from Siemens AG. The actual behavior of the software is determined by which type license key is installed for it. The type of use can be found on the accompanying Certificate of License.

<table>
<thead>
<tr>
<th>License Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single License</td>
<td>The software can be used on any single computer desired for an unlimited amount of time.</td>
</tr>
<tr>
<td>Floating License</td>
<td>The software can be used on a computer network (&quot;remote use&quot;) for an unlimited amount of time.</td>
</tr>
</tbody>
</table>
| Trial License      | The software can be used subject to the following restrictions:  
• A period of validity of up to a maximum of 14 days,  
• A total number of operating days after the day of first use,  
• A use for tests and validation (exemption from liability). |
| Rental License     | The software can be used subject to the following restrictions:  
• A period of validity of up to a maximum of 50 days  
• A specific number of hours for use |
| Upgrade License    | Certain requirements in the existing system may apply with regard to software upgrades:  
• An upgrade license may be used to convert an "old version X" of the software to a newer version X+.  
• An upgrade may be necessary due to an increase in the volume of data being handled in the given system. |
2.1.2 Installing the Automation License Manager

The Automation License Manager is installed by means of a setup process. The installation software for the Automation License Manager is included on the product CD of STEP 7.

You can install the Automation License Manager at the same time you install S7-SCL or at a later time.

Notes
- For detailed information on how to install the Automation License Manager, please refer to its current "Readme.wri" file.
- The online help for the Automation License Manager contains all the information you need on the function and handling of License Keys.

Subsequent installation of license keys

If you start the software and no license keys are available, a warning message indicating this condition will be displayed.

Notes
- You can use the standard software without a license key to familiarize yourself with the user interface and functions.
- However, a license is required and necessary for full, unrestricted use of the software in accordance with the license agreement.
- If you have not installed the license key, you will be prompted to do so at regular intervals.

You can subsequently install license keys in the following ways:
- Install license keys from diskettes
- Install license keys downloaded from the Internet. In this case, the license keys must be ordered first.
- Use floating license keys available in a network

For detailed information on installing license keys, refer to the online help for the Automation License Manager. To access this help, press F1 or select the Help > Help on License Manager menu command.

Notes
- In Windows 2000/XP, license keys authorization will only be operational if it is installed on a local hard disk and have write-access status.
- Floating licenses can also be used within a network ("remote" use).
2.1.3 Guidelines for Handling License Keys

Caution
Please note the information on handling license keys that is available in the online help and Readme file on the Automation License Manager. If you do not follow these guidelines, the license keys may be irretrievably lost.

To access online help for the Automation License Manager, press F1 for context-sensitive help or select the Help > Help on License Manager menu command.

This help section contains all the information you need on the function and handling of license keys.
2.2 Installation

2.2.1 Installation Requirements

System Requirements

The S7-SCL V5.3 SP1 optional package can run on a programming device/PC with an installation of the STEP 7 V5.3 standard package or higher. For prerequisites with regard to the operating system please refer to the Readme.wri file.

Hardware Requirements

The requirements for S7-SCL are the same as those for the STEP 7 standard package. The extra hard disk space required by the S7-SCL V5.3 SP1 optional package can be found in the Readme.wri file.

2.2.2 Installation of S7-SCL

Starting the Installation Program

S7-S7-SCL includes a Setup program that automatically installs the software. On-screen prompts that appear on the screen guide you step by step through the complete installation process.

Follow the steps outlined below:

1. Open the Control Panel in the Windows 2000/XP and double-click on the Add/Remove Programs icon.
2. Select Install...
3. Insert the CD and click "Next". Windows then automatically searches for the installation program "Setup.exe".
4. Follow the instructions displayed by the installation program.

Installing License Keys

During setup, the program checks to see whether a corresponding license key is installed on the hard disk. If no valid license key is found, a message stating that the software can be used only with a license key is displayed. If you want, you can install the license key immediately or continue setup and then install the key later. If you want to install the license key now, insert the authorization diskette when prompted to do so.
3 Designing an S7-SCL Program

3.1 Welcome to "Measured Value Acquisition" - A Sample Program for First-Time Users

What You Will Learn

The sample program for first-time users shows you how to use S7-SCL effectively. At first, you will probably have lots of questions, such as:

- How do I design a program written in S7-SCL?
- Which S7-SCL language functions are suitable for performing the task?
- What debugging functions are available?

These and other questions are answered in this section.

S7-SCL language Elements Used

The sample program introduces the following S7-SCL language functions:

- Structure and use of the various S7-SCL block types
- Block calls with parameter passing and evaluation
- Various input and output formats
- Programming with elementary data types and arrays
- Initializing variables
- Program structures and the use of branches and loops

Required Hardware

You can run the sample program on a SIMATIC S7-300 or SIMATIC S7-400 and you will need the following peripherals:

- One 16-channel input module
- One 16-channel output module

Debugging Functions

The program is constructed in so that you can test the program quickly using the switches on the input module and the displays on the output module. To run a thorough test, use the S7-SCL debugging functions.

You can also use all the other system functions provided by the STEP 7 Standard package.
### 3.2 Task

#### Overview

Measured values will be acquired by an input module and then sorted and processed by an S7-SCL program. The results will be displayed on an output module.

#### Acquire Measured Values

A measured value is set using the 8 input switches. This is then read into the measured value array in memory when an edge is detected at an input switch (see following diagram).

The range of the measured values is 0 to 255. One byte is therefore required for the input.

#### Processing Measured Values

The measured value array will be organized as a ring buffer with a maximum of eight entries.

When a signal is detected at the Sort switch, the values stored in the measured value array are arranged in ascending order. After that, the square root and the square of each number are calculated. One word is required for the processing functions.

![Diagram of measured data processing](image-url)

<table>
<thead>
<tr>
<th>Data Entry:</th>
<th>x=Signal detection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter switch</td>
<td>Measured value</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
</tr>
<tr>
<td>7</td>
<td>1</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Calculations</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Read in measured data</th>
<th>Sort measured data</th>
<th>Calculate results</th>
</tr>
</thead>
<tbody>
<tr>
<td>255</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>127</td>
<td>2</td>
<td>9</td>
</tr>
<tr>
<td>63</td>
<td>3</td>
<td>49</td>
</tr>
<tr>
<td>31</td>
<td>4</td>
<td>225</td>
</tr>
<tr>
<td>15</td>
<td>5</td>
<td>961</td>
</tr>
<tr>
<td>7</td>
<td>6</td>
<td>3969</td>
</tr>
<tr>
<td>3</td>
<td>7</td>
<td>16129</td>
</tr>
<tr>
<td>1</td>
<td>8</td>
<td>Overflow</td>
</tr>
</tbody>
</table>
Selectable Outputs

Only one value can ever be displayed on the output module. The following selections can therefore be made:

- Selection of an element from a list
- Selection of measured value, square root or square

The displayed value is selected as follows:

- Three switches are used to set a code that is copied if a signal is detected at a fourth switch, the Coding switch. From this, an address is calculated that is used to access the output.
- The same address identifies three values: the measured value, its square root and its square. To select one of these values, two selector switches are required.
3.3 Design of a Structured S7-SCL Program

Block Types

The task defined above is best solved using a structured S7-SCL program. This means using a modular design; in other words, the program is subdivided into a number of blocks, each responsible for a specific subtask. In S7-SCL, as with the other programming languages in STEP 7, you have the following block types available.

**STEP 7-Blocks**

- **OB**: Organization blocks form the interface between the S7 CPU operating system and the user program. The organization blocks specify the sequence in which the blocks of the user program are executed.

- **FB**: Function blocks are logic blocks with static data. Since an FB has a "memory", it is possible to access its parameters (for example, outputs) at any point in the user program.

- **FC**: Functions are logic blocks that do not have memory. Since they do not have memory, the calculated values must be processed further immediately after the function is called.

- **DB**: Data blocks are data areas in which the user data are stored. There are shared data blocks that can be accessed by all logic blocks and there are instance data blocks that are assigned to a specific FB call.

- **UDT**: User-defined data types are structured data types you can create yourself as required and then use as often as you wish. A user-defined data type is useful for generating a number of data blocks with the same structure. UDTs are handled as if they were blocks.
Arrangement of Blocks in S7-SCL Source Files

An S7-SCL program consists of one or more S7-SCL source files. A source file can contain a single block or a complete program consisting of various blocks.
3.4 Defining the Subtasks

Subtasks
The subtasks are shown in the figure below. The rectangular shaded areas represent the blocks. The arrangement of the logic blocks from left to right is also the order in which they are called.

[Diagram showing the organization and function blocks with data flows and program calls]
Selecting and Assigning the Available Block Types

The individual blocks were selected according to the following criteria:

<table>
<thead>
<tr>
<th>Function</th>
<th>Block Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>User programs can only be started in an OB. Since the measured values will be acquired cyclically, an OB for a cyclic call (OB1) is required. Part of the program - data input and data output - is programmed in the OB.</td>
<td>⇒ &quot;Cycle&quot; OB</td>
</tr>
<tr>
<td>The subtask &quot;acquire measured values&quot; requires a block with a memory; in other words, a function block (FB), since certain local block data (for example, the ring buffer) must be retained from one program cycle to the next. The location for storing data (memory) is the instance data block ACQUIRE_DATA. The same FB can also handle the address and select output subtask, since the data is available here.</td>
<td>⇒ &quot;Acquire&quot; FB</td>
</tr>
<tr>
<td>When selecting the type of block for the subtasks sort measured values and calculate results, remember that you need an output buffer containing the calculated results &quot;square root&quot; and &quot;square&quot; for each measured value. The only suitable block type is therefore an FB. Since this FB is called by an FB higher up in the call hierarchy, it does not require its own DB. Its instance data can be stored in the instance data block of the calling FB.</td>
<td>⇒ &quot;Evaluate&quot; FB</td>
</tr>
<tr>
<td>A function (FC) is best suited for the subtasks calculate square root and square since the result can be returned as a function value. Moreover, no data used in the calculation needs to be retained for more than one program cycle. The standard S7-SCL function SQRT can be used to calculate the square root. A special function SQUARE will be created to calculate the square and this will also check that the value is within the permitted range.</td>
<td>⇒ &quot;SQRT&quot; FC (square root) and ⇒ &quot;Square&quot; FC</td>
</tr>
</tbody>
</table>
3.5 Defining the Interfaces Between Blocks

Overview

The interface of a block is formed by parameters that can be accessed by other blocks.

Parameters declared in the blocks are placeholders that have a value only when the block is actually used (called). These placeholders are known as formal parameters and the values assigned to them when the block is called are referred to as the actual parameters. When a block is called, input data is passed to it as actual parameters. After the program returns to the calling block, the output data is available for further processing. A function (FC) can pass on its result as a function value.

Block parameters can be subdivided into the categories shown below:

<table>
<thead>
<tr>
<th>Block Parameter</th>
<th>Explanation</th>
<th>Declaration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input parameters</td>
<td>Input parameters accept the actual input values when the block is called. They are read-only.</td>
<td>VAR_INPUT</td>
</tr>
<tr>
<td>Output parameters</td>
<td>Output parameters transfer the current output values to the calling block. Data can be written to and read from them.</td>
<td>VAR_OUTPUT</td>
</tr>
<tr>
<td>In/out parameters</td>
<td>In/out parameters accept the actual value of a variable when the block is called, process the value, and write the result back to the original variable.</td>
<td>VAR_IN_OUT</td>
</tr>
</tbody>
</table>

Cycle OB

The CYCLE OB has no formal parameters itself. It calls the ACQUIRE FB and passes the measured value and the control data for its formal parameters to it.

Acquire FB

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Data Type</th>
<th>Declaration Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>measval_in</td>
<td>INT</td>
<td>VAR_INPUT</td>
<td>Measured value</td>
</tr>
<tr>
<td>newval</td>
<td>BOOL</td>
<td>VAR_INPUT</td>
<td>Switch for entering measured value in ring buffer</td>
</tr>
<tr>
<td>resort</td>
<td>BOOL</td>
<td>VAR_INPUT</td>
<td>Switch for sorting and evaluating measured data</td>
</tr>
<tr>
<td>funct_sel</td>
<td>BOOL</td>
<td>VAR_INPUT</td>
<td>Selector switch for square root or square</td>
</tr>
<tr>
<td>selection</td>
<td>WORD</td>
<td>VAR_INPUT</td>
<td>Code for selecting output value</td>
</tr>
<tr>
<td>newsel</td>
<td>BOOL</td>
<td>VAR_INPUT</td>
<td>Switch for reading in code</td>
</tr>
<tr>
<td>result_out</td>
<td>DWORD</td>
<td>VAR_OUTPUT</td>
<td>Output of calculated result</td>
</tr>
<tr>
<td>measval_out</td>
<td>DWORD</td>
<td>VAR_OUTPUT</td>
<td>Output of measured value</td>
</tr>
</tbody>
</table>
Evaluate

The **ACQUIRE FB** calls the **EVALUATE FB**. The data they share is the measured value array that require sorting. This array is therefore declared as an in/out parameter. A structured array is created as an output parameter for the calculated results Square Root and Square. The following table shows the formal parameters:

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Declaration Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sortbuffer</td>
<td>ARRAY[.].OF REAL</td>
<td>VAR_IN_OUT</td>
<td>Measured value array, corresponds to ring buffer</td>
</tr>
<tr>
<td>calcbuffer</td>
<td>ARRAY[.].OF STRUCT</td>
<td>VAR_OUTPUT</td>
<td>Array for results: Structure with &quot;square root&quot; and &quot;square&quot; components of type INT</td>
</tr>
</tbody>
</table>

**SQRT and Square**

These functions are called by **EVALUATE**. They require an input value (argument) and return their results as a function value.

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Declaration Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>value</td>
<td>REAL</td>
<td>VAR_INPUT</td>
<td>Input for SQRT</td>
</tr>
<tr>
<td>SQRT</td>
<td>REAL</td>
<td>Function value</td>
<td>Square root of input value</td>
</tr>
<tr>
<td>value</td>
<td>INT</td>
<td>VAR_INPUT</td>
<td>Input for SQUARE</td>
</tr>
<tr>
<td>SQUARE</td>
<td>INT</td>
<td>Function value</td>
<td>Square of input value</td>
</tr>
</tbody>
</table>
3.6 Defining the Input/Output Interface

The figure below shows the input/output interface. Note that when input/output is in bytes, the lower-order byte is at the top and the higher-order byte is at the bottom. If input/output is in words, on the other hand, the opposite is true.

Programmable controller

Input module

Byte 0

0.3
0.4

Byte 1

0 to 7 Input byte: measured value

Output module

Byte 4

0 to 7 Higher-order byte of the output word (bits 8 to 15) only required for calculation of square, otherwise 0

Byte 5

0 to 7 Lower-order byte of the output word (bits 0 to 7): measured value or result: square root or square
3.7 Defining the Order of the Blocks in the Source File

When arranging the order of the blocks in the S7-SCL source file, remember that a block must exist before you use it; in other words, before it is called by another block. This means that the blocks must be arranged in the S7-SCL source file as shown below:

```
<table>
<thead>
<tr>
<th>block</th>
<th>calls</th>
</tr>
</thead>
<tbody>
<tr>
<td>FC SQUARE</td>
<td></td>
</tr>
<tr>
<td>FB EVAL</td>
<td></td>
</tr>
<tr>
<td>FB ACQ</td>
<td></td>
</tr>
<tr>
<td>OB CYCLE</td>
<td></td>
</tr>
</tbody>
</table>
```
3.8 Defining Symbols

Using symbolic names for module addresses and blocks makes your program easier to follow. Before you can use these symbols, you must enter them in the symbol table.

The figure below shows the symbol table of the sample program. It describes the symbolic names that you declare in the symbol table so that the source file can be compiled free of errors:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Address</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coding</td>
<td>IW 0</td>
<td>WORD</td>
</tr>
<tr>
<td>Coding switch</td>
<td>I 0.7</td>
<td>BCOL</td>
</tr>
<tr>
<td>CYCLE</td>
<td>OB 1</td>
<td>OB 1</td>
</tr>
<tr>
<td>Entry</td>
<td>IB 1</td>
<td>BYTE</td>
</tr>
<tr>
<td>EVALUATE</td>
<td>FB 20</td>
<td>FB 20</td>
</tr>
<tr>
<td>Function switch</td>
<td>I 0.2</td>
<td>BCOL</td>
</tr>
<tr>
<td>Input 0.0</td>
<td>I 0.0</td>
<td>BCOL</td>
</tr>
<tr>
<td>Output</td>
<td>QW 4</td>
<td>INT</td>
</tr>
<tr>
<td>Output switch</td>
<td>I 0.3</td>
<td>BCOL</td>
</tr>
<tr>
<td>ACQUIRE</td>
<td>FB 10</td>
<td>FB 10</td>
</tr>
<tr>
<td>ACQUIRE_DATA</td>
<td>DB 10</td>
<td>FB 10</td>
</tr>
<tr>
<td>Sorting switch</td>
<td>I 0.1</td>
<td>BCOL</td>
</tr>
<tr>
<td>SQUARE</td>
<td>FC 41</td>
<td>FC 41</td>
</tr>
</tbody>
</table>
3.9 Creating the SQUARE Function

3.9.1 Statement Section of the SQUARE Function

Statement Section

The program first checks whether the input value exceeds the limit at which the result would be outside the numeric range. If it does, the maximum value for an integer is inserted. Otherwise, the square calculation is performed. The result is passed on as a function value.

FUNCTION SQUARE : INT
*********************************************************
This function returns as its function value the square of the input value or if there is overflow, the maximum value that can be represented as an integer.
***********************************************************)
VAR_INPUT
    value : INT;
END_VAR
BEGIN
IF value <= 181 THEN
    SQUARE := value * value; //Calculation of function value
ELSE
    SQUARE := 32_767; // If overflow, set maximum value
END_IF;
END_FUNCTION
3.10 Creating the EVALUATE function block

3.10.1 Flow Chart for EVALUATE

The figure shows the algorithm in the form of a flow chart:

![Flow Chart for EVALUATE function block](image-url)
3.10.2 Declaration Section of FB EVALUATE

Structure of the Declaration Section

The declaration section of this block consists of the following subsections:

- Constants: between CONST and END_CONST.
- In/out parameters: between VAR_IN_OUT and END_VAR.
- Output parameters: between VAR_OUTPUT and END_VAR.
- Temporary variables: between VAR_TEMP and END_VAR.

```plaintext
CONST
  LIMIT := 7;
END_CONST

VAR_IN_OUT
  sortbuffer : ARRAY[0..LIMIT] OF INT;
END_VAR

VAR_OUTPUT
  calcbuffer : ARRAY[0..LIMIT] OF STRUCT
    squareroot : INT;
    square     : INT;
   END_STRUCT;
END_VAR

VAR_TEMP
  swap        : BOOL;
  index, aux  : INT;
  valr, resultr : REAL;
END_VAR
```
3.10.3 Statement Section of FB EVALUATE

Program Sequence

The in/out parameter "sortbuffer" is linked to the ring buffer "measvals" so that the original contents of the buffer are overwritten by the sorted measured values.

The new array "calcbuffer" is created as an output parameter for the calculated results. Its elements are structured so that they contain the square root and the square of each measured value.

The figure below shows you the relationship between the arrays.

This interface shows the heart of the data exchange for processing the measured values. The data is stored in the instance data block ACQUIRE_DATA since a local instance for FB EVALUATE was created in the calling FB ACQUIRE.

Statement Section of EVALUATE

First, the measured values in the ring buffer are sorted and then the calculations are made.

- **Sort algorithm**
  The permanent exchange of values method is used to sort the measured value buffer. This means that consecutive values are compared and their order reversed until the final order is obtained throughout. The buffer used is the in/out parameter "sortbuffer".

- **Starting the calculation**
  Once sorting is completed, a loop is executed in which the functions SQUARE for squaring and SQRT for extracting the square root are called. Their results are stored in the structured array "calcbuffer".
Statement Section of EVALUATE

The statement section of the logic block is as follows:

BEGIN
********************************************************
Part 1 Sorting : According to the "bubble sort" method: Swap
pairs of values until the measured value buffer is sorted.
*********************************************************)
REPEAT
    swap := FALSE;
    FOR index := LIMIT TO 1 BY -1 DO
        IF sortbuffer[index-1] > sortbuffer[index]
            THEN aux := sortbuffer[index];
               sortbuffer[index] := sortbuffer[index-1];
               sortbuffer[index-1] := aux;
               swap := TRUE;
            END_IF;
    END_FOR;
UNTIL NOT swap
END_REPEAT;
*********************************************************
Part 2 Calculation : Square root with standard function
SQRT and squaring with the SQUARE function.
*********************************************************)
FOR index := 0 TO LIMIT BY 1 DO
    valr := INT_TO_REAL(sortbuffer[index]);
    resultr := SQRT(valr);
    calcbuffer[index].squeroot := REAL_TO_INT(resultr);
    calcbuffer[index].square := SQUARE(sortbuffer[index]);
END_FOR;
END_FUNCTION_BLOCK
3.11 Creating the function block ACQUIRE

3.11.1 Flow Chart for ACQUIRE

The following figure shows the algorithm in the form of a flow chart:

Start

newval changed? yes

no

resort changed? yes

no

new code changed? yes

no

function choice? TRUE FALSE

Load measured value

Load square root result

Load square result

Copy calculated results to results array

Copy measured value to cyclic buffer, recalculate index

Cyclic buffer is implemented by means of MOD operation: when limit is reached start from beginning again

Sort cyclic buffer and perform calculations (set up results array)

Analyze code and calculate output address

First shift relevant bits to right margin then hide spaces not required by means of AND

Load from instance data block

Copy: Write list items with output addresses to the output parameters so that their values can be displayed afterwards.
3.11.2 Declaration Section of FB ACQUIRE

Structure of the Declaration Section

The declaration section in this block consists of the subsections:

- Constants: between CONST and END_CONST.
- Input parameters: between VAR_INPUT and END_VAR.
- Output parameters: between VAR_OUTPUT and END_VAR.
- Static variables: between VAR and END_VAR.

This also includes declaration of the local instance for the EVALUATE block.

```scl
CONST
  LIMIT := 7;
  QUANTITY := LIMIT + 1;
END_CONST

VAR_INPUT
  measval_in  :  INT;  // New measured value
  newval           :  BOOL;  // Measured value in "measvals" ring buffer
  resort            :  BOOL;    // Sort measured values
  funct_sel:     BOOL; // Select calculation square root/square
  newsel            :  BOOL;    // Take output address
  selection         :  WORD; // Output address
END_VAR

VAR_OUTPUT
  result_out  :  INT;  // Calculated value
  measval_out  :  INT;     // Corresponding measured value
END_VAR

VAR
  measvals            :  ARRAY[0..LIMIT] OF INT := 8(0);
  resultbuffer  :  ARRAY[0..LIMIT] OF STRUCT
    squareroot              :  INT;
    square            :  INT;
  END_STRUCT;
  pointer                 :  INT    := 0;
  oldval                :  BOOL  := TRUE;
  oldsort               :  BOOL  := TRUE;
  oldsel                :  BOOL  := TRUE;
  address               :  INT    := 0;        // Converted output address
  outvalues_instance: EVALUATE;    // Define local instance
END_VAR
```
### Static Variables

The FB block type was chosen because some data needs to be retained from one program cycle to the next. These are the static variables declared in the declaration subsection "VAR, END_VAR".

Static variables are local variables whose values are retained throughout the processing of every block. They are used to save values of a function block and are stored in the instance data block.

### Initializing Variables

Note the initialization values that are entered in the variables when the block is initialized (after being downloaded to the CPU). The local instance for the EVALUATE FB is also declared in the declaration subsection "VAR, END_VAR". This name is used subsequently for calling and accessing the output parameters. The shared instance ACQUIRE_DATA is used to store the data.

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Initialization Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>measvals</td>
<td>ARRAY [..] OF INT</td>
<td>8(0)</td>
<td>Ring buffer for measured values</td>
</tr>
<tr>
<td>resultbuffer</td>
<td>ARRAY [..] OF STRUCT</td>
<td>-</td>
<td>Array for structures with the components &quot;square root&quot; and &quot;square&quot; of the type INT</td>
</tr>
<tr>
<td>index</td>
<td>INT</td>
<td>0</td>
<td>Index for ring buffer identifying location for next measured value</td>
</tr>
<tr>
<td>oldval</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Previous value for reading in measured value using &quot;newval&quot;</td>
</tr>
<tr>
<td>oldsort</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Previous value for sorting using &quot;resort&quot;</td>
</tr>
<tr>
<td>oldsel</td>
<td>BOOL</td>
<td>FALSE</td>
<td>Previous value for reading in code using &quot;newsel&quot;</td>
</tr>
<tr>
<td>address</td>
<td>INT</td>
<td>0</td>
<td>Address for output of measured value or result</td>
</tr>
<tr>
<td>eval_instance</td>
<td>Local instance</td>
<td>-</td>
<td>Local instance for the EVALUATE FB</td>
</tr>
</tbody>
</table>
3.11.3 Statement Section of FB ACQUIRE

Structure of the Statement Section

The statement section of ACQUIRE is divided into three subsections:

- **Acquire measured values:**
  If the input parameter "newval" is different from the "oldval", a new measured value is read into the ring buffer.

- **Start sorting and calculation**
  Sorting and calculation are started by calling the **EVALUATE** function block when the input parameter "resort" has changed compared with "oldsort".

- **Evaluating the coding and preparing output data**
  The coding is read word by word. According to SIMATIC conventions, this means that the upper group of switches (byte 0) contains the higher-order eight bits of the input word and the lower group of switches (byte 1) the lower-order bits. The figure below shows the location of the coding switches.

Calculating the Address

The figure below shows how the address is calculated: Bits 12 to 14 of input word IW0 contain the coding that is read in when an edge is detected at the coding switch (bit 15). The "address" is obtained by shifting right using the standard function SHR and masking the relevant bits using an AND mask.

This address is used to write the array elements (calculated result and corresponding measured value) to the output parameters. Whether square root or square is output depends on "funct_sel".

An edge at the coding switch is detected because "newsel" is different from "oldsel".
Statement Section

The statement section of the logic block is shown below:

```
BEGIN
(*---------------------------------------------------------------
Part 1 : Acquiring measured values. If "newval" changes, the
measured value is entered. The MOD operation is used to
implement a ring buffer for measured values.
---------------------------------------------------------------*)
IF newval <> oldval THEN
    pointer            := pointer MOD QUANTITY;
    measvals[pointer]  := measval_in;
    pointer            := pointer + 1;
END_IF;
oldval := newval;
(*---------------------------------------------------------------
Part 2 : Start sorting and calculation
if "resort" changes, start sorting the
ring buffer and run calculations with the
measured values. Results are stored in a new array called
"calcbuffer".
---------------------------------------------------------------*)
IF resort <> oldsort THEN
    pointer := 0;               //Reset ring buffer pointer
    eval_instance(sortbuffer := measvals); //Call EVALUATE
END_IF;
oldsort      := resort;
resultbuffer := eval_instance.calcbuffer; //Square and square
root
(*---------------------------------------------------------------
Part 3 : Evaluate coding and prepare output: If
"newsel" changes, the coding for addressing the array element
for output is recalculated: The relevant bits of "selection"
are masked and converted to integer. Depending on the setting
of
the "funct_sel" switch, "squareroot" or "square" is selected
for output.
---------------------------------------------------------------*)
IF newsel <> oldsel THEN
    address := WORD_TO_INT(SHR(IN := selection, N := 12) AND
16#0007);
END_IF;
oldsel := newsel;
IF funct_sel THEN
    result_out := resultbuffer[address].square;
ELSE
    result_out := resultbuffer[address].squareroot;
END_IF;
measval_out  := measvals[address]; //Measured value display
END_FUNCTION_BLOCK
```
3.12 Creating the CYCLE Organization Block

Tasks of the CYCLE OB

An OB1 was chosen because it is called cyclically. It performs the following tasks for the program:

- Calls and supplies the ACQUIRE function block with input and control data.
- Reads in the data returned by the ACQUIRE function block.
- Outputs the values to the display

At the beginning of the declaration section, there is the 20-byte temporary data array "system data".
### Program Code of the CYCLE OB

```plaintext
ORGANIZATION_BLOCK CYCLE
{**************************
CYCLE is like an OB1, i.e. it is called cyclically by the S7 system.
Part 1 : Function block call and transfer of
the input values Part 2 : Reading in of the output values
and output
with output switchover
**************************)
VAR_TEMP
  systemdata  : ARRAY[0..20] OF BYTE; // Area for OB1
END_VAR
BEGIN
(* Part 1 :
**************************)
ACQUIRE.ACQUIRE_DATA(
  measval_in:= WORD_TO_INT(input),
  newval        :=  "Input 0.0", //Input switch as signal
  identifier
  resort        :=  Sort_switch,
  funct_sel     :=  Function_switch,
  newsel        :=  Coding_switch,
  selection     :=  Coding);
(* Part 2 :
**************************)
IF Output_switch THEN
  //Output changeover
  Output    :=  ACQUIRE_DATA.result_out;      //Square root
  or square
ELSE
  Output    :=  ACQUIRE_DATA.measval_out;    //Measured value
END_IF;
END_ORGANIZATION_BLOCK
```

### Data Type Conversion

The measured value is applied to the input as a BYTE data type. It must be
to the INT data type. You will need to convert it from WORD to INT (the
the symbol table).

The prior conversion from BYTE to WORD is made implicitly by the compiler). The
output on the other hand requires no conversion, since this was declared as INT in
3.13 Test Data

Requirements

To perform the test, you require an input module with address 0 and an output module with address 4.

Before performing the test, set all eight switches in the upper group to the left ("0") and all eight switches in the lower group to the right ("1").

Reload the blocks on the CPU, since the initial values of the variables must also be tested.

Test Procedure

Run the test as described in the table.

<table>
<thead>
<tr>
<th>Test</th>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Set the code to &quot;111&quot; (I0.4, I0.5 and I0.6) and enter this with the coding switch (I0.7).</td>
<td>All outputs on the output module (lower-order byte) are activated and the LEDs light up.</td>
</tr>
<tr>
<td>2</td>
<td>Display the corresponding square root by setting the output switch (I0.3) to &quot;1&quot;.</td>
<td>The LEDs on the output module indicate the binary number &quot;10000&quot; (=16).</td>
</tr>
<tr>
<td>3</td>
<td>Display the corresponding square by setting the function switch (I0.2) to &quot;1&quot;.</td>
<td>15 LEDs on the output module light up. This indicates an overflow since the result of 255 x 255 is too high for the integer range.</td>
</tr>
<tr>
<td>4a</td>
<td>Reset the output switch (I0.3) back to &quot;0&quot;.</td>
<td>The measured value is displayed again. All LEDs on the outputs of the lower-order output byte are set.</td>
</tr>
<tr>
<td>4b</td>
<td>Set the value 3 (binary &quot;11&quot;) as the new measured value at the input.</td>
<td>The output does not change at this stage.</td>
</tr>
<tr>
<td>5a</td>
<td>Monitor reading in of the measured value: Set the code to &quot;000&quot; and enter it with coding switch (I0.7) so that you can later watch the value input.</td>
<td>The output module shows 0; i.e none of the LEDs lights up.</td>
</tr>
<tr>
<td>5b</td>
<td>Switch over the input switch &quot;Input 0.0&quot; (I0.0). This reads in the value set in test stage 4.</td>
<td>The output displays measured value 3, binary &quot;11&quot;.</td>
</tr>
<tr>
<td>6</td>
<td>Start sorting and calculation by switching over the sort switch (I0.1).</td>
<td>The output again indicates 0 since the sorting process has moved the measured value to a higher position in the array.</td>
</tr>
<tr>
<td>7</td>
<td>Display the measured value after sorting: Set the code &quot;110&quot; (I0.6 = 1, I0.5 = 1, I0.4 = 0 of IB0; corresponds to bit 14, bit 13 and bit 12 of IW0) and read it in by switching over the coding switch.</td>
<td>The output now indicates the measured value &quot;11&quot; again since it is the second highest value in the array.</td>
</tr>
<tr>
<td>8a</td>
<td>Display the corresponding results as follows: Switching over the output switch (I0.3) displays the square of the measured value from the 7th step.</td>
<td>The output value 9 (binary &quot;1001&quot;) is displayed.</td>
</tr>
<tr>
<td>8b</td>
<td>Switch over the function switch (I0.2) to obtain the square root.</td>
<td>The output value 2 (binary &quot;10&quot;) is displayed.</td>
</tr>
</tbody>
</table>
Additional Test

The following tables describe the switches on the input module and the examples for square and square root. These descriptions will help you to define your own tests:

- Input is made using switches. You can control the program with the top eight switches and you can set the measured value with the bottom 8 switches.
- Output is indicated by LEDs. The top group displays the higher-order output byte, the bottom group the lower-order byte.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel 0</td>
<td>Enter switch</td>
<td>Switch over to read in measured value</td>
</tr>
<tr>
<td>Channel 1</td>
<td>Sort switch</td>
<td>Switch over to start sorting/calculation</td>
</tr>
<tr>
<td>Channel 2</td>
<td>Function switch</td>
<td>Switch left (&quot;0&quot;): Square root, Switch right (&quot;1&quot;): Square</td>
</tr>
<tr>
<td>Channel 3</td>
<td>Output switch</td>
<td>Switch left (&quot;0&quot;): Measured value, Switch right (&quot;1&quot;): Result</td>
</tr>
<tr>
<td>Channel 4</td>
<td>Code</td>
<td>Output address bit 0</td>
</tr>
<tr>
<td>Channel 5</td>
<td>Code</td>
<td>Output address bit 1</td>
</tr>
<tr>
<td>Channel 6</td>
<td>Code</td>
<td>Output address bit 2</td>
</tr>
<tr>
<td>Channel 7</td>
<td>Code switch</td>
<td>Switch over to enter code</td>
</tr>
</tbody>
</table>

The following table contains eight examples of measured values that have already been sorted.

You can enter the values in any order. Set the bit combination for each value and transfer this value by operating the input switch. Once all values have been entered, start sorting and calculation by changing over the sort switch. You can then view the sorted values or the results (square root or square).

<table>
<thead>
<tr>
<th>Measured Value</th>
<th>Square Root</th>
<th>Square</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000 0001 = 1</td>
<td>0, 0000 0001 = 1</td>
<td>0000 0000, 0000 0001 = 1</td>
</tr>
<tr>
<td>0000 0011 = 3</td>
<td>0, 0000 0010 = 2</td>
<td>0000 0000, 0000 1001 = 9</td>
</tr>
<tr>
<td>0000 0111 = 7</td>
<td>0, 0000 0111 = 3</td>
<td>0000 0000, 0011 0001 = 49</td>
</tr>
<tr>
<td>0000 1111 = 15</td>
<td>0, 0000 1000 = 4</td>
<td>0000 0000, 1110 0001 = 225</td>
</tr>
<tr>
<td>0001 1111 = 31</td>
<td>0, 0000 1010 = 6</td>
<td>0000 0011, 1100 0001 = 961</td>
</tr>
<tr>
<td>0011 1111 = 63</td>
<td>0, 0000 1000 = 8</td>
<td>0000 1111, 1000 0001 = 3969</td>
</tr>
<tr>
<td>0111 1111 = 127</td>
<td>0, 0000 1011 = 11</td>
<td>0011 1111, 0000 0001 = 16129</td>
</tr>
<tr>
<td>1111 1111 = 255</td>
<td>0, 0001 0000 = 16</td>
<td>0111 1111, 1111 1111 = Overflow!</td>
</tr>
</tbody>
</table>
4 Using S7-SCL

4.1 Starting the S7-SCL Software

Starting from the Windows Interface

Once you have installed the S7-SCL software on your programming device/PC, you can start S7-SCL using the Start button in the Windows taskbar (entry under "SIMATIC / STEP7").

Starting from the SIMATIC Manager

The quickest way to start S7-SCL is to position the mouse pointer on an S7-SCL source file in the SIMATIC Manager and double-click on it.
4.2 User Interface

The S7-SCL windows have the following standard components:

1. **Title bar:**
   Contains the window title and window control buttons.

2. **Menu bar:**
   Shows all menus available for the open window.

3. **Toolbar:**
   Contains buttons for frequently used commands.

4. **Working area:**
   Contains one or more windows in which you can edit program text or read compiler information or debugging data.

5. **Status bar:**
   Displays the status and other information on the active object.
4.3 Customizing the User Interface

Customizing the Editor

To make the settings for the editor, select the menu command **Options > Customize** and click the "Editor" tab in the "Customize" dialog box. In this tab, you can make the following settings:

<table>
<thead>
<tr>
<th>Options in the &quot;Editor&quot; Tab</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fonts</td>
<td>Specifies the font for the entire source text.</td>
</tr>
<tr>
<td>Tabulator length</td>
<td>Specifies the column width of tabulators.</td>
</tr>
<tr>
<td>Display line numbers</td>
<td>Displays line numbers at the beginning of the lines.</td>
</tr>
<tr>
<td>Save before compiling</td>
<td>Before compiling, you are asked whether you want to save the source file.</td>
</tr>
<tr>
<td>Confirm before saving</td>
<td>Asks for confirmation before saving.</td>
</tr>
</tbody>
</table>

Adapting the Style and Color

To change the style and color of the various language elements, select the menu command **Options > Customize** and click the "Format" tab in the "Customize" dialog box. Here, you can make the following settings:

<table>
<thead>
<tr>
<th>Options in the &quot;Format&quot; Tab</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keywords in uppercase</td>
<td>Formats S7-SCL keywords such as FOR, WHILE, FUNCTION_BLOCK, VAR or END_VAR as upper case characters when you are writing your program.</td>
</tr>
<tr>
<td>Indent keywords</td>
<td>Indents lines in the declaration sections and within the control statements IF, CASE, FOR, WHILE and REPEAT while you are writing your program.</td>
</tr>
<tr>
<td>Indent automatically</td>
<td>After a line break, the new line is automatically indented by the same amount as the previous line. This setting applies only to new lines.</td>
</tr>
<tr>
<td>Style/Color</td>
<td>You can select the style and color of the individual language elements.</td>
</tr>
</tbody>
</table>

The settings in this tab are only effective when you have selected the option "Use following formats" in the "Format" tab.

Toolbar, Breakpoint Bar, Status Bar

You can toggle the display of the toolbar, breakpoint bar and status bar on and off individually. Simply select or deselect the appropriate command in the **View** menu. When the function is activated, a check mark appears next to the command.

"Errors and warnings" window

The "Errors and warnings" window lists the errors and warnings that occurred while a source was being compiled. You can activate and de-activate it by using the **View > Errors and warnings** menu command.
4.4 Creating and Handling an S7-SCL Source File

4.4.1 Creating a New S7-SCL Source File

Before you can write an S7-SCL program, you must first create a new S7-SCL source file. You create the source file in the source files folder in an S7 program.

Structure of an S7 Program in the SIMATIC Manager

Source files created in S7-SCL can be integrated in the structure of an S7 program as shown below:

Follow the steps outlined below:

1. Open the "New" dialog box as follows:
   - Click the "New" button in the toolbar or
   - Select the menu command File > New.

2. In the "New" dialog box, select
   - A project
   - The filter setting "S7-SCL Source File" and
   - The source files folder within the S7 program

3. Type in the name of the source object in the text box. The name can be up to 24 characters long.

4. Confirm with "OK".

The source object is created under the name you have selected and is then displayed in a window where you can continue working with it.

Note

You can also create an S7-SCL source file with the SIMATIC Manager by selecting a source file folder and the menu command Insert > S7 Software > S7-SCL Source File.
4.4.2 Opening an S7-SCL Source File

You can open an S7-SCL source file so that you can compile or edit it.

Follow the steps outlined below:

1. Open the "Open" dialog box as follows:
   - Click the "Open" button in the toolbar or
   - Select the menu command **File > Open**.
2. Once the dialog box is open, select the following:
   - Required project
   - The required S7 program
   - The corresponding source files folder
3. Select the S7-SCL source file.
4. Click the "OK" button.

---

**Note**
You can also open an S7-SCL source file in the SIMATIC Manager by double-clicking its icon or using the menu command **Edit > Open Object** when the object is selected.

---

4.4.3 Closing an S7-SCL Source File

Follow the steps outlined below:

- Select the menu command **File > Close**.
- Click on the "Close" symbol in the title bar of the window.

---

**Note**
If you have modified the source file, you will be asked whether or not you want to save any changes before you close the file. If you do not save changes they are lost.
4.4.4 Opening Blocks

It is not possible to open blocks with the S7-SCL application. You can always only open the corresponding source. Blocks created with S7-SCL can, however, be opened with the LAD/STL/FBD editor and displayed and edited in the STL programming language. Do not make any modifications to the block in this STL representation for the following reasons:

- The displayed MC7 commands do not necessarily represent a valid STL block.
- An error-free compilation with the STL compiler involves modifications that require thorough knowledge of both STL and S7-SCL.
- The block compiled with STL has the STL language identifier and no longer the S7-SCL identifier.
- The S7-SCL source file and the MC7 code are no longer consistent.

Further information is available in the STEP 7 online help.

Note

It is easier to maintain your CPU programs by making any changes you require in the S7-SCL source files, and then compiling them again.

4.4.5 Specifying Object Properties

You can specify the object properties by assigning attributes to the blocks. You can select the properties for the S7-SCL source file (for example, the author) in the "Properties" dialog box.

Follow the steps outlined below:

1. Select the menu command File > Properties.
2. Enter the options you require in the "Properties" dialog box.
3. Confirm with "OK".

4.4.6 Creating S7-SCL Source Files with a Standard Editor

You can also use a standard ASCII editor for editing your S7-SCL source file. If you choose this method, the helpful editing functions and integrated online help of S7-SCL are not available.

Once you have created the source file and saved it, you must then import it into the source file folder of an S7 program using the SIMATIC Manager (see STEP 7 documentation). Following this, you can open the source file in S7-SCL and continue working with it or compile it.
4.4.7 Block Protection

You can protect blocks by specifying the KNOW_HOW_PROTECT attribute when you program the block in the source file.

Result of Block Protection

- When you open a compiled block later with the incremental STL editor, the statements of the block are hidden.
- In the declarations of the block, only the variables of types VAR_IN, VAR_OUT and VAR_IN_OUT are displayed. The variables of the declaration fields VAR and VAR_TEMP remain hidden.

Rules for Using Block Protection

- The keyword is KNOW_HOW_PROTECT. Enter this before all other block attributes.
- OBs, FBs, FCs, and DBs can be protected in this way.

4.5 Guidelines for S7-SCL Source Files

4.5.1 General Rules for S7-SCL Source Files

S7-SCL source files must comply with the following rules:

- Any number of logic blocks (FB, FC, OB), data blocks (DB), and user-defined data types (UDT) can be edited in an S7-SCL source file.
- Each block type has a typical structure.
- Each statement and each variable declaration ends with a semicolon (;).
- No distinction is made between upper- and lowercase characters.
- Comments are only intended for documenting the program. They do not affect the running of the program.
- Instance data blocks are created automatically when a function block is called. They do not need to be edited.
- DB 0 has a special purpose. You cannot create a data block with this number.
4.5.2 Order of the Blocks

When creating the S7-SCL source file, remember the following rules governing the order of the blocks:

- Called blocks must precede the calling blocks.
- User-defined data types (UDTs) must precede the blocks in which they are used.
- Data blocks that have been assigned a user-defined data type (UDT) are located after the UDT.
- Shared data blocks come before all blocks that access them.

4.5.3 Using Symbolic Addresses

In an S7-SCL program, you work with addresses such as I/O signals, memory bits, counters, timers, and blocks. You can address these elements in your program using absolute addresses (for example, I1.1, M2.0, FB11), however the S7-SCL source files are much easier to read if you use symbols (for example Motor_ON). The address can then be accessed in your user program using the symbol.

Local and Shared Symbols

- You use shared symbols for memory areas of the CPU and block identifiers. These are known throughout the entire application program and must therefore be identified uniquely. You can create the symbol table with STEP 7.
- Local symbols are only known in the block in whose declaration section they are defined. You can assign names for variables, parameters, constants, and jump labels and can use the same name for different purposes in different blocks.

Note

Make sure that the symbolic names are unique and are not identical to any of the keywords.
4.6 Editing in S7-SCL Source Files

4.6.1 Undoing the Last Editing Action

With the menu command Edit > Undo, you can reverse one or more actions. You cannot reverse all actions. As an example, the menu command File > Save cannot be reversed.

4.6.2 Redoing an Editing Action

After you have reversed one or more actions, you can restore the reversed actions with the menu command Edit > Redo.

4.6.3 Finding and Replacing Text Objects

If you want to edit or modify an S7-SCL source file, you can often save valuable time by searching for text objects and replacing them. You can search, for example, for keywords, absolute identifiers, symbolic identifiers etc.

Follow the steps outlined below:
1. Select the menu command Edit > Find and Replace....
2. Enter the options in the "Find and Replace" dialog box.
3. Start the search as follows:
   - Click the "Find" button to find a text object and to mark it or
   - Click the "Replace" or "Replace All" button to find a text and replace it by the text entered in the "Replace with" text box.
4.6.4 Selecting Text Objects

You can select text objects by holding down the mouse button and dragging the mouse pointer over the selected area of text.

You can also:

- Select the complete source text by selecting the menu command Edit > Select All.
- Select a word by double-clicking on it.
- Select an entire line by clicking in the margin to the left of the line.

With the menu command Edit > Undo Selection, you can cancel the selection.

4.6.5 Copying Text Objects

With this function you can copy entire programs or sections of them. The copied text is placed on the clipboard and can then be pasted as often as you require at other points in the text.

Follow the steps outlined below:

1. Select the text object to be copied.
2. Copy the object as follows:
   - Click the “Copy” button in the toolbar or
   - Select the menu command Edit > Copy.
3. Move the cursor to the point at which you want to paste the object (in the same or in a different application).
4. Paste the object as follows:
   - Click the "Paste" button in the toolbar or
   - Select the menu command Edit > Paste.
4.6.6 Cutting Text Objects

With this function, you place the selected text on the clipboard. Normally, this menu command is used in conjunction with the menu command Edit > Paste that inserts the content of the clipboard at the position currently marked by the cursor.

Follow the steps outlined below:
1. Select the object you want to cut.
2. Cut the object as follows:
   - Click the “Cut” button in the toolbar or
   - Select the menu command Edit > Cut.

Note

- The selected object cannot be cut if the menu command Edit > Cut is not activated (on a gray background).
- Using the menu command Edit > Paste, you can insert the text you have cut at any point (in the same or in a different program).
- The content of the clipboard is retained until you use one of the menu commands Edit > Cut or Edit > Copy again.

4.6.7 Deleting Text Objects

You can delete a selected text object from the source text.

Follow the steps outlined below:
1. Select the text you want to delete.
2. Select the menu command Edit > Delete.

The deleted text is not copied to the clipboard. The deleted object can be retrieved with the menu command Edit > Undo or Edit > Redo.
4.6.8 Positioning the Cursor in a Specific Line

With the following functions you can position the cursor at a specific position.

Positioning in a specific line-number

You can position the cursor at the beginning of a specific line:

1. Select the menu command **Edit > Go To Line**.
   The "Go To" dialog box is opened.
2. Enter the line number in the "Go To" dialog box.
3. Confirm by clicking on "OK".

Positioning on the next/previous bookmark

If bookmarks were set in the source file, you can navigate between them:

- Select the menu command **Edit > Go To > Next Bookmark / Previous Bookmark**.

Positioning on the next/previous error in the program code

After compiling, all the syntactic errors are displayed in the "Errors and warnings" window with specification of the line and column number.

S7-SCL offers the possibility of navigating between the individual error positions in the program so that all the errors from the previous compilation run can be eliminated consecutively.

1. Position the cursor at any position in the source text.
2. Select the menu command **Edit > Go To > Next Error / Previous Error**.
4.6.9 Syntactically Correct Indenting of Lines

The following functions allow you to structure S7-SCL source files by indenting lines.

- **Automatic indent**
  When this function is active, the new line following a line break is automatically indented by the same amount as the previous line.

- **Indenting keywords**
  When this function is active, lines in the declaration sections and within the control structures IF, CASE, FOR, WHILE and REPEAT are indented.

Follow the steps outlined below:

1. Select the **Options > Customize** menu command.
2. Select the "Format" tab in the dialog displayed.
3. Make sure that the option "Use following formats" is active.
4. Activate the option "Indent automatically" or "Indent keywords".
4.6.10 Setting the Font Style and Color

The use of different styles and colors for the various language elements makes an S7-SCL source file easier to read and lends it a more professional appearance. To format the source text, you can use the following functions:

- **Keywords in uppercase:**
  When this function is active, defined keywords such as FOR, WHILE, FUNCTION_BLOCK, VAR or END_VAR are written in uppercase letters.

- **Defining the style and color:**
  There are various default styles and colors for the various language elements such as operations, comments or constants. You can change these default settings.
  The following colors are the defaults:

<table>
<thead>
<tr>
<th>Font Color</th>
<th>Language Element</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
<td>Keywords</td>
<td>ORGANIZATION_BLOCK</td>
</tr>
<tr>
<td></td>
<td>Predefined data types</td>
<td>INT</td>
</tr>
<tr>
<td></td>
<td>Predefined identifiers</td>
<td>ENO</td>
</tr>
<tr>
<td></td>
<td>Standard functions</td>
<td>BOOL_TO_WORD</td>
</tr>
<tr>
<td>Ochre</td>
<td>Operations</td>
<td>NOT</td>
</tr>
<tr>
<td>Pink</td>
<td>Constants</td>
<td>TRUE</td>
</tr>
<tr>
<td>Blue-green</td>
<td>Comments</td>
<td>//... or (<em>...</em>)</td>
</tr>
<tr>
<td>Violet</td>
<td>Shared symbols (symbol table) inside quotes</td>
<td>&quot;Motor&quot;</td>
</tr>
<tr>
<td>Black</td>
<td>Normal text</td>
<td>Variables</td>
</tr>
</tbody>
</table>

Follow the steps outlined below:

1. Select the **Options > Customize** menu command.
2. Select the "Format" tab in the dialog displayed.
3. Make sure that the option "Use following formats for printing:" is enabled.
4. You can now make the required settings. You can display detailed information about the dialog box by clicking the "Help" button while the dialog is open.
4.6.11 Placing Bookmarks In The Source Text

You can now use bookmarks to navigate rapidly with a source. Bookmarks are useful, for example, in order to carry out changes that have an effect at various points in the source. You can insert bookmarks at any point in a source. If there are several bookmarks, you can navigate forwards and backwards between the individual bookmarks.

Validity

Bookmarks are valid as long as the source is opened. They are not stored with the source.

Inserting bookmarks

1. Place the cursor in the line that you want to mark.
2. Select the menu command Edit > Bookmarks On/Off.

Navigating between the bookmarks

Select the menu command Edit > Go To > Next Bookmark / Previous Bookmark.

Deleting bookmarks

Select the menu command Edit > Delete All Bookmarks.

Note

The functions that you require in order to use the bookmarks can be accessed rapidly via the bookmark bar. The bookmark bar is displayed by using the menu command View > Bookmark Bar.
4.6.12 Inserting Templates

4.6.12.1 Inserting Block Templates

One S7-SCL editing function allows you to insert block templates for OBs, FBs, FCs, instance DBs, DBs, DBs that reference UDTs, and UDTs. Using these block templates makes it easier to program and to keep to the required syntax.

Follow the steps outlined below:
1. Position the cursor at the point at which you want to insert the block template.
2. Select the menu command Insert > Block Template > OB/FB/FC/DB/IDB/DB Referencing UDT/UDT.

4.6.12.2 Inserting Block Calls

S7-SCL supports you when programming block calls. You can call the following blocks:

- System function blocks (SFB) and system functions (SFC) from the SIMATIC libraries,
- Function blocks and functions created in S7-SCL,
- Function blocks and functions created in other STEP 7 languages.

Follow the steps outlined below:
1. Select the Insert > Block Call menu command.
2. Select the required SFC, SFB, FC, or FB in the dialog box and confirm your selection with "OK".
   S7-SCL copies the called block automatically to the S7 program and enters the block call and the formal parameters of the block with the correct syntax into the source file.
3. If you call a function block, add the information about the instance DB.
4. Enter the actual parameters required by the block. To help you select an actual parameter, S7-SCL indicates the required data type as a comment.

4.6.12.3 Inserting Templates for Comments

This S7-SCL editing function allows you to insert templates for comments. Using these templates makes it easier to input your information and to keep to the required syntax.

Follow the steps outlined below:
1. Position the cursor after the block header of the required block.
2. Select the menu command Insert > Block Template > Comment.
4.6.12.4 **Inserting Parameter Templates**

One S7-SCL editing function allows you to insert templates for the declarations of the parameters. Using these templates makes it easier to type in your program and to keep to the required syntax. You can declare parameters in function blocks and in functions.

**Follow the steps outlined below:**

1. Position the cursor in the declaration section of an FB or FC.
2. Select the menu command **Insert > Block Template > Parameter**.

4.6.12.5 **Inserting Control Structures**

This S7-SCL editing function allows you to insert control structure templates for logic blocks. Using these templates makes it easier to input your information and to keep to the required syntax.

**Follow the steps outlined below:**

1. Position the cursor at the point at which you want to insert the template.
2. Select the menu command **Insert > Control Structure > IF/CASE/FOR/WHILE/REPEAT**.
4.7 Compiling an S7-SCL Program

4.7.1 What You Should Know About Compiling

Before you run or test your program, you must first compile it. Once you start compilation, the compiler is started automatically. The compiler has the following characteristics:

- You can compile an entire S7-SCL source file in one compilation session or compile selected individual blocks from the source file.
- All syntax errors found by the compiler are displayed in a window.
- Each time a function block is called, a corresponding instance data block is created if it does not already exist.
- You can also compile several S7-SCL source files together by creating an S7-SCL compilation control file.
- Using the Options > Customize menu command, you can set options for the compiler.

Once you have created a user program that is free of errors and has been compiled, you can assume that the program is correct. Problems can, nevertheless, occur when the program is run on the PLC. Use the debugging functions of S7-SCL to find errors of this type.
4.7.2 Customizing the Compiler

You can adapt the compilation to meet your own requirements.

Follow the steps outlined below:

1. Select the menu command Options > Customize to open the "Customize" dialog box.
2. Select the "Compiler" tab or "Create Block" tab.
3. Enter the options you require in the tab.

Options in the "Compiler" tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create object code</td>
<td>With this option, you decide whether or not you want to create executable code. Compilation without this option serves simply as a syntax check.</td>
</tr>
<tr>
<td>Optimize object code</td>
<td>When you select this option, the blocks are optimized in terms of memory requirements and runtime on the PLC. It is advisable to keep this option permanently selected since the optimization has no disadvantages that affect the functionality of the block.</td>
</tr>
<tr>
<td>Monitor array limits</td>
<td>If you select this option, a check is made during the runtime of the S7 program to determine whether array indexes are within the permitted range according to the declaration for the ARRAY. If an array index exceeds the permitted range, the OK flag is set to FALSE.</td>
</tr>
<tr>
<td>Create debug info</td>
<td>This option allows you to run a test with the debugger after you have compiled the program and downloaded it to the CPU. The memory requirements of the program and the runtimes on the AS are, however, increased by this option.</td>
</tr>
<tr>
<td>Set OK flag</td>
<td>This option allows you to query the OK flag in your S7-SCL source texts.</td>
</tr>
<tr>
<td>Permit nested comments</td>
<td>Select this option if you want to nest comments within other comments in your S7-SCL source file.</td>
</tr>
<tr>
<td>Maximum string length:</td>
<td>Here, you can reduce the standard length of the STRING data type. The default is 254 characters. The setting affects all output and in/out parameters as well as the return values of functions. Note the value you set must not be smaller than the STRING variables actually used in the program.</td>
</tr>
</tbody>
</table>
### Options in the "Create Block" tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overwrite blocks</td>
<td>Overwrites existing blocks in the &quot;Blocks&quot; folder of an S7 program if blocks with the same identifier are created during compilation. Blocks with the same name that already exist on the target system are also overwritten when you download blocks. If you do not select this option, you are prompted for confirmation before a block is overwritten.</td>
</tr>
<tr>
<td>Display warnings</td>
<td>You can decide whether you also want warnings displayed in addition to errors following compilation.</td>
</tr>
<tr>
<td>Display errors before warnings</td>
<td>You can have errors listed before warnings in the display window.</td>
</tr>
<tr>
<td>Generate reference data</td>
<td>Select this option if you want reference data to be generated automatically when a block is created. With the menu command Options &gt; Reference Data, you can also generate or update the reference data later.</td>
</tr>
<tr>
<td>Include system attribute 'S7_server'</td>
<td>Select this option if you want the “S7 server” system attribute for parameters to be taken into account when a block is created. You assign this attribute when the parameter is relevant to the configuration of connections or messages. It contains the connection or message number. This option extends the time required for compilation.</td>
</tr>
</tbody>
</table>
4.7.3 Compiling the Program

Before you can test a program or run it, it must first be compiled. To make sure that you always compile the latest version of your S7-SCL source file, it is advisable to select the menu command Options > Customize and to select the option “Save before compiling” in the “Editor” tab. The menu command File > Compile then implicitly saves the S7-SCL source file.

Follow the steps outlined below:

1. Save the S7-SCL source file to be compiled.

2. To create an executable program, you must select the option “Create object code” in the “Compiler” tab of the “Customize” dialog box.

3. If required, modify other compiler settings.

4. Check whether the corresponding symbol table is in the same program folder.

5. You can start compilation in the following ways:
   - The menu command File > Compile compiles the entire source file.
   - The menu command File > Compile Selected Blocks opens a dialog box in which you can select individual blocks for compilation.

6. The “Errors and Warnings” dialog box displays all syntax errors and warnings that occurred while the program was being compiled. Correct any errors reported by the compiler and then repeat the procedure outlined above.
4.7.4 Creating a Compilation Control File

If you create a compilation control file, you can compile several S7-SCL source files at one time within a source folder. In the compilation control file, you enter the name of the S7-SCL source files in the order in which they are to be compiled.

Follow the steps outlined below:

1. Open the "New" dialog box by selecting the menu command File > New.
2. In the "New" dialog box, select
   - a source file folder within an S7 program and
   - the object type "S7-SCL Compilation Control File"
3. Enter the name of the control file in the corresponding box (max. 24 characters) and confirm with "OK".
4. The file is created and displayed in a working window for further editing. In the working window, enter the name of the S7-SCL source files to be compiled in the required order and save the file.
5. Then start the compilation by selecting the menu command File > Compile.

4.7.5 Debugging the Program After Compilation

All the syntax errors and warnings that occur during compilation are displayed in the "Errors and Warnings" window. If an error occurs, the block cannot be compiled, whereas if only warnings occur, an executable block is compiled. You may still, nevertheless, encounter problems running the block on the PLC.

To correct an error:

1. Select the error and press the F1 key to display a description of the error and instructions on correcting the error.
2. If a line number and column number are displayed, you can locate the error in the source text as follows:
   - Click the error message in the "Errors and Warnings" window with the right mouse button and then select the Display Errors command.
   - Double-click the error message to position the cursor on the point reported (line, column).
3. Find out the correct syntax in the S7-SCL Language Description.
4. Make the necessary corrections in the source text.
5. Save the source file.
6. Compile the source file again.
4.8 Saving and Printing an S7-SCL Source File

4.8.1 Saving an S7-SCL Source File

The term "saving" in S7-SCL always refers to saving the source files. Blocks are generated in S7-SCL when the source file is compiled and automatically stored in the appropriate program folder. You can save an S7-SCL source file in its current state at any time. The object is not compiled. Any syntax errors are also saved.

Follow the steps outlined below:

- Select the menu command File > Save, or click the "Save" button in the toolbar. The S7-SCL source file is updated.
- If you want to create a copy of the active S7-SCL source file, select the menu command File > Save As. The Save As dialog box appears in which you can enter a name and path for the duplicate file.

4.8.2 Customizing the Page Format

You can modify the appearance of a printout as follows:

- The menu command File > Page Setup allows you to select the page format and orientation for your printout.
- You can set headers and footers for your documents by selecting the menu command File > Page Setup and then selecting the "Headers and footers" tab in the subsequent dialog box.
- You can use the menu command File > Printer Setup to carry out further printer-specific settings.

Caution
The page orientation has to be set in the "Page setup" dialog box. The settings in the "Printer setup" dialog box are not relevant for printing out S7-SCL source files.

- You can also display and check the page layout before you print it using the menu command File > Print Preview.
4.8.3 Printing an S7-SCL Source File

The S7-SCL source file in the active editing window is printed; in other words, to print an S7-SCL source file, this file must already be open.

Follow the steps outlined below:

1. Activate the editing window for the S7-SCL source file you want to print.
2. Open the "Print" dialog box as follows:
   - Click the "Print" button in the toolbar or
   - Select the menu command File > Print.
3. Select the option you require in the "Print" dialog box, such as print range and number of copies.
4. Confirm with "OK".
4.8.4 Setting the Print Options

You can use the following functions to format your printout:

- **Form feed at start/end of block**
  When this check box is enabled, each block is printed out on a new page (start) or ends with a form feed (end).

- **Print line numbers**
  When this check box is enabled, line numbers are printed out at the beginning of each line.

- **Color printing**
  When this check box is enabled, the colors used in the source are output during printing.

- **Font for printing**
  The default font for the entire text is Courier New size 8. This font ensures optimal printing results.

- **Style**
  You can define various styles for the various language elements. You can select the following elements individually:

<table>
<thead>
<tr>
<th>Language Element</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal text</td>
<td></td>
</tr>
<tr>
<td>Keyword</td>
<td>ORGANIZATION_BLOCK</td>
</tr>
<tr>
<td>Identifiers of predefined data types</td>
<td>INT</td>
</tr>
<tr>
<td>Predefined identifiers</td>
<td>ENO</td>
</tr>
<tr>
<td>Identifiers of standard functions</td>
<td>BOOL_TO_WORD</td>
</tr>
<tr>
<td>Operations</td>
<td>NOT</td>
</tr>
<tr>
<td>Constants</td>
<td>TRUE</td>
</tr>
<tr>
<td>Comment section</td>
<td>(* *)</td>
</tr>
<tr>
<td>Line comment</td>
<td>//...</td>
</tr>
<tr>
<td>Shared symbols (symbol table) inside quotes</td>
<td>&quot;Motor&quot;</td>
</tr>
</tbody>
</table>

**Follow the steps outlined below:**

1. Select the **Options > Customize** menu command.
2. Select the "Print" tab in the dialog displayed.
3. Make sure that the "Use following formats" check box is enabled.
4. Now make the required settings. You can display detailed information about the dialog box by clicking the "Help" button while the dialog is open.
4.9 Downloading the Created Programs

4.9.1 CPU Memory Reset

With the Clear/Reset function, you can delete the entire user program on a CPU online.

Follow the steps outlined below:

1. Select the menu command PLC > Operating Mode and switch the CPU to STOP.
2. Select the menu command PLC > Clear/Reset.
3. Confirm this action in the dialog box that is then displayed.

⚠️ Warning
- The CPU is reset.
- All user data are deleted.
- The CPU terminates all existing connections.
- If a memory card is inserted, the CPU copies the content of the memory card to the internal load memory after the memory reset.

4.9.2 Downloading User Programs to the CPU

Requirements

When you compile an S7-SCL source file, blocks are created from the source file and are saved in the "Blocks" folder of the S7 program.

Blocks that are called at the first level in S7-SCL blocks are automatically copied to the "Blocks" directory and entered in the load list.

You can download further blocks from the user program with the SIMATIC Manager from the programming device to the CPU.

Before you can download blocks, a connection must exist between the programming device and CPU. An online user program must be assigned to the CPU module in the SIMATIC manager.
Procedure

Once you have compiled the source file, you can start the download in the following ways.

- The **File > Download** menu command downloads all blocks in the source file and all blocks that are called at the first level.
- The **File > Compile Selected Blocks** menu command opens a dialog box in which you can select individual blocks for compilation.

The blocks are transferred to the CPU. If a block already exists in the RAM of the CPU you will be asked to confirm whether or not you want to overwrite the block.

---

**Note**

It is advisable to download the user program in the STOP mode, since errors can occur if you overwrite an old program in the RUN mode.
4.10 Testing the Created Programs

4.10.1 The S7-SCL Debugging Functions

Using the S7-SCL debugging functions, you can check the execution of a program on the CPU and locate any errors in the program. Syntax errors are indicated by the compiler. Runtime errors occurring during the execution of the program are also indicated, in this case, by system interrupts. You can locate logical programming errors using the debugging functions.

S7-SCL Debugging Functions

In S7-SCL, you can start the following test functions:

- **Monitor**
  With this function, you can display the names and current values of variables in the S7-SCL source file. During the test, the values of the variables and the parameters are displayed in chronological order and updated cyclically.

- **Debug with Breakpoints/Single Step**
  With this function, you can set breakpoints and then debug in single steps. You can execute the program algorithm, for example statement by statement and can see how the values of the variables change.

> **Caution**

Running a test while your plant is in operation can lead to serious injury to personnel or damage to equipment if the program contains errors!

Always make sure that no dangerous situations can occur before activating debugging functions.

Requirements for Debugging

- The program has been compiled with the options "Create object code" and "Create debug info". You can select the options in the "Compiler" tab of the "Customize" dialog box. You can display this dialog with the menu command **Options > Customize**.

- Current reference data are available. Reference data are generated automatically during compiling if the option "Create Debug Info" is active.

- An online connection exists from the programming device/PC to the CPU.

- The program has been loaded on the CPU. You can do this with the menu command **PLC > Download**.
4.10.2 The "Monitor" Debugging Function

"Monitor" debugging function

Using the continuous monitoring function, you can debug a group of statements. This group of statements is also known as the monitoring range. During the test, the values of the variables and the parameters of this range are displayed in chronological order and updated cyclically. If the monitoring range is in a program section that is executed in every cycle, the values of the variables cannot normally be obtained from consecutive cycles.

Values that have changed in the current cycle and values that have not changed can be distinguished by their color.

Monitoring range

The range of statements that can be monitored tested depends on the performance of the connected CPU.

After compilation, the S7-SCL statements in the source code produce different numbers of statements in machine code so that the length of the monitoring range is variable and is determined and indicated by the S7-SCL debugger when you select the first statement of the required monitoring range.

You can furthermore define a specific monitoring range. To do so, select the statements to be monitored in the source file.

Debugging modes

Querying this information usually extends the length of the cycle times. To allow you to influence the extent to which the cycle time is extended, S7-SCL provides two different modes.

<table>
<thead>
<tr>
<th>Operating Mode</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Operation</td>
<td>In the &quot;Test Operation&quot; mode, the monitoring range is only limited by the performance of the connected CPU. All the debugging functions can be used without restrictions. The CPU cycle time can be extended considerably since the status of statements, for example, in programmed loops is queried in each iteration.</td>
</tr>
<tr>
<td>Process Operation</td>
<td>In the &quot;Process Operation&quot; mode, the S7-SCL debugger restricts the maximum monitoring range so that the cycle times during testing do not exceed the real runtimes of the process or only insignificantly.</td>
</tr>
</tbody>
</table>

Remember the following restrictions for the "Monitor" function:

- Variables of a higher data type cannot be displayed in their entirety. The elements of these variables can be monitored providing they are not of an elementary data type.
- Variables of the type DATE_AND_TIME and STRING and parameters of the type BLOCK_FB, BLOCK_FC, BLOCK_DB, BLOCK_SDB, TIMER and COUNTER are not displayed.
- Access to data blocks with the format <symbol>.<absoluteaddress> are not displayed (for example data.DW4).
4.10.3 Debugging with Breakpoints/Single Step Mode

If you test with breakpoints, the program is tested step by step. You can execute the program algorithm statement by statement and can see how the values of the variables change.

After setting breakpoints, you can allow the program to be executed as far as a breakpoint and then start step-by-step monitoring at this breakpoint.

Single Step Functions:

When the "Debugging with Breakpoints" function is active, you can use the following functions:

- Next Statement
  The currently selected statement is executed.

- Resume
  Resume until the next active breakpoint.

- To Cursor
  Resume as far as the cursor position you have selected in the source file.

- Execute Call
  Jump to or call an S7-SCL block lower down the call hierarchy.

Breakpoints

You can define breakpoints at any point in the statement section of the source text.

The breakpoints are only transferred to the programmable controller and activated when you select the menu command Debug > Breakpoints Active. The program is then executed as far as the first breakpoint.

The maximum number of active breakpoints depends on the CPU:

Requirements:

The opened source file was not modified previously in the editor.
4.10.4 Steps in Monitoring

Once you have downloaded the compiled program to the programmable controller, you can test it in the "Monitor" mode.

Note
The extent of the statements to be debugged (greatest possible monitoring range) depends on the performance of the connected CPU.

Follow the steps outlined below:

1. Make sure that the requirements for debugging are satisfied and that the CPU is in the RUN or RUN-P mode.
2. Select the window containing the source file of the program to be tested.
3. If you want to change the default mode (process operation), select the menu command Debug > Operation > Test Operation.
4. Define the monitoring range. You have two possibilities:
   - Position the cursor in the line of the source text containing the first statement of the range to be tested. S7-SCL now selects a maximum monitoring range from the position of the cursor.
   - Select the instructions that you want to monitor in the source text.
5. Make sure that no dangerous situations can result from running the program.
6. Select the menu command Debug > Monitor.
7. De-activate the menu command Debug > Monitor in order to interrupt debugging.
8. Select the menu command Debug > Finish Debugging in order to terminate debugging.

Result
The monitoring range is calculated and indicated by a gray bar at the left edge of the window. The window is split and the names and current values of the variables in the monitoring range are displayed line by line in the right-hand half of the window.

Adapting the monitoring function
You have the following possibilities of adapting the monitoring function to your requirements:

- Define a call environment for the block to be monitored.
- Select the menu command View > Symbolic Representation to toggle the symbolic names from the symbol table on and off in your program.
- Select the menu command Options > Customize, open the "Format" tab, and make the settings for the colors in which the values will be displayed.
4.10.4.1 Defining a Call Environment for Blocks

**Call environment**

In order to define the monitoring range even more specifically you can define a call environment for the blocks to be monitored in which you specify that a block is only monitored if one of the following conditions is fulfilled:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Selection possibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>The block is called from a specific higher-level block.</td>
<td>Call path</td>
</tr>
<tr>
<td>The block is called together with a specific data block.</td>
<td>Global data block and/or Instance data block</td>
</tr>
</tbody>
</table>

**Proceed as follows to define a call path**

1. Select the menu command **Debug > Blocks Call Environment**.
   
   A list of the existing blocks is displayed in the subsequent dialog box.
2. Select a block from the list.
3. Activate the option "Activate call path".
   
   The possible call paths are now displayed graphically in the lower window section.
4. Select the desired call path.

**Proceed as follows to define a data block**

1. Select the menu command **Debug > Blocks Call Environment**.
   
   A list of the existing blocks is displayed in the subsequent dialog box.
2. Select a block from the list.
3. Activate the option "Open data blocks".
4. Enter the number of the desired data block.

**Note**

When you have defined a call environment, proceed as follows in order to start the monitoring:

1. Position the insertion point in the block to be monitored, for which the call environment was defined.
2. Select the menu command **Debug > Monitor**.

The monitoring function will be started. The block will be monitored when all defined call conditions have been met.
4.10.5 Steps in Testing with Breakpoints

4.10.5.1 Defining Breakpoints

To set and define breakpoints:

1. Open the source file you want to debug.
2. Display the toolbar for breakpoint editing with the menu command View > Breakpoint Bar.
3. Position the cursor at the required point and select the menu command Test > Set Breakpoint or the button in the breakpoint bar. The breakpoints are displayed at the left edge of the window as a red circle.
4. If required, select Debug > Edit Breakpoints and define a call environment. The call environment decides whether or not a breakpoint is only active when the block in which it is located
   - is called by a specific higher-level block and/or
   - is called with a specific data block/instance data block.

4.10.5.2 Starting the Test with Breakpoints

Once you have downloaded the compiled program to the programmable controller and set breakpoints, you can debug it in the "Test with Breakpoints" mode.

Follow the steps outlined below:

1. Open the S7-SCL source file of the program you want to debug.
2. Make sure that no dangerous situations can result from running the program and that the CPU is in the RUN-P mode.
3. Select the menu command Debug > Breakpoints Active and then Debug > Monitor.
   Result: The window is split vertically into two halves. The program is executed as far as the next breakpoint. When this is reached, the CPU changes to HOLD and the red breakpoint is marked by a yellow arrow.
4. Continue with one of the following commands:
   - Select the menu command Debug > Resume or click the "Resume" button.
     The CPU changes to the RUN mode. When the next active breakpoint is reached, it changes to hold again and displays the breakpoint in the right-hand window.
   - Select the menu command Debug > Next Statement or click the "Next Statement" button.
     The CPU changes to RUN. After processing the selected statement it changes to hold again and displays the contents of the currently processed variables in the right-hand window.
   - Select the menu command Debug > To Cursor or click the "To Cursor" button.
     The CPU changes to the RUN mode. When the selected point in the program is reached, it changes to hold again.
Select the menu command **Debug > Execute call**, if the program stops in a line containing a block call.

If the lower block in the call hierarchy was created with S7-SCL, it is opened and executed in the test mode. After it is processed, the program jumps back again to the call point.

If the block was created in another language, the call is skipped and the program line that follows is selected.

### Note

The menu commands **Debug > Next Statement** or **Debug > To Cursor** set and activate a breakpoint implicitly. Make sure that you have not used the maximum number of active breakpoints for your particular CPU when you select these functions.

---

**4.10.5.3 Stopping the Test with Breakpoints**

To return to normal program execution:

- Deactivate the **Debug > Breakpoints Active** menu command to interrupt debugging or
- Select the menu command **Debug > Finish Debugging** to quit debugging.

**4.10.5.4 Activating, Deactivating and Deleting Breakpoints**

You can activate/deactivate and delete set breakpoints individually:

1. Select the menu command **Debug > Edit Breakpoints**.
2. In the dialog, you can
   - activate and deactivate selected breakpoints with a check mark.
   - delete individual breakpoints.

To delete all breakpoints, select the menu command **Debug > Delete All Breakpoints**.
4.10.5.5 Defining A Call Environment for Breakpoints

Call environment

By defining a call environment you specify that a breakpoint is only valid if one of the following conditions applies:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Selection possibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>The block which contains the breakpoint is called from a specific higher-level block.</td>
<td>Call path</td>
</tr>
<tr>
<td>The block which contains the breakpoint is called together with a specific higher-level block.</td>
<td>Global data block and/or Instance data block</td>
</tr>
</tbody>
</table>

**Proceed as follows to define a call path**

1. Select the **Debug > Edit Breakpoints** menu command.
   A list of the existing breakpoints is displayed in the subsequent dialog box.
2. Select a breakpoint from the list.
3. Activate the option "Activate call path".
   The possible call paths are now displayed graphically in the lower window section.
4. Select the desired call path.

**Proceed as follows to define a data block**

1. Select the **Debug > Edit Breakpoints** menu command.
   A list of the existing breakpoints is displayed in the subsequent dialog box.
2. Select a breakpoint from the list.
3. Activate the option "Open data blocks".
4. Enter the number of the desired data block.
4.10.5.6 Debugging in the Single Step Mode

Follow the steps outlined below:

1. Set a breakpoint before the statement line from which you want to debug your program in the single step mode.

2. Select the menu command **Debug > Breakpoints Active**.

3. Run the program until it reaches this breakpoint.

4. To execute the next statement, select the menu command **Debug > Next Statement**.
   - If the statement is a block call, the call is executed and the program jumps to the first statement after the block call.
   - With the **Debug > Execute Call** menu command, you jump to the block. Here, you can then continue debugging in the single step mode or you can set breakpoints. At the end of the block, you return to the statement after the block call.
4.10.6 Using the STEP 7 Test/Debug Functions

4.10.6.1 Creating and Displaying Reference Data

You can create and evaluate reference data to help you when debugging and modifying your user program.

You can display the following reference data:

- The user program structure
- The cross reference list
- The assignment list
- The list of unused addresses
- The list of addresses without symbols

Creating reference data

You can create reference data in the following ways:

- Using the menu command Options > Reference Data > Display, you can create or update and display the data as required.
- By filtering, you can restrict the amount of reference data displayed and speed up the creation and display of the data considerably. Select the Options > Reference Data > Filter menu command.
- Using menu command Options > Customize, you can decide whether or not the reference data are created automatically when the source file is compiled. If you want the reference data compiled automatically, enter a check mark beside "Create Reference Data" in the "Create Block" tab. Remember that creating reference data automatically will increase the time taken to compile your program.
4.10.6.2 Monitoring and Modifying Variables

When you test your program with the "monitoring and modifying variables" function, you can do the following:

- Display the current values of global data contained in your user program (monitor)
- Assign fixed values to the variables used in your user program (modify)

Follow the steps outlined below:

- Select the menu command **PLC > Monitor/Modify Variables**.
- Create the variable table (VAT) in the displayed window. If you want to modify variables, enter the new values for the variables.
- Specify the trigger points and conditions.

⚠️ **Caution**

Running a test while your plant is in operation can lead to serious injury to personnel or damage to equipment if the program contains errors! Before running the debugging functions, make sure that no dangerous situations can occur!

4.10.6.3 Checking the Block Consistency

**Note**

This function is available as from STEP 7 Version 5.3 SP2.

If an S7-SCL source file is modified, any blocks that may be referenced in it also have to be adapted. Otherwise inconsistencies can occur in the program. Inconsistencies can also arise if the time stamps of source files and blocks do not agree.

The STEP 7 function "Check block consistency" allows such inconsistencies to be uncovered and errors to be eliminated faster.

After program modifications you trigger a consistency check across all the S7-SCL source files in the project. In the case of inconsistencies that cannot be eliminated automatically, the function places you at the position to be changed in the source file, where you can carry out the required changes. All the inconsistencies are eliminated step-by-step.

**Prerequisites**

- STEP 7 V5.3 SP2 or higher is installed on your device.
- A source file that is to be checked in the "Check block consistency" function must have been compiled once with S7-SCL V5.3 SP1 or higher.
- S7-SCL must be installed on the device on which the consistency check is carried out.
Proceed as follows:

1. Open the SIMATIC Manager.
2. Select the "Blocks" folder.
3. Select the menu command Edit > Check Block Consistency.
4. Select the menu command View > Display S7-SCL Source File References.

Result

STEP 7 checks the time stamp and interfaces of all the blocks and corresponding source files in the current folder and reports the following conflicts:

- Time stamp conflicts between S7-SCL source files and blocks.
- References between different blocks and the resulting interface conflicts.

If an inconsistency is found, a new compilation of the corresponding source file is triggered. If the source file contains several block source s, all the blocks arising from this source file are re-compiled. The compilation options currently set apply during compilation.

Note

For further information about this function please refer to the STEP 7 help function.
4.11 Displaying and Modifying the CPU Properties

4.11.1 Displaying and Modifying the CPU Operating Mode

You can query and modify the current operating mode of a CPU. There must be a connection to the CPU.

Follow the steps outlined below:
1. Select the menu command **PLC > Operating Mode**.
2. In the dialog box that is then displayed, select one of the following modes:
   - Warm restart
   - Cold restart
   - Hot restart
   - STOP

⚠️ Warning

Modifying the operating mode while your plant is in operation can lead to serious injury to personnel or damage to equipment if the program contains errors!

Before running the debugging functions, make sure that no dangerous situations can occur!

4.11.2 Displaying and Setting the Date and Time on the CPU

You can query and modify the current time on a CPU. There must be a connection to the CPU.

Follow the steps outlined below:
1. Select the menu command **PLC > Set Date and Time**.
2. In the dialog box that appears, set the date and time for the real-time clock of the CPU.

If the CPU is not equipped with a real-time clock, the dialog box for the time displays "00:00:00" and the date box has the value "00.00.00". This means that you cannot make any changes.
4.11.3 Reading Out CPU Data

You can display the following information about a CPU:

- The system family, CPU type, order number, and version of the CPU.
- Size of the work memory and the load memory and the maximum possible configuration of the load memory.
- Number and address area of inputs and outputs, timers, counters, and memory bits.
- Number of local data with which this CPU can work.
- Whether or not a CPU is capable of multiprocessing (CPU-dependent).

There must be a connection to the CPU.

Follow the steps outlined below:
1. Select the menu command PLC > Module Information.
2. Select the "General" tab in the dialog box.

4.11.4 Reading Out the Diagnostic Buffer of the CPU

If you read out the diagnostic buffer, you can find out the cause of the STOP mode or back track the occurrence of diagnostic events.

There must be a connection to the CPU.

Follow the steps outlined below:
1. Select the menu command PLC > Module Information.
2. Select the "Diagnostic Buffer" tab in the next dialog box.

4.11.5 Displaying/Compressing the User Memory of the CPU

Using this function, you can display information about the memory load of the CPU and, if necessary, reorganize the CPU memory. This is necessary when the largest free continuous memory area is no longer large enough to take a new object downloaded onto the CPU from the PG.

There must be a connection to the CPU.

Follow the steps outlined below:
1. Select the menu command PLC > Module Information.
2. Select the "Memory" tab in the next dialog box.
4.11.6 Displaying the Cycle Time of the CPU

The following times are represented within the two selectable limit values:

- Duration of the longest cycle since the last change from STOP to RUN.
- Duration of the shortest cycle since the last change from STOP to RUN.
- Duration of the last cycle.

If the duration of the last cycle comes close to the watchdog time, it is possible that the watchdog time will be exceeded, and that the CPU will change to the STOP mode. The cycle time can be extended, for example, if you test blocks in the program status. To display the cycle times of your program, there must be a connection to the CPU.

Follow the steps outlined below:

1. Select the menu command PLC > Module Information.
2. Select the "Cycle Time" tab in the next dialog box.

4.11.7 Displaying the Time System of the CPU

The time system of the CPU includes information about the internal clock and the time synchronization between multiple CPUs.

There must be a connection to the CPU.

Follow the steps outlined below:

1. Select the menu command PLC > Module Information.
2. Select the "Time System" tab in the next dialog box.

4.11.8 Displaying the Blocks on the CPU

You can display the blocks available online for the CPU.

There must be a connection to the CPU.

Follow the steps outlined below:

1. Select the menu command PLC > Module Information.
2. In the next dialog box, select the "Performance Data/Blocks" tab.
4.11.9 Displaying Information about Communication with the CPU

For each CPU, you can display information online about the selected and maximum transmission rates, connections and the communications load.

There must be a connection to the CPU.

Follow the steps outlined below:
1. Select the menu command PLC > Module Information.
2. Select the "Communication" tab in the next dialog box.

4.11.10 Displaying the Stacks of the CPU

By selecting this tab, you can display information online about the content of the stacks of each CPU. The CPU must be in the STOP mode or must have reached a breakpoint.

Displaying the stacks is extremely useful to help you locate errors, for example when testing your blocks. If the CPU changes to STOP, you can display the interrupt point with the current status bits and accumulator contents in the interrupt stack (I stack) to find out the cause (for example of a programming error).

There must be a connection to the CPU.

Follow the steps outlined below:
1. Select the menu command PLC > Module Information.
2. Select the "Stacks" tab in the next dialog box.
5 S7-SCL Basic Terms

5.1 Interpreting the Syntax Diagrams

The basic tool for the description of the language in the various sections is the syntax diagram. It provides a clear insight into the structure of S7-SCL syntax. The section entitled "Language Description" contains a collection of all the diagrams with the language elements.

What is a Syntax Diagram?

The syntax diagram is a graphical representation of the structure of the language. That structure is defined by a series of rules. One rule may be based on others at a more fundamental level.

- **Sequence**: a sequence of boxes
- **Option**: a skippable branch
- **Iteration**: repetition of branches
- **Alternative**: multiple alternative branches

The syntax diagram is read from right to left. The following rule structures must be adhered to:
What Types of Boxes Are There?

A box is a basic element or an element made up of other objects. The diagram below shows the symbols that represent the various types of boxes.

- Basic element that requires no further explanation.
- Complex element that is described by other syntax diagrams.

What Does Flexible Format Mean?

When writing source code, the programmer must observe not only the syntax rules but also lexical rules.

The lexical and syntax rules are described in detail in the section entitled "Language Description". Flexible format means that you can insert formatting characters such as spaces, tabs and page breaks as well as comments between the rule sections.

With lexical rules, there is no flexibility of format! When you apply a lexical rule, you must adopt the specifications exactly as set out.

Lexical Rule

The following examples keep to the above rule:

- _R_CONTROLLER3
- _A_FIELD
- _100_3_3_10

The following examples are invalid for the reasons listed above:

- _1__AB
- RR__20
- *#AB
Syntax Rule

With syntax rules, the format is flexible.

The following examples keep to the above rule:

VARIABLE_1 := 100; SWITCH := FALSE;
VARIABLE_2 := 3.2;


5.2  Character Set

Letters and Numeric Characters
S7-SCL uses the following characters as a subset of the ASCII character set:

- The (upper- and lowercase) letters A to Z.
- The Arabic numbers 0 to 9.
- Blanks - the blank itself (ASCII value 32) and all control characters (ASCII 0-31) including the end of line character (ASCII 13).

Other Characters
The following characters have a specific meaning in S7-SCL:

<table>
<thead>
<tr>
<th>+</th>
<th>-</th>
<th>*</th>
<th>/</th>
<th>=</th>
<th>&lt;</th>
<th>&gt;</th>
<th>[</th>
<th>]</th>
<th>(</th>
<th>)</th>
</tr>
</thead>
<tbody>
<tr>
<td>:</td>
<td>:</td>
<td>$</td>
<td>#</td>
<td>&quot;</td>
<td>'</td>
<td>{</td>
<td>}</td>
<td>%</td>
<td>.</td>
<td>,</td>
</tr>
</tbody>
</table>

Note
In the section entitled "Language Description", you will find a detailed list of all the permitted characters and information on how the characters are interpreted in S7-SCL.
### 5.3 Reserved Words

Reserved words are keywords that you can only use for a specific purpose. No distinction is made between uppercase and lowercase.

#### Keywords in S7-SCL

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Start Block</th>
<th>Function Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>END_CASE</td>
<td>ORGANIZATION_BLOCK</td>
</tr>
<tr>
<td>ANY</td>
<td>END_CONST</td>
<td>POINTER</td>
</tr>
<tr>
<td>ARRAY</td>
<td>END_DATA_BLOCK</td>
<td>PROGRAM</td>
</tr>
<tr>
<td>AT</td>
<td>END_FOR</td>
<td>REAL</td>
</tr>
<tr>
<td>BEGIN</td>
<td>END_FUNCTION</td>
<td>REPEAT</td>
</tr>
<tr>
<td>BLOCK_DB</td>
<td>END_FUNCTION_BLOCK</td>
<td>RETURN</td>
</tr>
<tr>
<td>BLOCK_FB</td>
<td>END_IF</td>
<td>SSTIME</td>
</tr>
<tr>
<td>BLOCK_FC</td>
<td>END_LABEL</td>
<td>STRING</td>
</tr>
<tr>
<td>BLOCK_SDB</td>
<td>END_TYPE</td>
<td>STRUCT</td>
</tr>
<tr>
<td>BLOCK_SFB</td>
<td>END_ORGANIZATION_BLOCK</td>
<td>THEN</td>
</tr>
<tr>
<td>BLOCK_SFC</td>
<td>END_REPEAT</td>
<td>TIME</td>
</tr>
<tr>
<td>BOOL</td>
<td>END_STRUCT</td>
<td>TIMER</td>
</tr>
<tr>
<td>BY</td>
<td>END_VAR</td>
<td>TIME_OF_DAY</td>
</tr>
<tr>
<td>BYTE</td>
<td>END_WHILE</td>
<td>TO</td>
</tr>
<tr>
<td>CASE</td>
<td>ENO</td>
<td>TOD</td>
</tr>
<tr>
<td>CHAR</td>
<td>EXIT</td>
<td>TRUE</td>
</tr>
<tr>
<td>CONST</td>
<td>FALSE</td>
<td>TYPE</td>
</tr>
<tr>
<td>CONTINUE</td>
<td>FOR</td>
<td>VAR</td>
</tr>
<tr>
<td>COUNTER</td>
<td>FUNCTION</td>
<td>VAR_TEMP</td>
</tr>
<tr>
<td>DATA_BLOCK</td>
<td>FUNCTION_BLOCK</td>
<td>UNTIL</td>
</tr>
<tr>
<td>DATE</td>
<td>GOTO</td>
<td>VAR_INPUT</td>
</tr>
<tr>
<td>DATE_AND_TIME</td>
<td>IF</td>
<td>VAR_IN_OUT</td>
</tr>
<tr>
<td>DINT</td>
<td>INT</td>
<td>VAR_OUTPUT</td>
</tr>
<tr>
<td>DIV</td>
<td>LABEL</td>
<td>VOID</td>
</tr>
<tr>
<td>DO</td>
<td>MOD</td>
<td>WHILE</td>
</tr>
<tr>
<td>DT</td>
<td>NIL</td>
<td>WORD</td>
</tr>
<tr>
<td>DWORD</td>
<td>NOT</td>
<td>XOR</td>
</tr>
<tr>
<td>ELSE</td>
<td>OF</td>
<td>Names of the standard functions</td>
</tr>
<tr>
<td>ELSIF</td>
<td>OK</td>
<td></td>
</tr>
<tr>
<td>EN</td>
<td>OR</td>
<td></td>
</tr>
</tbody>
</table>
5.4 Identifiers

Definition
An identifier is a name that you assign to an S7-SCL language object; in other words, to a constant, a variable or a block.

Rules
Identifiers can be made up of a maximum of 24 letters or numbers in any order but the first character must be either a letter or the underscore character. Both uppercase and lowercase letters are permitted. However, the identifiers are not case-sensitive (AnNa and AnnA, for example, are identical).

Examples
The following names are examples of valid identifiers.

<table>
<thead>
<tr>
<th>X</th>
<th>y12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sum</td>
<td>Temperature</td>
</tr>
<tr>
<td>Name</td>
<td>Surface</td>
</tr>
<tr>
<td>Controller</td>
<td>Table</td>
</tr>
</tbody>
</table>

The following names are not valid identifiers for the reasons specified.

<table>
<thead>
<tr>
<th>4th</th>
<th>//The first character must be a letter or an underscore character</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array</td>
<td>//ARRAY is a keyword</td>
</tr>
<tr>
<td>S Value</td>
<td>//Blanks are not allowed (remember //that a blank is also a character).</td>
</tr>
</tbody>
</table>

Notes
- Make sure that the name is not already being used by keywords or standard identifiers.
- It is advisable to select unique names with a clear meaning to make the source text easier to understand.
5.5 Standard Identifiers

In S7-SCL, a number of identifiers are predefined and are therefore called standard identifiers. These standard identifiers are as follows:

- The block identifiers,
- The address identifiers for addressing memory areas of the CPU,
- The timer identifiers and
- The counter identifiers.

5.6 Block Identifiers

Definition

These standard identifiers are used for absolute addressing of blocks.

Rules

The table is sorted in the order of the German mnemonics and the corresponding international mnemonics are shown in the second column. The letter x is a placeholder for a number between 0 and 65533 or 0 and 65535 for timers and counters.

<table>
<thead>
<tr>
<th>Mnemonic (SIMATIC)</th>
<th>Mnemonic (IEC)</th>
<th>Identifies</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBx</td>
<td>DBx</td>
<td>Data block. The block identifier DB0 is reserved for S7-SCL.</td>
</tr>
<tr>
<td>FBx</td>
<td>FBx</td>
<td>Function block</td>
</tr>
<tr>
<td>FCx</td>
<td>FCx</td>
<td>Function</td>
</tr>
<tr>
<td>OBx</td>
<td>OBx</td>
<td>Organization block</td>
</tr>
<tr>
<td>SDBx</td>
<td>SDBx</td>
<td>System data block</td>
</tr>
<tr>
<td>SFCx</td>
<td>SFCx</td>
<td>System function</td>
</tr>
<tr>
<td>SFBx</td>
<td>SFBx</td>
<td>System function block</td>
</tr>
<tr>
<td>Tx</td>
<td>Tx</td>
<td>Timer</td>
</tr>
<tr>
<td>UDTx</td>
<td>UDTx</td>
<td>User-defined data type</td>
</tr>
<tr>
<td>Zx</td>
<td>Cx</td>
<td>Counter</td>
</tr>
</tbody>
</table>
In S7-SCL, there are several ways in which you can specify the block identifier. You can specify a whole decimal number as the number of the block.

Example

The following are examples of valid identifiers:

FB10
DB100
T141
5.7 Address Identifiers

Definition

At any point in your program, you can address memory areas of a CPU using their address identifiers.

Rules

The table is sorted in the order of the German mnemonics and the corresponding international mnemonics are shown in the second column. The address identifiers for data blocks are only valid when the data block is also specified.

<table>
<thead>
<tr>
<th>Mnemonic</th>
<th>Mnemonic (internat.)</th>
<th>addresses</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>AX.y</td>
<td>Qx.y</td>
<td>Output (via the process image)</td>
<td>Bit</td>
</tr>
<tr>
<td>ABx</td>
<td>QBx</td>
<td>Output (via process image)</td>
<td>Byte</td>
</tr>
<tr>
<td>ADx</td>
<td>QDx</td>
<td>Output (via process image)</td>
<td>Double word</td>
</tr>
<tr>
<td>AWx</td>
<td>QWx</td>
<td>Output (via process image)</td>
<td>Word</td>
</tr>
<tr>
<td>AXx.y</td>
<td>QXX.y</td>
<td>Output (via process image)</td>
<td>Bit</td>
</tr>
<tr>
<td>Dx.y</td>
<td>DX.y</td>
<td>Data block</td>
<td>Bit</td>
</tr>
<tr>
<td>DBx</td>
<td>DBx</td>
<td>Data block</td>
<td>Byte</td>
</tr>
<tr>
<td>DDx</td>
<td>DDx</td>
<td>Data block</td>
<td>Double word</td>
</tr>
<tr>
<td>DWx</td>
<td>DWx</td>
<td>Data block</td>
<td>Word</td>
</tr>
<tr>
<td>DXx.y</td>
<td>DXx.y</td>
<td>Data block</td>
<td>Bit</td>
</tr>
<tr>
<td>Ex.y</td>
<td>IX.y</td>
<td>Input (via the process image)</td>
<td>Bit</td>
</tr>
<tr>
<td>EBx</td>
<td>IBx</td>
<td>Input (via process image)</td>
<td>Byte</td>
</tr>
<tr>
<td>EDx</td>
<td>IDx</td>
<td>Input (via process image)</td>
<td>Double word</td>
</tr>
<tr>
<td>EWx</td>
<td>IWx</td>
<td>Input (via process image)</td>
<td>Word</td>
</tr>
<tr>
<td>EXx.y</td>
<td>IXx.y</td>
<td>Input (via process image)</td>
<td>Bit</td>
</tr>
<tr>
<td>Mx.y</td>
<td>Mx.y</td>
<td>Memory bit</td>
<td>Bit</td>
</tr>
<tr>
<td>MBx.y</td>
<td>MBx.y</td>
<td>Bit memory</td>
<td>Byte</td>
</tr>
<tr>
<td>MDx</td>
<td>MDx</td>
<td>Bit memory</td>
<td>Double word</td>
</tr>
<tr>
<td>MWx</td>
<td>MWx</td>
<td>Bit memory</td>
<td>Word</td>
</tr>
<tr>
<td>MXx</td>
<td>MXx</td>
<td>Bit memory</td>
<td>Bit</td>
</tr>
<tr>
<td>PABx</td>
<td>PQBx</td>
<td>Output (Direct to peripherals)</td>
<td>Byte</td>
</tr>
<tr>
<td>PADx</td>
<td>PQDx</td>
<td>Output (Direct to peripherals)</td>
<td>Double word</td>
</tr>
<tr>
<td>PAWx</td>
<td>PQWx</td>
<td>Output (Direct to peripherals)</td>
<td>Word</td>
</tr>
<tr>
<td>PEBx</td>
<td>PIbx</td>
<td>Input (Direct from peripherals)</td>
<td>Byte</td>
</tr>
<tr>
<td>PEDx</td>
<td>PIDx</td>
<td>Input (Direct from peripherals)</td>
<td>Double word</td>
</tr>
<tr>
<td>PEWx</td>
<td>PIWx</td>
<td>Input (Direct from peripherals)</td>
<td>Word</td>
</tr>
</tbody>
</table>

\[ x = \text{number between 0 and 65535 (absolute address)} \]
\[ y = \text{number between 0 and 7 (bit number)} \]

Example

I1.0       MW10   PQW5   DB20.DW3
5.8 Timer Identifiers

Rules

In S7-SCL, there are several ways in which you can specify a timer. You can specify a whole decimal number as the number of the timer.

5.9 Counter Identifiers

Rules

There are several ways of specifying a counter in S7-SCL. You can specify a whole decimal number as the number of the counter.
5.10 Numbers

In S7-SCL, there are various ways of writing numbers. The following rules apply to all numbers:

- A number can have an optional sign, a decimal point, and an exponent.
- A number must not contain commas or spaces.
- To improve legibility, the underscore ( _ ) can be used as a separator.
- The number can be preceded if required by a plus ( + ) or minus ( - ). If the number is not preceded by a sign, it is assumed to be positive.
- Numbers must not exceed or fall below certain maximum and minimum values.

Integers

An integer contains neither a decimal point nor an exponent. This means that an integer is simply a sequence of digits that can be preceded by a plus or minus sign. Two integer types are implemented in S7-SCL, INT and DINT, each of which has a different range of possible values.

Examples of valid integers:

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>+1</td>
<td>-1</td>
</tr>
<tr>
<td>743</td>
<td>-5280</td>
<td>600_00</td>
<td>-32_211</td>
</tr>
</tbody>
</table>

The following integers are incorrect for the reasons stated in each case:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>123,456</td>
<td>Integers must not contain commas.</td>
</tr>
<tr>
<td>36.</td>
<td>Integers must not contain a decimal point.</td>
</tr>
<tr>
<td>10 20 30</td>
<td>Integers must not contain spaces.</td>
</tr>
</tbody>
</table>

In S7-SCL, you can represent integers in different numeric systems by preceding the integer with a keyword for the numeric system. The keyword 2# stands for the binary system, 8# for the octal system and 16# for the hexadecimal system.

Valid integers for decimal 15:

2#1111 8#17 16#F
**Real Numbers**

A real number must either contain a decimal point or an exponent (or both). A decimal point must be between two digits. This means that a real number cannot start or end with a decimal point.

Examples of valid real numbers:

<table>
<thead>
<tr>
<th>0.0</th>
<th>1.0</th>
<th>-0.2</th>
<th>827.602</th>
</tr>
</thead>
<tbody>
<tr>
<td>50000.0</td>
<td>-0.000743</td>
<td>12.3</td>
<td>-315.0066</td>
</tr>
</tbody>
</table>

The following real numbers are **incorrect**:

1. There must be a digit on both sides of the decimal point.

<table>
<thead>
<tr>
<th>1,000.0</th>
</tr>
</thead>
</table>

2. Integers must not contain commas.

<table>
<thead>
<tr>
<th>.3333</th>
</tr>
</thead>
</table>

3. There must be a digit on both sides of the decimal point.

A real number can include an exponent to specify the position of the decimal point. If the number contains no decimal point, it is assumed that it is to the right of the digit. The exponent itself must be either a positive or a negative integer. Base 10 is represented by the letter E.

The value 3 x 10 exponent 10 can be represented in S7-SCL by the following real numbers:

<table>
<thead>
<tr>
<th>3.0E+10</th>
<th>3.0E10</th>
<th>3e+10</th>
<th>3E10</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.3E+11</td>
<td>0.3e11</td>
<td>30.0E+9</td>
<td>30e9</td>
</tr>
</tbody>
</table>

The following real numbers are **incorrect**:

<table>
<thead>
<tr>
<th>3.8+10</th>
<th>There must be a digit on both sides of the decimal point.</th>
</tr>
</thead>
<tbody>
<tr>
<td>8e2.3</td>
<td>The exponent must be an integer.</td>
</tr>
<tr>
<td>.333e-3</td>
<td>There must be a digit on both sides of the decimal point.</td>
</tr>
<tr>
<td>30 E10</td>
<td>Integers must not contain spaces.</td>
</tr>
</tbody>
</table>
5.11 Character Strings

Definition

A character string is a sequence of characters (in other words letters, numbers, and special characters) set in quotes.

Examples of valid character strings:

'RED'    '76181 Karlsruhe'    '270-32-3456'
'DM19.95' 'The correct answer is:'

Rules

You can enter special formatting characters, the quote (') or a $ character with the escape symbol $.

<table>
<thead>
<tr>
<th>Source Text</th>
<th>After Compilation</th>
</tr>
</thead>
<tbody>
<tr>
<td>'SIGNAL$'RED$'</td>
<td>SIGNAL'RED'</td>
</tr>
<tr>
<td>'50.0$'</td>
<td>50.0$</td>
</tr>
<tr>
<td>'VALUE$P'</td>
<td>VALUE page break</td>
</tr>
<tr>
<td>'RUL$L'</td>
<td>RUL line feed</td>
</tr>
<tr>
<td>'CONTROLLER$R'</td>
<td>CONTROLLER carriage return</td>
</tr>
<tr>
<td>'STEP$T'</td>
<td>STEP tabulator</td>
</tr>
</tbody>
</table>

To enter nonprintable characters, type in the substitute representation in hexadecimal code in the form $\text{hh}$, where $\text{hh}$ stands for the value of the ASCII character expressed in hexadecimal.

To enter comments in a character string that are not intended to be printed out or displayed, you use the characters $>$ and $<$ to enclose the comments.
5.12 Symbol

You can enter symbols in S7-SCL using the following syntax. The quotes are only necessary when the symbol does not adhere to the IDENTIFIER rule.

Syntax:
5.13 Comment Section

Rules

- The comment section can extend over a number of lines and is preceded by `(*)` and terminated by `*)`.
- The default setting permits the nesting of comment sections. You can, however, change this setting and prevent the nesting of comment sections.
- Comments must not be placed in the middle of a symbolic name or a constant. They may, however, be placed in the middle of a string.

Syntax

The comment section is represented formally by the following syntax diagram:

```
(* Character *)
```

Example

(* This is an example of a comment section, that can extend over several lines.*)

```
SWITCH := 3 ;
END_FUNCTION_BLOCK
```
5.14 Line Comment

Rules

- The line comment is introduced by "//" and extends to the end of the line.
- The length of a comment is limited to a maximum of 254 characters including the introductory characters '//'.
- Comments must not be placed in the middle of a symbolic name or a constant. They may, however, be placed in the middle of a string.

Syntax

The line comment is represented formally by the following syntax diagram:

```
VAR
    SWITCH : INT ; // line comment
END_VAR
```

Notes

- Comments within the declaration section that begin with // are included in the interface of the block and can therefore also be displayed in the LAD/STL/CSF editor.
- The printable characters are listed in the section entitled "Language Description".
- Within the line comment, the pair of characters "(" and ")" have no significance.
5.15 Variables

An identifier whose value can change during the execution of a program is called a variable. Each variable must be individually declared before it can be used in a logic block or data block. The declaration of a variable specifies that an identifier is a variable (rather than a constant, etc.) and defines the variable type by assigning it to a data type.

The following types of variable are distinguished on the basis of their scope:

- Local data
- Shared user data
- Permitted predefined variables (CPU memory areas)

Local Data

Local data are declared in a logic block (FC, FB, OB) and have only that logic block as their scope. Specifically these are the following:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static Variables</td>
<td>Static variables are local variables whose value is retained both during and after execution of the block (block memory). They are used for storing values for a function block.</td>
</tr>
<tr>
<td>Temporary Variables</td>
<td>Temporary variables belong to a logic block locally and do not occupy any static memory area. Their values are only retained while the block concerned is running. Temporary variables cannot be accessed from outside the block in which they are declared.</td>
</tr>
<tr>
<td>Block Parameters</td>
<td>Block parameters are formal parameters of a function block or a function. They are local variables that are used to pass the actual parameters specified when a block is called.</td>
</tr>
</tbody>
</table>

Shared User Data

These are data or data areas that can be accessed from any point in a program. To use shared user-defined variables, you must create data blocks (DBs).

When you create a DB, you define its structure in a structure declaration. Instead of a structure declaration, you can use a user-defined data type (UDT). The order in which you specify the structural components determines the sequence of the data in the DB.

Memory Areas of a CPU

You can access memory areas of a CPU directly using the address identifiers from any point in the program without having to declare these variables.

Remember also that you can always address these memory areas symbolically. The assignment of symbols in this situation is made globally using the symbol table in STEP 7.
6 S7-SCL Program Structure

6.1 Blocks in S7-SCL Source Files

You can program any number of blocks in an S7-SCL source file. STEP 7 blocks are subunits of a user program distinguished according to their function, their structure or their intended use.

Block Types

The following blocks are available:

STEP 7 Blocks

- OB
- FC
- FB
- DB
- UDT

Ready-made Blocks

You do not have to program every function yourself. You can also make use of various ready-made blocks. These are available in the CPU operating system or libraries (S7lib) in the STEP 7 Standard Package and can be used, for example, to program communication functions.
6.2 Order of the Blocks

The following general rule applies:

**Called blocks are located before the calling blocks.**

Specifically, this means the following:

- User-defined data types (UDTs) must precede the blocks in which they are used.
- Data blocks with an assigned user-defined data type (UDT) must follow the UDT.
- Data blocks that can be accessed by all logic blocks must precede all blocks that access them.
- Data blocks with an assigned function block come after the function block.
- The organization block OB1, which calls other blocks, comes at the very end. Blocks that are called by blocks called in OB1 must precede the calling blocks.
- Blocks that you call in a source file, but that you do not program in the same source file must exist already when the file is compiled into the user program.
- In addition to the blocks S7-SCL source files can also contain information about the compiler settings with which the individual blocks are to be compiled. The compiler options are positioned outside the block limits.

![Diagram showing the order of blocks in a S7-SCL program structure](image_url)
6.3 General Structure of a Block

A block consists of the following areas:

- Block start identified by a keyword and a block number or a symbolic block name, for example, "ORGANIZATION_BLOCK OB1" for an organization block. With functions, the function type is also specified. This decides the data type of the return value. If you want no value returned, specify the keyword VOID.

- Optional block title preceded by the keyword "TITLE =".

- Optional block comment. The block comment can extend over several lines, each line beginning with "//".

- Entry of the block attributes (optional)

- Entry of the system attributes for blocks (optional)

- Declaration section (depending on the block type)

- Statement section in logic blocks or assignment of actual values in data blocks (optional)

- In logic blocks: Statements

- Block end indicated by END_ORGANIZATION_BLOCK, END_FUNCTION_BLOCK or END_FUNCTION

6.4 Block Start and End

Depending on the type of block, the source text for a single block is introduced by a standard identifier for the start of the block and the block name. It is closed with a standard identifier for the end of the block.

The syntax for the various types of blocks can be seen in the following table:

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Block Type</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function block</td>
<td>FB</td>
<td>FUNCTION_BLOCK fb_name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>. . . END_FUNCTION_BLOCK</td>
</tr>
<tr>
<td>Function</td>
<td>FC</td>
<td>FUNCTION fc_name : function type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>. . . END_FUNCTION</td>
</tr>
<tr>
<td>Organization block</td>
<td>OB</td>
<td>ORGANIZATION_BLOCK ob_name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>. . . END_ORGANIZATION_BLOCK</td>
</tr>
<tr>
<td>Data block</td>
<td>DB</td>
<td>DATA_BLOCK db_name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>. . . END_DATA_BLOCK</td>
</tr>
<tr>
<td>Shared data type</td>
<td>UDT</td>
<td>TYPE udt_name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>. . . END_TYPE</td>
</tr>
</tbody>
</table>
Block name

In the table, *xx_name* stands for the block name according to the following syntax:

- **Block Keyword**: DB, FB, FC, OB, UDT
- **IDENTIFIER**
- **Symbol**
- **Number**

The block number can be a value from 0 to 65533, the data block identifier DB0 is, however, reserved.

Please note also that you must define an identifier or a symbol in the STEP 7 symbol table.

Example

```plaintext
FUNCTION_BLOCK FB10
FUNCTION_BLOCK Controller Block
FUNCTION_BLOCK "Controller.Bl&U2"
```
6.5 Attributes for Blocks

Definition

A block attribute is a block property that you can use, for example, to specify the block type, the version, the block protection or the author. You can display the properties in a STEP 7 properties page when you select blocks for your application.

You can assign the following attributes:

<table>
<thead>
<tr>
<th>Keyword/Attribute</th>
<th>Explanation</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>TITLE='printable characters'</td>
<td>Title of the block</td>
<td>TITLE='SORT'</td>
</tr>
<tr>
<td>VERSION :'decimal digit string. decimal digit string'</td>
<td>Version number of the block (0 to 15) Note: With data blocks (DBs), the VERSION attribute is not specified in quotes.</td>
<td>VERSION : '3.1'</td>
</tr>
<tr>
<td></td>
<td></td>
<td>//With a DB:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VERSION : 3.1</td>
</tr>
<tr>
<td>KNOW_HOW_PROTECT</td>
<td>Block protection; a block compiled with this option cannot be opened with STEP 7.</td>
<td>KNOW_HOW_PROTECT</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AUTHOR :</td>
<td>Name of the author: company name, department name or other name (IDENTIFIER and 'printable characters')</td>
<td>AUTHOR : Siemens</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AUTHOR : 'A&amp;D AS'</td>
</tr>
<tr>
<td>NAME :</td>
<td>Block name (IDENTIFIER and 'printable characters')</td>
<td>NAME : PID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NAME : 'A&amp;D AS'</td>
</tr>
<tr>
<td>FAMILY :</td>
<td>Name of the block family: for example motors. This saves the block in a group of blocks so that it can be found again more quickly (IDENTIFIER and 'printable characters').</td>
<td>FAMILY : example</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FAMILY : 'A&amp;D AS'</td>
</tr>
</tbody>
</table>
**Rules**

- You declare the block attributes using keywords directly after the statement for the block start.
- The identifier can be up to a maximum of 8 characters long.

The syntax for entering block attributes is shown below:

**Title**

- **TITLE** = **Printable character**

**Version**

- **Version** = **DECIMAL DIGIT STRING** = **DECIMAL DIGIT STRING**

**Block Protection**

- **KNOW_HOW_PROTECT**

**Author**

- **AUTHOR** = **IDENTIFIER** = **Printable character**

**Name**

- **NAME** = **IDENTIFIER** = **Printable character**

**Block Family**

- **FAMILY** = **IDENTIFIER** = **Printable character**
Examples

FUNCTION_BLOCK FB10
TITLE = 'Mean_Value'
VERSION : '2.1'
KNOW_HOW_PROTECT
AUTHOR : AUT_1
6.6  **Block Comment**

You can enter comments for the entire block in the block header after the "TITLE:" line. Here, you use the line comment notation. The comment can extend over several lines, each line beginning with "/\".

The block comment is displayed, for example, in the Properties window of the block in the SIMATIC Manager or in the LAD/STL/FBD editor.

**Example**

FUNCTION_BLOCK FB15

TITLE=MY_BLOCK

//This is a block comment.

//It is entered as a series of line comments

//and can be displayed, for example, in the SIMATIC Manager.

AUTHOR...

FAMILY...
6.7 System Attributes for Blocks

Definition

System attributes are control system attributes valid beyond the scope of a single application. System attributes for blocks apply to the entire block.

Rules

- You specify system attributes immediately after the block start statement.
- The syntax for the entries is shown below:

System attributes for blocks

\[
\text{max. 24 characters} \quad \rightarrow \quad \text{IDENTIFIER} \quad \rightarrow \quad \text{Printable character} \quad \rightarrow \quad \text{max. 24 characters}
\]

Examples

FUNCTION_BLOCK FB10
{S7_m_c := 'true' ;
S7_blockview := 'big'}
6.8 Declaration Section

Definition

The declaration section is used for declarations of local variables, parameters, constants, and labels.

- The local variables, parameters, constants, and labels that must only be valid within a block are defined in the declaration section of the logic block.
- You define the data areas you want to be accessible to any logic block in the declaration section of data blocks.
- In the declaration section of a UDT, you specify the user-defined data type.

Structure

A declaration section is divided into different declaration subsections indicated by their own pair of keywords. Each subsection contains a declaration list for data of the same type. These subsections can be positioned in any order. The following table shows the possible declaration subsections:

<table>
<thead>
<tr>
<th>Data</th>
<th>Syntax</th>
<th>FB</th>
<th>FC</th>
<th>OB</th>
<th>DB</th>
<th>UDT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constants</td>
<td>CONST declaration list</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>END_CONST</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Labels</td>
<td>LABEL declaration list</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>END_LABEL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temporary Variables</td>
<td>VAR_TEMP declaration list</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>END_VAR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Static variables</td>
<td>VAR declaration list</td>
<td>X</td>
<td>X *)</td>
<td>X **)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>END_VAR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>**)</td>
</tr>
<tr>
<td>Input parameters</td>
<td>VAR_INPUT declaration list</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>END_VAR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output parameters</td>
<td>VAR_OUTPUT declaration list</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>END_VAR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>In/out parameters</td>
<td>VAR_IN_OUT declaration list</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>END_VAR</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*) Although the declaration of variables between the keyword pair VAR and END_VAR is permitted in functions, the declarations are shifted to the temporary area when the source file is compiled.

**) In DBs and UDTs, the keywords VAR and END_VAR are replaced by STRUCT and END_STRUCT respectively.
6.9 System Attributes for Parameters

Definition

System attributes are control system attributes valid beyond the scope of a single application. They are used, for example, for configuring messages or connections. System attributes for parameters apply only to the specific parameters that have been configured. You can assign system attributes to input, output and in/out parameters.

Rules

- You assign system attributes for parameters in the declaration fields input parameters, output parameters, or in/out parameters.
- An identifier can have up to a maximum of 24 characters.
- The syntax for the entries is shown below:

Example

```plaintext
VAR_INPUT
  in1 {S7_server:='alarm_archiv';
    S7_a_type:='ar_send'}: DWORD ;
END_VAR
```

You can display help on system attributes in the S7-SCL online documentation by selecting "Displaying Reference Help".
6.10 Statement Section

Definition
The statement section contains statements that will be executed when a logic block is called. These statements are used for processing data or addresses. The statement section of a data block contains statements for initializing its variables.

Rules
- If you prefer, you can start the statement section with the BEGIN keyword. BEGIN is mandatory for data blocks. The statement section ends with the keyword for the end of the block.
- Each statement ends with a semicolon.
- Identifiers used in the statement section must already have been declared.
- If required, you can enter a label before each statement.

The syntax for the entries is shown below:

Statement Section

Example
BEGIN
  INITIAL_VALUE := 0;
  FINAL_VALUE := 200;
  .
  .
STORE: RESULT := SETPOINT;
  .
  .
END_FUNCTION_BLOCK
6.11 Statements

Definition

A statement is the smallest self-contained unit the user program. It represents an instruction to the processor to perform a specific operation.

The following types of statement can be used in S7-SCL:

- Value assignments used to assign the result of an expression or the value of another variable to a variable.
- Control statements used to repeat statements or groups of statements or to branch within a program.
- Subroutine calls used to call functions or function blocks.

Rules

The syntax for the entries is shown below:

- Value assignment
- Subroutine call
- Control statement

Example

The following examples illustrate the various types of statement:

// Example of a value assignment
MEASVAL := 0 ;

// Example of a subroutine call
FB1.DB11 (TRANSFER := 10) ;

// Example of a control statement
WHILE COUNTER < 10 DO..
  .
  .
END_WHILE;
6.12 Structure of a Function Block (FB)

Definition
A function block (FB) is a logic block that contains part of a program and that has a memory area assigned to it. Whenever an FB is called, an instance DB must be assigned to it. You specify the structure of this instance DB when you define the FB declaration section.

Syntax

```
PROGRAM
FUNCTION_BLOCK

BEGIN
Statement section
END_FUNCTION_BLOCK

FB IDENTIFIER

FB declaration section

END_PROGRAM
```

FB Identifier
After the FUNCTION_BLOCK or PROGRAM keyword, enter the keyword FB as the FB identifier followed by the block number or the symbolic name of the FB. The block number can be a value from 0 to 65533.

Examples:

```
FUNCTION_BLOCK FB10
FUNCTION_BLOCK MOTOR1
```

FB Declaration Section
The FB declaration section is used to define the block-specific data. The possible declaration sections are described in detail in the section entitled "Declaration Section". Remember that the declaration section also determines the structure of the assigned instance DB.
Example

The example below shows the source code for a function block. The input and output parameters (in this case, V1 and V2) are assigned initial values in this example.

```plaintext
FUNCTION_BLOCK FB11
VAR_INPUT
   V1 : INT := 7 ;
END_VAR
VAR_OUTPUT
   V2 : REAL ;
END_VAR
VAR
   FX1, FX2, FY1, FY2 : REAL ;
END_VAR
BEGIN
   IF V1 = 7 THEN
      FX1 := 1.5 ;
      FX2 := 2.3 ;
      FY1 := 3.1 ;
      FY2 := 5.4 ;
      //Call function FC11 and supply parameters
      //using the static variables.
      V2 := FC11 (X1:= FX1, X2 := FX2, Y1 := FY1,
      Y2 := FY2) ;
   END_IF ;
END_FUNCTION_BLOCK
```
6.13 Structure of a Function (FC)

Definition
A function (FC) is a logic block that is not assigned its own memory area. It does not require an instance DB. In contrast to an FB, a function can return a function result (return value) to the point from which it was called. A function can therefore be used like a variable in an expression. Functions of the type VOID do not have a return value.

Syntax

```
FUNCTION

FC IDENTIFIER : Data type specification

BEGIN

Statement section

END_FUNCTION
```

FC Identifier
After the "FUNCTION" keyword, enter the keyword FC as the FC identifier followed by the block number or the symbolic name of the FC. The block number can be a value from 0 to 65533.

Example
```
FUNCTION FC17 : REAL
FUNCTION FC17 : VOID
```

Data Type Specification
The data type specification determines the data type of the return value. All data types are permitted except for STRUCT and ARRAY. No data type needs to be specified if you do not require a return value (using VOID).

FC Declaration Section
The FC declaration section is used to declare the local data (temporary variables, input parameters, output parameters, in/out parameters, constants, labels).
FC Code Section

The function name must be assigned the function result in the code section. This assignment is unnecessary with functions of the type VOID. The following is an example of a valid statement within a function with the name FC31:

```plaintext
FC31 := VALUE;
```

Example

```plaintext
FUNCTION FC11 : REAL
VAR_INPUT
    x1 : REAL ;
    x2 : REAL ;
    x3 : REAL ;
    x4 : REAL ;
END_VAR
VAR_OUTPUT
    Q2 : REAL ;
END_VAR
BEGIN
    // Return value from function
    FC11 := SQRT( (x2 - x1)**2 + (x4 - x3)**2 ) ;
    Q2 := x1 ;
END_FUNCTION
```
6.14 Structure of an Organization Block (OB)

Definition

The organization block just like an FB or FC is part of the user program and is called cyclically or as a response to certain events by the operating system. It provides the interface between the user program and the operating system.

Syntax

Organization Block

```
BEGIN
ORGNIZATION_BLOCK OB IDENTIFIER
OB declaration section
```

```
BEGIN
Statement section
END_ORGANIZATION_BLOCK
```

OB Identifier

After the "ORGANIZATION_BLOCK" keyword, enter the keyword OB as the OB identifier followed by the block number or the symbolic name of the OB. The block number can be a value from 1 to 65533.

Examples

```
ORGANIZATION_BLOCK OB1
ORGANIZATION_BLOCK ALARM
```

OB Declaration Section

The OB declaration section is used to declare the local data (temporary variables, constants, labels).

To execute, each OB always requires 20 bytes of local data for the operating system. You must declare an array for this with an identifier. If you insert the block template for an OB, this declaration is already included.

Example

```
ORGANIZATION_BLOCK OB1
VAR_TEMP
    HEADER : ARRAY [1..20] OF BYTE ; //20 bytes for opsy
END_VAR
BEGIN
    FB17.DB10 (V1 := 7) ;
END_ORGANIZATION_BLOCK
```
6.15 Structure of a User-Defined Data Type

User-defined data types (UDTs) are special data structures that you create yourself. Since user-defined data types are assigned names they can be used many times over. Once they have been defined, they can be used at any point in the CPU program; in other words, they are shared data types. They can therefore be used:

- In blocks in the same way as elementary or complex data types, or
- As templates for creating data blocks with the same data structure.

When using user-defined data types, remember that they are located in the S7-SCL source file before the blocks in which they are used.

**User-Defined Data Type**

![Diagram of User-Defined Data Type]

**UDT Identifier**

After the `TYPE` keyword, enter the `UDT` keyword followed by a number or simply the symbolic name of the UDT. The block number can be a value from 0 to 65533.

**Examples:**

```
TYPE UDT10
TYPE SUPPLYBLOCK
```

**Specifying the Data Type**

The data type is always specified with a `STRUCT data type specification`. The data type UDT can be used in the declaration subsections of logic blocks or in data blocks or assigned to DBs.
Example of a UDT Definition

```plaintext
TYPE MEASVALUES
STRUC
  // UDT definition with symbolic identifier
  BIPOL_1 : INT := 5;
  BIPOL_2 : WORD := W#16#FFAA ;
  BIPOL_3 : BYTE  := B#16#F1 ;
  BIPOL_4 : WORD := B#(25,25) ;
  MEASURE : STRUCT
    BIPOLAR_10V : REAL ;
    UNIPOLAR_4_20MA : REAL ;
  END_STRUCT ;
END_STRUCT ;
END_TYPE

// Use of the UDT in an FB
FUNCTION_BLOCK FB10
  VAR
    MEAS_RANGE : MEASVALUES;
  END_VAR
  BEGIN
    // . . .
    MEAS_RANGE.BIPOL_1 := -4 ;
    MEAS_RANGE.MEASURE.UNIPOLAR_4_20MA := 2.7 ;
    // . . .
  END_FUNCTION_BLOCK
```
6.16 Compiler Options in S7-SCL Source Files

Definition

In addition to the blocks S7-SCL source files can also contain information about the compiler settings with which the individual blocks are to be compiled.

Compiler options control the compilation run for individual blocks or the entire source file, irrespective of the settings in the "Compiler (settings)" tab.

Compiler options can be used in S7-SCL source files or compiler control files.

Validity

The options apply only for the compilation of the source file for which they were defined. The validity of a compiler option begins with its designation and ends at the end of the source file or of the compiler control file. If several equivalent compiler options apply, the chronologically last one applies.

If compiler options were defined for a block, these have a higher priority than the settings in the "Compiler (settings)" tab. However, the settings in the tab remain globally valid.

Rules

The following rules apply for compiler options:

- The options are positioned outside the block limits in the source file.
- Each option is positioned in a separate line.
- The entries are not case-sensitive.
Available options

The table lists the available options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Scl_]ResetOptions</td>
<td>No value entry possible</td>
<td>Reset the default compiler settings (settings from dialog box)</td>
</tr>
<tr>
<td>[Scl_]OverwriteBlocks</td>
<td>'y[es]' or 'n[o]'</td>
<td>Overwrite the blocks</td>
</tr>
<tr>
<td>[Scl_]GenerateReferenceData</td>
<td>'y[es]' or 'n[o]'</td>
<td>Generate reference data</td>
</tr>
<tr>
<td>[Scl_]S7ServerActive</td>
<td>'y[es]' or 'n[o]'</td>
<td>Take the &quot;S7_server&quot; server attribute into consideration</td>
</tr>
<tr>
<td>[Scl_]CreateObjectCode</td>
<td>'y[es]' or 'n[o]'</td>
<td>Create the object code</td>
</tr>
<tr>
<td>[Scl_]OptimizeObjectCode</td>
<td>'y[es]' or 'n[o]'</td>
<td>Optimize the object code</td>
</tr>
<tr>
<td>[Scl_]MonitorArrayLimits</td>
<td>'y[es]' or 'n[o]'</td>
<td>Monitor the array limits</td>
</tr>
<tr>
<td>[Scl_]CreateDebugInfo</td>
<td>'y[es]' or 'n[o]'</td>
<td>Create the debug info</td>
</tr>
<tr>
<td>[Scl_]SetOKFlag</td>
<td>'y[es]' or 'n[o]'</td>
<td>Set the OK flag</td>
</tr>
<tr>
<td>[Scl_]SetMaximumStringLength</td>
<td>'1 .. 254'</td>
<td>Maximal string length</td>
</tr>
</tbody>
</table>

Example

```
{SCL_OverwriteBlocks := 'y' ; SCL_CreateDebugInfo := 'y'}
{SetOKFlag := 'y' ; OptimizeObjectCode := 'y'}
```
7 Data Types

7.1 Overview of the Data Types in S7-SCL

A data type is the combination of value ranges and operations in a single unit.

The data types decide:
- the type and interpretation of the data elements,
- the permitted ranges for the data elements,
- the permitted operations that can be executed on an address of a data type
- the notation of the constants of the data type.

Elementary Data Types

Elementary data types define the structure of data elements that cannot be subdivided into smaller units. They correspond to the definition in the DIN EN 1131-3 standard. An elementary data type describes a memory area with a fixed length and stands for bit, integer, real, time period, time-of-day and character values. The following data types are predefined in S7-SCL.

<table>
<thead>
<tr>
<th>Group</th>
<th>Data Types</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit Data Types</td>
<td>BOOL</td>
<td>Date elements of this type occupy either 1 bit, 8 bits, 16 bits or 32 bits</td>
</tr>
<tr>
<td></td>
<td>BYTE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>WORD</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DWORD</td>
<td></td>
</tr>
<tr>
<td>Character Types</td>
<td>CHAR</td>
<td>Data elements of this type occupy exactly 1 character in the ASCII character set</td>
</tr>
<tr>
<td>Numeric Types</td>
<td>INT</td>
<td>Data elements of this type are available for processing numeric values.</td>
</tr>
<tr>
<td></td>
<td>DINT</td>
<td></td>
</tr>
<tr>
<td></td>
<td>REAL</td>
<td></td>
</tr>
<tr>
<td>Time Types</td>
<td>TIME</td>
<td>Data elements of this type represent the various time and date values in STEP 7.</td>
</tr>
<tr>
<td></td>
<td>DATE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TIME_OF_DAY</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SSTIME</td>
<td></td>
</tr>
</tbody>
</table>
### Data Types

#### Complex Data Types

S7-SCL supports the following complex data types:

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATE_AND_TIME DT</td>
<td>Defines an area of 64 bits (8 bytes). This data type stores date and time (as a binary coded decimal) and is a predefined data type in S7-SCL.</td>
</tr>
<tr>
<td>STRING</td>
<td>Defines an area for a character string of up to 254 characters (data type CHAR).</td>
</tr>
<tr>
<td>ARRAY</td>
<td>Defines an array consisting of elements of one data type (either elementary or complex).</td>
</tr>
<tr>
<td>STRUCT</td>
<td>Defines a group of data types in any combination of types. It can be an array of structures or a structure consisting of structures and arrays.</td>
</tr>
</tbody>
</table>

#### User-Defined Data Types

You can create your own user-defined data types in the data type declaration. Each one is assigned a unique name and can be used any number of times. Once it has been defined, a user-defined data type can be used to generate a number of data blocks with the same structure.

#### Parameter Types

Parameter types are special data types for timers, counters and blocks that can be used as formal parameters:

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIMER</td>
<td>This is used to declare timer functions as parameters.</td>
</tr>
<tr>
<td>COUNTER</td>
<td>This is used to declare counter functions as parameters.</td>
</tr>
<tr>
<td>BLOCK_xx</td>
<td>This is used to declare FCs, FBs, DBs and SDBs as parameters.</td>
</tr>
<tr>
<td>ANY</td>
<td>This is used to allow an address of any data type as a parameter.</td>
</tr>
<tr>
<td>POINTER</td>
<td>This is used to allow a memory area as a parameter.</td>
</tr>
</tbody>
</table>

#### ANY Data Type

In S7-SCL, you can use variables of the ANY data type as formal parameters of a block. You can also create temporary variables of this type and use them in value assignments.
7.2 Elementary Data Types

7.2.1 Bit Data Types

Data of this type are bit combinations occupying either 1 bit (data type BOOL), 8 bits, 16 bits or 32 bits. A numeric range of values cannot be specified for the data types: byte, word, and double word. These are bit combinations that can be used only to formulate Boolean expressions.

<table>
<thead>
<tr>
<th>Type</th>
<th>Keyword</th>
<th>Bit Width</th>
<th>Alignment</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit</td>
<td>BOOL</td>
<td>1 bit</td>
<td>Begins at the least significant bit in the byte</td>
<td>0, 1 or FALSE, TRUE</td>
</tr>
<tr>
<td>Byte</td>
<td>BYTE</td>
<td>8 bits</td>
<td>Begins at the least significant byte in the word</td>
<td>-</td>
</tr>
<tr>
<td>Word</td>
<td>WORD</td>
<td>16 bits</td>
<td>Begins at a WORD boundary.</td>
<td>-</td>
</tr>
<tr>
<td>Double word</td>
<td>DWORD</td>
<td>32 bits</td>
<td>Begins at a WORD boundary.</td>
<td>-</td>
</tr>
</tbody>
</table>

7.2.2 Character Types

Data elements of this type occupy exactly one character of the ASCII character set.

<table>
<thead>
<tr>
<th>Type</th>
<th>Keyword</th>
<th>Bit Width</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single character</td>
<td>CHAR</td>
<td>8</td>
<td>Extended ASCII character set</td>
</tr>
</tbody>
</table>

7.2.3 Numeric Data Types

These types are available for processing numeric values (for example for calculating arithmetic expressions).

<table>
<thead>
<tr>
<th>Type</th>
<th>Keyword</th>
<th>Bit Width</th>
<th>Alignment</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer</td>
<td>INT</td>
<td>16</td>
<td>Begins at a WORD boundary.</td>
<td>-32_768 to 32_767</td>
</tr>
<tr>
<td>Double integer</td>
<td>DINT</td>
<td>32</td>
<td>Begins at a WORD boundary.</td>
<td>-2_147_483_648 to 2_147_483_647</td>
</tr>
<tr>
<td>Floating-point number</td>
<td>REAL</td>
<td>32</td>
<td>Begins at a WORD boundary.</td>
<td>-3.402822E+38 to -1.175495E-38 +/- 0 1.175495E-38 to 3.402822E+38</td>
</tr>
</tbody>
</table>
7.2.4 Time Types

Data of this type represent the various time and date values within STEP 7 (for example for setting the date or for entering the time value for a time).

<table>
<thead>
<tr>
<th>Type</th>
<th>Keyword</th>
<th>Bit Width</th>
<th>Alignment</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>S5 time</td>
<td>S5TIME</td>
<td>16</td>
<td>Begins at a WORD boundary.</td>
<td>T#0H_0M_0S_10MS to T#2H_46M_30S_0MS</td>
</tr>
<tr>
<td>Time period: IEC time in steps of 1 ms.</td>
<td>TIME</td>
<td>32</td>
<td>Begins at a WORD boundary.</td>
<td>-T#24D_20H_31M_23S_647MS to T#24D_20H_31M_23S_647MS</td>
</tr>
<tr>
<td>Date IEC data in steps of 1 day</td>
<td>DATE</td>
<td>16</td>
<td>Begins at a WORD boundary.</td>
<td>D#1990-01-01 to D#2168-12-31</td>
</tr>
<tr>
<td>Time of day time in steps of 1 ms.</td>
<td>TIME_OF_DAY</td>
<td>32</td>
<td>Begins at a WORD boundary.</td>
<td>TOD#0:0:0.0 to TOD#23:59:59.999</td>
</tr>
</tbody>
</table>

If the set value is higher than the upper limit of the range, the upper limit value is used.

With variables of the data type S5TIME, the resolution is limited, in other words, only the time bases 0.01 s, 0.1 s, 1 s, 10 s are available. The compiler rounds the values accordingly. If the set value is higher than the upper limit of the range, the upper limit value is used.
7.3 Complex Data Types

7.3.1 DATE_AND_TIME Data Type

Definition
This data type defines an area with 64 bits (8 bytes) for specifying the date and time. The data area stores the following information (in binary coded decimal format):
year, month, day, hours, minutes, seconds, milliseconds.

Syntax

```
DATE_AND_TIME
```

The exact syntax for specifying the date and time is described in "Declaring Constants".

Value Range

<table>
<thead>
<tr>
<th>Type</th>
<th>Keyword</th>
<th>Bit Width</th>
<th>Alignment</th>
<th>Value Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date and time</td>
<td>DATE_AND_TIME</td>
<td>64</td>
<td>Begins and ends at a WORD boundary.</td>
<td>DT#1990-01-01-0:0:0:0.0 to DT#2089-12-31-23:59:59.999</td>
</tr>
</tbody>
</table>

The Date_And_Time data type is stored in BCD format:

<table>
<thead>
<tr>
<th>Bytes</th>
<th>Content</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Year</td>
<td>1990 to 2089</td>
</tr>
<tr>
<td>1</td>
<td>Month</td>
<td>01 to 12</td>
</tr>
<tr>
<td>2</td>
<td>Day</td>
<td>1 to 31</td>
</tr>
<tr>
<td>3</td>
<td>Hour</td>
<td>0 to 23</td>
</tr>
<tr>
<td>4</td>
<td>Minute</td>
<td>0 to 59</td>
</tr>
<tr>
<td>5</td>
<td>Second</td>
<td>0 to 59</td>
</tr>
<tr>
<td>6</td>
<td>2 MSD (most significant decade) of ms</td>
<td>00 to 99</td>
</tr>
</tbody>
</table>
**Data Types**

<table>
<thead>
<tr>
<th>Bytes</th>
<th>Content</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>7 (4 MSB)</td>
<td>LSD (least significant decade) of ms</td>
<td>0 to 9</td>
</tr>
<tr>
<td>7 (4 LSB)</td>
<td>Weekday</td>
<td>1 to 7 (1 = Sunday)</td>
</tr>
</tbody>
</table>

**Example**

A valid definition for the date and time 20/Oct./1995 12:20:30 and 10 milliseconds is shown below:

```
DATE_AND_TIME#1995-10-20-12:20:30.10
DT#1995-10-20-12:20:30.10
```

**Note**

You can use standard functions (FCs) in the STEP 7 library to access the specific components DATE or TIME.
7.3.2 STRING Data Type

Definition

A STRING data type defines a character string with a maximum of 254 characters. The standard area reserved for a character string consists of 256 bytes. This memory area is required to store 254 characters and a header of 2 bytes.

You can reduce the memory required by a character string by defining a maximum number of characters to be saved in the string. A null string, in other words a string containing no data, is the smallest possible value.

Syntax

STRING Data Type Specification

The simple expression stands for the maximum number of characters in the STRING. All the characters of the ASCII code are permitted in a character string. A string can also include special characters, for example, control characters and nonprintable characters. You can enter these using the syntax $hh, where hh stands for the value of the ASCII character expressed in hexadecimal (example: '$0D$0AText' )

When you declare the memory space for character strings, you can define the maximum number of characters that can be stored in the string. If you do not specify a maximum length, a string with a length of 254 is created.

Example

VAR
    Text1 : String [123];
    Text2 : String;
END_VAR

The constant "123" in the declaration of the variable "Text1" stands for the maximum number of characters in the string. For variable "Text2", a length of 254 characters is reserved.

Note

For output and in/out parameters and for return values of functions, you can reduce the default length (254) reserved for strings to make better use of the resources on your CPU. To reduce the default length, select the menu command Options > Customize and enter the required length in the "Maximum String Length" box in the "Compiler" tab. Remember that this setting affects all STRING variables in the source file. The value you set must therefore not be smaller than the STRING variables actually used in the program.
Initializing Character Strings

String variables, just like other variables, can be initialized in the declaration of the parameters of function blocks (FBs) with constant character strings. It is not possible to initialize parameters of functions (FCs).

If the initialized string is shorter than the declared maximum length, the remaining characters are not initialized. When the variable is processed in the program, only the currently occupied character locations are taken into account.

Example


If temporary variables of the STRING type are required, for example, for buffering results, they must always be initialized with a string constant either in the variable declaration or in a value assignment before they are used for the first time.

Note

If a function from a standard library returns a value of the STRING data type and if you want this value to be assigned to a temporary variable, the variable must first be initialized.

Example

FUNCTION Test : STRING[45]
VAR_TEMP
  x : STRING[45];
END_VAR
x := 'a';
x := concat (in1 := x, in2 := x);
Test := x;
END_FUNCTION

Without the initialization x := 'a';, the function would return an incorrect result.

Alignment

Variables of the STRING type begin and end at a WORD boundary.
7.3.3 ARRAY Data Type

Definition

ARRAYs have a specified number of components of one data type. The following array types are possible in S7-SCL:

- The one-dimensional ARRAY type. This is a list of data elements arranged in ascending order.
- The two-dimensional ARRAY type. This is a table of data consisting of rows and columns. The first dimension refers to the row number and the second to the column number.
- The multidimensional ARRAY type. This is an extension of the two-dimensional ARRAY type adding further dimensions. The maximum number of dimensions permitted is 6.

Syntax

ARRAY Data Type Specification

Index Specification

This describes the dimensions of the ARRAY data type as follows:

- The smallest and highest possible index (index range) for each dimension. The index can have any integer value (-32768 to 32767).
- The limits must be separated by two periods. The individual index ranges must be separated by commas.
- The entire index specification is enclosed in square brackets.

Data Type Specification

With the data type specification, you declare the data type of the components. All the data types are permitted for the specification. The data type of an array can, for example, also be a STRUCT type. Parameter types must not be used as the element type for an array.
Data Types

Example

VAR
  CONTROLLER1 : ARRAY[1..3,1..4] OF INT:= -54, 736, -83, 77,
  -1289, 10362, 385, 2,
  60, -37, -7, 103 ;
  CONTROLLER2 : ARRAY[1..10] OF REAL ;
END_VAR

Alignment

Variables of the ARRAY type are created row by row. Each dimension of a variable of the type BOOL, BYTE or CHAR ends at a BYTE boundary, all others at a WORD boundary.
7.3.4 STRUCT Data Type

Definition

The STRUCT data type describes an area consisting of a fixed number of components that can be of different data types. These data elements are specified immediately following the STRUCT keyword in the component declaration.

The main feature of the STRUCT data type is that a data element can also be complex. This means that nesting of STRUCT data types is permitted.

Syntax

```
STRUCT
```

Component Declaration

The component declaration is a list of the various components of the STRUCT data type. It consists of the following:

- 1 to n identifiers with the assigned data type and
- an optional specification of initial values

```
IDENTIFIER
```

The identifier is the name of a structure element to which the subsequent data type specification will apply.

All data types with the exception of parameter types are permitted for the data type specification.

You have the option of specifying an initial value for a specific structure element after the data type specification using a value assignment.
Data Types

Example

```plaintext
VAR
    MOTOR : STRUCT
        DATA : STRUCT
            LOADCURR : REAL ;
            VOLTAGE : INT := 5 ;
        END_STRUCT ;
    END_STRUCT ;
END_VAR
```

Alignment

Variables of the STRUCT type begin and end at a WORD boundary.

Caution

If you define a structure that does not end at a WORD limit, S7-SCL automatically fills in the missing bytes and thus adapts the structure size.

Adapting the structure size can cause conflicts when data types with an odd bit length are accessed.
7.4 User-Defined Data Types (UDT)

Definition

You define a user-defined data type (UDT) as a block. Once it has been defined, it can be used throughout your user program; in other words, it is a shared data type. You can use these data types with their UDT identifier, UDTx (x represents a number), or with an assigned symbolic name defined in the declaration section of a logic block or data block.

The user-defined data type can be used to declare variables, parameters, data blocks, and other user-defined data types. Components of arrays or structures can also be declared with user-defined data types.

Syntax

User-Defined Data Type

UDT Identifier

The declaration of a user-defined data type starts with the TYPE keyword followed by the name of the user-defined data type (UDT identifier). The name of the user-defined data type can either be specified in absolute form; in other words, a standard name in the form UDTx (x stands for a number), or as a symbolic name.

Examples:

```
TYPE UDT10
TYPE MEASVALUES
```
**Data Types**

**Data Type Specification**

The UDT identifier is followed by the data type specification. The only data type specification permitted in this case is STRUCT.

```
STRUCT
:
END_STRUCT
```

**Note**

The syntax of STL must be used within a user-defined data type. This applies, for example, to the notation for constants and the assignment of initial values (initialization). For information about the syntax of the constants, refer to the STL online help.

**Example**

```c
// UDT definition with a symbolic name
TYPE
MEASVALUES: STRUCT
    BIPOL_1 : INT := 5;
    BIPOL_2 : WORD := W#16#FFAA ;
    BIPOL_3 : BYTE := B#16#F1 ;
    BIPOL_4 : WORD := W#16#1919 ;
    MEASURE : STRUCT
        BIPOLAR_10V : REAL ;
        UNIPOLAR_4_20MA :
            REAL ;
    END_STRUCT;
END_STRUCT;

// Use of the UDT in an FB
FUNCTION_BLOCK FB10
VAR
    MEAS_RANGE : MEASVALUES;
END_VAR
BEGIN
    // . . .
    MEAS_RANGE.BIPOL_1 := -4 ;
    MEAS_RANGE.MEASURE.UNIPOLAR_4_20MA := 2.7 ;
    // . . .
END_FUNCTION_BLOCK
```
7.5 Data Types for Parameters

To specify the formal block parameters of FBs and FCs, you can use parameter types in addition to the data types that have already been introduced.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIMER</td>
<td>2 bytes</td>
<td>Identifies a specific timer to be used by the program in the logic block called.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Actual Parameter for example, T1</td>
</tr>
<tr>
<td>COUNTER</td>
<td>2 bytes</td>
<td>Identifies a specific counter to be used by the program in the logic block called.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Actual Parameter for example, C10</td>
</tr>
<tr>
<td>BLOCK_FB</td>
<td>2 bytes</td>
<td>Identifies a specific block to be used by the STL program in the block called.</td>
</tr>
<tr>
<td>BLOCK_FC</td>
<td></td>
<td>Actual Parameter: for example, FC101</td>
</tr>
<tr>
<td>BLOCK_DB</td>
<td></td>
<td>DB42</td>
</tr>
<tr>
<td>BLOCK_SDB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ANY</td>
<td>10 bytes</td>
<td>Used if any data type with the exception of ANY is to be allowed for the data type of the actual parameter.</td>
</tr>
<tr>
<td>POINTER</td>
<td>6 bytes</td>
<td>Identifies a particular memory area to be used by the program.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Actual Parameter: for example, M50.0</td>
</tr>
</tbody>
</table>

Notes:

The data type BLOCK DB can be accessed absolutely (myDB.dw10). You can also process the BLOCK DB further with BLOCK_DB_TO_WORD(). The data types BLOCK_SDB, BLOCK_FB and BLOCK_FC cannot be analyzed by S7-SCL programs. You can only use them to supply parameters of this type with the call of STL blocks.

7.5.1 TIMER and COUNTER Data Types

You specify a particular timer or a particular counter to be used when a block executes. The TIMER and COUNTER data types are permitted only for input parameters (VAR_INPUT).
7.5.2 BLOCK Data Types

You specify a block that will be used as an input parameter. The declaration of the input parameter determines the block type (FB, FC, DB). For supplying parameters, you specify the block identifier. Both absolute and symbolic identifiers are permitted.

You can access the BLOCK_DB data type using absolute addressing (myDB.dw10). S7-SCL does not provide any operations for the other block data types. Parameters of this type can only be supplied with values when the blocks are called. When using functions, input parameters cannot be passed on.

In S7-SCL, you can assign addresses of the following data types as actual parameters:

- Function blocks without formal parameters
- Functions without formal parameters or return value (VOID function)
- Data blocks and system data blocks.
7.5.3 **POINTER Data Type**

You can assign variables to the POINTER data type that you have declared as formal parameters of a block. If you call such a block, these parameters can be supplied with addresses of any data type (except ANY).

SCL, however, only provides one statement for processing the POINTER data type, namely passing on to underlying blocks.

You can assign the following types of addresses as actual parameters:

- Absolute addresses
- Symbolic names
- Addresses of the POINTER data type
  This is only possible when the address is a formal parameter with a compatible parameter type.
- NIL constant
  You specify a nil pointer.

**Restrictions**

- The POINTER data type is permitted for formal input parameters, in/out parameters of FBs and FCs and for output parameters of FCs. Constants are not permitted as actual parameters (with the exception of the NIL constant).
- If you supply a formal parameter of the type POINTER with a temporary variable when an FB or FC is called, you cannot pass this parameter on to a further block. Temporary variables lose their validity when they are passed on.
- When an FC or FB is called, you can only assign process inputs (%PEW) to formal parameters of the POINTER type if the formal parameter was declared as an input parameter.
- When an FB is called, you can only assign process outputs (%PAW) to formal parameters of the POINTER type if the formal parameter was declared as an output parameter.
Example

FUNCTION FC100 : VOID
VAR_IN_OUT
  N_out : INT;
  out  : POINTER;
END_VAR
VAR_TEMP
  ret       : INT;
END_VAR
BEGIN
  // ...
  ret := SFC79(N := N_out, SA := out);
  // ...
END_FUNCTION

FUNCTION_BLOCK FB100
VAR
  ii   : INT;
  aa  : ARRAY[1..1000] OF REAL;
END_VAR
BEGIN
  // ...
  FC100(N_out := ii, out := aa);
  // ...
END_FUNCTION_BLOCK
7.6  ANY Data Type

In S7-SCL, you can declare variables of the ANY data type as follows:

- As formal parameters of a block; these parameters can then be supplied with actual parameters of any data type when the block is called.
- As temporary variables; you can assign values of any data type to these variables.

You can use the following data as the actual parameters or as a value assignment on the right-hand side:

- Local and shared variables
- Variables in the DB (addressed absolutely or symbolically)
- Variables in the local instance (addressed absolutely or symbolically)
- NIL constant
  You specify a nil pointer.
- ANY data type
- Timers, counters, and blocks
  You specify the identifier (for example, T1, C20 or FB6).

Restrictions

- The ANY data type is permitted for formal input parameters, in/out parameters of FBs and FCs and for output parameters of FCs. Constants are not permitted as the actual parameters or on the right-hand side of a value assignment (with the exception of the NIL constant).
- If you supply a formal parameter of the type ANY with a temporary variable when an FB or FC is called, you cannot pass this parameter on to a further block. Temporary variables lose their validity when they are passed on.
- Variables of this type must not be used as a component type in a structure or as an element type for an array.
- When an FC or FB is called, you can only assign process inputs (%PEW) to formal parameters of the ANY type if the formal parameter was declared as an input parameter.
- When an FB is called, you can only assign process outputs (%PAW) to formal parameters of the ANY type if the formal parameter was declared as an output parameter.
7.6.1 Example of the ANY Data Type

VAR_INPUT
  iANY : ANY;
END_VAR

VAR_TEMP
  pANY : ANY;
END_VAR

CASE ii OF
  1:
    pANY := MW4; // pANY contains the address // of MW4
  3..5:
    pANY := aINT[ii]; // pANY contains the address // of the ii th // element of the aINT field;
  100:
    pANY := iANY; // pANY contains the value // of the iANY input variable
ELSE
  pANY := NIL; // pANY contains the value // of the NIL pointer
END_CASE;

SFCxxx(IN := pANY);
8 Declaration of Local Variables and Parameters

8.1 Local Variables and Block Parameters

Categories of Variables

The following table illustrates the categories of local variables:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static Variables</td>
<td>Static variables are local variables whose value is retained throughout all block cycles (block memory). They are used to save values of a function block and are stored in the instance data block.</td>
</tr>
<tr>
<td>Temporary Variables</td>
<td>Temporary variables belong to a logic block at local level and do not occupy a static memory area, since they are stored in the CPU stack. Their value is only retained while the block concerned is running. Temporary variables cannot be accessed from outside the block in which they are declared.</td>
</tr>
</tbody>
</table>

Categories of Block Parameters

Block parameters are placeholders that are only assigned a specific value when the block is called. The placeholders in the block are known as formal parameters and the values assigned to them when the block is called are referred to as the actual parameters. The formal parameters of a block can be viewed like local variables.

Block parameters can be subdivided into the categories shown below:

<table>
<thead>
<tr>
<th>Block Parameter</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input parameters</td>
<td>Input parameters accept the current input values when the block is called. They are read-only.</td>
</tr>
<tr>
<td>Output parameters</td>
<td>Output parameters transfer the current output values to the calling block. Data can be written to and read from them.</td>
</tr>
<tr>
<td>In/out parameters</td>
<td>In/out parameters adopt current input values when a block is called. After processing the value, they receive the result and return it to the calling block.</td>
</tr>
</tbody>
</table>

Flags (OK Flag)

The S7-SCL compiler provides a flag that can be used to detect errors when programs are running on the CPU. It is a local variable of the type BOOL with the predefined name "OK".
8.2 General Syntax of a Variable or Parameter Declaration

Variables and block parameters must be declared individually before they can be used within a logic block or data block. The declaration specifies that an identifier is used as a block parameter or variable and assigns it a data type.

A variable or parameter declaration consists of an identifier (named by the user) and a data type. The basic format is shown in the syntax diagram below.

Syntax of a Variable or Parameter Declaration

```
Variable Declaration

IDENTIFIER AT

Simple variable

Data type specification

Data type initialization

1) System attributes for parameters
2) not for AT
```

Examples

```
VALUE1 : REAL;
if there are several variables of the same type:

VALUE2, VALUE3, VALUE4,.... : INT;

ARR : ARRAY[1..100, 1..10] OF REAL;

SET : STRUCT
   MEASARR:ARRAY[1..20] OF REAL;
   SWITCH:BOOL;
END_STRUCT
```

Note

If you want to use reserved words as identifiers, they must be preceded by the "#" character (for example, #FOR).
8.3 **Initialization**

Static variables as well as input and output parameters of an FB can be assigned an initial value when they are declared. In/out parameters can also be assigned an initial value, however, only if they are of an elementary data type. With simple variables, the initial value is assigned by assigning (:=) a constant after the data type specification.

**Syntax**

```
INITIALISATION

  CONSTANT

  ARRAY

  INITIALISATION LIST
```

**Example**

```plaintext
VALUE :REAL := 20.25;
```

**Note**

Initialization of a variable list ( A1, A2, A3,... : INT:=...) is not possible. In such cases, the variables have to be initialized individually.

**Array Initialization**

To initialize ARRAYs, you can either specify a value for each component separated by a comma, or by specifying a repetition factor (integer) you can initialize several components with the same value.

The initial values can optionally be enclosed in a bracket. Only one bracket pair is specified even at multiple-dimensional arrays.
Declaration of Local Variables and Parameters

Syntax of Array Initialization

Constant repetition list

Examples

VAR
  // Initialization of static variables:
  INDEX1 : INT := 3 ;
  //Array initialization:
  CONTROLLER1 : ARRAY [1..2, 1..2] OF INT := -54, 736, -83, 77;
  CONTROLLER2 : ARRAY[1..10] OF REAL := 10(2.5);
  CONTROLLER1 : ARRAY [1..2, 1..2] OF INT := [-54, 736, -83, 77];
  CONTROLLER2 : ARRAY[1..10] OF REAL := [10(2.5)];
  //Structure initialization:
  GENERATOR: STRUCT
    DAT1 : REAL         := 100.5;
    A1 : INT    := 10 ;
    A3 : ARRAY[1..12] OF REAL := 0.0, 10(100.0), 1.0;
  END_STRUCT ;
END_VAR
8.4 Declaring Views of Variable Ranges

To be able to access a declared variable with a different data type, you can define views of the variable or of ranges within the variables using the "AT" keyword. A view is visible only locally in the block; it is not included in the interface. A view can be used like any other variable in the block. It inherits all the properties of the variable that it references; only the data type is new.

Example

The following example makes several views of one input parameter possible:

```
VAR_INPUT
    Buffer : ARRAY[0..255] OF BYTE;
    Frame1 AT Buffer : UDT100 ;
    Frame2 AT Buffer : UDT200 ;
END_VAR
```

The calling block supplies the Buffer parameter, it does not see the names Frame1 and Frame2. The calling block now has three ways of interpreting the data, namely the array under the name buffer or with a different structure under Frame1 or Frame2.
Declaration of Local Variables and Parameters

Rules

- The declaration of a further view of a variable must be made following the declaration of the variable to which it points in the same declaration subsection.
- Initialization is not possible.
- The data type of the view must be compatible with the data type of the variable. The variable specifies the size of the memory area. The memory requirements of the view can be equal to this or smaller. The following rules for combining data types also apply:

<table>
<thead>
<tr>
<th></th>
<th>Data Type of the View</th>
<th>Data Type of the Variable</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Elementary</td>
<td>Complex</td>
<td>ANY/POINTER</td>
</tr>
<tr>
<td>FB</td>
<td>Declaration of a view in</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>VAR, VAR_TEMP, VAR_IN</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>or VAR_OUT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FB</td>
<td>Declaration of a view in</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>VAR_IN_OUT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FC</td>
<td>Declaration of a view in</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>VAR, VAR_TEMP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FC</td>
<td>Declaration of a view in</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>VAR_IN, VAR_OUT or VAR_IN_OUT</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

(1) ANY pointer not permitted in VAR_OUT.

Elementary = BOOL, BYTE, WORD, DWORD, INT, DINT, DATE, TIME, S5TIME, CHAR
Complex = ARRAY, STRUCT, DATE_AND_TIME, STRING
8.5 Using Multiple Instances

It is possible that you may want to or have to use a restricted number of data blocks for instance data owing to the performance (for example, memory capacity) of the S7 CPUs you are using. If other existing function blocks are called in an FB in your user program (call hierarchy of FBs), you can call these other function blocks without their own (additional) instance data blocks.

Use the following solution:

- Include the function blocks you want to call as static variables in the variable declaration of the calling function block.
- In this function block, call other function blocks without their own instance data block.
- This concentrates the instance data in one instance data block, allowing you to use the available number of data blocks more effectively.
### 8.6 Instance Declaration

For function blocks, you can also declare variables of the type FB or SFB in the declaration subsection for static variables (VAR; END_VAR) in addition to the variables with elementary, complex or user-defined data types. Such variables are called local instances of the FB or SFB.

The local instance data is stored in the instance data block of the calling function block. A local instance-specific initialization is not possible.

Blocks called as a local instance must not have the length 0. At least one static variable or a parameter must be declared in such blocks.

**Syntax**

Local instance name

**Example**

Supply1 : FB10;
Supply2,Supply3,Supply4 : FB100;
Motor1 : Motor;

Where Motor is a symbol for an FB entered in the symbol table.
8.7 Flags (OK Flag)

The OK flag is used to indicate the correct or incorrect execution of a block. It is a local variable of the type BOOL with the predefined name "OK".

At the beginning of the program, the OK flag has the value TRUE. It can be queried at any point in the block or can be set to TRUE / FALSE using S7-SCL statements. If an error occurs while an operation is being executed (for example division by zero), the OK flag is set to FALSE. When the block is exited, the value of the OK flag is saved in the output parameter ENO and can be evaluated by the calling block.

Declaration

The OK flag is a system variable. Declaration is not necessary. You must, however, select the compiler option "Set OK flag" before compilation if you want to use the OK flag in your user program.

Example

```plaintext
// Set OK flag to TRUE
// to check whether the
// action executes correctly.
OK:= TRUE;
Division:= 1 / IN;
IF OK THEN
   // Division was correct.
   // :
   // :
ELSE  // Division was not correct.
   // :
   // :
END_IF;
```
8.8 Declaration Subsections

8.8.1 Overview of the Declaration Subsections

Each category of local variables or parameters has its own declaration subsection identified by its own pair of keywords. Each subsection contains the declarations that are permitted for that particular declaration subsection. These subsections can be positioned in any order.

The following table shows which variables or types of parameter you can declare in the various logic blocks:

<table>
<thead>
<tr>
<th>Data</th>
<th>Syntax</th>
<th>FB</th>
<th>FC</th>
<th>OB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable as:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Static variable</td>
<td>VAR</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>. . .</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>END_VAR</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temporary variable</td>
<td>VAR_TEMP</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>. . .</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>END_VAR</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Block parameter as:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input parameter</td>
<td>VAR_INPUT</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>. . .</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>END_VAR</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Output parameter</td>
<td>VAR_OUTPUT</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>. . .</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>END_VAR</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>In/out parameter</td>
<td>VAR_IN_OUT</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td></td>
<td>. . .</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>END_VAR</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*) Although the declaration of variables between the keyword pair VAR and END_VAR is permitted in functions, the declarations are created in the temporary area when the source file is compiled.
8.8.2 Static Variables

Static variables are local variables whose value is retained when the blocks are run. They are used to save the values of a function block and are contained in a corresponding instance data block.

Syntax

Static variables are declared in the VAR / END_VAR declaration section. This declaration subsection is part of the FB declaration section. After compilation, this subsection and the subsections for the block parameters decide the structure of the assigned instance data block.

In this subsection you can:
- Create variables, assign data types to the variables and initialize the variables.
- Declare a called FB as a static variable if you want to call it in the current FB as a local instance.

Example

```plaintext
VAR
  RUN : INT;
  MEASARR : ARRAY [1..10] OF REAL;
  SWITCH : BOOL;
  MOTOR_1, MOTOR_2 : FB100; // Instance declaration
END_VAR
```

Access

The variables are accessed from the code section as follows:

- **Access within the block**: In the code section of the function block in which a variable was declared in the declaration section, you can access the variable. This is explained in detail in the section entitled "Value Assignment".
- **External access using the instance DB**: You can access the variable from other blocks using indexed access, for example \( \text{DBx.variable} \).
8.8.3 Temporary Variables

Temporary variables belong locally to a logic block and do not occupy a static memory area. They are located in the stack of the CPU. Their value is only retained while the block concerned is running. Temporary variables cannot be accessed from outside the block in which they are declared. When an OB, FB or FC is first executed, the value of the temporary data has not been defined. Initialization is not possible.

You should declare data as temporary data if you only require it to record interim results while your OB, FB or FC executes.

Syntax

Temporary variables are declared in the VAR_TEMP / END_VAR declaration section. This declaration subsection is part of an FB, FC, or OB. It is used to declare variable names and data types within the variable declaration.

Temporary Variable Subsection

```
VAR_TEMP
  BUFFER 1 : ARRAY [1..10] OF INT ;
  AUX1, AUX2 : REAL ;
END_VAR
```

Access

A variable is always accessed from the code section of the logic block in which the variable is declared in the declaration section (internal access). Refer to the section entitled "Value Assignment".
8.8.4 Block Parameters

Parameters are placeholders that are only assigned a value when the block is actually called. The placeholders declared in the block are known as formal parameters that are assigned values as actual parameters. Parameters therefore provide a mechanism for the exchange of information between the blocks.

Types of Block Parameters

- Formal input parameters are assigned the actual input values (data flow into the block).
- Formal output parameters are used to transfer output values (data flow from the block to the outside)
- Formal in/out parameters have both the function of an input and an output parameter.

Syntax

The declaration of formal parameters is made in the declaration section of a function block or a function grouped according to parameter type in the three declaration subsections for parameters. Within the variable declaration, you specify the parameter name and the data type. Initialization is only possible for the input and output parameters of an FB.

When declaring formal parameters, you can use not only elementary, complex, and user-defined data types but also the data types for parameters.

Parameter Subsection

Initialization only possible for VAR_INPUT and VAR_OUTPUT
Example

```plaintext
VAR_INPUT // Input parameters
  MY_DB       : BLOCK_DB ;
  CONTROLLER  : DWORD ;
  TIMEOFDAY   : TIME_OF_DAY ;
END_VAR

VAR_OUTPUT  // Output parameters
  SETPOINTS  : ARRAY [1..10] of INT ;
END_VAR

VAR_IN_OUT  // In_out parameters
  SETTING    : INT ;
END_VAR
```

Access

Block parameters are accessed from the code section of a logic block as follows:

- **Internal access**: Access from the code section of the block in whose declaration section the parameter is declared. This is explained in the sections entitled “Value Assignment” and “Expressions, Operations and Addresses”.

- **External access using an instance data block**: You can access block parameters of function blocks using the assigned instance DB.
9 Declaring Constants and Labels

9.1 Constants

Constants are data elements that have a fixed value that cannot change while the program is running.

The following groups of constants can be used in S7-SCL.

- Bit constants
- Numeric constants
  - Integer constants
  - Real-number constants
- Character constants
  - Char constants
  - String constants
- Times
  - Date constants
  - Time period constants
  - Time-of-day constants
  - Date and time constants
9.1.1 Declaring Symbolic Names for Constants

You do not have to declare constants. However, you have the option of assigning symbolic names for constants in the declaration section.

You can declare symbolic names for constants using the CONST statement in the declaration section of your logic block. This is advisable for all constants of a block. With this method, the block is easier to read and update if you want to make changes to constant values.

Syntax

Constant Subsection

CONST

IDENTIFIER

Simple expression

END_CONST

In simple expressions, only the basic arithmetic operations are permitted (*, /, +, -, DIV, MOD).

Example

CONST

Number := 10 ;
TIMEOFDAY1 := TIME#1D_1H_10M_22S_2MS ;
NAME := 'SIEMENS' ;
NUMBER2 := 2 * 5 + 10 * 4 ;
NUMBER3 := 3 + NUMBER2 ;

END_CONST
9.1.2 Data Types for Constants

The assignment of data types to constants is different from the method in STL:

A constant is given its data type only with the arithmetic or logic operation in which it is used, for example,

\[ \text{Int1} := \text{Int2} + 12345 \quad //"12345" \text{ is given the data type INT} \]
\[ \text{Real1} := \text{Real2} + 12345 \quad //"12345" \text{ is given the data type REAL} \]

The constant is assigned the data type with the smallest value range that will accommodate the constant without any loss of value. For example, the constant "12345" is not always given the INT data type as in STL but the ANY_NUM data type class; depending on its use therefore, INT, DINT, or REAL.

Type-Defined Constants

Using the type-defined constant notation, you can also explicitly specify a data type for the following numeric data types.

Examples:

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Type-Defined Notation</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL</td>
<td>BOOL#1 bool#0</td>
</tr>
<tr>
<td></td>
<td>Bool#false BOOL#TRUE</td>
</tr>
<tr>
<td>BYTE</td>
<td>BYTE#0 B#2#101</td>
</tr>
<tr>
<td></td>
<td>Byte#'ä' b#16#f</td>
</tr>
<tr>
<td>WORD</td>
<td>WORD#32768 word#16#f</td>
</tr>
<tr>
<td></td>
<td>W#2#1001_0100 WORD#8#177777</td>
</tr>
<tr>
<td>DWORD</td>
<td>DWORD#16#000_0000 dword#32768</td>
</tr>
<tr>
<td></td>
<td>DW#2#1111_0000_1111_0000 DWord#8#3777777777</td>
</tr>
<tr>
<td>INT</td>
<td>INT#16#3f_ff int#-32768</td>
</tr>
<tr>
<td></td>
<td>Int#2#1111_0000 inT#8#777777</td>
</tr>
<tr>
<td>DINT</td>
<td>DINT#16#3fff_ffff dint#-65000</td>
</tr>
<tr>
<td></td>
<td>DInt#2#1111_0000 dInT#8#17777777777</td>
</tr>
<tr>
<td>REAL</td>
<td>REAL#1 real#1.5</td>
</tr>
<tr>
<td></td>
<td>real#2e4 real#3.1</td>
</tr>
<tr>
<td>CHAR</td>
<td>CHAR#A CHAR#49</td>
</tr>
</tbody>
</table>
9.1.3 Notation for Constants

There is a specific notation or format for the value of a constant depending on its data type and data format. The type and value of a constant is decided directly by the notation and does not need to be declared.

Examples:

15  VALUE 15  as integer constant in decimal format
2#1111  VALUE 15  as integer constant in binary format
16#F  VALUE 15  as integer constant in hexadecimal format

Overview of the Possible Notations

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
<th>Example in S7-SCL</th>
<th>Examples in STL (where different)</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL</td>
<td>Bit 1</td>
<td>FALSE TRUE BOOL#0 BOOL#1 BOOL#FALSE BOOL#TRUE</td>
<td></td>
</tr>
<tr>
<td>BYTE</td>
<td>8-bit hexadecimal number</td>
<td>B#16#00 B#16#FF BYTE#0 B#2#101 Byte#ä b#16#f</td>
<td></td>
</tr>
<tr>
<td>CHAR</td>
<td>8-bit (1 ASCII character)</td>
<td>'A' CHAR#49</td>
<td></td>
</tr>
<tr>
<td>STRING</td>
<td>Maximum of 254 ASCII characters</td>
<td>'Address'</td>
<td></td>
</tr>
<tr>
<td>WORD</td>
<td>16-bit hexadecimal number</td>
<td>W#16#0000 W#16#FFFF word#16#f</td>
<td>WORD#8#177777 8#177777 W#2#1001_0100 WORD#32768</td>
</tr>
</tbody>
</table>
### Declaring Constants and Labels

#### DWORD
- **32-bit hexadecimal number**
  - `DW#16#0000_0000`
  - `DW#16#FFFF_FFFF`
- **32-bit octal number**
  - `Dword#8#37777777777`
  - `8#37777777777`
- **32-bit binary number**
  - `DW#2#1111_0000_1111_0000`
  - `dword#32768`

#### INT
- **16-bit fixed-point number**
  - `-32768`
  - `+32767`
  - `INT#16#3f_ff`
  - `int#-32768`
  - `Int#2#1111_0000`
  - `inT#8#77777777777`

#### DINT
- **32-bit floating-point number**
  - `-2147483648`
  - `+2147483647`
  - `DINT#16#3fff_ffff`
  - `dint#-65000`
  - `Dint#2#1111_0000`
  - `dinT#8#17777777777`

#### REAL
- **32-bit floating-point number**
  - Decimal format
    - `123.4567`
    - `REAL#1`
    - `real#1.5`
  - Exponential format
    - `real#2e4`
    - `+1.234567E+02`

#### S5TIME
- **16-bit time value in SIMATIC format**
  - `T#0ms`
  - `TIME#2h46m30s`
  - `T#0.0s`
  - `TIME#23.855134d`

#### TIME
- **32-bit time value in IEC format**
  - `-T#24d20h31m23s647ms`
  - `TIME#24d20h31m23s647ms`
  - `T#0s`
  - `TIME#24.855134d`

#### Date
- **16-bit date value**
  - `D#1990-01-01`
  - `DATE#2168-12-31`

#### TIME_OF_DAY
- **32-bit time of day**
  - `TOD#00:00:00`
  - `TIME_OF_DAY#23:59:59.999`

#### DATE_AND_TIME
- **Date and time value**
  - `DT#95-01-01-12:12:12.2`
9.1.3.1 Bit Constants

Bit constants contain values with the length 1 bit, 8 bits, 16 bits or 32 bits. Depending on their length, these can be assigned to variables in the S7-SCL program with the data types BOOL, BYTE, WORD or DWORD.

Syntax

```
BIT CONSTANT

(1) only with BYTE data type
```

Decimal Digit String

The decimal number in a constant consists of a string of digits (if required, these can be separated by underscores). The underscores are used to improve readability in the case of long numbers. Examples of valid notations for decimal digit strings in constants are shown below:

```
DW#2#1111_0000_1111_0000
dword#32768
```

Binary, Octal and Hexadecimal Values

You can specify an integer constant in a numeric system other than the decimal system by using the prefixes `2#`, `8#` or `16#` followed by the number in the notation of the selected system. This is illustrated in the figure below based on the example of a digit string for an octal number:

Example

The following examples illustrate the notations for bit constants:

```
Bool#false
8#177777
DW#16#0000_0000
```
9.1.3.2 Integer Constants

Integer constants contain whole number values with a length of 16 bits or 32 bits. Depending on their length, these can be assigned to variables with the data types INT or DINT in the S7-SCL program.

Syntax

INTEGER CONSTANT

(1) only with INT data type

Decimal Digit String

The decimal number in a constant consists of a string of digits (if required, these can be separated by underscores). The underscores are used to improve readability in the case of long numbers. Examples of valid notations for decimal digit strings in constants are shown below:

1000
1_120_200
666_999_400_311

Binary, Octal and Hexadecimal Values

You can specify an integer constant in a numeric system other than the decimal system by using the prefixes 2#, 8# or 16# followed by the number in the notation of the selected system.

Example

The following examples illustrate the notations for integer constants:

Value_2:=2#0101; // Binary number, decimal value 5
Value_3:=8#17;  // Octal number, decimal value 14
Value_4:=16#F; // Hexadecimal number, decimal value 15
Value_5:=INT#16#3f_ff // Hexadecimal number, type-defined notation
9.1.3.3 Real Number Constants

Real number constants are values with decimal places. They can be assigned to variables with the data type REAL.

Syntax

REAL NUMBER CONSTANT

The use of a plus or minus sign is optional. If no sign is specified, the number is assumed to be positive.

The decimal number in a constant consists of a string of digits (if required, these can be separated by underscores). The underscores are used to improve readability in the case of long numbers. Examples of valid notations for decimal digit strings in constants are shown below:

1000
1_120_200
666_999_400_311

Exponent

When specifying floating-point numbers, you can use an exponent. The exponent is specified by the letter "E" or "e" followed by an integer value.

The value 3x10\(^{10}\) can be represented by the following real numbers in S7-SCL:

3.0E+10  3.0E10  3e+10  3E10
0.3E+11  0.3e11  30.0E+9  30e9

Examples

NUM4:= -3.4 ;
NUM5:= 4e2 ;
NUM6:= real#1.5;
9.1.3.4 **Char Constants (Single Characters)**

The char constant contains exactly one character. The character is enclosed in single quotes ('). Char constants cannot be used in expressions.

**Syntax**

```
CHARACTER CONSTANT
```

**Example**

```
Charac_1 := 'B';
Charac_2 := char#43;
Charac_3 := char#'B';
```
Syntax of a Character

Any character in the complete, extended ASCII character set can be used. Special formatting characters, the quote (‘) or a $ character can be entered using the escape symbol $.

You can also use the nonprintable characters from the complete, extended ASCII character set. To do this, you specify the substitute representation in hexadecimal.

Example of a Character in Hexadecimal Code

CHARACTER := '$41';  //Corresponds to the character 'A'
Blank := '$20';  //Corresponds to the character □
9.1.3.5 String Constants

A string constant is a character string with a maximum of 254 characters. The characters are enclosed in single quotes. String constants cannot be used in expressions.

Syntax

```
STRING CONSTANT
```

Syntax of a Character

Any character in the complete, extended ASCII character set can be used. Special formatting characters, the quote ('') or a $ character can be entered using the escape symbol $.

You can also use the nonprintable characters from the complete, extended ASCII character set. To do this, you specify the substitute representation in hexadecimal code.

Character
Interrupting a String

You can interrupt and resume a string constant several times.

A string is located either in a line of an S7-SCL block or is spread over several lines using special identifiers. To interrupt a string, you use the $> identifier and to continue it in a later line, you use the $< identifier. The space between the interrupt and the resume identifiers can extend over several lines and can contain either comments or blanks.

String Break Syntax

Examples

```plaintext
// String constant:
NAME:= 'SIEMENS';
// Interrupting a string constant
MESSAGE1:= 'MOTOR- $>
$< Controller';
// string in hexadecimal:
MESSAGE1:= '$41$4E' (*character string AN*);
```
9.1.3.6 **Date Constants**

A date is introduced by the prefixes DATE# or D#. The date is specified by integers for the year (4 digits), the month and the day, separated by dashes.

**Syntax**

```
Date
```

```
Year - Month - Day
```

**Example**

```
TIMEVARIABLE1 := DATE#1995-11-11 ;
TIMEVARIABLE2 := D#1995-05-05 ;
```

9.1.3.7 **Time Period Constants**

A period of time is introduced by the prefixes TIME# or T#. The time period can be expressed in two possible ways:

- Decimal format
- Composite Format

**Syntax**

```
TIME PERIOD
```

```
TIME# Simple time
```

```
T# Composite time
```

- Each time unit (hours, minutes, etc.) may only be specified once.
- The order days, hours, minutes, seconds, milliseconds must be adhered to.

A change from composite format to decimal format is only possible when the time units have not yet been specified.

Following the introductory prefixes T# or TIME#, you must specify at least one time unit.
Decimal Format

You use the decimal format if you want to specify time components such as hours or minutes as a decimal number.

Simple Time Format

Use of the simple time format is only possible for undefined time units.
Composite format

The composite format is a sequence of individual time components. First days and then hours etc. are specified separated by the underscore character. You can, however, omit components from the sequence. However, at least one time unit must be specified.

Composite Time Format

Example

// Decimal format
Interval1 := TIME#10.5S ;

// Composite format
Interval2 := T#3D_2S_3MS ;

// Composite and decimal format
Interval3 := T#2D_2.3s ;
9.1.3.8 Time-of-Day Constants

A time of day is introduced by the prefixes TIME_OF_DAY# or TOD#.

Syntax

```
TIME OF DAY
```

A time of day is indicated by specifying the number of hours, minutes and seconds separated by colons. Specifying the number of milliseconds is optional. The milliseconds are separated from the other numbers by a decimal point.

Specifying the Time of Day

```
Time of Day
```

Example

```
TIMEOFDAY1:= TIME_OF_DAY#12:12:12.2 ;
TIMEOFDAY2:= TOD#11:11:11 ;
```
9.1.3.9 Date and Time Constants

A date and time are introduced by the prefixes DATE_AND_TIME# or DT#. This is a constant formed by specifying a date and a time of day.

Syntax

**DATE AND TIME**

- **DATE_AND_TIME#**
- **DT#**

Date

**DATE**

- **Year**
- **Month**
- **Day**

Time of Day

**TIME**

- **Hours**
- **Minutes**
- **Seconds**
- **Milliseconds**

Example

```
TIMEOFDAY1:= DATE_AND_TIME#1995-01-01-12:12:12.2 ;
TIMEOFDAY2:= DT#1995-02-02-11:11:11;
```
9.2 Declaring Labels

Labels are used to identify the destination of a GOTO statement. These are declared in the declaration section of a logic block with their symbolic names.

Syntax

Label Subsection

Example

LABEL
LAB1, LAB2, LAB3;
END_LABEL
10 Shared Data

10.1 Overview of Shared Data

In S7-SCL, you can access shared data. There are two types of shared data as follows:

- **CPU Memory Areas**
  These memory areas contain system data, for example, inputs, outputs and bit memory. The number of memory areas available depends on the CPU you are using.

- **Shared User Data in the Form of Loadable Data Blocks**
  These data areas are located within data blocks. To be able to use them, you must first create the data blocks and declare the data in them. Instance data blocks are based on specific function blocks and created automatically.

Access to Shared Data

You can access shared data as follows:

- **With absolute addressing**: Using the address identifier and the absolute address.
- **With symbolic addressing**: Specifying a symbol previously defined in the symbol table.
- **Indexed**: Using the address identifier and array index.
- **Structured**: Using a variable.

<table>
<thead>
<tr>
<th>Type of Access</th>
<th>CPU Memory Areas</th>
<th>Shared User Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absolute</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Symbolic</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Indexed</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Structured</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
10.2 Memory Areas of the CPU

10.2.1 Overview of the Memory Areas of the CPU

The memory areas of a CPU are areas declared throughout the system. For this reason, these areas do not need to be declared in your logic block. Every CPU provides the following memory areas with their own address ranges:

- Inputs/outputs in the process image (for example, Q1.0)
- Peripheral inputs/outputs (for example PQ1.0)
- Bit memory (for example M1.0)
- Timers, counters (C1)

Syntax for Access

- You access a CPU memory area using a value assignment in the code section of a logic block, as follows: With simple access that you can specify as an absolute location or as a symbol, or
- Using indexed access.
10.2.2 Absolute Access to Memory Areas of the CPU

To access a memory area of the CPU with the absolute memory location, you use, for example, a value assignment of an absolute identifier to a variable of the same type.

```
STATUS_2:= IB10;
```

Variable of matching type

The absolute identifier indicates a memory area in the CPU. You specify this area by specifying the address identifier (in this case IB) followed by the address (in this case 10).

Syntax of the Absolute Identifier

Memory Prefix

With the memory prefix, you specify the type of memory area to be addressed.

Depending on the mnemonic system you have selected, the German or English address identifiers have a reserved meaning.
**Size Prefix**

With the size prefix, you specify the length of the memory area to be read from the peripheral I/Os. You can, for example read a byte or a word. Using the size prefix is optional if you only want to specify one bit.

<table>
<thead>
<tr>
<th>Size Prefix</th>
<th>Bit</th>
<th>Byte</th>
<th>Word</th>
<th>Double word</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>W</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Address**

For the address, you first specify the absolute byte address and then the bit address of the byte separated by a period. Specifying a bit address is optional.

**Examples**

```plaintext
STATUSBYTE := IB10;
STATUS_3 := I1.1;
MEASVAL := IW20;
```
10.2.3 Symbolic Access to Memory Areas of the CPU

With symbolic addressing, instead of an absolute identifier, you can use symbolic names to address the CPU memory areas.

You assign the symbolic names to the particular addresses in your user program by creating a symbol table. You can open this table at any time in S7-SCL with the menu command **Options > Symbol Table** to add further symbols.

For the data type specification, you can use any elementary data type providing it can accept the specified data element size. The table below illustrates how a symbol table might appear.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Absolute Address</th>
<th>data type</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motor_contact_1</td>
<td>I 1.7</td>
<td>BOOL</td>
<td>Contact switch 1 for Motor A</td>
</tr>
<tr>
<td>Input1</td>
<td>IW 10</td>
<td>INT</td>
<td>Status word</td>
</tr>
</tbody>
</table>

**Access**

The address is accessed by assigning a value to a variable of the same type with the declared symbol.

**Example**

```plaintext
MEASVAL_1 := Motor_contact_1;
Status_Motor1 := Input1;
```
10.2.4 Indexed Access to Memory Areas of the CPU

You can also access memory areas of the CPU using an index. Compared with absolute addressing the advantage of this method is that you can address dynamically using variable indexes. You can, for example, use the control variable of a FOR loop as the address.

Indexed access to a memory area is performed in a similar manner to the absolute method. It differs only by virtue of the address specification. Instead of the absolute address, an index is specified which can be a constant, a variable or an arithmetic expression.

For indexed access, the absolute identifier is made up of the address identifier (memory prefix and size prefix) and the basic expression for indexing.

Syntax of the Absolute Identifier

![Syntax Diagram]

The indexing (base expression) must adhere to the following rules:

- Each index must be an arithmetic expression of the data type INT.
- When accessing data of the types BYTE, WORD or DWORD, you must use one index only. The index is interpreted as a byte address. The extent of the access is specified by the size prefix.
- When accessing data of the type BOOL, you must use two indexes. The first index specifies the byte address, the second index the bit position within the byte.

Example

```plaintext
MEASVAL_1 := IW[COUNTER];
OUTLABEL := I[BYTENO, BITNO];
```
10.3 **Data Blocks**

10.3.1 **Overview of Data Blocks**

Within data blocks, you can save and process all the data for your application whose scope is the entire program or the entire project. Each logic block can read or write shared user data.

**Access**

You can access the data of a shared data block in the following ways:

- absolute or simple,
- structured,
- indexed.

**Absolute DB access**

```
Address identifier --| Address
```

**Indexed DB access**

```
Address identifier --| Index
| Basic expression
```

**Structured DB access**

```
Address identifier --| Simple variable
```
10.3.2 Absolute Access to Data Blocks

To program absolute access to a data block, you assign a value to a variable of the same type just as with the memory areas of the CPU. You first specify the DB identifier followed by the keyword “D” and the size prefix (for example X for bit) and the byte address (for example 13.1).

\[ \text{STATUS}_5 := \text{DB11.DX13.1;} \]

Syntax

You define the access by specifying the DB identifier along with the size prefix and the address.

Size Prefix

The size prefix indicates the length of the memory area in the data block to be addressed. You can, for example, read a byte or a word from the DB. Using the size prefix is optional if you only want to specify one bit.
**Address**

When you specify the address, you first specify the absolute byte address and then the bit address (only with bit access) of the relevant byte separated by a period.

```
Address
```

**Example**

Examples of absolute access to a data are shown below. The data block itself is specified in absolute terms in the first part and in symbolic terms in the second part.

```
STATUSBYTE :=DB101.DB10;
STATUS_3 :=DB30.D1.1;
MEASVAL :=DB25.DW20;

STATUSBYTE :=Status_data.DB10;
STATUS_3 :="New data".D1.1;
MEASVAL :=Measdata.DW20.DW20;

STATUS_1 :=WORD_TO_BLOCK_DB (INDEX).DW10;
```
10.3.3 Indexed Access to Data Blocks

You can also access data blocks using an index. Compared with absolute addressing, this has the advantage of allowing you to address locations whose address is only decided during runtime. You can, for example, use the control variable of a FOR loop as the address.

Indexed access to a data block is similar to absolute access. It differs only in the address specification.

Instead of the absolute address, an index is specified which can be a constant, a variable or an arithmetic expression.

Indexed access is made up of the DB identifier, the address identifier (keyword "D" and size prefix) and a basic expression for indexing.

Syntax

When using indexes, the following rules must be adhered to:

- When accessing data of the types BYTE, WORD or DWORD, you must use one index only. The index is interpreted as a byte address. The extent of the access is specified by the size prefix.
- When accessing data of the type BOOL, you must use two indexes. The first index specifies the byte address, the second index the bit position within the byte.
- Each index must be an arithmetic expression of the data type INT (0 - 32767).

Example

```
STATUS_1:= DB11.DW[COUNTER];
STATUS_2:= DB12.DX[WNO, BITNO];
STATUS_1:= Database1.DW[COUNTER];
STATUS_2:= Database2.DX[WNO, BITNO];
STATUS_1:= WORD_TO_BLOCK_DB(INDEX).DW[COUNTER];
```
10.3.4 Structured Access to Data Blocks

Structured access uses the identifier of the variables declared in the data block. You can assign the variable to any variable of the same type. You reference the variable in the data block by specifying the DB name and the name of the simple variable separated by a period.

Syntax

![Diagram of Structured Access](image)

The simple variable stands for a variable to which you assigned an elementary or complex data type in the declaration of the DB.

If a parameter of the type BLOCK_DB or the result of the conversion function WORD_TO_BLOCK_DB is used to initiate access to a data block, only absolute or indexed access is possible and structured access is not.

Example

In the declaration section of FB10:

```
VAR
Result:   STRUCT RES1 : INT;
RES2 : WORD;
END_STRUCT
END_VAR
```

User-defined data type UDT1

```
TYPE UDT1   STRUCT RES1 : INT;
RES2 : WORD;
END_STRUCT
```

DB20 with user-defined data type:

```
DB20       STRUCT RES1 : INT;
RES2 : WORD;
END_STRUCT
```

DB30 without user-defined data type:

```
DB30       STRUCT RES1 : INT;
RES2 : WORD;
END_STRUCT
```

Function block with the following accesses:

```
.. 
FB10.DB10();
RESWORD_A   :=   DB10.Result.RES2;
RESWORD_B   :=   DB20.RES2;
RESWORD_C   :=   DB30.RES2;
```
11 Expressions, Operations and Addresses

11.1 Overview of Expressions, Operations and Addresses

An expression stands for a value that is calculated during compilation or during runtime and consists of addresses (for example constants, variables or function calls) and operations (for example *, /, + or -).

The data types of the addresses and the operations used determine the type of expression. The following expressions are possible in S7-SCL:

- Arithmetic expressions
- Comparison expressions
- Logical expressions

An expression is evaluated in a specific order. This is decided by the following:

- the precedence of the operations involved and
- working from left to right or
- with operations having the same precedence by the parentheses.

You can do the following with the result of an expression:

- Assign it to a variable.
- Use it as a condition for control statement.
- Use it as a parameter for calling a function or a function block.
11.2 Operations

Expressions consist of operations and addresses. Most S7-SCL operations combine two addresses and are therefore termed binary operators. The other operations involve only one address and are called unary operators.

Binary operations are written between the addresses (for example, A + B). A unary operation always stands immediately before its address (for example, -B).

The precedence of the operations listed in the table below governs the order of evaluation. ‘1’ represents the highest precedence.

<table>
<thead>
<tr>
<th>Class</th>
<th>Operation</th>
<th>Symbol</th>
<th>Precedence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment Operation:</td>
<td>Assignment</td>
<td>:=</td>
<td>11</td>
</tr>
<tr>
<td>Arithmetic Operations:</td>
<td>Power</td>
<td>**</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>**</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Unary Operations</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Unary plus</td>
<td>+</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>Unary minus</td>
<td>-</td>
<td>3</td>
</tr>
<tr>
<td>Basic Arithmetic Operations</td>
<td>Multiplication</td>
<td>*</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Division</td>
<td>/</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Modulo function</td>
<td>MOD</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Integer division</td>
<td>DIV</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Addition</td>
<td>+</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>Subtraction</td>
<td>-</td>
<td>5</td>
</tr>
<tr>
<td>Comparison Operations:</td>
<td>Less than</td>
<td>&lt;</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Greater than</td>
<td>&gt;</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Less than or equal to</td>
<td>&lt;=</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Greater than or equal to</td>
<td>&gt;=</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Equal to</td>
<td>=</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Not equal to</td>
<td>&lt;&gt;</td>
<td>7</td>
</tr>
<tr>
<td>Logical Operations:</td>
<td>Negation</td>
<td>NOT</td>
<td>3</td>
</tr>
<tr>
<td>Basic Logical Operations</td>
<td>And</td>
<td>AND or &amp;</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Exclusive or</td>
<td>XOR</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Or</td>
<td>OR</td>
<td>10</td>
</tr>
<tr>
<td>Parentheses :</td>
<td>Parentheses</td>
<td>()</td>
<td>1</td>
</tr>
</tbody>
</table>
11.3 Addresses

Addresses are objects with which an expression can be formed. The following elements are permitted in addresses:

Address

- Constant
- Extended variable
- ( Expression)
- NOT Address

Constants

Constants can be a numerical value or a symbolic name or a character string.

Constant

- Numerical value
- Character string
- Constant name

The following are examples of valid constants:

4_711
4711
30.0
'CHARACTER'
FACTOR
Extended Variable

An extended variable is a generic term for a series of variables that are dealt with in more detail in the section entitled "Value Assignments".

Some examples of valid variables:

SETPOINT simple variable
IW10 absolute variable
I100.5 absolute variable
DB100.DW [INDEX] variable in the DB
MOTOR.SPEED variable in a local instance
SQR (20) standard function
FC192 (SETPOINT) function call

Note

In the case of a function call, the calculated result, the return value, is inserted in the expression in place of the function name. VOID functions that do not return a value are therefore not allowed as addresses in an expression.
11.4 Syntax of an Expression

Syntax

Result of an Expression

You can do the following with the result of an expression:

- Assign it to a variable.
- Use it as the condition for a control instruction.
- Use it as a parameter for calling a function or a function block.

Order of Evaluation

The order of evaluation of an expression depends on the following:

- The precedence of the operations involved
- The order from left to right
- The use of parentheses (if operations have the same precedence).
Rules

Expressions evaluate according to the following rules:

- An address between two operations with different precedence is always associated with the higher precedence operation.
- The operations are processed according to the hierarchical order.
- Operations with the same precedence are evaluated from left to right.
- Placing a minus sign before an identifier is the same as multiplying it by -1.
- Arithmetic operations must not follow each other directly. The expression \( a \times -b \) is invalid, whereas \( a \times (-b) \) is permitted.
- Parentheses can be used to overcome operation precedence; in other words, parentheses have the highest precedence.
- Expressions in parentheses are considered as a single address and always evaluated first.
- The number of left parentheses must match the number of right parentheses.
- Arithmetic operations cannot be used in conjunction with characters or logical data. Expressions such as 'A' + 'B' and \((n <= 0) + (m > 0)\) are incorrect.

Examples of Expressions

- IB10 // address
- A1 AND (A2) // logical expression
- (A3) < (A4) // comparison expression
- 3+3*4/2 // arithmetic expression
11.5 Simple Expression

In S7-SCL, a simple expression means a simple arithmetic expression. You can multiply or divide constant values in pairs and add or subtract these pairs.

Syntax of a simple expression

Syntax of simple multiplication

Example

\[
\text{SIMP\_EXPRESSION= A * B + D / C - 3 * VALUE1};
\]
11.6 Arithmetic Expressions

An arithmetic expression is an expression formed with arithmetic operations. These expressions allow numeric data types to be processed.

The following table shows all the possible operations and indicates the type to which the result belongs depending on the addresses. The following abbreviations are used:

- **ANY_INT** for data types INT, DINT
- **ANY_NUM** for data types ANY_INT and REAL

<table>
<thead>
<tr>
<th>Operation</th>
<th>Identifier</th>
<th>1st Address</th>
<th>2nd Address</th>
<th>Result</th>
<th>Precedence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>**</td>
<td>ANY_NUM</td>
<td>ANY_NUM</td>
<td>REAL</td>
<td>2</td>
</tr>
<tr>
<td>Unary plus</td>
<td>+</td>
<td>ANY_NUM</td>
<td>-</td>
<td>ANY_NUM</td>
<td>3</td>
</tr>
<tr>
<td>Unary minus</td>
<td>-</td>
<td>ANY_NUM</td>
<td>-</td>
<td>ANY_NUM</td>
<td>3</td>
</tr>
<tr>
<td>Multiplication</td>
<td>*</td>
<td>ANY_NUM</td>
<td>ANY_NUM</td>
<td>ANY_NUM</td>
<td>4</td>
</tr>
<tr>
<td>Division</td>
<td>/</td>
<td>ANY_NUM</td>
<td>ANY_NUM</td>
<td>ANY_NUM</td>
<td>4</td>
</tr>
<tr>
<td>Integer division</td>
<td>DIV</td>
<td>ANY_INT</td>
<td>ANY_INT</td>
<td>ANY_INT</td>
<td>4</td>
</tr>
<tr>
<td>Modulo division</td>
<td>MOD</td>
<td>ANY_INT</td>
<td>ANY_INT</td>
<td>ANY_INT</td>
<td>4</td>
</tr>
<tr>
<td>Addition</td>
<td>+</td>
<td>ANY_NUM</td>
<td>ANY_NUM</td>
<td>ANY_NUM</td>
<td>5</td>
</tr>
<tr>
<td>Subtraction</td>
<td>-</td>
<td>ANY_NUM</td>
<td>ANY_NUM</td>
<td>ANY_NUM</td>
<td>5</td>
</tr>
</tbody>
</table>

**Note**

The data type of the result of a division (/) depends on the data type of the higher-value address.

If, for example, two addresses of the data type INT are divided, the result is also of the data type (i.e., $10/3=3$ whereas $10.0/3=3.33$).
Expressions, Operations and Addresses

Rules

Operations in arithmetic expressions are handled in the order of their precedence.

- It is advisable to place negative numbers in brackets for the sake of clarity even in cases where it is not syntactically necessary.
- When dividing with two whole numbers of the type INT, the operations "DIV" and "/" produce the same result (see example below).
- In the division operations (`/`, `MOD` and `DIV`), the second address must not be not equal to zero.
- If one number is of the INT type (integer) and the other of the REAL type (real number), the result will always be of the REAL type.
- When data of the type DATE_AND_TIME and TIME are subtracted, the address of the data type TIME must always be positioned to the right of the operator "-".

Examples

// The result (11) of the arithmetic expression is assigned to the variable "VALUE"
VALUE1 := 3 + 3 * 4 / 2 - (7+3) / (-5) ;

// The VALUE of the following expression is 1
VALUE2 := 9 MOD 2 ;
11.7 Logical Expressions

A logical expression is an expression formed by logic operations.

Basic Logic Operations

Using the operations AND, &, XOR and OR, logical addresses (BOOL type) or variables of the data type BYTE, WORD or DWORD can be combined to form logical expressions. To negate a logical address, the NOT operation is used.

Basic Logic Operator

<table>
<thead>
<tr>
<th>Operation</th>
<th>Identifier</th>
<th>1st Address</th>
<th>2nd Address</th>
<th>Result</th>
<th>Precedence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Negation</td>
<td>NOT</td>
<td>ANY_BIT</td>
<td>-</td>
<td>ANY_BIT</td>
<td>3</td>
</tr>
<tr>
<td>Conjunction</td>
<td>AND</td>
<td>ANY_BIT</td>
<td>ANY_BIT</td>
<td>ANY_BIT</td>
<td>8</td>
</tr>
<tr>
<td>Exclusive disjunction</td>
<td>XOR</td>
<td>ANY_BIT</td>
<td>ANY_BIT</td>
<td>ANY_BIT</td>
<td>9</td>
</tr>
<tr>
<td>Disjunction</td>
<td>OR</td>
<td>ANY_BIT</td>
<td>ANY_BIT</td>
<td>ANY_BIT</td>
<td>10</td>
</tr>
</tbody>
</table>

Result:
The result of a logic expression is either
- 1 (true) or 0 (false) if Boolean addresses are combined, or
- A bit pattern corresponding to the combination of the two addresses.
Examples

// The result of the comparison expression is negated.
   IF NOT (COUNTER > 5) THEN . . . ;
// The result of the first comparison expression
// is negated and combined with the result of the second
   A := NOT (COUNTER1 = 4) AND (COUNTER2 = 10) ;
// Disjunction of two comparison expressions
   WHILE (A >= 9) OR (SCAN <> "n") DO.... ;
// Masking an input byte (bit operation)
   Result := IB10 AND 2#11100000 ;
11.8 Comparison Expressions

The comparison operations compare the values of two addresses and evaluate to a Boolean value. The result is TRUE if the comparison condition is true and FALSE if it fails.

Syntax

Comparison Operation

[<] [>] [<] [>=] [<=] [<>]

Rules

The following table lists the comparable data types and the rules applying during conversion:

<table>
<thead>
<tr>
<th>Data type</th>
<th>=</th>
<th>&lt;&gt;</th>
<th>&gt;0</th>
<th>&lt;0</th>
<th>&gt;</th>
<th>&lt;</th>
<th>Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>INT</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>All comparison operators are allowed within the class of the numerical data types. The operator with the higher-value type determines the type of the operation.</td>
</tr>
<tr>
<td>DINT</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>REAL</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>BOOL</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Only EQUAL TO and NOT EQUAL TO are allowed as comparison operators within the class of the bit data types. The operator with the higher-value type determines the type of the operation.</td>
</tr>
<tr>
<td>BYTE</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WORD</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DWORD</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data type</td>
<td>=</td>
<td>&lt;&gt;</td>
<td>&gt;0</td>
<td>&lt;0</td>
<td>&gt;</td>
<td>&lt;</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>---</td>
<td>----</td>
<td>----</td>
<td>----</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>CHAR</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>STRING</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>DATE</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>TIME</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>DT</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>TOD</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>S5-TIME</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

In the case of characters and strings the length of the variables and of the numerical value of each individual ASCII character is used for comparison.

At STRING the comparison is carried out internally through the functions EQ_STRING, GE_STRING, LE_STRING, GT_STRING and LT_STRING of the IEC library.

The following addresses are not permissible for these functions:
- Parameters of an FC.
- IN_OUT parameters of an FB of the type STRUCT or ARRAY.

At DT the comparison is carried out internally through the functions EQ_DT, GE_DT, LE_DT, GT_STRING and LT_DT of the IEC library.

The following addresses are not permissible for these functions:
- Parameters of an FC.
- IN_OUT parameters of an FB of the type STRUCT or ARRAY.

S5 TIME variables are not permitted as comparison addresses. S5TIME format must be converted explicitly to TIME using IEC functions.
Combining of comparison expressions

Comparison expressions can be combined according to the rules of Boolean logic to implement statements such as "if a < b and b < c then ....".

The operations are evaluated in the order of their precedence. The precedence can be changed by parentheses.

Examples

// Compare 3 LESS THAN OR EQUAL TO 4. The result is "TRUE"
A := 3 <= 4

// Compare 7 NOT EQUAL TO 7. The result is "FALSE"
7 <> 7

// Evaluation of a comparison expression in an IF statement
IF COUNTER < 5 THEN ....

// Combining of two comparison expressions
Value_A > 20 AND Value_B < 20

// Combining of two comparison expressions with bracketing
A<>(B AND C)
12 Statements

12.1 Value Assignments

When a value is assigned, the current value of a variable is replaced by a new value specified by an expression. This expression can also contain identifiers for functions that are activated by the statement and then return corresponding values (return value).

As shown in the diagram below, the expression on the right-hand side of the assignment operator is evaluated and the value obtained as the result is set in the variable whose name is on the left-hand side of the assignment operator. The variables permitted for this function are shown in the figure.

Syntax of a Value Assignment

The type of an assignment expression is the type of the left address. The simple variable can be a variable of an elementary or complex data type.
12.1.1 Value Assignments with Variables of an Elementary Data Type

Every expression and every variable of an elementary data type can be assigned the value of a different variable of the same type.

Identifier := Expression ;
Identifier := Variable ;

Example

FUNCTION_BLOCK FB12
VAR
  SWITCH_1 : INT ;
  SWITCH_2 : INT ;
  SETPOINT_1 : REAL ;
  SETPOINT_2 : REAL ;
  QUERY_1 : BOOL ;
  TIME_1 : S5TIME ;
  TIME_2 : TIME ;
  DATE_1 : DATE ;
  TIMEOFDAY_1 : TIME_OF_DAY ;
END_VAR
BEGIN
  // Assignment of a constant to a variable
  SWITCH_1 := -17 ;
  SETPOINT_1 := 100.1 ;
  QUERY_1 := TRUE ;
  TIME_1 := T#1H_20M_10S_30MS ;
  TIME_2 := T#2D_1H_20M_10S_30MS ;
  DATE_1 := D#1996-01-10 ;

  // Assignment of a variable to a variable
  SETPOINT_1 := SETPOINT_2 ;
  SWITCH_2 := SWITCH_1 ;

  // Assignment of an expression to a variable
  SWITCH_2 := SWITCH_1 * 3 ;
END_FUNCTION_BLOCK
12.1.2 Value Assignments with Variables of the Type STRUCT and UDT

Variables of the types STRUCT and UDT are structured variables that represent either a complete structure or a component of the structure. The following are examples of valid structure variables:

- `Image` //Identifier for a structure
- `Image.element` //Identifier for a structure component
- `Image.arr` //Identifier for a single array //within a structure
- `Image.arr[2,5]` //Identifier for an array component //within a structure

Assigning a Complete Structure

An entire structure can only be assigned to another structure when the structure components match each other both in terms of data type and name. The following assignments would be valid:

```plaintext
structname_1 := structname_2 ;
```

Assigning Structure Components

You can assign a variable of the same type, an expression of the same type or another structure component to any structure component.

You can reference a structure component by specifying the identifier of the structure and the identifier of the structure component separated by a period. The following assignments would be valid:

```plaintext
structname_1.element1 := Value ;
structname_1.element1 := 20.0 ;
structname_1.element1 := structname_2.element1 ;
structname_1.arrname1 := structname_2.arrname2 ;
structname_1.arrname[10] := 100 ;
```
Example

FUNCTION_BLOCK FB3
VAR
  AUXVAR : REAL ;
  MEASVAL : STRUCT //Target structure
    VOLTAGE:REAL ;
    RESISTANCE:REAL ;
    SIMPLEARR : ARRAY
      [1..2, 1..2] OF INT ;
  END_STRUCT ;
  PROCVAL : STRUCT //Source structure
    VOLTAGE : REAL ;
    RESISTANCE : REAL ;
    SIMPLEARR : ARRAY
      [1..2, 1..2] OF INT ;
  END_STRUCT ;
END_VAR
BEGIN
  //Assignment of a complete structure to a complete structure
  MEASVAL := PROCVAL ;
  //Assignment of a structure component to a structure component
  //to a structure component
  MEASVAL.VOLTAGE := PROCVAL.VOLTAGE ;
  //Assignment of a structure component to a variable
  //of the same type
  AUXVAR := PROCVAL.RESISTANCE ;
  //Assignment of a constant to a structure component
  MEASVAL.RESISTANCE := 4.5 ;
  //Assignment of a constant to a single array element
  MEASVAL.SIMPLEARR[1,2] := 4 ;
END_FUNCTION_BLOCK
12.1.3 Value Assignments with Variables of the Type ARRAY

An array consists of one up to a maximum of six dimensions and contains elements that are all of the same type. To assign arrays to a variable there are two access variants. You can reference complete arrays or a component of an array.

Assigning a Complete Array

A complete array can be assigned to another array when both the data types of the components and the array limits (lowest and highest possible array indexes) match. If this is the case, specify the identifier of the array after the assignment operator. The following assignments would be valid:

```
arrname_1 := arrname_2 ;
```

**Note**

Take into account that constants cannot be assigned to complete arrays.

Assigning a Component of an Array

A single component of an array is addressed using the array name followed by suitable index values in square braces. An index is available for each dimension. These are separated by commas and also enclosed in square brackets. An index must be an arithmetic expression of the data type INT.

To obtain a value assignment for a permitted component, you omit indexes starting at the right in the square braces after the name of the array. In this way, you address a subset of the array whose number of dimensions is equal to the number of indexes omitted. The following assignments would be valid:

```
arrname_1[ i ] := arrname_2[ j ] ;
arrname_1[ i ] := expression ;
identifier_1 := arrname_1[ i ] ;
```
Example

FUNCTION_BLOCK FB3
VAR
SETPOINTS : ARRAY [0..127] OF INT ;
PROCVALS : ARRAY [0..127] OF INT ;
// Declaration of a matrix (=two-dimensional array)
// with 3 rows and 4 columns
CRTLLR : ARRAY [1..3, 1..4] OF INT ;
// Declaration of a vector (=one-dimensional array)
// with 4 components
CRTLLR_1 : ARRAY [1..4] OF INT ;
END_VAR

BEGIN
// Assignment of a complete array to an array
SETPOINTS := PROCVALS ;
// Assignment of a vector to the second row
// of the CRTLLR array
CRTLLR[2] := CRTLLR_1 ;
// Assignment of a component of an array to a component
// of the CRTLLR array
END_FUNCTION_BLOCK
12.1.4 Value Assignments with Variables of the Data Type STRING

A variable of the data type STRING contains a character string with a maximum of 254 characters. Each variable of the STRING data type can be assigned another variable of the same type. The following assignments would be valid:

```
stringvariable_1 := stringconstant;
stringvariable_1 := stringvariable_2;
```

Example

FUNCTION_BLOCK FB3
VAR
  DISPLAY_1 : STRING[50];
  STRUCTURE1 : STRUCT
    DISPLAY_2 : STRING[100];
    DISPLAY_3 : STRING[50];
  END_STRUCT;
END_VAR
BEGIN
  // Assignment of a constant to a STRING variable
  DISPLAY_1 := 'Error in module 1';
  // Assignment of a structure component to a STRING variable.
  DISPLAY_1 := STRUCTURE1.DISPLAY_3;
  // Assignment of a STRING variable to a STRING variable
  IF DISPLAY_1 <> STRUCTURE1.DISPLAY_3 THEN
    DISPLAY_1 := STRUCTURE1.DISPLAY_3;
  END_IF;
END_FUNCTION_BLOCK
12.1.5 Value Assignments with Variables of the Type DATE_AND_TIME

The data type DATE_AND_TIME defines an area with 64 bits (8 bytes) for the date and time. Each variable of the data type DATE_AND_TIME can be assigned another variable of the same type or a constant. The following assignments would be valid:

\[
\text{dtvariable}_1 := \text{date and time constant;}
\]
\[
\text{dtvariable}_1 := \text{dtvariable}_2 ;
\]

Example

FUNCTION_BLOCK FB3
VAR
  TIME_1 : DATE_AND_TIME ;
  STRUCTURE1 : STRUCT
    TIME_2 : DATE_AND_TIME ;
    TIME_3 : DATE_AND_TIME ;
  END_STRUCT ;
END_VAR
BEGIN
  // Assignment of a constant to a DATE_AND_TIME variable
  TIME_1 := DATE_AND_TIME#1995-01-01-12:12:12.2 ;
  STRUCTURE1.TIME_3 := DT#1995-02-02-11:11:11 ;
  // Assignment of a structure component to a DATE_AND_TIME variable.
  TIME_1 := STRUCTURE1.TIME_2 ;
  // Assignment of a DATE_AND_TIME variable to a DATE_AND_TIME variable
  IF TIME_1 < STRUCTURE1.TIME_3 THEN
    TIME_1 := STRUCTURE1.TIME_3 ;
  END_IF ;
END_FUNCTION_BLOCK
12.1.6 Value Assignments with Absolute Variables for Memory Areas

An absolute variable references the memory areas of a CPU with global scope. You can access these areas in three ways:

- Absolute Access
- Indexed Access
- Symbolic Access

Syntax of Absolute Variables

Absolute Variable

```
Memory prefix | Size prefix | Address identifier
```

Example

```
FUNCTION_BLOCK FB3
VAR
  STATUSWORD1 : WORD ;
  STATUSWORD2 : BOOL ;
  STATUSWORD3 : BYTE ;
  STATUSWORD4 : BOOL ;
  ADDRESS : INT ;
END_VAR
BEGIN
  ADDRESS := 10 ;
  // Assignment of an input word to a variable (simple access)
  STATUSWORD1 := IW4 ;
  // Assignment of a variable to an output bit (simple access)
  a1.1 := STATUSWORD2 ;
  // Assignment of an input byte to a variable (indexed access)
  STATUSWORD3 := IB[ADDRESS] ;
  // Assignment of an input bit to a variable (indexed access)
  FOR ADDRESS := 0 TO 7 BY 1 DO
    STATUSWORD4 := e[1, ADDRESS] ;
  END_FOR ;
END_FUNCTION_BLOCK
```
12.1.7 Value Assignments with Shared Variables

You also access data in data blocks by assigning a value to variables of the same type or vice-versa. You can assign any global variable a variable or expression of the same type. There are several ways in which you can access this data:

- Structured Access
- Absolute Access
- Indexed Access

Syntax of the DB Variable

```
DB Variable
```

\[ DB \text{ IDENTIFIER} \quad D \quad \text{Size prefix} \quad \text{Address} \]
Example

FUNCTION_BLOCK FB3
VAR
   CRTLLR_1 : ARRAY [1..4] OF INT ;
   STATUSWORD1 : WORD ;
   STATUSWORD2 : ARRAY [0..10] OF WORD ;
   STATUSWORD3 : INT ;
   STATUSWORD4 : WORD ;
   ADDRESS : INT ;
END_VAR
VAR_INPUT
   ADDRESSWORD : WORD ;
END_VAR
BEGIN
   // Assignment of word 1 from DB11
   // to a variable (simple access)
   STATUSWORD1 := DB11.DW1 ;
   // The array component in the 1st row and
   // 1st column of the matrix is assigned the value
   // of the "NUMBER" variable (structured access):
   CRTLLR_1[1] := DB11.NUMBER ;
   // Assignment of structure component "NUMBER2"
   // of structure "NUMBER1" to the variable status word3
   STATUSWORD3 := DB11.NUMBER1.NUMBER2 ;
   // Assignment of a word with index address
   // from DB11 to a variable (indexed access)
   FOR
      ADDRESS := 1 TO 10 BY 1 DO
         STATUSWORD2[ADDRESS] := DB11.DW[ADDRESS] ;
         // Here the input parameter ADDRESSWORD as number
         // of the DB and
         // the index ADDRESS are used to specify
         // the word address
         // within the DB.
         STATUSWORD4 :=
            WORD_TO_BLOCK_DB(ADDRESSWORD).DW[ADDRESS] ;
   END_FOR ;
END_FUNCTION_BLOCK
12.2 Control Statements

12.2.1 Overview of Control Statements

Selective Statements
A selective statement enables you to direct program execution into alternative sequences of statements.

<table>
<thead>
<tr>
<th>Types of Branch</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>IF Statement</td>
<td>The IF statement enables you to direct program execution into one of two alternative branches depending on a condition being TRUE or FALSE.</td>
</tr>
<tr>
<td>CASE Statement</td>
<td>The CASE statement enables you to direct program execution into 1 of n alternative branches based on the value of a variable.</td>
</tr>
</tbody>
</table>

Loops
You can control loop execution using iteration statements. An iteration statement specifies which parts of a program should be iterated depending on certain conditions.

<table>
<thead>
<tr>
<th>Types of Branch</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>FOR Statement</td>
<td>Used to repeat a sequence of statements for as long as the control variable remains within the specified value range</td>
</tr>
<tr>
<td>WHILE Statement</td>
<td>Used to repeat a sequence of statements while an execution condition continues to be satisfied</td>
</tr>
<tr>
<td>REPEAT Statement</td>
<td>Used to repeat a sequence of statements until a terminate condition is met</td>
</tr>
</tbody>
</table>

Program Jump
A program jump means an immediate jump to a specified jump destination and therefore to a different statement within the same block.

<table>
<thead>
<tr>
<th>Types of Branch</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONTINUE Statement</td>
<td>Used to stop execution of the current loop iteration.</td>
</tr>
<tr>
<td>EXIT Statement</td>
<td>Used to exit a loop at any point regardless of whether the terminate condition is satisfied or not</td>
</tr>
<tr>
<td>GOTO Statement</td>
<td>Causes the program to jump immediately to a specified label</td>
</tr>
<tr>
<td>RETURN Statement</td>
<td>Causes the program to exit the block currently being executed</td>
</tr>
</tbody>
</table>
12.2.2 Conditions

The condition is either a comparison expression, a logical expression or an arithmetic expression. It is of the type BOOL and can have the values TRUE or FALSE. Arithmetic expressions are TRUE if they result in a value other than 0 and FALSE when they result in the value 0. The table below shows examples of conditions:

<table>
<thead>
<tr>
<th>Type</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comparison expression</td>
<td>TEMP &gt; 50</td>
</tr>
<tr>
<td></td>
<td>COUNTER &lt;= 100</td>
</tr>
<tr>
<td></td>
<td>CHAR1 &lt; 'S'</td>
</tr>
<tr>
<td>Comparison and logical expression</td>
<td>(ALPHA &lt;&gt; 12) AND NOT BETA</td>
</tr>
<tr>
<td>Boolean address</td>
<td>I 1.1</td>
</tr>
<tr>
<td>Arithmetic expression</td>
<td>ALPHA = (5 + BETA)</td>
</tr>
</tbody>
</table>
12.2.3 IF Statements

The IF statement is a conditional statement. It provides one or more options and selects one (or none) of its statement components for execution.

Execution of the conditional statement evaluates the specified logical expressions. If the value of an expression is TRUE then the condition is satisfied, if it is FALSE the condition is not satisfied.

Syntax

An IF statement is executed according to the following rules:

- The first sequence of statements whose logical expression = TRUE is executed. The remaining sequences of statements are not executed.
- If no Boolean expression = TRUE, the sequence of statements introduced by ELSE is executed (or no sequence of statements if the ELSE branch does not exist).
- Any number of ELSIF statements can exist.

Note

Using one or more ELSIF branches has the advantage that the logical expressions following a valid expression are no longer evaluated in contrast to a sequence of IF statements. The runtime of a program can therefore be reduced.
Example

IF I1.1 THEN
    N := 0 ;
    SUM := 0 ;
    OK := FALSE ;  // Set OK flag to FALSE
ELSIF START = TRUE THEN
    N := N + 1 ;
    SUM := SUM + N ;
ELSE
    OK := FALSE ;
END_IF ;
12.2.4 CASE Statement

The CASE statement is used to select one of several alternative program sections. This choice is based on the current value of a selection expression.

Syntax

The CASE statement is executed according to the following rules:

- The selection expression must return a value of the type INTEGER.
- When a CASE statement is processed, the program checks whether the value of the selection expression is contained within a specified list of values. If a match is found, the statement component assigned to the list is executed.
- If no match is found, the program section following ELSE is executed or no statement is executed if the ELSE branch does not exist.
Value List

This contains the values permitted for the selection expression.

The following rules apply to the value list:

- Each value list begins with a constant, a list of constants or a range of constants.
- The values within the value list must be of the type INTEGER.
- Each value must only occur once.

Value

The value has the syntax shown below:

Example

```plaintext
CASE TW OF
  1 : DISPLAY:= OVEN_TEMP;
  2 : DISPLAY:= MOTOR_SPEED;
  3 : DISPLAY:= GROSS_TARE;
      QW4 := 16#0003;
  4..10: DISPLAY:= INT_TO_DINT (TW);
        QW4 := 16#0004;
  11,13,19: DISPLAY:= 99;
           QW4 := 16#0005;
ELSE:
  DISPLAY:= 0;
  TW_ERROR:= 1;
END_CASE ;
```
12.2.5 FOR Statement

A FOR statement is used to repeat a sequence of statements as long as a control variable is within the specified range of values. The control variable must be the identifier of a local variable of the type INT or DINT. The definition of a loop with FOR includes the specification of an initial and an end value. Both values must be the same type as the control variable.

Syntax

The FOR statement executes as follows:

- At the start of the loop, the control variable is set to the initial value (initial assignment) and each time the loop iterates, it is incremented by the specified increment (positive increment) or decremented (negative increment) until the final value is reached.
- Following each run through of the loop, the condition is checked (final value reached) to establish whether or not it is satisfied. If the condition is satisfied, the sequence of statements is executed, otherwise the loop and with it the sequence of statements is skipped.

Rules

Rules for formulating FOR statements

- The control variable may only be of the data type INT or DINT.
- You can omit the statement BY [increment]. If no increment is specified, it is automatically assumed to be +1.
**Initial Assignment**

The initial value of the control variable must have the following syntax. The simple variable on the left of the assignment must be data type INT or DINT.

**Initial Assignment**

![Diagram of Initial Assignment](image)

Examples of valid initial assignments:

```
FOR I := 1 TO 20
FOR I := 1 TO (START + J)
```

**Final Value and Increment**

You can write a basic expression for the final value and the required increment. This basic expression must have the following syntax:

![Diagram of Final Value and Increment](image)

- You can omit the statement `BY [increment]`. If no increment is specified, it is automatically assumed to be +1.
- The initial value, final value and increment are expressions (see "Expressions, Operations and Addresses"). It is evaluated once at the start when the FOR statement is executed.
- Alteration of the values for final value and increment is not permitted while the loop is executing.
Statements

Example

FUNCTION_BLOCK FOR_EXA
VAR
   INDEX: INT;
   IDWORD: ARRAY [1..50] OF STRING;
END_VAR
BEGIN
FOR INDEX := 1 TO 50 BY 2 DO
   IF IDWORD [INDEX] = 'KEY' THEN
      EXIT;
   END_IF;
END_FOR;
END_FUNCTION_BLOCK

12.2.6 WHILE Statement

The WHILE statement allows the repeated execution of a sequence of statements controlled by an execution condition. The execution condition is formed according to the rules for logical expressions.

Syntax

WHILE Statement

WHILE Expression DO  END_WHILE

Execution condition  Statement section

The WHILE statement executes according to the following rules:

- Prior to each iteration of the loop body, the execution condition is evaluated.
- The loop body following DO iterates as long as the execution condition has the value TRUE.
- Once the value FALSE occurs, the loop is skipped and the statement following the loop is executed.
Example

FUNCTION_BLOCK WHILE_EXA
VAR
  INDEX: INT ;
  IDWORD: ARRAY [1..50] OF STRING ;
END_VAR
BEGIN
  INDEX := 1 ;
  WHILE INDEX <= 50 AND IDWORD[INDEX] <> 'KEY' DO
    INDEX := INDEX + 2;
  END_WHILE ;
END_FUNCTION_BLOCK
12.2.7 REPEAT Statement

A REPEAT statement causes the repeated execution of a sequence of statements between REPEAT and UNTIL until a terminate condition occurs. The terminate condition is formed according to the rules for logical expressions.

Syntax

REPEAT Statement

![Diagram of REPEAT Statement]

The condition is evaluated after the loop body has been executed. This means that the loop body must be executed at least once even if the termination condition is satisfied when the loop is started.

Example

```
FUNCTION_BLOCK REPEAT_EXA
  VAR
    INDEX: INT;
    IDWORD: ARRAY [1..50] OF STRING;
  END_VAR

  BEGIN
    INDEX := 0;
    REPEAT
      INDEX := INDEX + 2;
      UNTIL INDEX > 50 OR IDWORD[INDEX] = 'KEY'
    END_REPEAT;

  END_FUNCTION_BLOCK
```
12.2.8 CONTINUE Statement

A CONTINUE statement is used to terminate the execution of the current iteration of a loop statement (FOR, WHILE or REPEAT).

Syntax

```
CONTINUE
```

The CONTINUE statement executes according to the following rules:

- This statement immediately terminates execution of a loop body.
- Depending on whether the condition for repeating the loop is satisfied or not the body is executed again or the iteration statement is exited and the statement immediately following is executed.
- In a FOR statement, the control variable is incremented by the specified increment immediately after a CONTINUE statement.

Example

```
FUNCTION_BLOCK CONTINUE_EXA
VAR
  INDEX : INT ;
  ARRAY : ARRAY[1..100] OF INT ;
END_VAR
BEGIN
  INDEX := 0 ;
  WHILE INDEX <= 100 DO
    INDEX := INDEX + 1 ;
    // If ARRAY[INDEX] is equal to INDEX,
    // then ARRAY [INDEX] is not changed:
    IF ARRAY[INDEX] = INDEX THEN
      CONTINUE ;
    END_IF ;
    ARRAY[INDEX] := 0 ;
    // Further statements
  END_WHILE ;
END_FUNCTION_BLOCK
```
12.2.9 **EXIT Statement**

An EXIT statement is used to exit a loop (FOR, WHILE or REPEAT) at any point regardless of whether the terminate condition is satisfied.

**Syntax**

```plaintext
EXIT
```

The EXIT statement executes according to the following rules:

- This statement causes the repetition statement immediately surrounding the exit statement to be exited immediately.
- Execution of the program is continued after the end of the loop (for example after END_FOR).

**Example**

```plaintext
FUNCTION_BLOCK EXIT_EXA
VAR
   INDEX_1 : INT ;
   INDEX_2 : INT ;
   INDEX_SEARCH : INT ;
   IDWORD : ARRAY[1..51] OF STRING ;
END_VAR
BEGIN
   INDEX_2 := 0 ;
   FOR INDEX_1 := 1 TO 51 BY 2 DO
      // Exit the FOR loop, if
      // IDWORD[INDEX_1] is equal to 'KEY':
      IF IDWORD[INDEX_1] = 'KEY' THEN
         INDEX_2 := INDEX_1 ;
         EXIT ;
      END_IF ;
   END_FOR ;
   // The following value assignment is made
   // after executing EXIT or after the
   // regular end of the FOR loop:
   INDEX_SEARCH := INDEX_2 ;
END_FUNCTION_BLOCK
```
12.2.10 GOTO Statement

You can implement a program jump using the GOTO statement. This causes an immediate jump to the specified label and therefore to a different statement within the same block.

GOTO statements should only be used in special situations, for example in error handling. According to the rules of structured programming, the GOTO statement should not be used.

Syntax

Here, label is a label in the LABEL/END_LABEL declaration section. This label precedes the statement that will be executed next after the GOTO statement.

If you use the GOTO statement, remember the following rules:

- The destination of the jump must be in the same block.
- The destination of the jump must be uniquely identified.
- It is not possible to jump to a loop section. It is possible to jump from within a loop.
Example

FUNCTION_BLOCK GOTO_EXA
VAR
  INDEX : INT ;
  A : INT ;
  B : INT ;
  C : INT ;
  IDWORD : ARRAY[1..51] OF STRING ;
END_VAR
LABEL
  LAB1, LAB2, LAB3 ;
END_LABEL
BEGIN
  IF A > B THEN
    GOTO LAB1 ;
  ELSIF A > C THEN
    GOTO LAB2 ;
  END_IF ;
  // . . .
  LAB1: INDEX := 1 ;
        GOTO LAB3 ;
  LAB2: INDEX := 2 ;
        // . . .
  LAB3:
        // . . .

12.2.11 RETURN Statement

A RETURN statement exits the currently active block (OB, FB, FC) and returns to the calling block or to the operating system, when an OB is exited.

Syntax

RETURN Statement

Note

A RETURN statement at the end of the code section of a logic block or the declaration section of a data block is redundant since this is automatically executed.
12.3 Calling of Functions and Function Blocks

12.3.1 Call and Parameter Transfer

Calling FCs and FBs

To make it easier to read and update user programs, the functions of the program are divided into smaller individual tasks that are performed by function blocks (FBs) and functions (FCs). You can call other FCs and FBs from within an S7-SCL block. You can call the following blocks:

- Function blocks and functions created in S7-SCL
- Function blocks and functions created in other STEP 7 languages (LAD, FBD, STL)
- System functions (SFCs) and system function blocks (SFBs) available in the operating system of the CPU.

Basic Principle of Parameter Transfer

When functions or function blocks are called, data is exchanged between the calling and the called block. Parameters are defined in the interface of the called block with which the block works. These parameters are known as formal parameters. They are merely "placeholders" for the parameters that are passed to the block when it is called. The parameters passed to the block are known as actual parameters.

Syntax of Parameter Transfer

The parameters that are to be transferred must be specified in the call in the form of a parameter list. The parameters are enclosed in brackets. A number of parameters are separated by commas.

In the example of a function call below, an input parameter, an in/out parameter and an output parameter are specified.

<table>
<thead>
<tr>
<th>Formal Parameter</th>
<th>Actual Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>I_Par</td>
</tr>
<tr>
<td>LENGTH</td>
<td>IO_Par</td>
</tr>
<tr>
<td>Digitsum</td>
<td>O_Par</td>
</tr>
</tbody>
</table>

The parameters are specified in the form of a value assignment. That value assignment assigns a value (actual parameter) to the parameters defined in the declaration section of the called block (formal parameters).
12.3.2 Calling Function Blocks

12.3.2.1 Calling Function Blocks (FB or SFB)

When you call a function block, you can use both shared instance data blocks and local instance areas of the currently active instance data block.

Calling an FB as a local instance differs from the call as a shared instance in the way in which the data are stored. Here, the data are not saved in a special DB but in the instance data block of the calling FB.

Syntax

Function Block Call

FB: Function block
SFB: System function block

Call as a Shared Instance

The call is made in a call statement by specifying the following:

- The name of the function block or system function block (FB or SFB identifier),
- The instance data block (DB identifier),
- The parameter supply (FB parameter).

A function call for a shared instance can be either absolute or symbolic.
Statements

Absolute function call:
FB10.DB20 (X1:=5,X2:=78,......);

Symbolic function call:
DRIVE.ON (X1:=5,X2:=78,......);

Call as a Local Instance
The call is made in a call statement by specifying the following:
• The local instance name (IDENTIFIER)
• The parameter supply (FB parameters)

A call for a local instance is always symbolic. You must declare the symbolic name in the declaration section of the calling block.

MOTOR (X1:=5,X2:=78,......);

12.3.2.2 Supplying FB Parameters
When calling a function block (as a shared or local instance) you must supply the following parameters:
• Input Parameters
• In/out parameters

The output parameters do not have to be specified when an FB is called.

Syntax of a Value Assignment for Defining FB Parameters
The syntax of the FB parameter specification is the same when calling shared or local instances.

The following rules apply when supplying parameters:
The assignments can be in any order.
The data types of formal and actual parameters must match.
The assignments are separated by commas.
Output assignments are not possible in FB calls. The value of a declared output parameter is stored in the instance data. From there it can be accessed by all FBs. To read an output parameter, you must define the access from within an FB.
Remember the special features for parameters of the ANY data type and POINTER data type.

Result after Executing the Block
After executing the block:
• The actual parameters transferred are unchanged.
• The transferred and modified values of the in/out parameters have been updated; In/out parameters of an elementary data type are an exception to this rule.
• The output parameters can be read by the calling block from the shared instance data block or the local instance area.

Example
A call with an assignment for an input and an in/out parameter could, for example, appear as follows:

FB31.DB77(I_Par:=3, IO_Par:=LENGTH);

12.3.2.3 Input Assignment (FB)
The input assignments assign actual parameters to the formal parameters. The FB cannot change these actual parameters. The assignment of actual input parameters is optional. If no actual parameter is specified, the values of the last call are retained.
Possible actual parameters are shown below:

<table>
<thead>
<tr>
<th>Actual Parameter</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expression</td>
<td>• Arithmetic, logical or comparison expression</td>
</tr>
<tr>
<td></td>
<td>• Constant</td>
</tr>
<tr>
<td></td>
<td>• Extended variable</td>
</tr>
<tr>
<td>TIMER/COUNTER identifier</td>
<td>Defines a specific timer or counter to be used when a block is processed</td>
</tr>
</tbody>
</table>
## Actual Parameter Explanation

<table>
<thead>
<tr>
<th>Actual Parameter</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>BLOCK identifier</td>
<td>Defines a specific block to be used as an input parameter. The block type (FB, FC or DB) is specified in the input parameter declaration. When assigning parameter values you specify the block number. You can specify this in absolute or symbolic form.</td>
</tr>
</tbody>
</table>

### Syntax

In the syntax diagram, the actual parameter `IDENTIFIER` represents the parameter name of the input parameter (formal parameter).

### 12.3.2.4 In/Out Assignment (FB)

In/out assignments are used to assign actual parameters to the formal in/out parameters. The called FB can modify the in/out parameters. The new value of a parameter that results from processing the FB is written back to the actual parameters. The original value is overwritten.

If in/out parameters are declared in the called FB, they must be supplied with values when the block is called the first time. When it is executed again, specifying actual parameters is optional. With in/out parameters of an elementary data type, there is no updating of the actual parameter if the formal parameter is not supplied with a value when the block is called.

Since the assigned actual parameter as an in/out parameter can be changed while the FB is being executed, it must be a variable.

<table>
<thead>
<tr>
<th>Actual Parameter</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| Extended Variable | The following types of extended variable are possible:  
  - Simple variables and parameters  
  - Access to absolute variables  
  - Access to data blocks  
  - Function calls |
Syntax

In/Out Assignment

![Diagram showing In/Out Assignment]

Note

- Special rules apply to supplying values for the data types ANY and POINTER.
- The following cannot be used as actual parameters for an in/out parameter of a non elementary data type:
  - FB in/out parameters
  - FC parameters

12.3.2.5 Reading Output Values (FB Call)

After the called block has been executed, the output parameters can be read from the shared instance block or the local instance area using a value assignment.

Example

RESULT := DB10.CONTROL;

12.3.2.6 Example of a Call as a Shared Instance

An example of a function block with a FOR loop might appear as shown in the following examples. These examples assume that the symbol TEST has been declared in the symbol table for FB17.

Function Block

FUNCTION_BLOCK TEST

VAR_INPUT
  FINALVAL: INT; //Input parameter
END_VAR
VAR_IN_OUT
  IQ1 : REAL; //In_out parameter
END_VAR
VAR_OUTPUT
  CONTROL: BOOL; //Output parameter
END_VAR
VAR
INDEX: INT;
END_VAR

BEGIN
CONTROL :=FALSE;
FOR INDEX := 1 TO FINALVAL DO
  IQ1 := IQ1*2;
  IF IQ1 > 10000 THEN
    CONTROL := TRUE;
  END_IF;
END_FOR;
END_FUNCTION_BLOCK

Call

To call the FB, you can choose one of the following variants. It is assumed that VARIABLE1 has been declared in the calling block as a REAL variable.

//Absolute function call, shared instance:
FB17.DB10 (FINALVAL:=10, IQ1:=VARIABLE1);

//Symbolic call, shared instance:
TEST.TEST_1 (FINALVAL:=10, IQ1:= VARIABLE1);

Result:

After the block has executed, the value calculated for the in/out parameter IQ1 is available in VARIABLE1.

Reading an Output Value

The two examples below illustrate the two possible ways of reading the output parameter CONTROL.

// The output parameter is accessed
//by:
RESULT:= DB10.CONTROL;

//You can also use the output parameter
//directly in another FB call to
//supply an input parameter:
FB17.DB12 (INP_1:=DB10.CONTROL);

12.3.2.7 Example of a Call as a Local Instance

A function block with a simple FOR loop could be programmed as in the example "Call as a Shared Instance" assuming that the symbol TEST is declared in the symbol table for FB17.

This FB can be called as shown below, assuming that VARIABLE1 has been declared in the calling block as a REAL variable.
Call

FUNCTION_BLOCK CALL
VAR
  // Local instance declaration
  TEST_L : TEST;
  VARIABLE1 : REAL;
  RESULT : BOOL;
END_VAR
BEGIN
. . .

// Call local instance:
TEST_L (FINALVAL:= 10, IQ1:= VARIABLE1);

Reading an Output Value

The CONTROL output parameter can be read as follows:
// The output parameter is accessed
// by:
RESULT := TEST_L.CONTROL;
END_FUNCTION_BLOCK

12.3.3 Calling Functions

12.3.3.1 Calling Functions (FC)

You call a function by specifying the function name (FC, SFC IDENTIFIER) and the parameter list. You can specify the function name that identifies the return value in absolute or symbolic form:

FC31 (X1:=5, Q1:=Checksum) ; // Absolute
DISTANCE (X1:=5, Q1:=Checksum) ; // Symbolic

After the call, the results of the function are available as a return value or as output and in/out parameters (actual parameters).
Syntax

Function Call

Note

If a function is called in S7-SCL and its return value was not supplied, this can lead to incorrect execution of the user program:

- This can occur with a function programmed in S7-SCL when the return value was supplied but the corresponding statement was not executed.
- This can occur in a function programmed in STL/LAD/FBD, if the function was programmed without the supply of the return value or the corresponding statement was not executed.
12.3.3.2 Return Value (FC)

In contrast to function blocks, functions supply a result known as the return value. For this reason, functions can be treated as addresses (exception: functions of the type VOID).

The function calculates the return value that has the same name as the function and returns it to the calling block. There, the value replaces the function call.

In the following value assignment, for example, the DISTANCE function is called and the result assigned to the LENGTH variable:

\[
\text{LENGTH} := \text{DISTANCE (X1:=-3, Y1:=2)};
\]

The return value can be used in the following elements of an FC or FB:

- in a value assignment,
- in a logic, arithmetic or comparison expression or
- as a parameter for a further function block or function call.

**Note**

- If functions have the return value ANY, at least one input or in/out parameter must also be of the type ANY. If more than one ANY parameter is defined, you must supply them with actual parameters of the same type class (for example, INT, DINT and REAL). The return value is then automatically of the largest used data type in this type class.
- The maximum length of the data type STRING can be reduced from 254 characters to any length.
12.3.3.3 FC Parameters

In contrast to function blocks, functions do not have any memory in which they could save the values of the parameters. Local data is only stored temporarily while the function is active. For this reason, when you call a function, all formal input, in/out and output parameters defined in the declaration section of a function must be assigned actual parameters.

Syntax

![Syntax Diagram]

Rules

Rules for supplying parameters

- The assignments can be in any order.
- The data types of formal and actual parameters must match.
- The data type of formal and actual parameters must match.

Example

A call with an assignment for an input, output and an in/out parameter could, for example appear as follows:

```plaintext
FC32 (E_Param1:=5, D_Param1:=LENGTH, A_Param1:=Checksum)
```
12.3.3.4 Input Assignment (FC)

Using input assignments, the formal input parameters of the called FC are assigned values (actual parameters). The FC can work with these actual parameters but cannot change them. In contrast to an FB call, this assignment is not optional with an FC call.

The following actual parameters can be assigned in input assignments:

<table>
<thead>
<tr>
<th>Actual Parameter</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| Expression       | An expression represents a value and consists of addresses and operations. The following types of expression are possible:  
• Arithmetic, logical or comparison expression  
• Constant  
• Extended Variable |
| TIMER/COUNTER Name | Defines a specific timer or counter to be used when a block is processed |
| BLOCK Name       | Defines a specific block to be used as an input parameter. The block type (FB, FC or DB) is specified in the input parameter declaration. When assigning parameters, you specify the block address. You can use either the absolute or the symbolic address. |

Syntax

```
Expression := TIMER IDENTIFIER BLOCK IDENTIFIER COUNTER IDENTIFIER  
```

Note

With formal input parameters of a non-elementary type, FB in/out parameters and FC parameters are not permitted as actual parameters. Remember the special features for the data types ANY and POINTER.
### 12.3.3.5 Output and In/Out Assignment (FC)

In an output assignment, you specify the variable of the calling block into which the output values resulting from executing a function will be written. An in/out assignment is used to assign an actual value to an in/out parameter.

The actual parameters in output and in/out assignments must be variables since the FC writes values to the parameters. For this reason, input parameters cannot be assigned in in/out assignments (the value could not be written). This means that only extended variables can be assigned in output and in/out assignments.

<table>
<thead>
<tr>
<th>Actual Parameter</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extended Variable</td>
<td>The following types of extended variable are possible:</td>
</tr>
<tr>
<td></td>
<td>• Simple variables and parameters</td>
</tr>
<tr>
<td></td>
<td>• Access to absolute variables</td>
</tr>
<tr>
<td></td>
<td>• Access to data blocks</td>
</tr>
<tr>
<td></td>
<td>• Function calls</td>
</tr>
</tbody>
</table>

### Syntax

**Out Assignments**

- IDENTIFIER
- Parameter name of the output parameter (formal parameter)
- Extended variable
- Actual parameter

**In/Out Assignments**

- IDENTIFIER
- Parameter name of the in/out parameter (formal parameter)
- Extended variable
- Actual parameter

### Note

The following actual parameters are not permitted with formal output or in/out parameters:

- FC/FB input parameters
- FB in/out parameters of a non-elementary data type
- FC in/out parameters and output parameters of a non-elementary data type
- Remember the special features for the data types ANY and POINTER.
- The maximum length of the data type STRING can be reduced from 254 characters to any length.
12.3.3.6 Example of a Function Call

Function to be Called

A function DISTANCE for calculating the distance between two points \((X_1,Y_1)\) and \((X_2,Y_2)\) in the same plane using the Cartesian system of coordinates might take the following form (the examples assume that the symbol DISTANCE has been declared in a symbol table for FC37).

```plaintext
FUNCTION DISTANCE: REAL // symbolic
VAR_INPUT
   X1: REAL;
   X2: REAL;
   Y1: REAL;
   Y2: REAL;
END_VAR
VAR_OUTPUT
   Q2: REAL;
END_VAR
BEGIN
   DISTANCE:= SQRT( (X2-X1)**2 + (Y2-Y1)**2 );
   Q2:= X1+X2+Y1+Y2;
END_FUNCTION
```

Calling Block

The examples below show more options for further use of a function value:

```plaintext
FUNCTION_BLOCK CALL
VAR
   LENGTH : REAL ;
   CHECKSUM : REAL ;
   RADIUS : REAL;
   Y : REAL;
END_VAR
BEGIN
   . . .
   // Call in a value assignment:
   LENGTH := DISTANCE (X1:=3, Y1:=2, X2:=8.9, Y2:= 7.4,
   Q2:=CHECKSUM) ;
   //Call in an arithmetic or logic expression, for example,
   Y := RADIUS + DISTANCE (X1:=-3, Y1:=2, X2:=8.9,
   Y2:=7.4, Q2:=Checksum)
   //Use in the parameter supply of a further called block
   FB32.DB32 (DIST:= DISTANCE (X1:=-3, Y1:=2, X2:=8.9,
   Y2:=7.4), Q2:=Checksum)
   . . .
END_FUNCTION_BLOCK
```
12.3.4 Implicitly Defined Parameters

12.3.4.1 Input Parameter EN

Every function block and every function has the implicitly defined input parameter EN. EN is of the data type BOOL and is stored in the temporary block data area. If EN is TRUE, the called block is executed. Otherwise it is not executed. Supplying a value for the parameter EN is optional. Remember, however, that it must not be declared in the declaration section of a block or function.

Since EN is an input parameter, you cannot change EN within a block.

---

Note

The return value of a function is not defined if it was not called (EN : FALSE).

---

Example

FUNCTION_BLOCK FB57
VAR
    MY_ENABLE: BOOL ;
    Result : REAL;
END_VAR
// . . .
BEGIN
// . . .
MY_ENABLE:= FALSE ;
// Calling a function and supplying the EN parameter:
Result := FC85 (EN:= MY_ENABLE, PAR_1:= 27) ;
// FC85 was not executed since MY_ENABLE above was set to FALSE
END_FUNCTION_BLOCK
12.3.4.2 Output Parameter ENO

Every function block and every function has the implicitly defined output parameter ENO which is of the data type BOOL. It is stored in the temporary block data. Once a block has executed, the current value of the OK flag is entered into ENO.

Immediately after a block has been called, you can check the value of ENO to see whether all the operations in the block ran correctly or whether errors occurred.

Example

```
// Function block call:
FB30.DB30 ([Parameter supply]);

// Check whether everything ran correctly in the called block:
IF ENO THEN
    // Everything OK
    // . . .
ELSE
    // Error occurred, so error handling required
    // . . .
END_IF;
```
13 Counters and Timers

13.1 Counters

13.1.1 Counter Functions

STEP 7 provides a series of standard counter functions. You can use these counters in your S7-SCL program without needing to declare them previously. You must simply supply them with the required parameters. STEP 7 provides the following counter functions:

<table>
<thead>
<tr>
<th>Counter Function</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_CU</td>
<td>Count Up</td>
</tr>
<tr>
<td>S_CD</td>
<td>Count Down</td>
</tr>
<tr>
<td>S_CUD</td>
<td>Count Up Down</td>
</tr>
</tbody>
</table>

13.1.2 Calling Counter Functions

Counter functions are called like functions. The function identifier can therefore be used anywhere instead of an address in an expression as long as the type of the function value is compatible with that of the replaced address.

The function value (return value) returned to the calling block is the current count value (BCD format) in data type WORD.

Absolute or Dynamic Call

For the call, you can enter an absolute value as the counter number (for example C_NO:=C10). Such values can, however, no longer be modified during runtime.

Instead of the absolute counter number, you can also specify a variable or constant of the INT data type. The advantage of this method is that the counter call can be made dynamic by assigning the variable or constant a different number in each call.

To achieve a dynamic call, you can also specify a variable of the COUNTER data type.
Examples

//Example of an absolute call:
S_CUD (C_NO:=C12,
CD:=I0.0,
CU:=I0.1,
S:=I0.2 & I0.3,
PV:=120,
R:=FALSE,
CV:=binVal,
Q:=actFlag);

//Example of a dynamic call: In each iteration of a
//FOR loop, a different counter is called:
FUNCTION_BLOCK COUNT
VAR_INPUT
    Count: ARRAY [1..4] of STRUCT
        C_NO: INT;
PV : WORD;
    END_STRUCT;
.
END_VAR
.
FOR I:= 1 TO 4 DO
    S_CD(C_NO:=Count[I].C_NO, S:=true, PV:= Count[I].PV);
END_FOR;

//Example of a dynamic call using a variable of the
//COUNTER data type:
FUNCTION_BLOCK COUNTER
VAR_INPUT
    MYCounter:COUNTER;
END_VAR
.
.
CurrVal:=S_CD (C_NO:=MyCounter,......);
### 13.1.3 Supplying Parameters for Counter Functions

The following table provides you with an overview of the parameters for counter functions.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C_NO</td>
<td>COUNTER INT</td>
<td>Counter number (COUNTER IDENTIFIER); the area depends on the CPU</td>
</tr>
<tr>
<td>CD</td>
<td>BOOL</td>
<td>CD input: Count down</td>
</tr>
<tr>
<td>CU</td>
<td>BOOL</td>
<td>CU input: Count up</td>
</tr>
<tr>
<td>S</td>
<td>BOOL</td>
<td>Input for presetting the counter</td>
</tr>
<tr>
<td>PV</td>
<td>WORD</td>
<td>Value in the range between 0 and 999 for initializing the counter (entered as 16#&lt;value&gt;, with the value in BCD format)</td>
</tr>
<tr>
<td>R</td>
<td>BOOL</td>
<td>Reset input</td>
</tr>
<tr>
<td>Q</td>
<td>BOOL</td>
<td>Output: Status of the counter</td>
</tr>
<tr>
<td>CV</td>
<td>WORD</td>
<td>Output: Count value binary</td>
</tr>
<tr>
<td>RET_VAL</td>
<td>WORD</td>
<td>Result in BCD format</td>
</tr>
</tbody>
</table>

#### Rules

Since the parameter values (for example, CD:=I0.0) are stored globally, it is not necessary to specify them in certain situations. The following general rules should be observed when supplying parameters with values:

- The parameter for the counter identifier C_NO must be supplied when the function is called. Instead of the absolute counter number (for example, C12), you can also specify a variable or a constant with the INT data type or an input parameter of the COUNTER data type in the call.
- Either the parameter CU (count up) or the parameter CD (count down) must be supplied.
- The parameters PV (initialization value) and S (set) can be omitted as a pair.
- The result value in BCD format is always the function value.
Example

FUNCTION_BLOCK FB1
VAR
  CurrVal, binVal: word;
  actFlag: bool;
END_VAR

BEGIN
  CurrVal := S_CD (C_NO:= C10, CD:=TRUE, S:=TRUE, PV:=100,
                   R:=FALSE,
                   CV:=binVal, Q:=actFlag);
  CurrVal := S_CU (C_NO:= C11, CU:=M0.0, S:=M0.1, PV:=16#110,
                   R:=M0.2,
                   CV:=binVal, Q:=actFlag);
  CurrVal := S_CUD (C_NO:= C12, CD:=I0.0, CU:=I0.1,
                    S:=I0.2 & I0.3, PV:=120,
                    R:=FALSE, CV:=binVal, Q:=actFlag);
  CurrVal := S_CD (C_NO:= C10, CD:=FALSE, S:=FALSE,
                   PV:=100, R:=TRUE,
                   CV:=binVal, Q:=actFlag);
END_FUNCTION_BLOCK
13.1.4 Input and Evaluation of the Counter Value

To input the initialization value or to evaluate the result of the function you require the internal representation of the count value. The count value is of the data type WORD in which bits 0 to 11 contain the count value in BCD code. Bits 12-15 are not used.

When you set the counter, the value you have specified is written to the counter. The range of values is between 0 and 999. You can change the count value within this range by specifying the operations count up/down (S_CUD), count up (S_CU) and count down (S_CD).

Format

The figure below illustrates the bit configuration of the count value.

![Count value in BCD format (0 to 999)](image)

These bits are irrelevant, they are ignored when a counter is set.

Input

- Decimal as an integer value: For example, 295, assuming that this value corresponds to a valid BCD format.
- In BCD format (input as a hexadecimal constant): for example 16#127

Evaluation

- As a function result (type WORD): in BCD format
- As the output parameter CV (type WORD): in binary code
### 13.1.5 Count Up (S_CU)

With the count up (S_CU) function, you can only execute incrementing counter operations. The table illustrates how the counter works.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count up</td>
<td>The count value is increased by &quot;1&quot; if the signal status at input CU changes from &quot;0&quot; to &quot;1&quot; and the count value is less than 999.</td>
</tr>
<tr>
<td>Set counter</td>
<td>When the signal state at input S changes from &quot;0&quot; to &quot;1&quot;, the counter is set with the value of input PV. Such a signal change is always required to set a counter.</td>
</tr>
<tr>
<td>Reset</td>
<td>The counter is reset when input R = 1 is set. Resetting the counter sets the count value to &quot;0&quot;.</td>
</tr>
<tr>
<td>Query counter</td>
<td>A signal status query at output Q returns &quot;1&quot; if the count value is greater than &quot;0&quot;. The query returns &quot;0&quot; if the count value is equal to &quot;0&quot;.</td>
</tr>
</tbody>
</table>

### 13.1.6 Count Down (S_CD)

With the count down (S_CD) function, you can only execute decrementing counter operations. The table illustrates how the counter works.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count down</td>
<td>The value of the counter is decremented by &quot;1&quot; when the signal state at input CD changes from &quot;0&quot; to &quot;1&quot; and the count value is greater than &quot;0&quot;.</td>
</tr>
<tr>
<td>Set counter</td>
<td>When the signal state at input S changes from &quot;0&quot; to &quot;1&quot;, the counter is set with the value of input PV. Such a signal change is always required to set a counter.</td>
</tr>
<tr>
<td>Reset</td>
<td>The counter is reset when input R = 1 is set. Resetting the counter sets the count value to &quot;0&quot;.</td>
</tr>
<tr>
<td>Query counter</td>
<td>A signal state query at output Q produces &quot;1&quot; when the count value is greater than &quot;0&quot;. The query returns &quot;0&quot; if the count value is equal to &quot;0&quot;.</td>
</tr>
</tbody>
</table>
13.1.7 Count Up/Down (S_CUD)

With the count up/down (S_CUD) function, you can execute both up and down counter operations. If up and down count pulses are received simultaneously, both operations are executed. The count value remains unchanged. The table illustrates how the counter works.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count up</td>
<td>The value of the counter is incremented by &quot;1&quot; when the signal state at input <strong>CU</strong> changes from &quot;0&quot; to &quot;1&quot; and the count value is less than 999.</td>
</tr>
<tr>
<td>Count down</td>
<td>The value of the counter is decremented by &quot;1&quot; when the signal state at input <strong>CD</strong> changes from &quot;0&quot; to &quot;1&quot; and the count value is greater than &quot;0&quot;.</td>
</tr>
<tr>
<td>Set counter</td>
<td>When the signal state at input <strong>S</strong> changes from &quot;0&quot; to &quot;1&quot;, the counter is set with the value of input <strong>PV</strong>. Such a signal change is always required to set a counter.</td>
</tr>
<tr>
<td>Reset</td>
<td>The counter is reset when input <strong>R</strong> = 1 is set. Resetting the counter sets the count value to &quot;0&quot;.</td>
</tr>
<tr>
<td>Query counter</td>
<td>A signal status query at output <strong>Q</strong> returns &quot;1&quot; if the count value is greater than &quot;0&quot;. The query returns &quot;0&quot; if the count value is equal to &quot;0&quot;.</td>
</tr>
</tbody>
</table>

13.1.8 Example of Counter Functions

Parameter Assignment

The table below illustrates the parameter assignment for the function S_CD.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C_NO</td>
<td>MYCOUNTER:</td>
</tr>
<tr>
<td>CD</td>
<td>INPUT I0.0</td>
</tr>
<tr>
<td>S</td>
<td>SET</td>
</tr>
<tr>
<td>PV</td>
<td>INITIALVALUE 16#0089</td>
</tr>
<tr>
<td>R</td>
<td>RESET</td>
</tr>
<tr>
<td>Q</td>
<td>Q0.7</td>
</tr>
<tr>
<td>CV</td>
<td>BIN VALUE</td>
</tr>
</tbody>
</table>
Example

FUNCTION_BLOCK COUNT
VAR_INPUT
  MYCOUNTER : COUNTER ;
END_VAR
VAR_OUTPUT
  RESULT : INT ;
END_VAR
VAR
  SET : BOOL ;
  RESET : BOOL ;
  BCD_VALUE : WORD ; // Count value BCD coded
  BIN_VALUE : WORD ; // Count value binary
  INITIALVALUE: WORD ;
END_VAR
BEGIN
  Q0.0 := 1 ;
  SET := I0.2 ;
  RESET := I0.3 ;
  INITIALVALUE := 16#0089 ;
  // Count down
  BCD_VALUE := S_CD (C_NO := MYCOUNTER,
                      CD:= I0.0 ,
                      S := SET ,
                      PV:= INITIALVALUE,
                      R := RESET ,
                      CV:= BIN_VALUE ,
                      Q := Q0.7) ;
  // Further processing as output parameter
  RESULT := WORD_TO_INT (BIN_VALUE) ;
  QW4 := BCD_VALUE ;
END_FUNCTION_BLOCK
13.2 Timers

13.2.1 Timer Functions

Timers are function elements in your program, that execute and monitor time-controlled functions. STEP 7 provides a series of standard timer functions that you can use in your S7-SCL program.

<table>
<thead>
<tr>
<th>Timer Function</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_PULSE</td>
<td>Start timer as pulse timer</td>
</tr>
<tr>
<td>S_PEXT</td>
<td>Start timer as extended pulse timer</td>
</tr>
<tr>
<td>S_ODT</td>
<td>Start timer as on-delay timer</td>
</tr>
<tr>
<td>S_ODTS</td>
<td>Start timer as retentive on-delay timer</td>
</tr>
<tr>
<td>S_OFFDT</td>
<td>Start timer as off-delay timer</td>
</tr>
</tbody>
</table>

13.2.2 Calling Timer Functions

Timer functions are called like functions. The function identifier can therefore be used anywhere instead of an address in an expression as long as the type of the function result is compatible with the first replaced address.

The function value (return value) that is returned to the calling block is a time value of the data type S5TIME.

Absolute or Dynamic Call

In the call, you can enter an absolute value, (for example T_NO:=T10) of the TIMER data type as the number of the timer function. Such values can, however, no longer be modified during runtime.

Instead of the absolute number, you can also specify a variable or constant of the INT data type. The advantage of this method is that the call can be made dynamic by assigning the variable or constant a different number in each call.

To achieve a dynamic call, you can also specify a variable of the TIMER data type.
Examples

//Example of an absolute call:
CurrTime:=S_ODT (T_NO:=T10,
S:=TRUE,
TV:=T#1s,
R:=FALSE,
BI:=biVal,
Q:=actFlag);

//Example of a dynamic call: In each iteration of a
//FOR loop, a different timer function is called:
FUNCTION_BLOCK TIME
VAR_INPUT
  MY_TIMER: ARRAY [1..4] of STRUCT
    T_NO: INT;
    TV : WORD;
  END_STRUCT;
.
.
END_VAR
.
.
FOR I:= 1 TO 4 DO
  CurrTime:= S_ODT(T_NO:=MY_TIMER[I].T_NO, S:=true, TV:=
    MY_TIMER[I].TV);
END_FOR;

//Example of a dynamic call using a variable of the
//TIMER data type:
FUNCTION_BLOCK TIMER
VAR_INPUT
  mytimer:TIMER;
END_VAR
.
.
CurrTime:=S_ODT (T_NO:=mytimer,.....);

Note
The names of the functions are the same in both the German and English mnemonics.
### 13.2.3 Supplying Parameters for Timer Functions

The following table shows an overview of the parameters of the timer functions:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>T_NO</td>
<td>TIMER</td>
<td>Identification number of the timer; the range depends on the CPU</td>
</tr>
<tr>
<td>S</td>
<td>BOOL</td>
<td>Start input</td>
</tr>
<tr>
<td>TV</td>
<td>S5TIME</td>
<td>Initialization of the timer value (BCD format)</td>
</tr>
<tr>
<td>R</td>
<td>BOOL</td>
<td>Reset input</td>
</tr>
<tr>
<td>Q</td>
<td>BOOL</td>
<td>Status of the timer</td>
</tr>
<tr>
<td>BI</td>
<td>WORD</td>
<td>Time remaining (binary)</td>
</tr>
</tbody>
</table>

**Rules**

Since the parameter values are stored globally, it is not necessary to specify these value in certain situations. The following general rules should be observed when assigning values to parameters:

- The parameters for the timer identifier T_NO must be supplied when the function is called. Instead of the absolute timer number (for example, T10), you can also specify a variable of the INT data type or an input parameter of the TIMER data type in the call.
- The parameters PV (initialization value) and S (set) can be omitted as a pair.
- The result value in S5TIME format is always the function value.

**Example**

```plaintext
FUNCTION_BLOCK FB2
VAR
    CurrTime : S5time;
    BiVal    : word;
    ActFlag  : bool;
END_VAR

BEGIN
    CurrTime := S_ODT (T_NO:= T10, S:=TRUE, TV:=T#1s, R:=FALSE,
                       BI:=biVal,Q:=actFlag);
    CurrTime := S_ODTS (T_NO:= T11, S:=M0.0, TV:= T#1s, R:=M0.1,
                        BI:=biVal,Q:=actFlag);
    CurrTime := S_OFFDT(T_NO:= T12, S:=I0.1 & actFlag,
                        TV:= T#1s, R:=FALSE,
                        BI:=biVal,Q:=actFlag);
    CurrTime := S_PEXT (T_NO:= T13, S:=TRUE, TV:= T#1s, R:=I0.0,
                        BI:=biVal,Q:=actFlag);
    CurrTime := S_PULSE(T_NO:= T14, S:=TRUE, TV:= T#1s, R:=FALSE,
                        BI:=biVal,Q:=actFlag);
END_FUNCTION_BLOCK
```
13.2.4 **Input and Evaluation of a Time Value**

To input the initial value and to evaluate the function result in BCD code, you require the internal representation of the time value. The time value is of the WORD data type, where bits 0 to 11 contain the time value in BCD format and bits 12 and 13 the time base. Bits 14 and 15 are not used.

Updating the time decreases the timer reading by 1 unit in 1 interval as specified by the time base. The timer reading is decreased until it reaches “0”. The possible range of time is from 0 to 9990 seconds.

**Format**

The figure below illustrates the bit configuration of the time value.

![Time Value Configuration](image)

**Input**

You can load a predefined time value with the following formats:

- In composite time format
- In decimal time format

The time base is selected automatically in both cases and the value is rounded down to the next number in this time base.

**Evaluation**

You can evaluate the result in two different formats:

- As a function result (type S5TIME): in BCD format
- As an output parameter (time without time base in data type WORD): in binary code
Time Base for Time Values

To input and evaluate the time value, you require a time base (bits 12 and 13 of the timer word). The time base defines the interval at which the time value is decremented by one unit (see table). The smallest time base is 10 ms; the largest 10 s.

<table>
<thead>
<tr>
<th>Time Base</th>
<th>Binary Code for Time Base</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 ms</td>
<td>00</td>
</tr>
<tr>
<td>100 ms</td>
<td>01</td>
</tr>
<tr>
<td>1 s</td>
<td>10</td>
</tr>
<tr>
<td>10 s</td>
<td>11</td>
</tr>
</tbody>
</table>

Note

Since time values are only saved at intervals, values that are not an exact multiple of the time interval are truncated. Values with a resolution too high for the required range are rounded down so that the required range but not the required resolution is achieved.
13.2.5 **Start Timer as Pulse Timer (S_PULSE)**

The maximum time for which the output signal remains set to "1" is the same as the programmed time value. If, during the run time of the timer, the signal state 0 appears at the input, the timer is set to "0". This means a premature termination of the timer runtime.

<table>
<thead>
<tr>
<th>Input signal</th>
<th>Output signal (pulse timer)</th>
</tr>
</thead>
<tbody>
<tr>
<td>I 2.1</td>
<td>Q 4.0 S_PULSE</td>
</tr>
</tbody>
</table>

**How the Timer Functions**

The table shows how the "pulse timer" function works:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time</td>
<td>The &quot;pulse timer&quot; operation starts the specified time when the signal state at the start input (S) changes from &quot;0&quot; to &quot;1&quot;. To enable the timer, a signal change is always required.</td>
</tr>
<tr>
<td>Specify runtime</td>
<td>The timer runs using the value at input TV until the programmed time expires and the input S = 1 is set.</td>
</tr>
<tr>
<td>Abort runtime</td>
<td>If input S changes from &quot;1&quot; to &quot;0&quot; before the time has expired, the timer is stopped.</td>
</tr>
<tr>
<td>Reset</td>
<td>The time is reset when the reset input (R) changes from &quot;0&quot; to &quot;1&quot; while the timer is running. With this change, both the timer reading and the time base are reset to zero. The signal state &quot;1&quot; at input R has no effect if the timer is not running.</td>
</tr>
<tr>
<td>Query signal status</td>
<td>As long as the timer is running, a signal state query following a &quot;1&quot; at output Q produces the result &quot;1&quot;. If the timer is aborted, a signal state query at output Q produces the result &quot;0&quot;.</td>
</tr>
<tr>
<td>Query current timer reading</td>
<td>The current timer reading can be queried at output BI and using the function value S_PULSE.</td>
</tr>
</tbody>
</table>
13.2.6 Start Timer as Extended Pulse Timer (S_PEXT)

The output signal remains set to "1" for the programmed time (t) regardless of how long the input signal remains set to "1". Triggering the start pulse again restarts the time so that the output pulse is extended (retrigerring).

How the Timer Functions

The table shows how the "extended pulse timer" function works:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time</td>
<td>The &quot;extended pulse timer&quot; (S_PEXT) operation starts the specified time when the signal state at the start input (S) changes from &quot;0&quot; to &quot;1&quot;. To enable the timer, a signal change is always required.</td>
</tr>
<tr>
<td>Restart the counter time</td>
<td>If the signal state at input S changes to &quot;1&quot; again while the timer is running, the timer is restarted with the specified time value.</td>
</tr>
<tr>
<td>Initialize runtime</td>
<td>The timer runs with the value at input TV until the programmed time has expired.</td>
</tr>
<tr>
<td>Reset</td>
<td>The time is reset when the reset input (R) changes from &quot;0&quot; to &quot;1&quot; while the timer is running. With this change, both the timer reading and the time base are reset to zero. The signal state &quot;1&quot; at input R has no effect if the timer is not running.</td>
</tr>
<tr>
<td>Query signal status</td>
<td>As long as the timer is running, a signal state query following &quot;1&quot; at output Q produces the result &quot;1&quot; regardless of the length of the input signal.</td>
</tr>
<tr>
<td>Query current timer reading</td>
<td>The current time value can be queried at output BI and using the function value S_PEXT.</td>
</tr>
</tbody>
</table>
13.2.7 Start Timer as On-Delay Timer (S_ODT)

The output signal only changes from "0" to "1" when the programmed time has expired and the input signal is still "1". This means that the output is activated following a delay. Input signals that remain active for a time that is shorter than the programmed time do not appear at the output.

How the Timer Functions

The table illustrates how the "on delay timer" function works.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time</td>
<td>The &quot;on delay timer&quot; starts a specified time when the signal state at the start input (S) changes from &quot;0&quot; to &quot;1&quot;. To enable the timer, a signal change is always required.</td>
</tr>
<tr>
<td>Stop timer</td>
<td>If the signal state at input S changes from &quot;1&quot; to &quot;0&quot; while the timer is running, it is stopped.</td>
</tr>
<tr>
<td>Specify runtime</td>
<td>The timer continues to run with the value at input TV as long as the signal state at input S = 1 is set.</td>
</tr>
<tr>
<td>Reset</td>
<td>The time is reset when the reset input (R) changes from &quot;0&quot; to &quot;1&quot; while the timer is running. With this change, both the timer reading and the time base are reset to zero. The time is also reset when R = 1 is set although the timer is not running.</td>
</tr>
<tr>
<td>Query signal status</td>
<td>A signal state query following &quot;1&quot; at output Q produces &quot;1&quot; when the time expired without an error occurring and input S is still set to &quot;1&quot;. If the timer was stopped, a signal status query following &quot;1&quot; always produces &quot;0&quot;. A signal state query after &quot;1&quot; at output Q also produces &quot;0&quot; when the timer is not running and the signal state at input S is still &quot;1&quot;.</td>
</tr>
<tr>
<td>Query current timer reading</td>
<td>The current time value can be queried at output BI and using the function value S_ODT.</td>
</tr>
</tbody>
</table>
13.2.8 Start Timer as Retentive On-Delay Timer (S_ODTS)

The output signal only changes from "0" to "1" when the programmed time has expired regardless of how long the input signal remains set to "1".

How the Timer Functions

The table shows how the "retentive on delay timer" function works.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time</td>
<td>The &quot;retentive on delay timer&quot; starts a specified time when the signal state at the start input (S) changes from &quot;0&quot; to &quot;1&quot;. To enable the timer, a signal change is always required.</td>
</tr>
<tr>
<td>Restart timer</td>
<td>The timer is restarted with the specified value when input S changes from &quot;0&quot; to &quot;1&quot; while the timer is running.</td>
</tr>
<tr>
<td>Specify runtime</td>
<td>The timer continues to run with the value at input TV even if the signal state at input S changes to &quot;0&quot; before the time has expired.</td>
</tr>
<tr>
<td>Reset</td>
<td>If the reset input (R) changes from &quot;0&quot; to &quot;1&quot;, the timer is reset regardless of the signal state at input S.</td>
</tr>
<tr>
<td>Query signal status</td>
<td>A signal state query following &quot;1&quot; at output Q produces the result &quot;1&quot; after the time has expired regardless of the signal state at input S.</td>
</tr>
<tr>
<td>Query current timer reading</td>
<td>The current time value can be queried at output BI and using the function value S_ODTS.</td>
</tr>
</tbody>
</table>
13.2.9 Start Timer as Off-Delay Timer (S_OFFDT)

With a signal state change from "0" to "1" at start input S, a "1" is set at output Q. If the start input changes from "1" to "0", the timer is started. The output only returns to signal status "0" after the time has expired. The output is therefore deactivated following a delay.

How the Timer Functions

The table shows how the "off delay timer" function works.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time</td>
<td>The &quot;off delay timer&quot; operation starts the specified time when the signal state at the start input (S) changes from &quot;1&quot; to &quot;0&quot;. A signal change is always required to enable the timer.</td>
</tr>
<tr>
<td>Restart timer</td>
<td>The timer is restarted when the signal state at input S changes from &quot;1&quot; to &quot;0&quot; again (for example following a reset).</td>
</tr>
<tr>
<td>Specify runtime</td>
<td>The timer runs with the value specified at input TV.</td>
</tr>
<tr>
<td>Reset</td>
<td>If the reset input (R) changes from &quot;0&quot; to &quot;1&quot; while the timer is running, the timer is reset.</td>
</tr>
<tr>
<td>Query signal status</td>
<td>A signal state query following &quot;1&quot; at output Q produces &quot;1&quot; if the signal state at input S = 1 is set or the timer is running.</td>
</tr>
<tr>
<td>Query current timer reading</td>
<td>The current time value can be queried at output BI and using the function value S_OFFDT.</td>
</tr>
</tbody>
</table>
13.2.10 Example of Timer Functions

FUNCTION_BLOCK TIMER
VAR_INPUT
    mytime : TIMER ;
END_VAR
VAR_OUTPUT
    result : S5TIME ;
END_VAR
VAR
    set : BOOL ;
    reset : BOOL ;
    bcdvalue : S5TIME ; //Time base and time remaining
        //in BCD
    binvalue : WORD ; //Time value in binary
    initialvalue : S5TIME ;
END_VAR
BEGIN
    Q0.0  := 1;
    set  := I0.0 ;
    reset := I0.1;
    initialvalue := T#25S ;
    bcdvalue := S_PEXT (T_NO := mytime ,
        S := set ,
        TV := initialvalue ,
        R := reset ,
        BI := binvalue ,
        Q := Q0.7) ;

    //Further processing as output parameter
    result := bcdvalue ;
    //To output for display
    QW4 := binvalue ;
END_FUNCTION_BLOCK
13.2.11 Selecting the Right Timer

The following figure provides an overview of the five different timer functions described in this section. This overview will help you to select the timer function best suited to your particular purpose.

<table>
<thead>
<tr>
<th>Input signal</th>
<th>Output signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>I 2.1</td>
<td>Q 4.0 S_PULSE</td>
</tr>
</tbody>
</table>

(Pulse timer)

The maximum time for which the output signal remains "1" is equal to the programmed time t. The output signal remains "1" for a shorter period if the input signal switches to "0".

Output signal (Extended pulse timer)

Q 4.0 S_PEXT

The output signal remains "1" for the duration of the programmed time regardless of how long the input signal remains "1". The pulse is restarted if the start signal is triggered again within "t".

Output signal (On delay timer)

Q 4.0 S_ODT

The output signal only switches from "0" to "1" if the programmed time has expired and the input signal is still "1".

Output signal (Retentive on-delay timer)

Q 4.0 S_ODTS

The output signal only switches from "0" to "1" if the programmed time has expired regardless of how long the input signal remains "1".

Output signal (Off-delay timer)

Q 4.0 S_OFFDT

The output signal only switches from "0" to "1" if the input signal changes from "0" to "1". The output signal remains "1" for the duration of the programmed period. The timer is started when the input signal switches from "1" to "0".
14 Standard Functions of S7-SCL

14.1 Data Type Conversion Functions

14.1.1 Converting Data Types

If you use two addresses in a logic operation, you must make sure that the data types of the addresses are compatible. If the addresses are of different data types, a data type conversion is necessary. The following data type conversions are possible in S7-SCL:

- Implicit Data Type Conversion
  The data types are grouped in classes. If the addresses fall within the same class, S7-SCL makes an implicit data type conversion. The functions used by the compiler are grouped in "Conversion Functions Class A".

- Explicit Data Type Conversion
  If the addresses do not belong to the same class, you must start a conversion function yourself. To allow explicit data type conversion, S7-SCL provides numerous standard functions grouped in the following classes:
  - Conversion Functions Class B
  - Functions for Rounding and Truncating
14.1.2 Implicit Data Type Conversion

Within the classes of data types defined in the table, the compiler makes an implicit data type conversion in the order shown. The common format of two addresses is always the larger of the two data types defined. The common format of BYTE and WORD, for example, is INTEGER WORD.

Remember that a data type conversion in the ANY_BIT class results in leading bits being set to 0.

<table>
<thead>
<tr>
<th>Classes</th>
<th>Conversion Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANY_BIT</td>
<td>BOOL &gt; BYTE &gt; WORD &gt; DWORD</td>
</tr>
<tr>
<td>ANY_NUM</td>
<td>INT &gt; DINT &gt; REAL</td>
</tr>
</tbody>
</table>

Example of Implicit Data Type Conversion

```plaintext
VAR
    PID_CTRLLER_1 : BYTE;
    PID_CTRLLER_2 : WORD;
END_VAR
BEGIN
    IF (PID_CTRLLER_1 <> PID_CTRLLER_2) THEN ...
    (* In the IF statement above, PID_CTRLLER_1 is converted implicitly from BYTE to WORD. *)
```

14.1.2.1 Conversion Functions Class A

The table shows the data type conversion functions of Class A. These functions are executed implicitly by the compiler, however, you can also specify them explicitly if you prefer. The result is always defined.

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Conversion Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL_TO_BYTE</td>
<td>Adds leading zeros</td>
</tr>
<tr>
<td>BOOL_TO_DWORD</td>
<td>Adds leading zeros</td>
</tr>
<tr>
<td>BOOL_TO_WORD</td>
<td>Adds leading zeros</td>
</tr>
<tr>
<td>BYTE_TO_DWORD</td>
<td>Adds leading zeros</td>
</tr>
<tr>
<td>BYTE_TO_WORD</td>
<td>Adds leading zeros</td>
</tr>
<tr>
<td>CHAR_TO_STRING</td>
<td>Transformation to a string (of length 1) containing the same character.</td>
</tr>
<tr>
<td>DINT_TO_REAL</td>
<td>Transformation to REAL according to the IEEE standard. The value may change (due to the different accuracy of REAL).</td>
</tr>
<tr>
<td>INT_TO_DINT</td>
<td>The higher-order word of the function value is padded with 16#FFFF for a negative input parameter, otherwise it is padded with zeros. The value remains the same.</td>
</tr>
<tr>
<td>INT_TO_REAL</td>
<td>Transformation to REAL according to the IEEE standard. The value remains the same.</td>
</tr>
<tr>
<td>WORD_TO_DWORD</td>
<td>Adds leading zeros</td>
</tr>
</tbody>
</table>
14.1.3 Standard Functions for Explicit Data Type Conversion

You will find a general description of the function call in “Calling Functions”.

Remember the following points when calling the conversion functions:

- **Input parameters:**
  Each function for converting a data type has exactly one input parameter with the name IN. Since it is a function with only one parameter, this does not need to be specified.

- **Function value**
  The result is always the function value.

- **Names of the functions**
  The data types of the input parameter and the function value can clearly be recognized in the function name in the overview of classes A and B. For example, for the function BOOL_TO_BYTE, the data type of the input parameter is BOOL and the data type of the function value BYTE.

14.1.3.1 Conversion Functions Class B

The table shows the data type conversion functions of Class B. These functions must be specified explicitly. The result can also be undefined if the destination type is not large enough.

You can check for this situation yourself by including a limit check or you can have the system make the check by selecting the “OK flag” option prior to compilation. In situations where the result is undefined, the system sets the OK flag to FALSE.

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Conversion Rule</th>
<th>OK</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL_TO_INT</td>
<td>WORD_TO_INT(BOOL_TO_WORD(x))</td>
<td>N</td>
</tr>
<tr>
<td>BOOL_TO_DINT</td>
<td>DWORD_TO_DINT(BOOL_TO_DWORD(x))</td>
<td>N</td>
</tr>
<tr>
<td>BYTE_TO_BOOL</td>
<td>Copies the least significant bit</td>
<td>Y</td>
</tr>
<tr>
<td>BYTE_TO_CHAR</td>
<td>Copies the bit string</td>
<td>N</td>
</tr>
<tr>
<td>BYTE_TO_INT</td>
<td>WORD_TO_INT(BYTE_TO_WORD(x))</td>
<td>N</td>
</tr>
<tr>
<td>BYTE_TO_DINT</td>
<td>DWORD_TO_DINT(BYTE_TO_DWORD(x))</td>
<td>N</td>
</tr>
<tr>
<td>CHAR_TO_BYTE</td>
<td>Copies the bit string</td>
<td>N</td>
</tr>
<tr>
<td>CHAR_TO_INT</td>
<td>The bit string in the input parameter is entered in the lower-order byte of the function value. The higher-order byte is padded with zeros.</td>
<td>N</td>
</tr>
<tr>
<td>DATE_TO_DINT</td>
<td>Copies the bit string</td>
<td>N</td>
</tr>
<tr>
<td>DINT_TO_DATE</td>
<td>Copies the bit string</td>
<td>Y</td>
</tr>
<tr>
<td>DINT_TO_DWORD</td>
<td>Copies the bit string</td>
<td>N</td>
</tr>
<tr>
<td>DINT_TO_INT</td>
<td>Copies the bit for the sign. The value in the input parameter is interpreted in the data type INT. If the value is less than -32_768 or greater than 32_767, the OK variable is set to FALSE.</td>
<td>Y</td>
</tr>
<tr>
<td>DINT_TO_TIME</td>
<td>Copies the bit string</td>
<td>N</td>
</tr>
<tr>
<td>DINT_TO_TOD</td>
<td>Copies the bit string</td>
<td>Y</td>
</tr>
<tr>
<td>DINT_TO_BOOL</td>
<td>DWORD_TO_BOOL(DINT_TO_DWORD(x))</td>
<td>Y</td>
</tr>
<tr>
<td>DINT_TO_BYTE</td>
<td>DWORD_TO_BYTE(DINT_TO_DWORD(x))</td>
<td>Y</td>
</tr>
<tr>
<td>DINT_TO_STRING</td>
<td>DI_STRING</td>
<td>Y</td>
</tr>
</tbody>
</table>
### Standard Functions of S7-SCL

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Conversion Rule</th>
<th>OK</th>
</tr>
</thead>
<tbody>
<tr>
<td>DINT_TO_WORD</td>
<td>DWORD_TO_WORD(DINT_TO_DWORD(x))</td>
<td>Y</td>
</tr>
<tr>
<td>DWORD_TO_BOOL</td>
<td>Copies the least significant bit</td>
<td>Y</td>
</tr>
<tr>
<td>DWORD_TO_BYTE</td>
<td>Copies the 8 least significant bits</td>
<td>Y</td>
</tr>
<tr>
<td>DWORD_TO_DINT</td>
<td>Copies the bit string</td>
<td>N</td>
</tr>
<tr>
<td>DWORD_TO_REAL</td>
<td>Copies the bit string</td>
<td>N</td>
</tr>
<tr>
<td>DWORD_TO_WORD</td>
<td>Copies the 16 least significant bits</td>
<td>Y</td>
</tr>
<tr>
<td>DWORD_TO_INT</td>
<td>DINT_TO_INT(DWORD_TO_DINT(x))</td>
<td>Y</td>
</tr>
<tr>
<td>INT_TO_CHAR</td>
<td>Copies the bit string</td>
<td>Y</td>
</tr>
<tr>
<td>INT_TO_WORD</td>
<td>Copies the bit string</td>
<td>N</td>
</tr>
<tr>
<td>INT_TO_BOOL</td>
<td>WORD_TO_BOOL(INT_TO_WORD(x))</td>
<td>Y</td>
</tr>
<tr>
<td>INT_TO_BYTE</td>
<td>WORD_TO_BYTE(INT_TO_WORD(x))</td>
<td>Y</td>
</tr>
<tr>
<td>INT_TO_DWORD</td>
<td>WORD_TO_DWORD(INT_TO_WORD(x))</td>
<td>Y</td>
</tr>
<tr>
<td>INT_TO_STRING</td>
<td>I_STRING(x)</td>
<td>Y</td>
</tr>
<tr>
<td>REAL_TO_DINT</td>
<td>Rounds the IEEE REAL value to DINT.</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>If the value is less than -2,147,483,648 or greater than 2,147,483,647, the OK variable is set to FALSE.</td>
<td></td>
</tr>
<tr>
<td>REAL_TO_DWORD</td>
<td>Copies the bit string</td>
<td>N</td>
</tr>
<tr>
<td>REAL_TO_INT</td>
<td>Rounds the IEEE REAL value to INT.</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>If the value is less than -32,768 or greater than 32,767, the OK variable is set to FALSE.</td>
<td></td>
</tr>
<tr>
<td>REAL_TO_STRING</td>
<td>R_STRING(x)</td>
<td>Y</td>
</tr>
<tr>
<td>STRING_TO_CHAR</td>
<td>Copies the first character of the string.</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>If the STRING does not have a length of 1, the OK variable is set to FALSE.</td>
<td></td>
</tr>
<tr>
<td>STRING_TO_INT</td>
<td>STRING_I(x)</td>
<td>Y</td>
</tr>
<tr>
<td>STRING_TO_DINT</td>
<td>STRING_DI(x)</td>
<td>Y</td>
</tr>
<tr>
<td>STRING_TO_REAL</td>
<td>STRING_R(x)</td>
<td>Y</td>
</tr>
<tr>
<td>TIME_TO_DINT</td>
<td>Copies the bit string</td>
<td>N</td>
</tr>
<tr>
<td>TOD_TO_DINT</td>
<td>Copies the bit string</td>
<td>N</td>
</tr>
<tr>
<td>WORD_TO_BOOL</td>
<td>Copies the least significant bit</td>
<td>Y</td>
</tr>
<tr>
<td>WORD_TO_BYTE</td>
<td>Copies the 8 least significant bits</td>
<td>Y</td>
</tr>
<tr>
<td>WORD_TO_INT</td>
<td>Copies the bit string</td>
<td>N</td>
</tr>
<tr>
<td>WORD_TO_DINT</td>
<td>INT_TO_DINT(WORD_TO_INT(x))</td>
<td>N</td>
</tr>
<tr>
<td>WORD_TO_BLOCK_DB</td>
<td>The bit pattern of WORD is interpreted as the data block number</td>
<td>N</td>
</tr>
<tr>
<td>BLOCK_DB_TO_WORD</td>
<td>The data block number is interpreted as the bit pattern of WORD</td>
<td>N</td>
</tr>
<tr>
<td>BCD_TO_INT(x)</td>
<td>The expression x is of the type WORD and is assumed to be a BCD-coded value between -999 and +999. After conversion the result is available as an integer (binary form) of the type INT. If an error occurs during conversion, the programmable controller changes to the STOP state. The cause of the stop can be edited in the OB 121.</td>
<td>N</td>
</tr>
<tr>
<td>WORD_BCD_TO_INT(x)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>INT_TO_BCD(x)</td>
<td>The expression x is of the type INT and is assumed to be an integer with a value between -999 and +999. After conversion the result is available as a BCD-coded number of the type WORD. The result is undefined outside the value range. If the &quot;Set OK flag&quot; option is activated, the OK flag has the value 'false'.</td>
<td>Y</td>
</tr>
<tr>
<td>INT_TO_BCD_WORD(x)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Standard Functions of S7-SCL

**Function Name** | **Conversion Rule** | **OK**
--- | --- | ---
BCD_TO_DINT(x) | The expression x is of the type DWORD and is assumed to be a BCD-coded value between -9999999 and +9999999. After conversion the result is available as an integer (binary form) of the type DINT. If an error occurs during conversion, the programmable controller changes to the STOP state. The cause of the stop can be edited in the OB 121. | N
DWORD_BCD_TO_DINT(x) |  | 

**Function Name** | **Conversion Rule** | **OK**
--- | --- | ---
DINT_TO_BCD(x) | The expression x is of the type DINT and is assumed to be an integer with a value between -9999999 and +9999999. After conversion the result is available as a BCD-coded number of the type DWORD. The result is undefined outside the value range. If the "Set OK flag" option is activated, the OK flag has the value 'false'. | Y
DINT_TO_BCD_DWORD(x) |  | 

---

**Caution**
If a constant of a higher data type is converted in a lower data type, you will receive an error message when compiling, in case the constant lies outside the range of the lower data type.

**Examples:**

```plaintext
M0.0 := WORD_TO_BOOL(W#16#FFFF);
MW0 := DINT_TO_INT(35000);
```

---

**Note**
You also have the option of using further IEC functions for data type conversion. For information about the functions, refer to the STEP 7 reference manual "System and Standard Functions for S7-300/400".
14.1.3.2 Functions for Rounding and Truncating

The functions for rounding and truncating numbers also belong to the data type conversion functions. The table shows the names, data types (for the input parameters and the function value) and tasks of these functions:

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Data Type Input Parameter</th>
<th>Data Type Function Value</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROUND</td>
<td>REAL</td>
<td>DINT</td>
<td>Rounds (forming a DINT number)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>In compliance with DIN EN 61131-3, the function always rounds to the next even integer value; in other words, 1.5 returns 2 and 2.5 also returns 2.</td>
</tr>
<tr>
<td>TRUNC</td>
<td>REAL</td>
<td>DINT</td>
<td>Truncates (forming a DINT number)</td>
</tr>
</tbody>
</table>

**Note**

You also have the option of using further IEC functions for data type conversion. For information about the functions, refer to the STEP 7 reference manual "System and Standard Functions for S7-300/400".

**Example**

```plaintext
// Rounding down (result: 3)
ROUND (3.14) ;

// Rounding up (result: 4)
ROUND (3.56) ;

// Truncating (result: 3)
TRUNC (3.14) ;

// Truncating (result: 3)
TRUNC (3.56) ;
```
14.1.3.3 Examples of Converting with Standard Functions

In the example below, an explicit conversion is necessary since the destination data type is of a lower order than the source data type.

FUNCTION_BLOCK FB10
VAR
  SWITCH : INT;
  CTRLLER : DINT;
END_VAR

(* INT is lower order than DINT *)
SWITCH := DINT_TO_INT (CTRLLER) ;
// . . .
END_FUNCTION_BLOCK

In the following example, an explicit data type conversion is necessary, since the data type REAL is not allowed for an arithmetic expression with the MOD operation.

FUNCTION_BLOCK FB20
VAR
  SWITCH : REAL
  INTVALUE : INT := 17;
  CONV2  : INT ;
END_VAR

(* MOD can only be used with data of the INT or DINT type *)
CONV2 := INTVALUE MOD REAL_TO_INT (SWITCH);
// . . .
END_FUNCTION_BLOCK

In the following example, conversion is necessary because the data type is incorrect for a logical operation. The NOT operation can only be used for data of the types BOOL, BYTE, WORD or DWORD.

FUNCTION_BLOCK FB30
VAR
  INTVALUE : INT := 17;
  CONV1     : WORD ;
END_VAR

(* NOT must not be applied to data of the INT type *)
CONV1 := NOT INT_TO_WORD(INTVALUE);
// . . .
END_FUNCTION_BLOCK
The following example illustrates data type conversion for peripheral inputs/outputs.

FUNCTION_BLOCK FB40
VAR
  Radius_in    : WORD ;
  Radius            : INT;
END_VAR

  Radius_in    := %IB0;
  Radius            := WORD_TO_INT (radius_in);
(* Conversion when changing to a different type class. Value comes from input and is converted for further processing.*)

  Radius    := Radius (area:= circledata.area)
    %QB0        :=WORD_TO_BYTE (INT_TO_WORD(RADIUS));
(*Radius is recalculated from the area and is then as an integer. For output, the value is first converted to a different type class (INT_TO_WORD) and then into a lower order type (WORD_TO_BYTE).*)
   // . . .
END_FUNCTION_BLOCK
14.2 Numeric Standard Functions

14.2.1 General Arithmetic Standard Functions

These are the functions for calculating the absolute value, the square or the square root of a value.

The data type ANY_NUM stands for INT, DINT or REAL. Note that input parameters of the INT or DINT type are converted internally to REAL variables if the function value is of the REAL type.

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Data Type Input Parameter</th>
<th>Data Type Function Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABS</td>
<td>ANY_NUM</td>
<td>ANY_NUM</td>
<td>Number</td>
</tr>
<tr>
<td>SQR</td>
<td>ANY_NUM</td>
<td>REAL</td>
<td>Square</td>
</tr>
<tr>
<td>SQRT</td>
<td>ANY_NUM</td>
<td>REAL</td>
<td>Square Root</td>
</tr>
</tbody>
</table>

Note
You also have the option of using further IEC functions for data type conversion. For information about the functions, refer to the STEP 7 reference manual "System and Standard Functions for S7-300/400".

14.2.2 Logarithmic Functions

These are functions for calculating an exponential value or a logarithm of a value.

The data type ANY_NUM stands for INT, DINT or REAL. Note that input parameters of the type ANY_NUM are converted internally into real variables.

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Data Type Input Parameter</th>
<th>Data Type Function Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXP</td>
<td>ANY_NUM</td>
<td>REAL</td>
<td>e to the power IN</td>
</tr>
<tr>
<td>EXPD</td>
<td>ANY_NUM</td>
<td>REAL</td>
<td>10 to the power IN</td>
</tr>
<tr>
<td>LN</td>
<td>ANY_NUM</td>
<td>REAL</td>
<td>Natural logarithm</td>
</tr>
<tr>
<td>LOG</td>
<td>ANY_NUM</td>
<td>REAL</td>
<td>Common logarithm</td>
</tr>
</tbody>
</table>

Note
You also have the option of using further IEC functions for data type conversion. For information about the functions, refer to the STEP 7 reference manual "System and Standard Functions for S7-300/400".
14.2.3 Trigonometric Functions

The trigonometric functions represented in the table calculate values of angles in radians.

The data type ANY_NUM stands for INT, DINT or REAL. Note that input parameters of the type ANY_NUM are converted internally into real variables.

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Data Type Input Parameter</th>
<th>Data Type Function Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACOS</td>
<td>ANY_NUM</td>
<td>REAL</td>
<td>Arc cosine</td>
</tr>
<tr>
<td>ASIN</td>
<td>ANY_NUM</td>
<td>REAL</td>
<td>Arc sine</td>
</tr>
<tr>
<td>ATAN</td>
<td>ANY_NUM</td>
<td>REAL</td>
<td>Arc tangent</td>
</tr>
<tr>
<td>COS</td>
<td>ANY_NUM</td>
<td>REAL</td>
<td>Cosine</td>
</tr>
<tr>
<td>SIN</td>
<td>ANY_NUM</td>
<td>REAL</td>
<td>Sine</td>
</tr>
<tr>
<td>TAN</td>
<td>ANY_NUM</td>
<td>REAL</td>
<td>Tangent</td>
</tr>
</tbody>
</table>

Note

You also have the option of using further IEC functions for data type conversion. For information about the functions, refer to the STEP 7 reference manual "System and Standard Functions for S7-300/400".

14.2.4 Examples of Numeric Standard Functions

<table>
<thead>
<tr>
<th>Call</th>
<th>RESULT</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESULT := ABS (-5) ;</td>
<td>//5</td>
</tr>
<tr>
<td>RESULT := SQRT (81.0);</td>
<td>//9</td>
</tr>
<tr>
<td>RESULT := SQRT (23);</td>
<td>//529</td>
</tr>
</tbody>
</table>
| RESULT := EXP (4.1);  | //60.340 ...
| RESULT := EXPD (3);   | //1 000 |
| RESULT := LN (2.718 281) ; | //1 |
| RESULT := LOG (245);  | //2.389_166 ...
| PI := 3. 141 592 ;    |       |
| RESULT := SIN (PI / 6) ; | //0.5 |
| RESULT := ACOS (0.5); | //1.047_197 (=PI / 3) |
14.3 Bit String Standard Functions

Every bit string standard function has two input parameters identified by IN and N. The result is always the function value. The following table lists the function names and data types of the two input parameters and the function value. Explanation of input parameters:

- Input parameter IN: buffer in which bit string operations are performed. The data type of this input parameter decides the data type of the function value.
- Input parameter N: number of cycles of the cyclic buffer functions ROL and ROR or the number of places to be shifted in the case of SHL and SHR.

The table shows the possible bit string standard functions.

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Data Type Input Parameter IN</th>
<th>Data Type Input Parameter N</th>
<th>Data Type Function Value</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROL</td>
<td>BOOL BYTE WORD DWORD</td>
<td>INT INT INT</td>
<td>BOOL BYTE WORD DWORD</td>
<td>The value in the parameter IN is rotated left by the number of bit places specified by the content of parameter N.</td>
</tr>
<tr>
<td>ROR</td>
<td>BOOL BYTE WORD DWORD</td>
<td>INT INT INT</td>
<td>BOOL BYTE WORD DWORD</td>
<td>The value in the parameter IN is rotated right by the number of bit places specified by the content of parameter N.</td>
</tr>
<tr>
<td>SHL</td>
<td>BOOL BYTE WORD DWORD</td>
<td>INT INT INT</td>
<td>BOOL BYTE WORD DWORD</td>
<td>The value in the parameter IN is shifted as many places left and as many bit places on the right-hand side are replaced by 0 as specified by the parameter N.</td>
</tr>
<tr>
<td>SHR</td>
<td>BOOL BYTE WORD DWORD</td>
<td>INT INT INT</td>
<td>BOOL BYTE WORD DWORD</td>
<td>The value in the parameter IN is shifted as many places right and as many bit places on the left-hand side are replaced by 0 as specified by the parameter N.</td>
</tr>
</tbody>
</table>

Note
You also have the option of using further IEC functions for data type conversion. For information about the functions, refer to the STEP 7 reference manual "System and Standard Functions for S7-300/400".
### 14.3.1 Examples of Bit String Standard Functions

<table>
<thead>
<tr>
<th>Call</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>RESULT := ROL (IN:=BYTE#2#1101_0011, N:=5); //2#0111_1010&lt;br&gt;//(= 122 decimal)</td>
<td></td>
</tr>
<tr>
<td>RESULT := ROR (IN:=BYTE#2#1101_0011, N:=2); //2#1111_0100&lt;br&gt;//(= 244 decimal)</td>
<td></td>
</tr>
<tr>
<td>RESULT := SHL (IN:=BYTE#2#1101_0011, N:=3); //2#1001_1000&lt;br&gt;//(= 152 decimal)</td>
<td></td>
</tr>
<tr>
<td>RESULT := SHR (IN:=BYTE#2#1101_0011, N:=2); //2#0011_0100&lt;br&gt;//(= 52 decimal)</td>
<td></td>
</tr>
</tbody>
</table>
14.4 Functions for Processing Strings

14.4.1 Functions for String Manipulation

LEN

The LEN function (FC21) returns the current length of a string (number of valid characters). An empty string ("") has zero length. The function does not report errors.

Example LEN (S := 'XYZ')

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>data type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>Input variable in the STRING format</td>
</tr>
<tr>
<td>Return value</td>
<td></td>
<td>INT</td>
<td>I, Q, M, D, L</td>
<td>Current number of characters</td>
</tr>
</tbody>
</table>

CONCAT

The CONCAT function combines a maximum of 32 STRING variables to form a string. If the resulting string is longer than the variable at the output parameter, the resulting string is limited to the maximum length.

When using the S7-SCL function CONCAT, the FC2 is implicitly called from the "IEC-functions" library.

Example CONCAT (IN1 := 'Valve', IN2 := ' open')

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>data type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN1</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>Input variable in the STRING format or CHAR</td>
</tr>
<tr>
<td>IN2</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>Input variable in the STRING format or CHAR</td>
</tr>
<tr>
<td>INn</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>Input variable in the STRING format or CHAR</td>
</tr>
<tr>
<td>Return value</td>
<td></td>
<td>STRING</td>
<td>D, L</td>
<td>Resulting string</td>
</tr>
</tbody>
</table>
LEFT or RIGHT

The LEFT and RIGHT functions (FC20 and FC32) return the first or last L characters of a string. If L is higher than the current length of the STRING variable, the complete string is returned. If L = 0, an empty string is returned. If L is negative, an empty string is output.

Example LEFT (IN:= 'Valve', L:= 4)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>data type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>Input variable in the STRING format</td>
</tr>
<tr>
<td>L</td>
<td>INPUT</td>
<td>INT</td>
<td>I, Q, M, D, L, const.</td>
<td>Length of the left string</td>
</tr>
<tr>
<td>Return value</td>
<td></td>
<td>STRING</td>
<td>D, L</td>
<td>Output variable in the STRING format</td>
</tr>
</tbody>
</table>

MID

The MID function (FC26) returns part of a string. L is the length of the string that will be read out, P is the position of the first character to be read out. If the sum of L and (P-1) is longer than the current length of the STRING variable, a string is returned that starts at the character indicated by P and extends up to the end of the input value. In all other situations (P is outside the current length, P and/or L equal to zero or negative), an empty string is output.

Example MID (IN:= 'Temperature', L:= 2, P:= 3)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>data type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>Input variable in the STRING format</td>
</tr>
<tr>
<td>L</td>
<td>INPUT</td>
<td>INT</td>
<td>I, Q, M, D, L, const.</td>
<td>Length of the mid string section</td>
</tr>
<tr>
<td>P</td>
<td>INPUT</td>
<td>INT</td>
<td>I, Q, M, D, L, const.</td>
<td>Position of the first character</td>
</tr>
<tr>
<td>Return value</td>
<td></td>
<td>STRING</td>
<td>D, L</td>
<td>Output variable in the STRING format</td>
</tr>
</tbody>
</table>
**INSERT**

The INSERT function (FC17) inserts the character string at parameter IN2 into the string at parameter IN1 after the character identified by P. If P equals zero, the second string is inserted before the first string. If P is higher than the current length of the first string, the second string is appended to the first string. If P is negative, an empty string is output. When the resulting string is longer than the variable specified at the output parameter; the resulting string is limited to the configured maximum length.

Example INSERT (IN1:= 'Participant arrived', IN2:='Miller':= 2, P:= 11)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>data type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN1</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>STRING variable into which string will be inserted</td>
</tr>
<tr>
<td>IN2</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>STRING variable to be inserted</td>
</tr>
<tr>
<td>P</td>
<td>INPUT</td>
<td>INT</td>
<td>I, Q, M, D, L, const.</td>
<td>Insert position</td>
</tr>
<tr>
<td>Return value</td>
<td></td>
<td>STRING</td>
<td>D, L</td>
<td>Resulting string</td>
</tr>
</tbody>
</table>

**DELETE**

The DELETE function (FC 4) deletes L characters in a string starting at the character identified by P (inclusive). If L and/or P equals zero or if P is higher than the current length of the input string, the input string is returned. If the sum of L and P is higher than the input string length, the string is deleted up to the end. If L and/or P is negative, an empty string is output.

Example: DELETE (IN:= 'Temperature ok', L:= 6, P:= 5)
REPLACE

The REPLACE function (FC31) replaces L characters of the first string (IN1) starting at the character identified by P (inclusive) with the second string (IN2). If L equals zero, the first string is returned. If P equals zero or one, the characters are replaced starting at the first character (inclusive). If P is outside the first string, the second string is appended to the first string. If L and/or P is negative, an empty string is output. When the resulting string is longer than the variable specified at the output parameter; the resulting string is limited to the configured maximum length.

Example REPLACE (IN1:= 'Temperature', IN2:= ' high' L:= 6, P:= 5)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>data type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN1</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>STRING variable in which characters will be replaced</td>
</tr>
<tr>
<td>IN2</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>STRING variable to be inserted</td>
</tr>
<tr>
<td>L</td>
<td>INPUT</td>
<td>INT</td>
<td>I, Q, M, D, L, const.</td>
<td>Number of characters to be replaced</td>
</tr>
<tr>
<td>P</td>
<td>INPUT</td>
<td>INT</td>
<td>I, Q, M, D, L, const.</td>
<td>Position of the first replaced character</td>
</tr>
<tr>
<td>Return value</td>
<td></td>
<td>STRING</td>
<td>D, L</td>
<td>Resulting string</td>
</tr>
</tbody>
</table>

FIND

The FIND function (FC11) returns the position of the second string (IN2) within the first string (IN1). The search begins at the left; the first occurrence of the string is reported. If the second string does not occur in the first string, zero is returned. The function does not report errors.

Example FIND (IN1:= 'Processingstation', IN2:='station')

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>data type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN1</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>STRING variable to search</td>
</tr>
<tr>
<td>IN2</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>STRING variable to search for</td>
</tr>
<tr>
<td>Return value</td>
<td></td>
<td>INT</td>
<td>I, Q, M, D, L</td>
<td>Position of the located string</td>
</tr>
</tbody>
</table>
14.4.2 Functions for Comparing Strings

You can compare strings using the S7-SCL comparison functions =, <>, <, >, <= and >=. The compiler includes the required function call automatically. The following functions are listed simply to provide you with a complete picture.

**EQ_STRING and NE_STRING**

The EQ_STRING (FC10) and NE_STRING (FC29) functions compare the contents of two variables in the STRING format for equality (FC10) or inequality (FC29) and return the result of the comparison. The return value has signal state "1" if the string of parameter S1 equals (does not equal) the string of parameter S2. The function does not report errors.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>data type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>Input variable in the STRING format</td>
</tr>
<tr>
<td>S2</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>Input variable in the STRING format</td>
</tr>
<tr>
<td>Return value</td>
<td></td>
<td>BOOL</td>
<td>I, Q, M, D, L</td>
<td>Comparison result</td>
</tr>
</tbody>
</table>

**GE_STRING and LE_STRING**

The GE_STRING (FC13) and LE_STRING (FC19) functions compare the contents of two variables in the STRING format for greater than (less than) or equal to and return the result of the comparison. The return value has signal state "1" if the string of parameter S1 is greater than (less than) or equal to the string of parameter S2. The characters are compared starting from the left using their ASCII coding (for example, 'a' is greater than 'A'). The first character to differ, decides the result of the comparison. If the left part of the longer string is identical to the shorter string, the longer string is considered to the greater. The function does not report errors.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>data type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>Input variable in the STRING format</td>
</tr>
<tr>
<td>S2</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>Input variable in the STRING format</td>
</tr>
<tr>
<td>Return value</td>
<td></td>
<td>BOOL</td>
<td>I, Q, M, D, L</td>
<td>Comparison result</td>
</tr>
</tbody>
</table>
GT_STRNG and LT_STRNG

The GT_STRNG (FC15) and LT_STRNG (FC24) functions compare the values of two variables in the STRING format for greater than (less than) and return the value of the comparison. The return value has signal state “1” if the string of parameter S1 is greater than (less than) the string of parameter S2. The characters are compared starting from the left using their ASCII coding (for example, ‘a’ is greater than ‘A’). The first character to differ, decides the result of the comparison. If the left part of the longer string is identical to the shorter string, the longer string is considered to the greater. The function does not report errors.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>data type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>Input variable in the STRING format</td>
</tr>
<tr>
<td>S2</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>Input variable in the STRING format</td>
</tr>
<tr>
<td>RET_VAL</td>
<td></td>
<td>BOOL</td>
<td>I, Q, M, D, L</td>
<td>Comparison result</td>
</tr>
</tbody>
</table>
14.4.3   Functions for Converting the Data Format

INT_TO_STRING and STRING_TO_INT

The functions INT_TO_STRING and STRING_TO_INT convert a variable in the INT format into a character string or a string into an INT variable. Functions I_STRNG (FC16) and STRNG_I (FC38) are implicitly used from the provided "IEC-functions" library. The string is represented with a leading sign. If the variable specified at the return parameter is too short, no conversion is made.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>data type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INT_TO_STRING</td>
<td>INPUT</td>
<td>INT</td>
<td>I, Q, M, D, L, const.</td>
<td>Input value</td>
</tr>
<tr>
<td>Return value</td>
<td>STRING</td>
<td>D, L</td>
<td></td>
<td>Resulting string</td>
</tr>
</tbody>
</table>

STRING_TO_INT

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>data type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>Input string</td>
</tr>
<tr>
<td>Return value</td>
<td>INT</td>
<td>I, Q, M, D, L</td>
<td></td>
<td>Result</td>
</tr>
</tbody>
</table>

DINT_TO_STRING and STRING_TO_DINT

The functions DINT_TO_STRING and STRING_TO_DINT convert a variable in the DINT format into a character string or a string into a DINT variable. Functions DI_STRNG (FC5) and STRNG_DI (FC37) are implicitly used from the provided "IEC-functions" library. The string is represented with a leading sign. If the variable specified at the return parameter is too short, no conversion is made.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>data type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DINT_TO_STRING</td>
<td>INPUT</td>
<td>DINT</td>
<td>I, Q, M, D, L, const.</td>
<td>Input value</td>
</tr>
<tr>
<td>Return value</td>
<td>STRING</td>
<td>D, L</td>
<td></td>
<td>Resulting string</td>
</tr>
</tbody>
</table>

STRING_TO_DINT

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>data type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>Input string</td>
</tr>
<tr>
<td>Return value</td>
<td>DINT</td>
<td>I, Q, M, D, L</td>
<td></td>
<td>Result</td>
</tr>
</tbody>
</table>
REAL_TO_STRING and STRING_TO_REAL

The functions REAL_TO_STRING and STRING_TO_REAL convert a variable in the REAL format into a character string or a string into a REAL variable. Functions R_STRNG (FC30) and STRNG_R (FC39) are implicitly used from the provided "IEC-functions" library. The string must have the following format:

\[ \pm v.nnnnnn \times \pm xx \] (\( \pm = \) Sign, \( v = \) digit before the decimal point, \( n = \) digits after the decimal point, \( x = \) exponential digits)

If the length of the string is smaller than 14, or if it is not structured as shown above, no conversion takes place.

If the variable specified at the return parameter is too short or if there is no valid floating-point number at the IN parameter, no conversion is made.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>data type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>REAL_TO_STRING</td>
<td>IN INPUT</td>
<td>REAL</td>
<td>I, Q, M, D, L, const.</td>
<td>Input value</td>
</tr>
<tr>
<td>Return value</td>
<td>OUTPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>Resulting string</td>
</tr>
<tr>
<td>STRING_TO_REAL</td>
<td>S INPUT</td>
<td>STRING</td>
<td>D, L</td>
<td>Input string</td>
</tr>
<tr>
<td>Return value</td>
<td>REAL</td>
<td>I, Q, M, D, L</td>
<td>Result</td>
<td></td>
</tr>
</tbody>
</table>
14.4.4 Example of Processing Character Strings

Putting together message texts

//Put message texts together controlled by the process
//and store them

////////////////////////////////////////////////////////////////////////
//The block contains the necessary message texts and the //
//last 20 messages generated
////////////////////////////////////////////////////////////////////////

DATA_BLOCK Messagetexts

STRUCT
  Index : int;
  textbuffer : array [0..19] of string[34];
  HW : array [1..5] of string[16]; //5 different devices
      statuses : array [1..5] of string[12]; //5 different statuses
END_STRUCT
BEGIN
  Index := 0;
  HW[1] := 'Motor ';
  Statuses[1] := ' problem';
  Statuses[2] := ' started';
END_DATA_BLOCK

////////////////////////////////////////////////////////////////////////
//The function puts message texts together and enters //
//them in the DB message texts. The message texts //
//are stored in a circulating buffer. //
//The next free index of the text buffer is also in the //
//DB message texts and is updated by the function. //
////////////////////////////////////////////////////////////////////////
FUNCTION Textgenerator : bool
VAR_INPUT
    unit : int;  // Index of the device text
    no : int;   // ID no. of the device
    status : int;
    value : int;
END_VAR
VAR_TEMP
    text : string[34];
    I : int;
END_VAR
// initialization of the temporary variables
    text := '';
    Textgenerator := true;
    Case unit of
        1..5 : case status of
            1..5 : text := concat( in1 := Messagetexts.HW[unit],
                in2 := right(l:=2,
                    in:=I_STRNG(no)));
            text := concat( in1 := text,
                in2 := Messagetexts.statuses[status]);
            if value <> 0 then
                text := concat( in1 := text,
                    in2 := I_STRNG(value));
            end_if;
        else Textgenerator := false;
        end_case;
    else Textgenerator := false;
    else Textgenerator := false;
    end_case;
    i := Messagetexts.index;
    Messagetexts.textbuffer[i] := text;
    Messagetexts.index := (i+1) mod 20;
END_FUNCTION

///////////////////////////////////////////////////
// The function is called in the cyclic program at an
// edge change in %M10.0 and a message is entered once if a
// parameter changes.
///////////////////////////////////////////////////

Organization_block Cycle
Var_temp
    Opry_ifx : array [0..20] of byte;
    error: BOOL;
End_var;
if %M10.0 <> %M10.1 then
    error := Textgenerator (unit := word_to_int(%MW0),
                            no := word_to_int(%IW2),
                            status := word_to_int(%MW2),
                            value := 0);

    %M10.1:=M10.0;
end_if;
end_organization_block
14.5 Functions for Selecting Values

14.5.1 Functions for Selecting Values

The following functions for selecting values are available as internal S7-SCL functions. They conform to IEC 61131-3.

Note
Some of the functions are also contained in the STEP 7 standard library. However, the functions from the library do not fulfill the requirements of the IEC in all regards.

SEL

The SEL function selects one of two input values.

All the data types are permitted as input values with the exception of the ARRAY and STRUCT data types and the parameter data types. All the parameterized variables have to be of a data type of the same class.

Example:

\[ A := \text{SEL} \left( G := \text{SELECT}, \; \text{IN0} := X, \; \text{IN1} := Y \right); \]

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>Data Type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>INPUT</td>
<td>BOOL</td>
<td>I, Q, M, D, L</td>
<td>Selection criterion</td>
</tr>
<tr>
<td>IN0</td>
<td>INPUT</td>
<td>All the data types except ARRAY and STRUCT</td>
<td>I, Q, M, D, L</td>
<td>First input value</td>
</tr>
<tr>
<td>IN1</td>
<td>INPUT</td>
<td>All the data types except ARRAY and STRUCT</td>
<td>I, Q, M, D, L</td>
<td>Second input value</td>
</tr>
<tr>
<td>Return Value</td>
<td>OUTPUT</td>
<td>All the data types except ARRAY and STRUCT</td>
<td>I, Q, M, D, L</td>
<td>Selected input value (optional)</td>
</tr>
</tbody>
</table>
MAX

The MAX function selects the highest value from a number of variable values. Numerical data types and time data types are permitted as input values. All the parameterized variables have to be of a data type of the same class. The expression takes over the highest-value data type.

Example: `A := MAX (IN1:=a, IN2:=b, IN3:=c, IN4:=d);`

<table>
<thead>
<tr>
<th>Bit</th>
<th>Declaration</th>
<th>Data Type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN1</td>
<td>INPUT</td>
<td>ANY_NUM</td>
<td>I, Q, M, D, L</td>
<td>First input value</td>
</tr>
<tr>
<td>IN2</td>
<td>INPUT</td>
<td>ANY_NUM</td>
<td>I, Q, M, D, L</td>
<td>Second input value</td>
</tr>
<tr>
<td>INn</td>
<td>(n=3...32)</td>
<td>INPUT</td>
<td>I, Q, M, D, L</td>
<td>Last input value (optional)</td>
</tr>
<tr>
<td>Return Value</td>
<td>OUTPUT</td>
<td>ANY_NUM</td>
<td>I, Q, M, D, L</td>
<td>Highest of the input values (optional)</td>
</tr>
</tbody>
</table>

MIN

The MIN function selects the lowest value from a number of variable values. Numerical data types and time data types are permitted as input values. All the parameterized variables have to be of the same data type. The expression takes over the highest-value data type.

Example: `A := MIN (IN1:=a, IN1:=b, IN1:=c, IN1:=d);`

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>Data Type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN1</td>
<td>INPUT</td>
<td>ANY_NUM</td>
<td>I, Q, M, D, L</td>
<td>First input value</td>
</tr>
<tr>
<td>IN2</td>
<td>INPUT</td>
<td>ANY_NUM</td>
<td>I, Q, M, D, L</td>
<td>Second input value</td>
</tr>
<tr>
<td>INn</td>
<td>(n=3...32)</td>
<td>INPUT</td>
<td>I, Q, M, D, L</td>
<td>Last input value (optional)</td>
</tr>
<tr>
<td>Return Value</td>
<td>OUTPUT</td>
<td>ANY_NUM</td>
<td>I, Q, M, D, L</td>
<td>Lowest of the input values (optional)</td>
</tr>
</tbody>
</table>
**LIMIT**

The LIMIT function limits the numerical value of a variable to a parameterizable limit. All the numerical data types and the time data types are permitted as input values. All the parameters have to be of the same data type. The expression takes over the highest-value data type. The lower limit (MN) may not be greater than the upper limit (MX).

Example: `A := LIMIT (MN := 5, IN := Execution steps, MX := 10);`

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>Data Type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MN</td>
<td>INPUT</td>
<td>ANY_NUM</td>
<td>I, Q, M, D, L</td>
<td>Lower limit</td>
</tr>
<tr>
<td>IN</td>
<td>INPUT</td>
<td>ANY_NUM</td>
<td>I, Q, M, D, L</td>
<td>Input variable</td>
</tr>
<tr>
<td>MX</td>
<td>INPUT</td>
<td>ANY_NUM</td>
<td>I, Q, M, D, L</td>
<td>Upper limit</td>
</tr>
<tr>
<td>Return Value</td>
<td>OUTPUT</td>
<td>ANY_NUM</td>
<td>I, Q, M, D, L</td>
<td>Limited output variable (optional)</td>
</tr>
</tbody>
</table>

**MUX**

The MUX function selects an input value from a number of input values. Selection is carried out on the basis of the input parameter K. All the data types are permitted as input values. The expression takes over the highest-value data type.

Example:

```plaintext
A := MUX (K := SELECT, IN0 := Steps, IN1 := Number, IN2 := Total);
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Declaration</th>
<th>Data Type</th>
<th>Memory Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>K</td>
<td>INPUT</td>
<td>INT</td>
<td>I, Q, M, D, L</td>
<td>Selection criterion</td>
</tr>
<tr>
<td>IN0</td>
<td>INPUT</td>
<td>All the data types except ARRAY and STRUCT</td>
<td>I, Q, M, D, L</td>
<td>First input value</td>
</tr>
<tr>
<td>IN1</td>
<td>INPUT</td>
<td>All the data types except ARRAY and STRUCT</td>
<td>I, Q, M, D, L</td>
<td>Second input value</td>
</tr>
<tr>
<td>INn</td>
<td>INPUT</td>
<td>All the data types except ARRAY and STRUCT</td>
<td>I, Q, M, D, L</td>
<td>Last input value (optional)</td>
</tr>
<tr>
<td>(n=2…31)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Declaration</td>
<td>Data Type</td>
<td>Memory Area</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>------------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| INELSE     | INPUT       | All the data types except ARRAY and STRUCT | I, Q, M, D, L | Alternative input value (optional)  
If K lies outside 0...n, therefore the current value from INELSE is used.  
If INELSE not occupied, then the current value from INO is used. |
| Return Value | OUTPUT   | All the data types except ARRAY and STRUCT | I, Q, M, D, L | Selected value (optional) |
14.6 System Functions/Function Blocks and the Standard Library

14.6.1 System Functions/Function Blocks and the Standard Library

The S7 CPUs have integrated system and standard functions in their operating systems that you can use when programming in S7-SCL. Specifically these are the following:

- Organization blocks (OBs)
- System functions (SFCs)
- System function blocks (SFBs)

Call Interface (SFC/SFB)

You can address blocks in symbolic or absolute form. You require either the symbolic name that must be declared in the symbol table or the number of the absolute identifier of the block.

When these functions and blocks are called, you must assign the actual parameters (with the values used by the block when your program runs) to the formal parameters whose names and data types were specified when the configurable block was created.

S7-SCL searches the following folders and libraries for the block to be called:

- The "Programs" folder
- The Simatic standard libraries
- The IEC standard library

If S7-SCL finds a block, it is copied to the user program. The exceptions to this are the blocks that must be called with the notation (" ... ") due to their names and those that are called using the absolute identifier. S7-SCL then searches for these names only in the symbol table of the user program. You must copy these functions into your user program yourself with the SIMATIC Manager.
Conditional Call (SFB/SFC)

For a conditional function call, you must set the predefined input parameter EN to 0 (for example, via input I0.3). The block is then not called. If EN has the value 1, the function is called. The output parameter ENO is also set to "1" in this case (otherwise to "0") if no error occurred during the execution of the block.

Conditional SFC calls are not recommended since the variable that should normally receive the return value of the function is undefined if the function is not called.

Note

If you use the following operations for the data types TIME, DATE_AND_TIME and STRING in your program, S7-SCL implicitly calls the corresponding standard blocks.

The symbols and block numbers of these standard blocks are therefore reserved and must not be used for other blocks. If you break this rule, it will not always be detected by S7-SCL and can lead to a compiler error.

The following table contains an overview of the IEC standard functions used implicitly by S7-SCL.

<table>
<thead>
<tr>
<th>Operation</th>
<th>DATE_AND_TIME</th>
<th>STRING</th>
</tr>
</thead>
<tbody>
<tr>
<td>==</td>
<td>EQ_DT (FC9)</td>
<td>EQ_STRING (FC10)</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>NE_DT (FC28)</td>
<td>NE_STRING (FC29)</td>
</tr>
<tr>
<td>&gt;</td>
<td>GT_DT (FC14)</td>
<td>GT_STRING (FC15)</td>
</tr>
<tr>
<td>&gt;=</td>
<td>GE_DT (FC12)</td>
<td>GE_STRING (FC13)</td>
</tr>
<tr>
<td>&lt;=</td>
<td>LE_DT (FC18)</td>
<td>LE_STRING (FC19)</td>
</tr>
<tr>
<td>&lt;</td>
<td>LT_DT (FC23)</td>
<td>LT_STRING (FC24)</td>
</tr>
<tr>
<td>DATE_AND_TIME + TIME</td>
<td>AD_DT_TM (FC1)</td>
<td></td>
</tr>
<tr>
<td>DATE_AND_TIME + TIME</td>
<td>SB_DT_TM (FC35)</td>
<td></td>
</tr>
<tr>
<td>DATE_AND_TIME +</td>
<td>SB_DT_DT (FC34)</td>
<td></td>
</tr>
<tr>
<td>DATE_AND_TIME</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIME_TO_S5TIME(TIME)</td>
<td>TIM_S5TI (FC40)</td>
<td></td>
</tr>
<tr>
<td>S5TIME_TO_TIME(S5TIME)</td>
<td>S5TI_TIM (FC33)</td>
<td></td>
</tr>
</tbody>
</table>

For detailed information about available SFBs, SFCs and OBs and a detailed interface description, refer to the STEP 7 reference manual "System and Standard Functions for S7-300/400".
14.6.2 Transfer Interface to OBs

Organization Blocks

Organization blocks form the interface between the CPU operating system and the user program. OBs can be used to execute specific program sections in the following situations:

- when the CPU is powered up
- as cyclic or timed operations
- at specific times or on specific days
- on expiry of a specified time period
- if errors occur
- if hardware or communications interrupts are triggered

Organization blocks are processed according to the priority they are assigned.

Available OBs

Not all CPUs can execute all OBs provided by S7. Refer to the data sheets for your CPU to find out which OBs you can use.
15 Language Description

15.1 Formal Language Description

15.1.1 Overview of Syntax Diagrams

The basic tool for the description of the language in the various sections is the syntax diagram. It provides a clear insight into the structure of S7-SCL syntax. You will find a complete collection of all the diagrams with the language elements in the sections entitled "Lexical Rules" and "Syntax Rules".

What is a Syntax Diagram?

The syntax diagram is a graphic representation of the structure of the language. The structure is defined by a series of rules. One rule may be based on others at a more fundamental level.

The syntax diagram is read from right to left. The following rule structures must be adhered to:

- **Sequence**: a sequence of boxes
- **Option**: a skippable branch
- **Iteration**: repetition of branches
- **Alternative**: multiple alternative branches

![Syntax Diagram Example](image-url)
What Types of Boxes Are There?

A box is a basic element or an element made up of other objects. The diagram below shows the symbols that represent the various types of boxes:

<table>
<thead>
<tr>
<th>Term</th>
<th>Non Term</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Basic element that requires no further explanation" /></td>
<td><img src="image2" alt="Rule name may use upper or lower case letters" /></td>
</tr>
<tr>
<td>This refers to printing characters and special characters, keywords and predefined identifiers. The information in these blocks must be copied as it is shown.</td>
<td>Complex element described by additional syntax diagrams.</td>
</tr>
</tbody>
</table>

15.1.2 Rules

The rules you apply to the structure of your S7-SCL program are subdivided into the categories **lexical** and **syntax** rules.

Lexical Rules

The lexical rules describe the structure of the elements (tokens) processed during the lexical analysis performed by the Compiler. For this reason lexical rules do not allow a flexible format and must be strictly observed. In particular, this means that:

- Inserting formatting characters is not permitted,
- Section and line comments cannot be inserted,
- Inserting attributes for identifiers is not permitted.
The above example shows the lexical rule for IDENTIFIER. It defines the structure of an identifier (name), for example:

```
MEAS_FIELD_12
SETPOINT_B_1
```

**Syntax Rules**

The syntax rules are built up from the lexical rules and define the structure of S7-SCL. Within the limitations of these rules, the structure of your S7-SCL program has a flexible format.

```
SCL Program
```

**Formal Aspects**

Each rule has a name which precedes the definition. If that rule is used in a higher-level rule, that name appears in the higher-level rule as a non term.

If the rule name is written in upper case, it is a token that is described in the lexical rules.
Semantics

The rules can only represent the formal structure of the language. The meaning (semantics) is not always obvious from the rules. For this reason, where it is important, additional information is written next to the rule. The following are examples of such situations:

- When elements of the same type have a different meaning, an additional name is given: For example in the data specification rule for DECIMALDIGITSTRING year, month or day. The name indicates the usage.
- Important restrictions are noted alongside the rules: For example, you will find a note with the symbol rule telling you that a symbol must be defined in the symbol table.
15.1.3 Terms Used in the Lexical Rules

Definition

A term is a basic element that cannot be explained by another rule but only verbally. In a syntax diagram, it is represented by the following symbol:

A term is represented by an oblong box with rounded corners or a circle. The item is shown in literal terms or as a name (in upper case letters). This defines the range of ASCII characters that can be used.

The tables below define the terms on the basis of a range of characters from the ASCII character set.

Letters and Numeric Characters

Letters and numeric characters are the main characters used. The IDENTIFIER, for example, consists of letters, numeric characters and the underscore.

<table>
<thead>
<tr>
<th>Character</th>
<th>Subgroup</th>
<th>Character Set Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter</td>
<td>Uppercase</td>
<td>A to Z</td>
</tr>
<tr>
<td></td>
<td>Lowercase</td>
<td>a to z</td>
</tr>
<tr>
<td>Digit</td>
<td>Decimal digits</td>
<td>0.. 9</td>
</tr>
<tr>
<td>Octal digit</td>
<td>Octal digits</td>
<td>0.. 7</td>
</tr>
<tr>
<td>Hexadecimal digit</td>
<td>Hexadecimal digits</td>
<td>0 to 9, A to F, a to f</td>
</tr>
<tr>
<td>Bit</td>
<td>Binary digits</td>
<td>0, 1</td>
</tr>
</tbody>
</table>
Printable Characters and Special Characters

The complete, extended ASCII character set can be used in strings, comments and symbols.

<table>
<thead>
<tr>
<th>Character</th>
<th>Subgroup</th>
<th>Character Set Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printable character</td>
<td>Depends on the character code used. In ASCII code, for example, characters starting at the decimal equivalent of 32 without DEL and without the following substitute characters:</td>
<td>All printing characters</td>
</tr>
<tr>
<td>Substitute characters</td>
<td>Dollar sign</td>
<td>$</td>
</tr>
<tr>
<td>Control characters</td>
<td>$P or $p</td>
<td>form feed</td>
</tr>
<tr>
<td></td>
<td>$L or $l</td>
<td>line feed</td>
</tr>
<tr>
<td></td>
<td>$R or $r</td>
<td>carriage return</td>
</tr>
<tr>
<td></td>
<td>$T or $t</td>
<td>tabulator</td>
</tr>
<tr>
<td></td>
<td>$N or $n</td>
<td>new line</td>
</tr>
<tr>
<td>Substitute representation in hexadecimal code</td>
<td>$hh</td>
<td>Any characters capable of representation in hexadecimal code (hh)</td>
</tr>
</tbody>
</table>
### 15.1.4 Formatting Characters, Separators and Operations

#### Used in the Lexical Rules

The following table shows the characters of the ASCII character set used as formatting characters and separators in the lexical rules.

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>:</td>
<td>Delimiter between hours, minutes and seconds</td>
</tr>
<tr>
<td>.</td>
<td>Attribute</td>
</tr>
<tr>
<td>:</td>
<td>Separator for absolute addresses in real number or time period representation</td>
</tr>
<tr>
<td>.</td>
<td>Characters and character strings</td>
</tr>
<tr>
<td>* *</td>
<td>Introductory character for symbols according to symbol editor rules</td>
</tr>
<tr>
<td>_</td>
<td>Underscore Separator for numbers in constants and can be used in IDENTIFIERS</td>
</tr>
<tr>
<td>$</td>
<td>Escape symbol for specifying control characters or substitute characters</td>
</tr>
<tr>
<td>$&gt; $&lt;</td>
<td>String break, in case the string does not fit in one line, or if the comments are to be inserted.</td>
</tr>
</tbody>
</table>

#### For Constants

The following table shows the use of individual characters and character strings for constants in the lexical rules. The table applies to both the English and German mnemonics.

<table>
<thead>
<tr>
<th>Prefix</th>
<th>Represents</th>
<th>Lexical Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL#</td>
<td>Type-defined constant of type BOOL</td>
<td>BIT constant</td>
</tr>
<tr>
<td>BYTE#</td>
<td>Type-defined constant of type BYTE</td>
<td>BIT constant</td>
</tr>
<tr>
<td>WORD#</td>
<td>Type-defined constant of type WORD</td>
<td>BIT constant</td>
</tr>
<tr>
<td>DWORD#</td>
<td>Type-defined constant of type DWORD</td>
<td>BIT constant</td>
</tr>
<tr>
<td>INT#</td>
<td>Type-defined constant of type INT</td>
<td>Integer constant</td>
</tr>
<tr>
<td>DINT#</td>
<td>Type-defined constant of type DINT</td>
<td>Integer constant</td>
</tr>
<tr>
<td>REAL#</td>
<td>Type-defined constant of type REAL</td>
<td>REAL constant</td>
</tr>
<tr>
<td>CHAR#</td>
<td>Type-defined constant of type CHAR</td>
<td>CHAR constant</td>
</tr>
<tr>
<td>2#</td>
<td>Numeric constant</td>
<td>Binary digit string</td>
</tr>
<tr>
<td>8#</td>
<td>Numeric constant</td>
<td>Octal digit string</td>
</tr>
<tr>
<td>16#</td>
<td>Numeric constant</td>
<td>Hexadecimal digit string</td>
</tr>
<tr>
<td>D#</td>
<td>Times</td>
<td>DATE</td>
</tr>
<tr>
<td>DATE#</td>
<td>Times</td>
<td>DATE</td>
</tr>
<tr>
<td>DATE_AND_TIME#</td>
<td>Times</td>
<td>DATE AND TIME</td>
</tr>
<tr>
<td>DT#</td>
<td>Times</td>
<td>DATE AND TIME</td>
</tr>
<tr>
<td>E</td>
<td>Separator for REAL number constant</td>
<td>Exponent</td>
</tr>
<tr>
<td>e</td>
<td>Separator for REAL number constant</td>
<td>Exponent</td>
</tr>
<tr>
<td>D</td>
<td>Separator for time unit (day)</td>
<td>Days (rule: complex format)</td>
</tr>
<tr>
<td>H</td>
<td>Separator for time unit (hours)</td>
<td>Hours: (rule: complex format)</td>
</tr>
</tbody>
</table>
Prefix | Represents | Lexical Rule
---|---|---
M | Separator for time unit (minutes) | Minutes : (rule: complex format)
MS | Separator for time unit (milliseconds) | Milliseconds: (rule: complex format)
S | Separator for time unit (seconds) | Seconds: (rule: complex format)
T# | Times | TIME PERIOD
TIME# | Times | TIME PERIOD
TIME_OF_DAY# | Times | TIME OF DAY
TOD# | Times | TIME OF DAY

In the Syntax Rules

The following table shows the use of individual characters as formatting characters and separators in the syntax rules and in comments and attributes.

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
<th>Syntax Rule, Remarks or Attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>:</td>
<td>Delimiter for type specification in statement after label</td>
<td>Variable declaration, instance declaration, function code section, CASE statement</td>
</tr>
<tr>
<td>;</td>
<td>Terminates a declaration or statement</td>
<td>Constant and variable declarations, code section, DB assignment section, constant subsection, label subsection, component declaration</td>
</tr>
<tr>
<td>.</td>
<td>Delimiter for lists and label subsection</td>
<td>Array declaration, array data type specification, array initialization list, FB parameters, FC parameters, value list, instance declaration</td>
</tr>
<tr>
<td>..</td>
<td>Range specification</td>
<td>Array data type specification, value list</td>
</tr>
<tr>
<td>.</td>
<td>Delimiter for FB and DB name, absolute address</td>
<td>FB call, structured variables</td>
</tr>
<tr>
<td>( )</td>
<td>Function and function block calls bracketed in expressions Initialization list for arrays</td>
<td>Function call, FB call, expression, Array initialization list, simple multiplication, exponential expression</td>
</tr>
<tr>
<td>[ ]</td>
<td>Array declaration, array structured variable section, indexing of shared variables and strings</td>
<td>Array data type specification, STRING data type specification</td>
</tr>
<tr>
<td>(* *)</td>
<td>Comment section</td>
<td>See &quot;Lexical Rules&quot;</td>
</tr>
<tr>
<td>//</td>
<td>Line comment</td>
<td>See &quot;Lexical Rules&quot;</td>
</tr>
<tr>
<td>{}</td>
<td>Attribute field</td>
<td>For specifying attributes</td>
</tr>
<tr>
<td>%</td>
<td>Introduces a direct identifier</td>
<td>To program in conformity with IEC, %M4.0 can be used instead of M4.0.</td>
</tr>
<tr>
<td>#</td>
<td>Introduces a non-keyword</td>
<td>Indicates that an identifier is not a keyword, for example, #FOR.</td>
</tr>
</tbody>
</table>
Operations

The following table lists all S7-SCL operations, keywords, for example AND and the common operations as single characters. This table applies to both the English and German mnemonics.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
<th>Example, Syntax Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>:=</td>
<td>Assignment operation, initial assignment, data type initialization</td>
<td>Value assignment, DB assignment section, constant subsection, output and in/out assignments, input assignment, in/out assignment</td>
</tr>
<tr>
<td>+, -</td>
<td>Arithmetic operations: unary operations, sign</td>
<td>Expression, simple expression, exponential expression</td>
</tr>
<tr>
<td>+, -, *, /, MOD; DIV</td>
<td>Basic arithmetic operations</td>
<td>Basic arithmetic operation, simple multiplication</td>
</tr>
<tr>
<td>**</td>
<td>Arithmetic operations: exponential operation</td>
<td>Expression</td>
</tr>
<tr>
<td>NOT</td>
<td>Logical operations: negation</td>
<td>Expression</td>
</tr>
<tr>
<td>AND, &amp;, OR; XOR,</td>
<td>Basic logic operations</td>
<td>Basic logic operation</td>
</tr>
<tr>
<td>&lt;, &gt;, &lt;=, &gt;=, =, &lt;&gt;</td>
<td>Comparison operation</td>
<td>Comparison operation</td>
</tr>
</tbody>
</table>
### 15.1.5 Keywords and Predefined Identifiers

The following table lists the keywords in S7-SCL and the predefined identifiers in alphabetical order. Alongside each one is a description and the syntax rule in which they are used as a term. Keywords are generally independent of the mnemonics.

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Description</th>
<th>Example, Syntax Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>Logic operation</td>
<td>Basic logic operation</td>
</tr>
<tr>
<td>ANY</td>
<td>Identifier for data type ANY</td>
<td>Parameter data type specification</td>
</tr>
<tr>
<td>ARRAY</td>
<td>Introduces the specification of an array and is followed by the index list enclosed in &quot;[&quot; and &quot;]&quot;.</td>
<td>Array data type specification</td>
</tr>
<tr>
<td>AT</td>
<td>Declares a view of a variable</td>
<td>Variable Declaration</td>
</tr>
<tr>
<td>BEGIN</td>
<td>Introduces code section in logic blocks or initialization section in data blocks</td>
<td>Organization block, function, function block, data block</td>
</tr>
<tr>
<td>BLOCK_DB</td>
<td>Identifier for data type BLOCK_DB</td>
<td>Parameter data type specification</td>
</tr>
<tr>
<td>BLOCK_FB</td>
<td>Identifier for data type BLOCK_FB</td>
<td>Parameter data type specification</td>
</tr>
<tr>
<td>BLOCK_FC</td>
<td>Identifier for data type BLOCK_FC</td>
<td>Parameter data type specification</td>
</tr>
<tr>
<td>BLOCK_SDB</td>
<td>Identifier for data type BLOCK_SDB</td>
<td>Parameter data type specification</td>
</tr>
<tr>
<td>BOOL</td>
<td>Elementary data type for binary data</td>
<td>Bit data type</td>
</tr>
<tr>
<td>BY</td>
<td>Introduces increment specification</td>
<td>FOR statement</td>
</tr>
<tr>
<td>BYTE</td>
<td>Elementary data type</td>
<td>Bit data type</td>
</tr>
<tr>
<td>CASE</td>
<td>Introduces control statement for selection</td>
<td>CASE Statement</td>
</tr>
<tr>
<td>CHAR</td>
<td>Elementary data type</td>
<td>Character type</td>
</tr>
<tr>
<td>CONST</td>
<td>Introduces definition of constants</td>
<td>constant subsection</td>
</tr>
<tr>
<td>CONTINUE</td>
<td>Control statement for FOR, WHILE and REPEAT loops</td>
<td>CONTINUE statement</td>
</tr>
<tr>
<td>COUNTER</td>
<td>Data type for counters, useable in parameter subsection only</td>
<td>Parameter data type specification</td>
</tr>
<tr>
<td>DATA_BLOCK</td>
<td>Introduces a data block</td>
<td>Data block</td>
</tr>
<tr>
<td>DATE</td>
<td>Elementary data type for dates</td>
<td>Time type</td>
</tr>
<tr>
<td>DATE_AND_TIME</td>
<td>Composite data type for date and time</td>
<td>DATE_AND_TIME</td>
</tr>
<tr>
<td>DINT</td>
<td>Elementary data type for whole numbers (integers), double resolution</td>
<td>Numeric data type</td>
</tr>
<tr>
<td>DIV</td>
<td>Operation for division</td>
<td>Basic arithmetic operation, simple multiplication</td>
</tr>
<tr>
<td>DO</td>
<td>Introduces statement section for FOR statement</td>
<td>FOR statement, WHILE statement</td>
</tr>
<tr>
<td>DT</td>
<td>Elementary data type for date and time</td>
<td>DATE_AND_TIME</td>
</tr>
<tr>
<td>DWORD</td>
<td>Elementary data type for double word</td>
<td>Bit data type</td>
</tr>
<tr>
<td>ELSE</td>
<td>Introduces instructions to be executed if condition is not satisfied</td>
<td>IF statement CASE statement</td>
</tr>
<tr>
<td>ELSIF</td>
<td>Introduces alternative condition</td>
<td>IF statement</td>
</tr>
<tr>
<td>EN</td>
<td>Block clearance flag</td>
<td></td>
</tr>
<tr>
<td>ENO</td>
<td>Block error flag</td>
<td></td>
</tr>
<tr>
<td>END_CASE</td>
<td>Terminates CASE statement</td>
<td>CASE Statement</td>
</tr>
<tr>
<td>END_CONST</td>
<td>Terminates definition of constants</td>
<td>constant subsection</td>
</tr>
<tr>
<td>END_DATA_BLOCK</td>
<td>Terminates data block</td>
<td>Data block</td>
</tr>
</tbody>
</table>
### Keywords

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Description</th>
<th>Example, Syntax Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>END_FOR</td>
<td>Terminates FOR statement</td>
<td>FOR statement</td>
</tr>
<tr>
<td>END_FUNCTION</td>
<td>Terminates function</td>
<td>Function</td>
</tr>
<tr>
<td>END_FUNCTION_BLOCK</td>
<td>Terminates function block</td>
<td>Function block</td>
</tr>
<tr>
<td>END_IF</td>
<td>Terminates IF statement</td>
<td>IF statement</td>
</tr>
<tr>
<td>END_LABEL</td>
<td>Terminates declaration of a label subsection</td>
<td>Label subsection</td>
</tr>
<tr>
<td>END_TYPE</td>
<td>Terminates UDT</td>
<td>User-defined data type</td>
</tr>
<tr>
<td>END_ORGANIZATION_BLOCK</td>
<td>Terminates organization block</td>
<td>Organization block</td>
</tr>
<tr>
<td>END_REPEAT</td>
<td>Terminates REPEAT statement</td>
<td>REPEAT Statement</td>
</tr>
<tr>
<td>END_STRUCT</td>
<td>Terminates specification of a structure</td>
<td>Structure data type specification</td>
</tr>
<tr>
<td>END_VAR</td>
<td>Terminates declaration block</td>
<td>Temporary variables subsection, static variables subsection, parameter subsection</td>
</tr>
<tr>
<td>END WHILE</td>
<td>Terminates WHILE statement</td>
<td>WHILE Statement</td>
</tr>
<tr>
<td>EXIT</td>
<td>Executes immediate exit from loop</td>
<td>EXIT</td>
</tr>
<tr>
<td>FALSE</td>
<td>Predefined Boolean constant: logic condition not true, value equals 0</td>
<td></td>
</tr>
<tr>
<td>FOR</td>
<td>Introduces control statement for loop processing</td>
<td>FOR statement</td>
</tr>
<tr>
<td>FUNCTION</td>
<td>Introduces function</td>
<td>Function</td>
</tr>
<tr>
<td>FUNCTION_BLOCK</td>
<td>Introduces function block</td>
<td>Function block</td>
</tr>
<tr>
<td>GOTO</td>
<td>Instruction for executing a jump to a label</td>
<td>Program jump</td>
</tr>
<tr>
<td>IF</td>
<td>Introduces control statement for selection</td>
<td>IF statement</td>
</tr>
<tr>
<td>INT</td>
<td>Elementary data type for whole numbers (integers), single resolution</td>
<td>Numeric data type</td>
</tr>
<tr>
<td>LABEL</td>
<td>Introduces declaration of a label subsection</td>
<td>Label subsection</td>
</tr>
<tr>
<td>MOD</td>
<td>Arithmetic operation for division remainder</td>
<td>Basic arithmetic operation, simple multiplication</td>
</tr>
<tr>
<td>NIL</td>
<td>Zero pointer</td>
<td></td>
</tr>
<tr>
<td>NOT</td>
<td>Logic operation, belongs to the unary operations</td>
<td>Expression</td>
</tr>
<tr>
<td>OF</td>
<td>Introduces data type specification</td>
<td>Array data type specification, CASE statement</td>
</tr>
<tr>
<td>OK</td>
<td>Flag that indicates whether the instructions in a block have been processed without errors</td>
<td></td>
</tr>
<tr>
<td>OR</td>
<td>Logic operation</td>
<td>Basic logic operation</td>
</tr>
<tr>
<td>ORGANIZATION_BLOCK</td>
<td>Introduces an organization block</td>
<td>Organization block</td>
</tr>
<tr>
<td>POINTER</td>
<td>Pointer data type, only allowed in parameter declarations in parameter subsection, not processed in S7-SCL</td>
<td>Refer to the section &quot;Global data&quot;.</td>
</tr>
<tr>
<td>PROGRAM</td>
<td>Introduces the statement section of an FB (synonymous with FUNCTION_BLOCK)</td>
<td>Function block</td>
</tr>
<tr>
<td>REAL</td>
<td>Elementary data type</td>
<td>Numeric data type</td>
</tr>
<tr>
<td>REPEAT</td>
<td>Introduces control statement for loop processing</td>
<td>REPEAT Statement</td>
</tr>
</tbody>
</table>
### Language Description

<table>
<thead>
<tr>
<th>Keywords</th>
<th>Description</th>
<th>Example, Syntax Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>RET_VAL</td>
<td>Return value of a function Function</td>
<td></td>
</tr>
<tr>
<td>RETURN</td>
<td>Control statement which executes return from subroutine RETURN Statement</td>
<td></td>
</tr>
<tr>
<td>S5TIME</td>
<td>Elementary data type for time specification, special S5 format Time type</td>
<td></td>
</tr>
<tr>
<td>STRING</td>
<td>Data type for character string STRING data type specification</td>
<td></td>
</tr>
<tr>
<td>STRUCT</td>
<td>Introduces specification of a structure and is followed by a list of components STRUCT data type specification</td>
<td></td>
</tr>
<tr>
<td>THEN</td>
<td>Introduces resulting actions if condition is satisfied IF statement</td>
<td></td>
</tr>
<tr>
<td>TIME</td>
<td>Elementary data type for time specification Time type</td>
<td></td>
</tr>
<tr>
<td>TIMER</td>
<td>Data type of timer, useable only in parameter subsection Parameter data type specification</td>
<td></td>
</tr>
<tr>
<td>TIME_OF_DAY</td>
<td>Elementary data type for time of day Time type</td>
<td></td>
</tr>
<tr>
<td>TO</td>
<td>Introduces the terminal value FOR statement</td>
<td></td>
</tr>
<tr>
<td>TOD</td>
<td>Elementary data type for time of day Time type</td>
<td></td>
</tr>
<tr>
<td>TRUE</td>
<td>Predefined Boolean constant: Logic condition met, value does not equal 0</td>
<td></td>
</tr>
<tr>
<td>TYPE</td>
<td>Introduces UDT User-defined data type</td>
<td></td>
</tr>
<tr>
<td>VAR</td>
<td>Introduces declaration subsection Static variables subsection</td>
<td></td>
</tr>
<tr>
<td>VAR_TEMP</td>
<td>Introduces declaration subsection Temporary variables subsection</td>
<td></td>
</tr>
<tr>
<td>UNTIL</td>
<td>Introduces terminate condition for REPEAT statement REPEAT Statement</td>
<td></td>
</tr>
<tr>
<td>VAR_INPUT</td>
<td>Introduces declaration subsection Parameter subsection</td>
<td></td>
</tr>
<tr>
<td>VAR_IN_OUT</td>
<td>Introduces declaration subsection Parameter subsection</td>
<td></td>
</tr>
<tr>
<td>VAR_OUTPUT</td>
<td>Introduces declaration subsection Parameter subsection</td>
<td></td>
</tr>
<tr>
<td>WHILE</td>
<td>Introduces control statement for loop processing WHILE Statement</td>
<td></td>
</tr>
<tr>
<td>WORD</td>
<td>Elementary data type Word Bit data type</td>
<td></td>
</tr>
<tr>
<td>VOID</td>
<td>No return value from a function call Function</td>
<td></td>
</tr>
<tr>
<td>XOR</td>
<td>Logic operation Basic logic operation</td>
<td></td>
</tr>
</tbody>
</table>
15.1.6 Address Identifiers and Block Keywords

Shared System Data

The following table lists the SIMATIC mnemonics of S7-SCL address identifiers arranged in alphabetical order along with a description of each.

- Address identifier specification:
  - Memory prefix (Q, I, M, PQ, PI) or data block (D)

- Data element size specification:
  - Size prefix (optional or B, D, W, X)

The mnemonics represent a combination of the address identifier (memory prefix or D for data block) and the size prefix. Both are lexical rules. The table is sorted in the order of the German mnemonics and the corresponding English mnemonics are shown in the second column.

<table>
<thead>
<tr>
<th>German Mnemonic</th>
<th>English Mnemonic</th>
<th>Memory Prefix or Data Block</th>
<th>Size Prefix</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Q</td>
<td>Output (via process image)</td>
<td>Bit</td>
</tr>
<tr>
<td>AB</td>
<td>QB</td>
<td>Output (via process image)</td>
<td>Byte</td>
</tr>
<tr>
<td>AD</td>
<td>QD</td>
<td>Output (via process image)</td>
<td>Double word</td>
</tr>
<tr>
<td>AW</td>
<td>QW</td>
<td>Output (via process image)</td>
<td>Word</td>
</tr>
<tr>
<td>AX</td>
<td>QX</td>
<td>Output (via process image)</td>
<td>Bit</td>
</tr>
<tr>
<td>D</td>
<td>D</td>
<td>Data block</td>
<td>Bit</td>
</tr>
<tr>
<td>DB</td>
<td>DB</td>
<td>Data block</td>
<td>Byte</td>
</tr>
<tr>
<td>DD</td>
<td>DD</td>
<td>Data block</td>
<td>Double word</td>
</tr>
<tr>
<td>DW</td>
<td>DW</td>
<td>Data block</td>
<td>Word</td>
</tr>
<tr>
<td>DX</td>
<td>DX</td>
<td>Data block</td>
<td>Bit</td>
</tr>
<tr>
<td>E</td>
<td>I</td>
<td>Input (via process image)</td>
<td>Bit</td>
</tr>
<tr>
<td>EB</td>
<td>IB</td>
<td>Input (via process image)</td>
<td>Byte</td>
</tr>
<tr>
<td>ED</td>
<td>ID</td>
<td>Input (via process image)</td>
<td>Double word</td>
</tr>
<tr>
<td>EW</td>
<td>IW</td>
<td>Input (via process image)</td>
<td>Word</td>
</tr>
<tr>
<td>EX</td>
<td>IX</td>
<td>Input (via process image)</td>
<td>Bit</td>
</tr>
<tr>
<td>M</td>
<td>M</td>
<td>Bit memory</td>
<td>Bit</td>
</tr>
<tr>
<td>MB</td>
<td>MB</td>
<td>Bit memory</td>
<td>Byte</td>
</tr>
<tr>
<td>MD</td>
<td>MD</td>
<td>Bit memory</td>
<td>Double word</td>
</tr>
<tr>
<td>MW</td>
<td>MW</td>
<td>Bit memory</td>
<td>Word</td>
</tr>
<tr>
<td>MX</td>
<td>MX</td>
<td>Bit memory</td>
<td>Bit</td>
</tr>
<tr>
<td>PAB</td>
<td>PQB</td>
<td>Output (direct to peripherals)</td>
<td>Byte</td>
</tr>
<tr>
<td>PAD</td>
<td>PQD</td>
<td>Output (direct to peripherals)</td>
<td>Double word</td>
</tr>
<tr>
<td>PAW</td>
<td>PQW</td>
<td>Output (direct to peripherals)</td>
<td>Word</td>
</tr>
<tr>
<td>PEB</td>
<td>PiB</td>
<td>Input (direct from peripherals)</td>
<td>Byte</td>
</tr>
<tr>
<td>PED</td>
<td>PiD</td>
<td>Input (direct from peripherals)</td>
<td>Double word</td>
</tr>
<tr>
<td>PEW</td>
<td>PiW</td>
<td>Input (direct from peripherals)</td>
<td>Word</td>
</tr>
</tbody>
</table>
Block Keywords

Used for absolute addressing of blocks. The table is sorted in the order of the German mnemonics and the corresponding English mnemonics are shown in the second column.

<table>
<thead>
<tr>
<th>German Mnemonic</th>
<th>English Mnemonic</th>
<th>Memory Prefix or Data Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB</td>
<td>DB</td>
<td>Data block</td>
</tr>
<tr>
<td>FB</td>
<td>FB</td>
<td>Function block</td>
</tr>
<tr>
<td>FC</td>
<td>FC</td>
<td>Function</td>
</tr>
<tr>
<td>OB</td>
<td>OB</td>
<td>Organization block</td>
</tr>
<tr>
<td>SDB</td>
<td>SDB</td>
<td>System data block</td>
</tr>
<tr>
<td>SFC</td>
<td>SFC</td>
<td>System function</td>
</tr>
<tr>
<td>SFB</td>
<td>SFB</td>
<td>System function block</td>
</tr>
<tr>
<td>T</td>
<td>T</td>
<td>Timer</td>
</tr>
<tr>
<td>UDT</td>
<td>UDT</td>
<td>User-defined data type</td>
</tr>
<tr>
<td>Z</td>
<td>C</td>
<td>Counter</td>
</tr>
</tbody>
</table>

15.1.7 Overview of Non Terms

A non term is a complex element that is described by another rule. A non term is represented by an oblong box. The name in the box is the name of the more specific rule.

Non term

<Rule name>

Rule name may be in upper or lower case!

This element occurs in lexical and syntax rules.
15.1.8 Overview of Tokens

A token is a complex element used as a basic element in syntax rules and explained in the lexical rules. A token is represented by an oblong box. The NAME, written in upper case letters, is the name of the explanatory lexical rule (not shown inside a box).

<table>
<thead>
<tr>
<th>Token</th>
<th>&lt;Rule name&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Rule name must always be in upper case letters!</td>
</tr>
</tbody>
</table>

The defined tokens represent identifiers obtained on the basis of lexical rules. Such tokens describe:

- Identifiers
- S7-SCL Naming Conventions
- Predefined constants and flags

15.1.9 Identifiers

Identifier

You can access language objects of S7-SCL using identifiers. The following table shows the classes of identifiers.

<table>
<thead>
<tr>
<th>Identifier Type</th>
<th>Comments, Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keywords</td>
<td>For example, control statements BEGIN, DO, WHILE</td>
</tr>
<tr>
<td>Predefined names</td>
<td>Names of</td>
</tr>
<tr>
<td></td>
<td>• Standard data types (for example, BOOL, BYTE, INT)</td>
</tr>
<tr>
<td></td>
<td>• Predefined standard functions, for example ABS</td>
</tr>
<tr>
<td></td>
<td>• Standard constants TRUE and FALSE</td>
</tr>
<tr>
<td>Absolute address identifiers</td>
<td>For shared system data and data blocks: For example, I1.2, MW10, FC20, T5, DB30, DB10.D4.5</td>
</tr>
<tr>
<td>User-defined names based on the rule IDENTIFIER</td>
<td>Names of</td>
</tr>
<tr>
<td></td>
<td>• declared variables</td>
</tr>
<tr>
<td></td>
<td>• structure components</td>
</tr>
<tr>
<td></td>
<td>• parameters</td>
</tr>
<tr>
<td></td>
<td>• declared constants</td>
</tr>
<tr>
<td></td>
<td>• labels</td>
</tr>
<tr>
<td>Symbol editor symbols</td>
<td>Conform either to the lexical rule IDENTIFIER or the lexical rule Symbol; in other words, enclosed in quotes, for example, &quot;xyz&quot;</td>
</tr>
</tbody>
</table>
Upper- and Lowercase

Upper- and lowercase notation is not relevant for the keywords. Since S7-SCL version 4.0, the notation of predefined names and the freely selectable names, such as for variables and symbols from the symbol table is no longer case sensitive. The following table provides an overview.

<table>
<thead>
<tr>
<th>Identifier Type</th>
<th>Case-Sensitive?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keywords</td>
<td>No</td>
</tr>
<tr>
<td>Predefined names for standard data types</td>
<td>No</td>
</tr>
<tr>
<td>Names of standard functions</td>
<td>No</td>
</tr>
<tr>
<td>Predefined names for standard constants</td>
<td>No</td>
</tr>
<tr>
<td>Absolute address identifiers</td>
<td>No</td>
</tr>
<tr>
<td>User-defined names</td>
<td>No</td>
</tr>
<tr>
<td>Symbol editor symbols</td>
<td>No</td>
</tr>
</tbody>
</table>

The names of standard functions, such as BYTE_TO_WORD and ABS can also be written in lowercase characters. This also applies to parameters for timer and counter functions, for example, SV, se or CV.
15.1.10 Assigning Names in S7-SCL

Assigning Selectable Names

You can assign names in two basic ways:

- You can assign names within S7-SCL itself. These names must conform to the rule IDENTIFIER (see Figure). IDENTIFIER is the general term you can use for any name in S7-SCL.
- Alternatively, you can assign the name in STEP 7 using the symbol table. The rule to be applied in this case is also IDENTIFIER or, as an additional option, Symbol. By putting your entry in inverted commas, you can write the symbol with all printable characters (for example, spaces).

Symbols must be defined in the symbol table.

Rules for Assigning Names

Please remember the following points:

- Choose names that are unambiguous and self-explanatory and which enhance the comprehensibility of the program.
- Check whether the name is already being used by the system, for example by identifiers for data types or standard functions.
- Scope: If you use names with a global scope, the scope covers the entire program. Names with a local scope are valid only within a block. This enables you to use the same names in different blocks. The following table lists the various options available.
Restrictions

When assigning names, remember the following restrictions:

A name must be unique within the limits of its own applicability, that is, names already used within a particular block cannot be used again within the same block. In addition, the following names reserved by the system may not be used:

- Names of keywords: For example, CONST, END_CONST, BEGIN
- Names of operations: For example, AND, XOR
- Names of predefined identifiers: For example, names of data types such as BOOL, STRING, INT
- Names of the predefined constants TRUE and FALSE
- Names of standard functions: For example, ABS, ACOS, ASIN, COS, LN
- Names of absolute address identifiers for shared system data: For example, IB, IW, ID, QB, QW, QD MB, MD

Using IDENTIFIERS

The following table shows the situations in which you can use names that conform to the rule for IDENTIFIERS.

<table>
<thead>
<tr>
<th>IDENTIFIER</th>
<th>Description</th>
<th>Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block name</td>
<td>Symbolic name for block</td>
<td>BLOCK IDENTIFIER, function call</td>
</tr>
<tr>
<td>Name of timer or counter</td>
<td>Symbolic name for timer or</td>
<td>TIMER IDENTIFIER, COUNTER</td>
</tr>
<tr>
<td></td>
<td>counter</td>
<td>IDENTIFIER</td>
</tr>
<tr>
<td>Attribute name</td>
<td>Name of an attribute</td>
<td>Attribute assignment</td>
</tr>
<tr>
<td>Constant name</td>
<td>Declaration/use of symbolic</td>
<td>constant subsection</td>
</tr>
<tr>
<td></td>
<td>constant</td>
<td>Constant</td>
</tr>
<tr>
<td>Label</td>
<td>Declaration of label, use of</td>
<td>Labels subsection statement</td>
</tr>
<tr>
<td></td>
<td>label</td>
<td>section, GOTO statement</td>
</tr>
<tr>
<td>Variable name</td>
<td>Declaration of temporary or</td>
<td>Variable declaration, simple</td>
</tr>
<tr>
<td></td>
<td>static variable</td>
<td>variable, Structured variable</td>
</tr>
<tr>
<td>Local instance name</td>
<td>Declaration of local instance</td>
<td>Instance declaration, FB call name</td>
</tr>
</tbody>
</table>
BLOCK IDENTIFIER

In the BLOCK IDENTIFIER rule, you can use IDENTIFIERS or symbols:

- **Block Keyword**: DB, FB, FC, OB, SDB, SFC, SFB, UDT
- **IDENTIFIER**
- **Symbol**

The TIMER IDENTIFIER and COUNTER IDENTIFIER rules are analogous to the BLOCK IDENTIFIER rule.
15.1.11 Predefined Constants and Flags

The tables apply to both the German and English mnemonics.

### Constants

<table>
<thead>
<tr>
<th>Mnemonics</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FALSE</td>
<td>Predefined Boolean constants (standard constants) with the value 0. The logical meaning is that a condition is not satisfied.</td>
</tr>
<tr>
<td>TRUE</td>
<td>Predefined Boolean constants (standard constants) with the value 1. The logical meaning is that a condition is satisfied.</td>
</tr>
</tbody>
</table>

### Flags

<table>
<thead>
<tr>
<th>Mnemonics</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EN</td>
<td>Block enable flag</td>
</tr>
<tr>
<td>ENO</td>
<td>Block error flag</td>
</tr>
<tr>
<td>OK</td>
<td>Flag is set to FALSE if the statement has been incorrectly executed.</td>
</tr>
</tbody>
</table>
15.2 Lexical Rules

15.2.1 Overview: Lexical Rules

The lexical rules describe the structure of the elements (tokens) processed during the lexical analysis performed by the Compiler. For this reason lexical rules do not have a flexible format and must be strictly observed. In particular, this means that:

- Inserting formatting characters is not permitted,
- Section and line comments cannot be inserted,
- Inserting attributes for identifiers is not permitted.

15.2.2 Identifiers

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifier</td>
<td>Syntax Diagram</td>
</tr>
<tr>
<td>Block identifier</td>
<td>Syntax Diagram</td>
</tr>
<tr>
<td>Timer identifier</td>
<td>Syntax Diagram</td>
</tr>
</tbody>
</table>
### Language Description

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Counter identifier</td>
<td><img src="image1" alt="Diagram 1" /></td>
</tr>
<tr>
<td>Block keyword</td>
<td><img src="image2" alt="Diagram 2" /></td>
</tr>
<tr>
<td>Symbol</td>
<td><img src="image3" alt="Diagram 3" /></td>
</tr>
<tr>
<td>Number</td>
<td><img src="image4" alt="Diagram 4" /></td>
</tr>
</tbody>
</table>
### 15.2.3 Constants

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit constant</td>
<td><img src="image1" alt="" /></td>
</tr>
<tr>
<td>Integer constant</td>
<td><img src="image2" alt="" /></td>
</tr>
<tr>
<td>Real number constant</td>
<td><img src="image3" alt="" /></td>
</tr>
<tr>
<td>Decimal digit string</td>
<td><img src="image4" alt="" /></td>
</tr>
</tbody>
</table>

#### Bit constant
- **BIT CONSTANT**
  - `BOOL#`
  - `BYTE#`
  - `WORD#`
  - `DWORD#`
  - `DECIMAL DIGIT STRING`
  - `OCTAL DIGIT STRING`
  - `HEXADECIMAL DIGIT STRING`
  - `BINARY DIGIT STRING`
  - `CHARACTER (1)`

(1) only with BYTE data type

#### Integer constant
- **INTEGER CONSTANT**
  - `INT#`
  - `DINT#`
  - `DECIMAL DIGIT STRING`
  - `OCTAL DIGIT STRING`
  - `HEXADECIMAL DIGIT STRING`
  - `BINARY DIGIT STRING`
  - `CHARACTER (1)`

(1) only with INT data type

#### Real number constant
- **REAL NUMBER CONSTANT**
  - `REAL#`
  - `DECIMAL DIGIT STRING`
  - `DECIMAL DIGIT STRING`
  - `Exponent`

#### Decimal digit string
- **Decimal Digit String**
  - `Digit`
  - Underscore
  - Decimal digits: 0-9

![Diagram](image1)

![Diagram](image2)

![Diagram](image3)

![Diagram](image4)
## Language Description

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Binary digit string</strong></td>
<td>![Binary Digit String Diagram]</td>
</tr>
<tr>
<td><strong>Octal digit string</strong></td>
<td>![Octal Digit String Diagram]</td>
</tr>
<tr>
<td><strong>Hexadecimal digit string</strong></td>
<td>![Hexadecimal Digit String Diagram]</td>
</tr>
<tr>
<td><strong>Exponent</strong></td>
<td>![Exponent Diagram]</td>
</tr>
<tr>
<td><strong>Character constant</strong></td>
<td>![Character Constant Diagram]</td>
</tr>
<tr>
<td>Rule</td>
<td>Syntax Diagram</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>String constant</td>
<td>STRING CONSTANT</td>
</tr>
</tbody>
</table>

```
 STRING CONSTANT
    Character
    String break
    Character
```

<table>
<thead>
<tr>
<th>Characters</th>
<th>Character</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

```
 Character
  $ Escape symbol $
  Substitute char.
    $ or '
  Control char.
    *P or L or R or T or N
  Hexadecimal digit**
  Hexadecimal digit**

Alternative representation in hex code

* P=Form feed
  L=Line feed
  R=Carriage return
  T=Tabulator
  N=New line

** $00 not permitted
```

<table>
<thead>
<tr>
<th>String Break</th>
<th>String Break Syntax</th>
</tr>
</thead>
</table>
|                 | Space,
|                 | Line feed,
|                 | Carriage return,
|                 | Form feed, or
|                 | Tabulator |

```
 String Break Syntax
    Formatting character
    Comments
    $>
```

<table>
<thead>
<tr>
<th>Date</th>
<th>DATE#</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Details of date</td>
</tr>
</tbody>
</table>

```
 DATE#
   D#
```

* $00 not permitted
** $00 not permitted

---

**S7-SCL V5.3 for S7-300/400**

ASE00324650-01

15-25
## Rule Description

### Time period

**TIME PERIOD**

- Each time unit (hours, minutes, etc.) may only be specified once.
- The order days, hours, minutes, seconds, milliseconds must be adhered to.

### Time of day

**TIME OF DAY**

### Date and time

**DATE AND TIME**

### Date

- **Year**: DECIMAL DIGIT STRING
- **Month**: DECIMAL DIGIT STRING
- **Day**: DECIMAL DIGIT STRING

### Time of day

- **Hours**: DECIMAL DIGIT STRING
- **Minutes**: DECIMAL DIGIT STRING
- **Seconds**: DECIMAL DIGIT STRING
- **Milliseconds**: DECIMAL DIGIT STRING
### Rule: Decimal representation

#### Syntax Diagram:

**Simple Time Format**

```
DECIMAL DIGIT STRING  D
   |                     
   V                     
DECIMAL DIGIT STRING  H
   |                     
   V                     
DECIMAL DIGIT STRING  M
   |                     
   V                     
DECIMAL DIGIT STRING  S
   |                     
   V                     
DECIMAL DIGIT STRING  MS
```

**Composite Time Format**

```
DECIMAL DIGIT STRING  D
   |                     
   V                     
DECIMAL DIGIT STRING  H
   |                     
   V                     
DECIMAL DIGIT STRING  M
   |                     
   V                     
DECIMAL DIGIT STRING  S
   |                     
   V                     
DECIMAL DIGIT STRING  MS
```

Use of the simple time format is only possible for undefined time units.

---

**Composite Time Format**

```
DECIMAL DIGIT STRING  D
   |                     
   V                     
DECIMAL DIGIT STRING  H
   |                     
   V                     
DECIMAL DIGIT STRING  M
   |                     
   V                     
DECIMAL DIGIT STRING  S
   |                     
   V                     
DECIMAL DIGIT STRING  MS
```

**Use of the simple time format is only possible for undefined time units.**
### 15.2.4 Absolute Addressing

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple memory access</td>
<td><img src="#" alt="Diagram" /></td>
</tr>
<tr>
<td>Indexed memory access</td>
<td><img src="#" alt="Diagram" /></td>
</tr>
<tr>
<td>Address identifier for memory</td>
<td><img src="#" alt="Diagram" /></td>
</tr>
<tr>
<td>Absolute DB access</td>
<td><img src="#" alt="Diagram" /></td>
</tr>
<tr>
<td>Indexed DB access</td>
<td><img src="#" alt="Diagram" /></td>
</tr>
<tr>
<td>Rule</td>
<td>Syntax Diagram</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Structured DB access</td>
<td>![Structured DB access Diagram]</td>
</tr>
<tr>
<td>Address identifier DB</td>
<td>![Address identifier DB Diagram]</td>
</tr>
<tr>
<td>Memory prefix</td>
<td>![Memory prefix Diagram]</td>
</tr>
<tr>
<td>Size prefix for memory and DB</td>
<td>![Size prefix Diagram]</td>
</tr>
<tr>
<td>Address for memory and DB</td>
<td>![Address for memory and DB Diagram]</td>
</tr>
</tbody>
</table>
Rule Description

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access to local instance</td>
<td><img src="image1" alt="Diagram" /></td>
</tr>
</tbody>
</table>

**15.2.5 Comments**

The following points are the most important things to remember when inserting comments:

- Nesting of comments is permitted if the “Allow nested comments” is activated.
- They can be inserted at any point in the syntax rules but not in the lexical rules.

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment</td>
<td><img src="image2" alt="Diagram" /></td>
</tr>
<tr>
<td>Line comment</td>
<td><img src="image3" alt="Diagram" /></td>
</tr>
<tr>
<td>Comment section</td>
<td><img src="image4" alt="Diagram" /></td>
</tr>
</tbody>
</table>
15.2.6 **Block Attributes**

Block attributes can be placed after the BLOCK IDENTIFIER and before the declaration of the first variable or parameter subsection using the syntax shown here.

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td>Version</td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td>Block protection</td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td>Author</td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td>Parameter name</td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td>Block family</td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td>Rule</td>
<td>Syntax Diagram</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>System attributes for blocks</td>
<td>System attributes for blocks</td>
</tr>
<tr>
<td></td>
<td>max. 24 characters</td>
</tr>
<tr>
<td></td>
<td>IDENTIFIER</td>
</tr>
<tr>
<td></td>
<td>Printable character</td>
</tr>
</tbody>
</table>

Diagram shows the flow of system attributes for blocks with a maximum of 24 characters, an identifier, and a printable character.
15.2.7 **Compiler Options**

Compiler options are positioned outside the block limits in a separate line in the source file. The entries are not case-sensitive.

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compiler option</td>
<td>![Syntax diagram image]</td>
</tr>
</tbody>
</table>

*Value=y(es) or n(o)
15.3 Syntactic Rules

15.3.1 Overview: Syntax Rules

The syntax rules are built up from the lexical rules and define the structure of S7-SCL. Within the limitations of these rules, the structure of the your S7-SCL program is flexible.

Each rule has a name that precedes the definition. If the rule is used in a higher-level rule, the name appears in the higher-level rule as a non term.

If the name in the oblong box is in upper case letters, this means it is a token that is described in the lexical rules.

You will find information on rule names in rounded or circular boxes in the section entitled "Formal Language Description".

Flexible Format

Flexible format means:

- You can insert formatting characters at any point.
- You can insert comment lines and comment sections
15.3.2 Structure of S7-SCL Source Files

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-SCL program</td>
<td>![Diagram of S7-SCL program]</td>
</tr>
<tr>
<td>S7-SCL program unit</td>
<td>![Diagram of S7-SCL program unit]</td>
</tr>
<tr>
<td>Organization block</td>
<td>![Diagram of Organization block]</td>
</tr>
<tr>
<td>Function</td>
<td>![Diagram of Function]</td>
</tr>
</tbody>
</table>

Note that if functions do not have VOID in the code section, the return value must be assigned to the function name.
<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function block</td>
<td>Function block</td>
</tr>
<tr>
<td></td>
<td>PROGRAM</td>
</tr>
<tr>
<td></td>
<td>FUNCTION_BLOCK</td>
</tr>
<tr>
<td></td>
<td>FB IDENTIFIER</td>
</tr>
<tr>
<td></td>
<td>FB declaration section</td>
</tr>
<tr>
<td></td>
<td>BEGIN Statement section</td>
</tr>
<tr>
<td></td>
<td>END_PROGRAM</td>
</tr>
<tr>
<td></td>
<td>END_FUNCTION_BLOCK</td>
</tr>
<tr>
<td>Data block</td>
<td>Data Block</td>
</tr>
<tr>
<td></td>
<td>DATA_BLOCK</td>
</tr>
<tr>
<td></td>
<td>DB NAME</td>
</tr>
<tr>
<td></td>
<td>DB declaration section</td>
</tr>
<tr>
<td></td>
<td>BEGIN DB assignment section</td>
</tr>
<tr>
<td></td>
<td>END_DATA_BLOCK</td>
</tr>
<tr>
<td>User-defined data type</td>
<td>User-Defined Data Type</td>
</tr>
<tr>
<td></td>
<td>TYPE UDT NAME</td>
</tr>
<tr>
<td></td>
<td>Structure data type specification</td>
</tr>
<tr>
<td></td>
<td>END_TYPE</td>
</tr>
</tbody>
</table>
### 15.3.3 Structure of the Declaration Sections

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>OB declaration section</td>
<td><img src="" alt="OB Syntax Diagram" /></td>
</tr>
<tr>
<td>FC declaration section</td>
<td><img src="" alt="FC Syntax Diagram" /></td>
</tr>
<tr>
<td>FB declaration section</td>
<td><img src="" alt="FB Syntax Diagram" /></td>
</tr>
</tbody>
</table>
### Rule Description

#### DB declaration section

**Syntax Diagram**

- **UDT**
- **IDENTIFIER**
- Structure data type specification

#### DB assignment section

**Syntax Diagram**

- **Simple variable**
- **Constant***
- **;**

* in STL notation

#### Constant subsection

**Syntax Diagram**

- **CONST**
- **IDENTIFIER**
- **Simple expression**
- **;**
- **END_CONST**

Constant name

#### Label subsection

**Syntax Diagram**

- **LABEL**
- **IDENTIFIER**
- **;**
- **END_LABEL**

Label
<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static variable subsection</td>
<td>Static Variable Section</td>
</tr>
<tr>
<td></td>
<td>[Diagram showing variable declaration and instance declaration]</td>
</tr>
<tr>
<td></td>
<td>* only with FB</td>
</tr>
<tr>
<td>Variable declaration</td>
<td>[Diagram showing variable name, data type, and data type initialization]</td>
</tr>
<tr>
<td></td>
<td>1) System attributes for parameters</td>
</tr>
<tr>
<td>Data type initialization</td>
<td>[Diagram showing data type initialization components]</td>
</tr>
</tbody>
</table>

**Rule: Static variable subsection**

**Syntax Diagram:**

Static Variable Section

- **Variable declaration**
  - **VAR**
  - **END_VAR**
  - **Instance declaration**

**Variable declaration**

- **IDENTIFIER**
  - Variable name, Parameter name, or Component name
  - Component name within structures
  - Not during initialization

**Data type initialization**

- **INITIALISATION**
  - **CONSTANT**
  - **ARRAY**
  - **INITIALISATION LIST**
<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array initialization list</td>
<td></td>
</tr>
<tr>
<td>Array Initialization List</td>
<td></td>
</tr>
<tr>
<td>Instance declaration (possible only in the VAR section of an FB)</td>
<td>Instance Declaration</td>
</tr>
<tr>
<td>Temporary variable subsection</td>
<td>Temporary Variable Subsection</td>
</tr>
</tbody>
</table>

### Array initialization list

- **Constant repetition list**
  - Decimal digit sequence
  - Repetition factor
  - Constant

### Array Initialization List

- Constant
  - Repetition factor

### Instance declaration (possible only in the VAR section of an FB)

- Instance Declaration
  - Local instance name
  - IDENTIFIER
  - FB NAME
  - SFB NAME

### Temporary variable subsection

- Temporary Variable Subsection
  - VAR_TEMP
  - Variable declaration
  - END_VAR

Initialization not possible
Parameter subsection

Parameter Subsection

VAR_INPUT
VAR_OUTPUT
VAR_IN_OUT

Variable declaration

END_VAR

Initialization only possible for VAR_INPUT and VAR_OUTPUT

Data type specification

Elementary data type

DATE_AND_TIME

String data type specification

ARRAY data type specification

STRUCT data type specification

UDT IDENTIFIER

Parameter data type specification
15.3.4 Data Types in S7-SCL

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elementary data type</td>
<td><img src="image1.png" alt="Diagram" /></td>
</tr>
<tr>
<td>Bit data type</td>
<td><img src="image2.png" alt="Diagram" /></td>
</tr>
<tr>
<td>Character type</td>
<td><img src="image3.png" alt="Diagram" /></td>
</tr>
<tr>
<td>STRING data type specification</td>
<td><img src="image4.png" alt="Diagram" /></td>
</tr>
<tr>
<td>Numeric data type</td>
<td><img src="image5.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

**Bit data type**
- **BOOL**
- **BYTE**
- **WORD**
- **DWORD**

**Character type**
- **CHAR**

**STRING Data Type Specification**
- **STRING**
- **Simple expression**
- **String dimension**

**Numeric data type**
- **INT**
- **DINT**
- **REAL**

- Integer
- Integer, double resolution
- Real number
### Rule Syntax Diagram

**Time type**

<table>
<thead>
<tr>
<th>S5TIME</th>
<th>Time, S5 format</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIME</td>
<td>Time</td>
</tr>
<tr>
<td>TIME_OF_DAY</td>
<td>Time of day</td>
</tr>
<tr>
<td>TOD</td>
<td>Date</td>
</tr>
<tr>
<td>DATE</td>
<td>Date</td>
</tr>
</tbody>
</table>

**DATE_AND_TIME**

<table>
<thead>
<tr>
<th>DATE_AND_TIME#</th>
<th>Date</th>
<th>Time</th>
</tr>
</thead>
</table>

**ARRAY data type specification**

<table>
<thead>
<tr>
<th>ARRAY</th>
<th>Index specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ ]</td>
<td>Data type specification</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>i</th>
<th>Index 1</th>
<th>Index n</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**STRUCT data type specification**

Remember that the END_STRUCT keyword must be terminated by a semicolon.

<table>
<thead>
<tr>
<th>STRUCT</th>
<th>Component declaration</th>
<th>END_STRUCT</th>
</tr>
</thead>
</table>

**Component declaration**

<table>
<thead>
<tr>
<th>IDENTIFIER</th>
<th>Component name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Data type specification</td>
</tr>
<tr>
<td></td>
<td>Data initialization ;</td>
</tr>
</tbody>
</table>
**Parameter type specification**

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIMER</td>
<td>Timer</td>
</tr>
<tr>
<td>COUNTER</td>
<td>Counter</td>
</tr>
<tr>
<td>ANY</td>
<td>Any type</td>
</tr>
<tr>
<td>POINTER</td>
<td>Address</td>
</tr>
<tr>
<td>BLOCK_FC</td>
<td>Function</td>
</tr>
<tr>
<td>BLOCK_FB</td>
<td>Function block</td>
</tr>
<tr>
<td>BLOCK_DB</td>
<td>Data block</td>
</tr>
<tr>
<td>BLOCK_SDB</td>
<td>System data block</td>
</tr>
</tbody>
</table>
### 15.3.5 Statement Section

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statement section</td>
<td><img src="image" alt="Statement Section Diagram" /></td>
</tr>
<tr>
<td>Statement</td>
<td><img src="image" alt="Statement Diagram" /></td>
</tr>
<tr>
<td>Value assignment</td>
<td><img src="image" alt="Value Assignment Diagram" /></td>
</tr>
</tbody>
</table>

#### Rule

**Statement section**

- Identifier
  - Label
- Statement

**Statement**

- Value assignment
- Subroutine call
- Control statement

**Value assignment**

- Simple variable
  - Absolute variable
    - in CPU memory areas
    - Variable in DB
    - Variable in local instance
- Expression
Language Description

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extended variable</td>
<td><img src="image1" alt="Extended variable Diagram" /></td>
</tr>
<tr>
<td>Simple variable</td>
<td><img src="image2" alt="Simple variable Diagram" /></td>
</tr>
<tr>
<td>Structured variable</td>
<td><img src="image3" alt="Structured variable Diagram" /></td>
</tr>
</tbody>
</table>

**Extended variable**
- Simple variable
- Absolute variable for CPU memory areas
- Variable in DB
- Variable in local instance
- FC call

**Simple variable**
- IDENTIFIER
- Variable name or Parameter name
- Structured variable
- Simple array

**Structured variable**
- IDENTIFIER
- Simple array
- First part of identifier is variable name or parameter name,
  and part following period is component name
# 15.3.6 Value Assignments

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expression</td>
<td><img src="image" alt="Expression Diagram" /></td>
</tr>
<tr>
<td>Simple expression</td>
<td><img src="image" alt="Simple Expression Diagram" /></td>
</tr>
<tr>
<td>Simple multiplication</td>
<td><img src="image" alt="Simple Multiplication Diagram" /></td>
</tr>
</tbody>
</table>

- **Expression**: Basic logic operations, comparison operations, basic arithmetic operations, exponent, unary plus, unary minus, negation, expression.  
- **Simple expression**: simple multiplication, multiplication, addition, subtraction, simple expression, constant.  
- **Simple multiplication**: multiplication, division, modulus, simple multiplication, constant, simple expression.
<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Address</strong></td>
<td><img src="image" alt="Address Syntax Diagram" /></td>
</tr>
<tr>
<td><strong>Extended Variable</strong></td>
<td><img src="image" alt="Extended Variable Syntax Diagram" /></td>
</tr>
<tr>
<td><strong>Constant</strong></td>
<td><img src="image" alt="Constant Syntax Diagram" /></td>
</tr>
<tr>
<td><strong>Exponent</strong></td>
<td><img src="image" alt="Exponent Syntax Diagram" /></td>
</tr>
<tr>
<td><strong>Basic logic operation</strong></td>
<td><img src="image" alt="Basic Logic Operation Diagram" /></td>
</tr>
<tr>
<td>Rule</td>
<td>Syntax Diagram</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Basic arithmetic operation</td>
<td>![Basic Arithmetic Operation Diagram]</td>
</tr>
<tr>
<td>Comparison operation</td>
<td>![Comparison Operation Diagram]</td>
</tr>
</tbody>
</table>
### 15.3.7 Calling Functions and Function Blocks

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>FB call</td>
<td>Function Block Call</td>
</tr>
<tr>
<td></td>
<td>FB: Function block</td>
</tr>
<tr>
<td></td>
<td>SFB: System function block</td>
</tr>
<tr>
<td></td>
<td>Local instance name</td>
</tr>
<tr>
<td></td>
<td>IDENTIFIER</td>
</tr>
<tr>
<td>Function call</td>
<td>Function Call</td>
</tr>
<tr>
<td></td>
<td>FC: Function</td>
</tr>
<tr>
<td></td>
<td>SFC: System function</td>
</tr>
<tr>
<td></td>
<td>Standard function name or symbolic name</td>
</tr>
<tr>
<td></td>
<td>IDENTIFIER</td>
</tr>
<tr>
<td>FB parameter</td>
<td>FB Parameters</td>
</tr>
<tr>
<td></td>
<td>Input assignment</td>
</tr>
<tr>
<td></td>
<td>In/out assignment</td>
</tr>
<tr>
<td>Rule</td>
<td>Syntax Diagram</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>FC parameters</td>
<td><img src="image1" alt="Diagram" /></td>
</tr>
<tr>
<td>Input assignment</td>
<td><img src="image2" alt="Diagram" /></td>
</tr>
<tr>
<td>In/out assignment</td>
<td><img src="image3" alt="Diagram" /></td>
</tr>
<tr>
<td>Output assignment</td>
<td><img src="image4" alt="Diagram" /></td>
</tr>
</tbody>
</table>
### 15.3.8 Control Statements

<table>
<thead>
<tr>
<th>Rule</th>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IF statement</strong>&lt;br&gt;Remember that the END_IF keyword must be terminated by a semicolon.</td>
<td>![IF Statement Diagram]</td>
</tr>
<tr>
<td><strong>CASE statement</strong>&lt;br&gt;Remember that the END_CASE keyword must be terminated by a semicolon.</td>
<td>![CASE Statement Diagram]</td>
</tr>
<tr>
<td><strong>Value list</strong></td>
<td>![Value List Diagram]</td>
</tr>
</tbody>
</table>
### Rule: Value

<table>
<thead>
<tr>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>IDENTIFIER Constant name</td>
</tr>
<tr>
<td>Numeric constant</td>
</tr>
</tbody>
</table>

### Iteration and Jump Statements

<table>
<thead>
<tr>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>FOR statement</td>
</tr>
<tr>
<td>WHILE statement</td>
</tr>
<tr>
<td>REPEAT statement</td>
</tr>
<tr>
<td>CONTINUE statement</td>
</tr>
<tr>
<td>EXIT statement</td>
</tr>
<tr>
<td>RETURN statement</td>
</tr>
<tr>
<td>GOTO statement</td>
</tr>
</tbody>
</table>

### FOR Statement

Remember that the END_FOR keyword must be terminated by a semicolon.

<table>
<thead>
<tr>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>FOR Initial statement</td>
</tr>
<tr>
<td>BY Basic expression</td>
</tr>
<tr>
<td>END_FOR</td>
</tr>
</tbody>
</table>

### Initial Assignment

<table>
<thead>
<tr>
<th>Syntax Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple variable of data type INT/DINT</td>
</tr>
<tr>
<td>Rule</td>
</tr>
<tr>
<td>-------------------</td>
</tr>
<tr>
<td><strong>WHILE statement</strong></td>
</tr>
<tr>
<td>Remember that the END_WHILE keyword must be terminated by a semicolon.</td>
</tr>
<tr>
<td><strong>REPEAT statement</strong></td>
</tr>
<tr>
<td>Remember that the END_REPEAT keyword must be terminated by a semicolon.</td>
</tr>
<tr>
<td><strong>CONTINUE statement</strong></td>
</tr>
<tr>
<td><strong>RETURN statement</strong></td>
</tr>
<tr>
<td><strong>EXIT statement</strong></td>
</tr>
<tr>
<td><strong>Program jump</strong></td>
</tr>
</tbody>
</table>
16  Tips and Tricks

Runtime Optimized Code when Accessing Structures in Data Blocks

If you need to access a structure more than once in a data block, the following method can be recommended:

1. Create a local variable with the type of the structure.
2. Assign the structure from the data block to the variable once.
3. You can then use the variable more than once in the code without having to access the DP again.

Example

```
DB100.array[i].value :=
DB100.array[i].value1  * DB100.array[i].value2  /
DB100.array[i].value3 ;
```

This example requires less memory and has a shorter runtime if you program it as follows:

```
VAR_TEMP
  tmp : STRUCT
    value : REAL;
    value1 : REAL;
    value2 : REAL;
    value3 : REAL;
END_STRUCT;
END_VAR

tmp := DB100.array[i];
DB100.array[i].value := tmp.value1 * tmp.value2 / tmp.value3;
```

Note

With VAR_TEMP, you store variables in the stack of the CPU. With smaller CPUs, this can lead to a stack overflow. You should therefore use temporary variables sparingly!
Problems Allocating the L Stack with Small CPUs

Problems allocating the L stack are due to the small stack size of the smaller CPUs. In most cases, the problem can be avoided by taking the measures outlined below:

- Use temporary variables sparingly (VAR_TEMP or VAR section).
- Do not declare any variables of a higher data type and reduce the number of variables of an elementary data type to a minimum.
- Use static variables:
  - When you program an FB, you can use the VAR section instead of VAR_TEMP.
  - When you program an OB or FC, make use of a shared data block or bit memory.
- Avoid complicated expressions. When it processes complicated expressions, the compiler stores interim results on the stack. Depending on the type and number of interim results, the available stack size might be exceeded.
  Remedy:
  Break down your expression into several smaller expressions and assign the interim results explicitly to variables.

Output of REAL Numbers during Monitoring

The "Monitoring" test function can produce the following patterns when displaying nonprintable REAL numbers:

<table>
<thead>
<tr>
<th>Value</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>+ infinity</td>
<td>1.#INFrandom-digits</td>
</tr>
<tr>
<td>- infinity</td>
<td>-1.#INFrandom-digits</td>
</tr>
<tr>
<td>Indefinite</td>
<td>digit.#INDrandom-digits</td>
</tr>
<tr>
<td>NaN digit.</td>
<td>#NANrandom-digits</td>
</tr>
</tbody>
</table>
Displaying S7-SCL Programs in STL Representation

You can open an S7-SCL block with the STL/LAD/FBD editor and display the compiled MC7 commands. Do not make any changes in STL for the following reasons:

- The displayed MC7 command do not necessarily represent a valid STL block.
- An error-free compilation with the STL compiler normally requires modifications to be made that require thorough knowledge of both STL and S7-SCL.
- The block compiled with STL then has the STL language identifier and no longer the S7-SCL identifier.
- The S7-SCL source file and the MC7 code are no longer consistent.

Handling the Time Stamp of Source File, Interface and Code

Time stamps of the source file
An S7-SCL source file always has the time stamp of the last modification.

Time stamp of the block code
Blocks (FB, FC and OB) always have the time stamp of the time at which they are compiled.

Time stamp of the block interface
The time stamp of an interface is changed only when the structure of the interface is modified; in other words,

- The time stamp is retained if modifications are made in the code section, in the attributes, in the comment, in the section VAR_TEMP (with FCs also VAR) or in the notation of the names of parameters or variables. This also applies to underlying interfaces.
- The time stamp of an interface is updated when the data type or any initialization of a parameter or variable is modified or when parameters are removed or added and if the name of the FB changes when multiple instances are involved. This also applies to underlying interfaces.
Return Value of STEP 7 Standard and System Functions

Many STEP 7 standard and system functions have a function value of the type INT that contains the error code. In the reference manual for these functions, the possible error codes are specified as WORD constants of the type "W#16#8093".

S7-SCL is a language that is strict in its rules regarding mixing of types, so that INT and WORD cannot be mixed. The following query, for example, does not produce the required result.

IF SFCxx(..) = 16#8093 THEN ...

You can, however, tell the S7-SCL compiler that a WORD constant should be considered as INT as follows.

- By type-defining the constant. In this case, the query above appears as follows:
  IF SFCxx(..) = INT#16#8093 THEN ...
- By converting WORD_TO_INT(). You would then formulate the query above as follows:
  IF SFCxx(..) = WORD_TO_INT(16#8093) THEN ...

Rewiring Blocks

You can no longer rewire the block calls in the S7-SCL blocks using the Options > Rewire SIMATIC Manager function. You must edit the calls in the S7-SCL source file of the blocks affected manually.

Recommendation:

- Define symbolic names for the blocks in the symbol table and call the blocks using their symbolic names.
- Define symbolic names for absolute addresses (I, M, Q etc.) in the symbol table and use the symbolic names in your program.

If you want to rewire a block later, you only need to change the assignment in the symbol table and do not need to make changes in the S7-SCL source file.
Allocating Structures with an Odd Byte Length

The length of a structure is always filled up to word limits. In order to apply a structure to an odd byte number, S7-SCL provides the AT construct:

Example:
VAR
theStruct : STRUCT
  twoBytes : ARRAY [0..1] OF BYTE;
  oneInt : INT
  oneByte : BYTE;
END_STRUCT;
fiveBytes AT theStruct : ARRAY[0..4] OF BYTE;
END_VAR

You use the identifier five Bytes where 5 BYTEs are required. The identifier the Struct can then be used for structured access.

Limits for FOR Statements

Observe the following rules and limits in order to program "reliable" FOR statements that do not run continuously:

Rule

FOR ii := beginning TO end BY step DO

<table>
<thead>
<tr>
<th>If...</th>
<th>...then:</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>beginning &lt; end</td>
<td>end &lt; (PMAX - step)</td>
<td>Run variable ii runs in the positive direction</td>
</tr>
<tr>
<td>beginning &gt; end AND step &lt; 0</td>
<td>end &gt; (NMAX - step)</td>
<td>Run variable ii runs in the negative direction</td>
</tr>
</tbody>
</table>

Limits

Different limits apply for the two possible data types:

<table>
<thead>
<tr>
<th>Data Type</th>
<th>PMAX</th>
<th>NMAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>ii of type INT</td>
<td>32_767</td>
<td>-32_768</td>
</tr>
<tr>
<td>ii of type DINT</td>
<td>2_147_483_647</td>
<td>-2_147_483_648</td>
</tr>
</tbody>
</table>
Glossary

**Actual Parameter**

Actual parameters replace the formal parameters when a function block (FB) or function (FC) is called.

Example: the formal parameter "Start" is replaced by the actual parameter "I3.6".

**Address**

An address is the part of a statement that specifies the data on which an operation is to be performed. It can be addressed in both absolute and symbolic terms.

**Address Identifier**

An address identifier is that part of an address of an operation that contains information, for example, the details of the memory area where the operation can access a value (data object) with which it is to perform a logic operation, or the value of a variable (data object) with which it is to perform a logic operation. In the instruction "Value := IB10", "IB" is the address identifier ("I" designates the input area of the memory and "B" stands for a byte in that area).

**Addressing**

Assignment of a memory location in the user program. Memory locations can be assigned specific addresses or address areas (examples: input I 12.1, memory word MW25)

**Addressing, Absolute**

With absolute addressing, you specify the memory location of the address to be processed. Example: The address Q4.0 describes bit 0 in byte 4 of the process-image output area.

**Addressing, Symbolic**

Using symbolic addressing, the address to be processed is entered as a symbol and not as an address. The assignment of a symbol to an address is made in the symbol table or using a symbol file.

**Array**

An array is a complex data type consisting of a number of data elements of the same type. These data elements in turn can be elementary or complex.
Assignment
Mechanism for assigning a value to a variable.

Attribute
An attribute is a characteristic that can be attached, for example, to a block identifier or variable name. In SCL there are attributes for the following items of information: block title, release version, block protection, author, block name, block family.

BCD
Binary-coded decimal. In STEP 7, internal coding of timers and counters in the CPU is in BCD format only.

Bit Memory (M)
A memory area in the system memory of a SIMATIC S7 CPU. This area can be accessed using write or read access (bit, byte, word, and double word). The bit memory area can be used to store interim results.

Block
Blocks are subunits of a user program and are distinguished by their function, their structure or their purpose. In STEP 7, there are logic blocks (FBs, FCs, OBs, SFCs and SFBs), data blocks (DBs and SDBs) and user-defined data types (UDTs).

Block Call
A block call starts a block in a STEP 7 user program. Organization blocks are only called by the operating system; all other blocks are called by the STEP 7 user program.

Block Class
Blocks are subdivided according to the type of information they contain into the following two classes: Logic blocks and data blocks;

Block Comment
You can enter additional information about a block (for example, to describe the automated process). These comments are not loaded into the work memory of SIMATIC S7 programmable controllers.
Block Protection
Using block protection, you can protect individual blocks from being decompiled. You enable this protection by assigning the keyword "KNOW_HOW_PROTECTED" when the block source file is compiled.

Block Type
The block architecture of STEP 7 includes the following block types: Organization blocks, function blocks, functions, data blocks as well as system function blocks, system functions, system data blocks and user-defined data types.

Bookmarks
Bookmarks are temporary text marks that mark a position within a source file. They facilitate navigation in the source file.

Breakpoint
This function can be used to switch the CPU to HOLD at specific points in the program. When the program reaches a breakpoint, debugging functions such as single-step instruction processing or controlling/monitoring variables are possible.

Call Hierarchy
Blocks must be called before they can be processed. The order and nesting sequence of these block calls is known as the call hierarchy.

Call Interface
The call interface is defined by the input, output and in/out parameters (formal parameters) of a block in the STEP 7 user program. When the block is called, these parameters are replaced by the actual parameters.

CASE Statement
This statement is a selective branching statement. It is used to select a specific program branch from a choice of n branches on the basis of the value of a selection expression.

Comments
Language construction with which you can include explanatory text in a program and that has no influence on the running of the program.

Compilation
The process of generating an executable user program from a source file.
**Compilation, Source-Oriented**

In source-oriented input, the source is compiled into an executable user program only when all the instructions have been entered. The compiler checks for input errors.

**Constant**

Placeholders for constant values in logic blocks. Constants are used for improving the legibility of a program. Example: Instead of specifying a value (for example, 10), the placeholder "Max_loop_iterations" is specified. When the block is called, the value of the constant (for example, 10) replaces the placeholder.

**Constant, (symbolic)**

Constants with symbolic names are placeholders for constant values in logic blocks. Symbolic constants are used for improving the legibility of a program.

**CONTINUE Statement**

A CONTINUE statement is used in SCL to terminate the execution of the current iteration of a loop statement (FOR, WHILE or REPEAT).

**Counter**

Counters are components of the system memory of the CPU. The contents of a counter are updated by the operating system asynchronously with the user program. STEP 7 instructions are used to define the precise function of a counter (for example, count up) and to execute it (for example, start).

**Data Block (DB)**

Data blocks are blocks containing the data and parameters with which the user program operates. In contrast to all other types of blocks, they contain no instructions.

**Data, Static**

Static data are local data of a function block that are stored in the instance data block and are therefore retained until the next time the function block is processed.

**Data, Temporary**

Temporary data are the local data for a block that are entered in the local stack (L stack) while the block is executing. Once a block has executed, this data is no longer available.
Data Type

Data types determine the following:

- The type and interpretation of data elements
- The permitted memory and value ranges of data elements
- The set of operations that can be performed on an address of a data type
- The notation of data elements

Data Type, Complex

Complex data types made up of data elements of elementary data types. A distinction is made between structures and arrays. The data types STRING and DATE_AND_TIME are also complex data types.

Data Type Conversion

A data type conversion is necessary when an operation is required on two variables of different data types.

Data Type, Elementary

Elementary data types are predefined data types in accordance with IEC 1131-3. Examples: The data type "BOOL" defines a binary variable ("bit"); the data type "INT" defines a 16-bit integer variable.

Data Type, User-defined

User-defined data types (UDTs) are data types you can create yourself using the data type declaration. Each one is assigned a unique name and can be used any number of times. A user-defined data type is useful for generating a number of data blocks with the same structure (for example, controller).

Declaration

A mechanism for defining a language element. A declaration involves the linking of an identifier with the language element and the assignment of attributes and data types.

Declaration Section

The variable declaration of a block is divided into various declaration sections for declaring the various block parameters. The declaration section IN contains, for example, the declaration of the input parameters, the declaration section OUT contains the declaration of the output parameters.

Declaration Section

You declare the local data of a logic block in the declaration section if you write your program with a text editor.
Download
The transfer of loadable objects (for example, logic blocks) from a programming device to the load memory of a CPU.

Enable (EN)
In STEP 7, each function block and each function has the implicitly defined input parameter "Enable" (EN) that can be set when the block is called. If EN is TRUE, the called block is executed. Otherwise it is not executed.

Enable Output (ENO)
In STEP 7 every block has an "Enable Output" (ENO). When the execution of a block is completed the current value of the OK flag is set in ENO. Immediately after a block has been called, you can check the value of ENO to see whether all the operations in the block ran correctly or whether errors occurred.

EXIT Statement
Language construction within a program used to exit a loop at any point regardless of conditions.

Expression
In SCL, an expression is a means of processing data. A distinction is made between arithmetic, logical and comparison expressions.

FOR Statement
Language construction within a program. A FOR statement is used to execute a sequence of statements in a loop while a control variable is continuously assigned values.

Formal Parameter
A formal parameter is a placeholder for the "actual" parameter in configurable logic blocks. In the case of FBs and FCs, the formal parameters are declared by the programmer, in the case of SFBs and SFCs they already exist. When a block is called, the formal parameters are assigned actual parameters with the result that the called block works with the actual values. The formal parameters count as local block data and are subdivided into input, output and in/out parameters.

Function (FC)
According to the International Electrotechnical Commission's IEC 1131-3 standard, functions are logic blocks that do not have static data. A function allows you to pass parameters in the user program, which means they are suitable for programming complex functions that are required frequently, for example, calculations.
Function Block (FB)

According to the International Electrotechnical Commission's IEC 1131-3 standard, function blocks are logic blocks with static data (Data, Static). Since an FB has a "memory" (instance data block), it is possible to access its parameters (for example, outputs) at any time and at any point in the user program.

GOTO Statement

Language construction within a program. A GOTO statement causes the program to jump immediately to a specified label and therefore to a different statement within the same block.

HOLD

The CPU changes to the HOLD state from the RUN mode following a request from the programming device. Special test functions are possible in this mode.

Identifier

Combination of letters, numbers and underscores that identify a language element.

Initial Value

Value assigned to a variable when the system starts up.

In/Out Parameter

In/out parameters exist in functions and function blocks. In/out parameters are used to transfer data to the called block, where they are processed, and to return the result to the original variable from the called block.

Input Parameters

Input parameters exist only in functions and function blocks. Input parameters are used to transfer data to the called block for processing.

Instance

The term “instance” refers to a function block call. The function block concerned is assigned an instance data block or a local instance. If a function block in a STEP 7 user program is called n times, each time using different parameters and a different instance data block name, then there are n instances.

Instance Data Block (Instance DB)

An instance data block stores the formal parameters and static local data for a function block. An instance data block can be assigned to an FB call or a function block call hierarchy.
**Integer (INT)**

Integer (INT) is one of the elementary data types. Its values are all 16-bit whole numbers.

**Keyword**

A reserved word that characterizes a language element, for example, "IF".
Keywords are used in SCL to mark the beginning of a block, to mark subsections in the declaration section and to identify instructions. They are also used for attributes and comments.

**Lexical Rule**

The lower level of rules in the formal language description of SCL consists of the lexical rules. When applied, they do not permit flexible formats; in other words, the addition of spaces and control characters is not permitted.

**Literal**

Formal notation that determines the value and type of a constant.

**Local Data**

Local data is data assigned to a specific logic block that is declared in its declaration section or in its variable declaration. Depending on the particular block, it consists of the formal parameters, static data and temporary data.

**Logic Block**

A logic block in SIMATIC S7 is a block that contains a section of a STEP 7 user program. In contrast, a data block contains only data. There are the following types of logic blocks: organization blocks (OBs), function blocks (FBs), functions (FCs), system function blocks (SFBs) and system functions (SFCs).

**Memory Area**

A SIMATIC S7 CPU has three memory areas: the load area, the working area and the system area.

**Mnemonics**

Mnemonics are the abbreviated representation of the addresses and programming operations in the program. STEP 7 supports English representation (in which, for example, "I" stands for input) and German representation (where, for example, "E" stands for input (Eingang in German)).
Monitoring
By monitoring a program, you can check how the program is executed on the CPU. During monitoring, for example, names and actual values of variables and parameters are displayed in chronological order and updated cyclically.

Multiple Instance
When multiple instances are used, the instance data block holds the data for a series of function blocks within a call hierarchy.

Non Term
A non term is a complex element in a syntactical description that is described by another lexical or syntax rule.

Offline
Offline is the operating mode in which the programming device is not connected (physically or logically) to the PLC.

OK Flag
The OK flag is used to indicate the correct or incorrect execution of a sequence of commands in a block. It is a shared variable of the type BOOL.

Online
Online is the operating mode in which the programming device is connected (physically or logically) with the PLC.

Online Help
When working with STEP 7 programming software, you can display context-sensitive help on the screen.

Operation
An operation is the part of a statement specifying what action the processor is to perform.

Organization Block (OB)
Organization blocks form the interface between the S7 CPU operating system and the user program. The organization blocks specify the sequence in which the blocks of the user program are executed.
Output Parameter

The output parameters of a block in the user program are used to pass results to the calling block.

Parameter Type

A parameter type is a special data type for timers, counters and blocks. It can be used for input parameters of function blocks and functions, and for in/out parameters of function blocks only in order to transfer timer and counter readings and blocks to the called block.

Process Image

The signal states of the digital input and output modules are stored on the CPU in a process image. There is a process-image input table (PII) and a process-image output table (PIQ).

Process-Image Input Table (PII)

The process image of the inputs is read in from the input modules by the operating system before the user program is processed.

Process-Image Output Table (PIQ)

The process image of the outputs is transferred to the output modules at the end of the user program by the operating system.

Programming, Structured

To make it easier to implement complex automation tasks, a user program is subdivided into separate, self-contained subunits (blocks). Subdivision of a user program is based on functional considerations or the technological structure of the system.

Programming, Symbolic

The SCL programming language allows you to use symbolic character strings instead of addresses: For example, the address Q1.1 can be replaced by "valve_17". The symbol table creates the link between the address and its assigned symbolic character string.

Project

A folder for storing all objects relating to a particular automation solution regardless of the number of stations, modules or how they are networked.

Real Number

A real number is a positive or negative number representing a decimal value, for example 0.339 or −11.1.
REPEAT Statement
Language construction within a program used to repeat a sequence of statements until a termination condition is reached.

RETURN Statement
Language construction within a program with which you can exit the current block.

Return Value (RET_VAL)
In contrast to function blocks, functions produce a result known as the return value.

RUN
In the RUN mode the user program is processed and the process image is updated cyclically. All digital outputs are enabled.

RUN-P
The RUN-P operating mode is the same as RUN operating mode except that in RUN-P mode, all programming device functions are permitted without restriction.

S7 User Program
A folder for blocks that are downloaded to a programmable S7 module (for example CPU or FM) and are capable of being run on the module as part of the program controlling a system or a process.

Scan Cycle Monitoring Time
If the time taken to execute the user program exceeds the set scan cycle monitoring time, the operating system generates an error message and the CPU switches to STOP mode.

Scan Cycle Time
The scan cycle time is the time required by the CPU to execute the user program once.

SCL
PASCAL-based high-level language that conforms to the standard DIN EN-61131-3 (international IEC 1131-3) and is used to program complex operations on a PLC, for example, algorithms and data processing tasks. Abbreviation for “Structured Control Language”.
**Glossary**

**SCL Compiler**
The SCL Compiler is a batch compiler which is used to translate a program written using a text editor (SCL source file) into M7 machine code. The compiled blocks are stored in the "Blocks" folder in the S7 program.

**SCL Debugger**
The SCL Debugger is a high-level language debugger used for finding logical programming errors in user programs created with SCL.

**SCL Editor**
The SCL Editor is a text editor specially designed for use with SCL with which you create SCL source files.

**SCL Source File**
An SCL source file is a file in which a program is written in SCL. The SCL source file is later translated into machine code by the SCL Compiler.

**Semantics**
Relationship between the symbolic elements of a programming language and their meaning, interpretation and application.

**Shared Data**
Shared data is data that can be accessed by any logic block (FC, FB or OB). Specifically it includes bit memory (M), inputs (I), outputs (O), timers, counters and elements of data blocks (DBs). Global data can be addressed in either absolute or symbolic terms.

**Single Step**
A single step is a step in a debugging operation carried out by the SCL Debugger. In single-step debugging mode, you can execute a program one instruction at a time and view the results of each step in the Results window.

**Source File**
Part of a program created with a graphics or textual editor from which an executable user program can be compiled.

**Statement**
A statement is the smallest indivisible unit of a user program written in a text-based language. It represents an instruction to the processor to perform a specific operation.
**Status Word**

The status word is a component of the CPU registers. The status word contains status information and error information in connection with the processing of STEP 7 commands. The status bits can be read and written by the programmer. The error bits can only be read.

**Structure (STRUCT)**

Complex data type consisting of any data elements of different data types. The data types within structures can be elementary or more complex.

**Symbol**

A symbol is a name defined by the user that adheres to certain syntax rules. This name can be used in programming and in operating and monitoring once you have defined it (for example, as a variable, a data type, a jump label, or a block). Example: Address: I 5.0, data type: Bool, Symbol: Emer_Off_Switch

**Symbol Table**

A table used to assign symbols (or symbolic names) to addresses for shared data and blocks. Examples: Emer_Off (Symbol), I1.7 (Address)Controller (Symbol), SFB24 (Block)

**Syntax Rule**

The higher level of rules in the formal SCL language description consists of the syntactical rules. When they are used they are not subject to formatting restrictions; in other words, spaces and control characters can be added.

**System Data Block (SDB)**

System data blocks are data areas in the S7 CPU that contain system settings and module parameters System data blocks are created and edited using the STEP 7 standard software.

**System Function (SFC)**

A system function (SFC) is a function integrated in the CPU operating system that can be called in the STEP 7 user program when required.

**System Function Block (SFB)**

A system function block (SFB) is a function block integrated in the CPU operating system that can be called in the STEP 7 user program when required.
**System Memory (System Area)**

The system memory is integrated in the S7 CPU and is implemented as RAM. The address areas (timers, counters, bit memory etc.) and data areas required internally by the operating system (for example, backup for communication) are stored in the system memory.

**Term**

A term is a basic element of a lexical or syntax rule that can not be explained by another rule but is represented in literal terms. A term might be a keyword or even a single character.

**Timers**

Timers are components of the system memory of the CPU. The contents of these timers are updated by the operating system asynchronously to the user program. You can use STEP 7 instructions to define the exact function of the timer (for example, on-delay timer) and start its execution (Start).

**UDT**

See: Data Type, User-defined

**User Data**

User data are exchanged between a CPU and a signal module, function module and communications modules via the process image or by direct access. Examples of user data are: Digital and analog input/output signals from signal modules, control and status data from function modules.

**User Program**

The user program contains all the statements and declarations and the data required for signal processing to control a plant or a process. The program is assigned to a programmable module (for example, CPU, FM) and can be structured in the form of smaller units (blocks.)

**Variable**

A variable defines an item of data with variable content that can be used in the STEP 7 user program. A variable consists of an address (for example, M3.1) and a data type (for example, BOOL), and can be identified by means of a symbolic name (for example, TAPE_ON): Variables are declared in the declaration section.

**Variable Declaration**

The variable declaration includes the specification of a symbolic name, a data type and, if required, an initialization value and a comment.
Variable Table

The variable table is used to collect together the variables including their format information that you want to monitor and modify.

View

To be able to access a declared variable with a different data type, you can define views of the variable or of areas within the variables. A view can be used like any other variable in the block. It inherits all the properties of the variable that it references; only the data type is new.
Index

*  11-8, 11-9
**  11-8
/
  11-8
+
  11-8, 11-9
<
  11-14
<=  11-14
<>  11-12
<=  11-14
>=  11-12

A
ABS  14-9
Absolute Access to Data Blocks  10-8
Absolute Access to Memory Areas of the CPU  10-3
Absolute Addressing  15-28
ACOS  14-10
Actual Parameters  8-1
  Definition  8-1
Addition  11-2
Address Identifier  5-9
Addresses  10-2, 11-3, 11-4
Allocating Structures with an Odd Byte Length  16-5
And  11-2
AND  11-10, 11-11
ANY  7-19, 7-20
ANY Data Type  7-19
Area of application  1-1
Arithmetic Expressions  11-8

ARRAY  7-9, 7-10, 8-3, 8-4, 12-5, 12-6
  Initialization  8-3
  Value Assignment with Variables of the Data Type ARRAY  12-5
ARRAY Data Type  7-9
Arrays  7-9
ASIN  14-10
AT  8-5
ATAN  14-10
Attributes  6-6, 6-9, 6-11
Authorization  2-1
  Authorization Diskette  2-6
AUTHORS.EXE  2-6
Automation License Manager  2-1, 2-4

B
Basic Terms in SCL  5-4, 5-13
BIT  7-3
Bit Constants  9-6
Bit Data Types  7-3
Bit Memory  10-2
Bit String Standard Functions  14-11
Block Attributes  6-5, 6-9
  Definition  6-5
  Lexical Rules  15-31
  System Attributes for Blocks  6-9
Block Call  4-16
BLOCK Data Types  7-16
Block End  6-3
Block Identifier  5-7, 5-8
Block Name  6-3, 6-4
Block Parameters  5-17, 8-13
Block Protection  4-7
Block Start  6-3
Block Structure  6-3
Block Templates  4-16
BLOCK_DB_TO_WORD  14-3
Blocks  3-4, 3-5, 4-6, 4-1
Bookmarks  4-15
Boolean Expression  11-12
Boxes in Syntax Diagrams  5-1
Breakpoints  4-33, 4-36
BYTE  7-3
BYTE_TO_BOOL  14-3
BYTE_TO_CHAR  14-3
Index

C

Call environment 4-32
Calling Blocks 4-16
Calling Counter Functions 13-1
Calling Function Blocks (FB or SFB) 12-28
  Call as Local Instance 12-28
  Call as Shared Instance 12-28
  In/Out Assignment 12-31
  Input Assignment 12-30
  Procedure 12-28
  Reading Output Values 12-32
  Supplying FB Parameters 12-29
  Syntax 12-28
  Calling Functions (FC) 12-34
    Input Assignment 12-38
    Input Parameter EN 12-41
    Output or In/Out Assignment 12-39
    Output Parameter ENO 12-42
    Parameter Supply 12-37
    Procedure 12-34
    Return Value 12-36
    Syntax 12-34
    Calling Timer Functions 13-9
    CASE Statement 12-12, 12-16
    Certificate of License 12-12, 12-16
    CHAR 7-3
    Char Constants 9-9
    CHAR_TO_BYTE 14-3
    CHAR_TO_INT 14-3
    Character Set 5-4
    Character Strings 5-13
    Character Types 7-3
    Checking the Block Consistency 4-38
    Closing an S7-SCL Source File 4-5
    Color and Font of the Source Text 4-14
    Color and Font Style of the Source Text 4-25
    Comment
    Comment Section 5-15
    Inserting Templates for Comments 4-16
    Lexical Rules 15-30
    Comment Section 5-15
    Comments
    Line Comment 6-16
    Comparison Expressions 11-12
    Compilation Control File 4-22
    Compiler 1-2
    Customizing the Compiler 4-19
    Compiler control file 6-21
    Compiler options 6-21
    Compiler Options 15-33
    Compiling 4-18, 4-22, 6-21
    Complex Data Types 7-1, 7-5, 7-7
    CONCAT 14-13
    Conditions 12-13
    Constants 9-2, 9-17
    CONTINUE Statement 12-12, 12-23
    Continuous Monitoring 4-29
    Control File for Compilation 4-22
    Control Statements 4-17, 6-13, 12-14
    CASE Statement 12-16
    CONTINUE Statement 12-23
    EXIT Statement 12-24
    FOR Statement 12-18, 12-19
    GOTO Statement 12-25
    IF Statement 12-14
    Inserting Control Statements 4-17
    REPEAT Statement 12-22
    Statements 6-13
    Syntax Rules 15-52
    WHILE Statement 12-20
    Conversion Functions 14-3
    Class B 14-3
    Copying Text Objects 4-10
    Correct Syntax Formatting the Source Text 4-14
    COS 14-10
    Count Down (S_CD) 13-6
    Count Up (S_CU) 13-6
    Count Up/Down (S_CUD) 13-7
    COUNTER 7-15, 13-3
    COUNTER Data Type 7-15
    Counters 13-1, 13-7
    Calling Counter Functions 13-1
    Count Down (S_CD) 13-6
    Count Up (S_CU) 13-6
    Count Up/Down (S_CUD) 13-7
    Example of Counter Functions 13-7
    Input and Evaluation of the Counter Value 13-5
    Parameter Supply for Counter Functions 13-3
    CPU Communication 4-43
    CPU Memory Areas 5-9
    CPU Memory Reset 4-26
    Creating a Compilation Control File 4-22
    Creating a New S7-SCL Source File 4-4
    Creating Source Files with a Standard Editor 4-6
    Customizing 4-3, 4-19
    Customizing the Page Format 4-23
    Cutting Text Objects 4-11
    Cycle Time 4-42
    D
    Data Blocks 10-7, 10-11
    Data Type Conversion Functions 14-3, 14-6
    Data Type POINTER 7-17
    Data Type STRUCT 7-11
    Data Type UDT 7-13
    Data Types 7-1, 7-13
    Complex 7-2
    Description 7-1
    Elementary 7-1, 7-2
    User-Defined (UDT) 6-19
    User-Defined (UDT) 7-13
    Data types for Parameters 7-17
    Data Types for Parameters 7-15, 7-16
    DATE 7-4
    Date Constant 9-13
    DATE_AND_TIME 7-5
    DATE_AND_TIME Data Type 7-5
    DATE_TO_DINT 14-3
    Debugger 1-2

S7-SCL V5.3 for S7-300/400
A5E00324650-01
Index-2
Index

Debugging Functions in STEP 7  4-37
Debugging Functions of STEP 7  4-38
Debugging in Single Steps  4-30
Debugging the Program After Compilation  4-22
Declaration  6-10
Declaration of Static Variables  8-2
Declaration Section  6-10, 8-3 - 8-14
   Block Parameters  8-14
   Definition  6-10
   Initialization  8-3
   Overview of the Declaration Subsections  8-10
   Static Variables  8-11
   Structure  6-10
   Syntax Rules  15-37
   Temporary Variables  8-12
Defining a call environment for blocks  4-32
Defining A Call Environment for Breakpoints  4-35
DELETE  14-15
Deleting Text Objects  4-11
Designing S7-SCL Programs  3-1
   Development environment  1-3
DI_STRING  14-19
Diagnostic Buffer  4-41
DIN standard EN-61131-3  1-1
DINT  7-3
DINT_TO_DATE  14-3
DINT_TO_DWORD  14-3
DINT_TO_INT  14-4
DINT_TO_TIME  14-3
DINT_TO_TOD  14-3
Displaying and Modifying the CPU Operating Mode  4-40
Displaying and Setting the Date and Time on the CPU  4-40
Displaying Information about Communication with the CPU  4-43
Displaying the Blocks on the CPU  4-42
Displaying the Cycle Time of the CPU  4-42
Displaying the Stacks of the CPU  4-43
Displaying the Time System of the CPU  4-42
Displaying/Compressing the User Memory of the CPU  4-41
DIV  11-8
Division  11-2
Double Word  7-3
Downloading  4-26
Downloading User Programs  4-26
DWORD  7-3
DWORD_TO_BOOL  14-3
DWORD_TO_BYTE  14-3
DWORD_TO_DINT  14-3
DWORD_TO_REAL  14-3
DWORD_TO_WORD  14-3

E
Editing an S7-SCL Source File  4-9
Editor  1-2
Emergency Authorization  2-6
EN  12-41
ENO  12-42
EQ_STRING  14-17
Equality  11-2
Examples  7-20, 12-32, 12-33, 12-40, 13-7, 13-19, 14-7, 14-10, 14-12
Exclusive Or  11-2
EXIT Statement  12-12, 12-24
EXP  14-9
EXPD  14-9
Expressions  11-2 - 11-14
Extended Variable  11-4

F
FB Parameters  12-29, 12-32
FC  6-16, 6-17, 12-27, 12-34
FC Parameters  12-37, 12-39
Field (ARRAY)  12-5
FIND  14-16
Finding Text Objects  4-9
Flags (OK Flag)  8-9
Flexible Format  5-2
Flow Chart for ACQUIRE  3-18
Flow Chart for EVALUATE  3-14
Font Style and Color  4-14, 4-25
FOR Statement  12-12, 12-18
Formal Language Description  15-1
Formal Parameters  8-1
Fulfilling of standard  1-1
Function (FC)  6-16, 12-27, 12-34
Function Block (FB)  6-14, 12-27, 12-29
Functions for Rounding and Truncating  14-6
Functions for Selecting Values  14-24
Functions of S7-SCL  1-4

G
GE_STRING  14-17
Generating and Displaying Reference Data  4-37
Go To  4-12
GOTO Statement  12-25
GT_STRING  14-18
Guidelines
   Handling License Keys  2-5
Guidelines for Handling License Keys  2-5
H

How S7-SCL functions 1-2

I

I_STRING 14-19
Identifiers 5-6, 15-17
Definition 5-6
Examples 5-6
Formal Language Description 15-15, 15-17
Lexical Rules 15-21
Rules 5-6
IF Statement 12-12
In/Out Assignment 12-31
In/Out Assignment (FB/SFB) 12-31
In/Out Assignment (FC) 12-39
In/Out Parameters 12-31
Indent Automatically 4-13
Indexed Access to Memory Areas of the CPU 10-6
Inequality 11-2
Initial Values 8-3
Initialization 8-3
Input Parameter 12-41
Input Parameters 8-1, 12-30, 12-38
Definition 8-1
Input Assignment (FB) 12-30
Input Assignment (FC) 12-38
Input Parameter EN 12-41
INSERT 14-15
Inserting Block Calls 4-16
Inserting Block Templates 4-16
Inserting Control Structures 4-17
Inserting Parameter Templates 4-17
Inserting Templates for Comments 4-16
Installation 2-6
Installation Requirements 2-6
Installing the Automation License Manager 2-4
Instance Declaration 8-8
INT 7-3
INT_TO_CHAR 14-3
INT_TO_WORD 14-3
Integer Constant 9-7
Integer Division 11-2

J

Jump Statements 12-12

K

Keywords 5-5, 15-10

L

Labels 9-18
Language Description 5-1, 15-1
LE_STRING 14-17
LEFT 14-14
LEN 14-13
Lexical Rules 2-2, 2-3
License Key 2-1, 2-2, 2-3
License Keys 2-5
License Manager 2-1, 2-2
License Types 2-1
Enterprise License 2-1
Floating License 2-1
Rental License 2-1
Single License 2-1
Trial License 2-1
Upgrade License 2-3
Line Comment 5-16
Line Indent 4-13
Line Numbers 4-3, 4-25
Literals 9-6, 9-17
see constants 15-23
LN 14-9
Local Data 5-17, 8-1, 8-3, 8-11, 8-12
Local Instance 12-28, 12-29, 12-34
LOG 14-9
Logarithmic Functions 14-9
Logic Blocks 3-4, 4-8, 8-1
Loops 12-12
LT_STRING 14-18

M

Math Standard Functions 14-9, 14-10
Memory Areas of the CPU 10-1, 11-6
Memory Location of Variables 8-5
Menu Bar 4-2
MID 14-14
MOD 11-9
Modulo Function 11-2
Monitoring 4-29, 4-31, 4-32
Multiple Instances 8-7
Multiplication 11-2
Index

N
Names 5-6
Definition 5-6
Examples 5-6
Formal Language Description 15-15, 15-17
Rules 5-6
NE_STRING 14-17
Negation 11-2
NIL Pointer 7-19
Non Terms (in syntax diagrams) 15-14
Nonprintable Characters 9-10, 9-11
NOT 11-10, 11-11
Numbers 5-11, 5-12
Numeric Data Types 7-3
Numeric Standard Functions 14-9, 14-10

O
OB 6-18
OK Flag 8-1, 8-9
Opening an S7-SCL Source File 4-5
Opening Blocks 4-6
Operating Mode 4-40
Operations 15-9
Alphabetic List 15-7
Or 11-2
OR 11-10, 11-11
Order of the Blocks 4-8
Organization Block 6-18
Output Parameter ENO 12-42
Output Parameters 8-1

P
Page Break 4-25
Page Format 4-23
Parameter 8-13, 8-14
Parameter Supply 12-27
Parameter Supply for Counter Functions 13-3
Parameter Templates 4-17
Parameters 6-11, 7-15, 7-16, 8-1, 8-10,
12-29, 12-39
Parenthesis 11-2
Peripheral Inputs/Outputs 10-2
Placing bookmarks in the source text 4-15
POINTER 7-17, 7-18
Positioning the Cursor in a Specific Line 4-12
Power 11-2
Predefined Constants and Flags
Formal Language Description 15-20
Printable Characters 9-9, 9-11
Printing an S7-SCL Source File 4-24
Process Image of the Inputs and Outputs 10-2
Program Branch 12-12
Program Design 3-1
Program Jump 12-12

S
S_CD 13-6
S_CU 13-6
S_CUD 13-6
S_ODT 13-16
S_ODTS 13-17
S_OFFDT 13-18
S_PEXT 13-15
S_PULSE 13-14
S5 Time 13-12
S5TIME 7-4
S7-SCL 1-2, 1-3, 1-4
functions 1-4
How it works 1-2
S7-SCL debug functions 4-32
S7-SCL Debugging Functions 4-28, 4-30
S7-SCL User Interface 4-2
Sample Program "Measured Value Acquisition" 3-1
Sample Program for First-Time Users 3-1
Saving an S7-SCL Source File 4-23
Selecting Text Objects 4-10
Selecting the Right Timer 13-20
Selective Statement 12-20

Programming
structured 1-4
Programming language
higher-level 1-1
Programming with Symbols 4-8
Programming language
higher-level 1-4

R
R_STRING 14-20
Reading Out CPU Data 4-41
Reading Out the Diagnostic Buffer of the CPU 4-41
Reading Output Values 12-32
Output Assignment at an FC Call 12-39
Output Assignment in an FB Call 12-32
REAL 7-3
Real Number Constant 9-8
REAL_TO_DINT 14-3
REAL_TO_DWORD 2) 14-3
REAL_TO_INT 14-3
Redoing an Editing Action 4-9
Reference Data 4-37
REPEAT Statement 12-12, 12-22
REPLACE 14-16
Replacing Text Objects 4-9
Reserved Words 5-5
RETURN Statement 12-12, 12-26
Return Value 12-36
Return Value (FC) 12-36
RIGHT 14-14
ROL 14-11
ROR 14-11
ROUND 14-6
Rule Structures 5-1
Rules for S7-SCL Sources 4-7

S7-SCL V5.3 for S7-300/400
ASE00324650-01
Index-5
### Index

| Setting the Date | Setting the Time | SFCs/SFBs | Shared Data | Shared Instance | Simple Expression | SIN | Single Step | Source File | Source Files | Specifying Object Properties | SHL | SHR | SQR | SQRT | Standard Functions | Standard Identifier | Starten | Statement Section | Structure | Syntax Rules | Statements | Static Variables | Status Bar | STEP 7 Debugging Functions | STRING | STRING Data Type | STRING_TO_CHAR | STRUCT | STRUCTURE | SUBROUTINE CALL | Symbolic Access the Memory Areas of the CPU | Symbolic Constants | Syntax Diagrams | Syntax Rules | System Attributes | System Functions/Function Blocks and the Standard Library | TAN | Templates | Templates for Blocks | Templates for Comments | Templates for Control Structures | Templates for Parameters | Temporary Variables | Terminable Condition | Terms Used in the Lexical Rules (Syntax Diagrams) | Textmarks | TIME | TIME Period Constant | Time System | Time Value | TIME_OF_DAY | TIME_TO_DINT | Timer | Timer Data Type | Timer Functions | Timers | Calling Timer Functions | Examples | Input and Evaluation of a Time Value | Start Timer as Extended Pulse Timer | Start Timer as Off-Delay Timer (S_OFFDT) | Start Timer as On-Delay Timer (S_ODT) | Start Timer as Pulse Timer (S_PULSE) | Start Timer as Retentive On-Delay Timer (S_ODTS) | Supplying Parameters for Timer Functions | Title Bar | TOOLBAR | TRUNC | UDT | UDT Call | UDT Definition | UDT Elements | Unary Minus | Unary Plus | Undoing the Last Editing Action | Uninstalling the User Authorization | User Authorization | User Data | Shared | User Interface | User Memory | User Program |
|----------------|-----------------|-----------|-------------|----------------|------------------|-----|-------------|------------|-------------|-----------------------------|-----|-----|-----|-----|----------------|-------------------|---------|----------------|----------|-------------|----------------|---------------|----------------|----------------|----------------|----------------|----------------|----------------|----------------|---------------|----------------|----------------|----------------|----------------|----------------|---------------|----------------|
| 4-40 | 4-40 | 14-28 | 10-1 | 12-28, 12-32 | 11-7 | 14-10 | 4-30 | 4-4, 4-24, 6-12, 6-19 | 4-8 | 4-6 | 5-17, 8-1, 8-12 | 12-24 | 10-1 | 4-1 | 6-12 | 10-2 | 6-2 | 6-10-6-18 | 6-10 | 6-10 | 13-9-13-19 | 13-19 | 13-13 | 4-2 | 4-16 | 4-16 | 4-16 | 4-17 | 4-17 | 9-13 | 4-42 | 13-12, 13-13 | 7-4 | 14-3 | 9-16 | 7-4 | 13-15 | 13-18 | 13-16 | 13-14 | 13-17 | 13-11 | 4-2 | 14-3 | 14-6 | 7-13, 7-14 | 6-19 | 6-20 | 6-19 | 11-2 | 11-2 | 4-9 | 2-5 | 2-6 | 6-1 | 10-1 | 10-1 | 4-2 | 4-41 | 3-4, 6-1 |
User Rights Through The Automation License Manager 2-1
User-Defined Data Types (UDT) 6-19, 12-3
User-Defined Data Types (UDT) 7-13

V
Value Assignment 12-2 - 12-10
Syntax Rules 15-47
Value Assignment with Absolute Variables for Memory Areas 12-9
Value Assignment with Variables of the Type DATE_AND_TIME 12-8
Value Assignment with Variables of the Type STRUCT and UDT 12-3
Value Assignments with Shared Variables 12-10
Value Assignments with Variables of an Elementary Data Type 12-2
Value Assignments with Variables of the Data Type ARRAY 12-5
Value Assignments with Variables of the Type STRING 12-7
Value Assignments with Variables of the Data Type ARRAY 12-5
Value Assignments 6-13
VAR 8-10
VAR_IN_OUT 8-10
VAR_INPUT 8-10
VAR_OUTPUT 8-10
VAR_TEMP 8-10

Variables
General Syntax of a Variable or Parameter Declaration 8-2
Initialization 8-3 - 8-4
Instance Declaration 8-8
Local Variables and Block Parameters 8-1
Monitoring/Modifying Variables 4-38
Overview of the Declaration Subsections 8-10
Static Variables 5-17, 8-1
Temporary Variables 5-17, 8-1
Views of Variable Ranges 8-5

W
Warnings 4-22
What is new? 1-6
WHILE Statement 12-12, 12-20
WORD 7-3
WORD_TO_BLOCK_DB 14-3
WORD_TO_BOOL 14-3
WORD_TO_BYTE 14-3
WORD_TO_INT 14-3
Working Area 4-2
Working with an S7-SCL Source File 4-5, 4-6, 4-23, 4-24

X
XOR 11-10